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Objectives
After studying this unit, you will be able to:
z

Explain the growing importance of computer-based instructional design tools

z

Describe a sample of computer-based ID tools

z

Discuss the types of graphic applications

z

Elaborate upon the web and window based graphics

Introduction
A computer is a crucial element in today’s design world. It acts both as design tool and business
tool. You can create illustrations; work with type, touch-up photos and complete layouts, all
with the help of graphics software. Products like Photoshop and Illustrator, focus on the creative
part of design. The business end of design is handled by other packages, such as project
management or time tracking software, which also will help you stay organized.
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1.1 The Growing Importance of Computer-based ID Tools
The term “new learning” refers to an extensive collection of instructional approaches that are all
characterized by their rivet on rich, multidisciplinary and cooperative learning tasks (called
projects, problems, etc.) that are, in one way or another, account for authentic, real-life tasks. All
the tasks must make sure that integrate multiple learning objectives and active learning happen
in a significant way. Collaborative learning tasks take advantage of the fact that multiple
perspectives on reality exist which enriches the learning experience and also provides the prospect
for negotiation between students. From a task-analytical perspective, new learning asks for
more potent techniques that can deal with authentic-life tasks and, especially, intricate sets of
integrated learning objectives.
The design of practice is given precedence over the traditional design of to be presented
information especially from a design perspective. The changes contribute to an incremented
intricacy of the design process and the instructional systems. All the other changes, though may
be of less consequence but are still very importance to the design process.
The context is elucidated by a comprehensive contextual analysis and all stakeholders are
identified. To cope with personalized and individualized forms of injunctive authorization,
(which are needed to develop authentically learner-centred instructional systems), traditional
target group analysis are developed.
The increased use of Information and Communication Technology (ICT) in instructional systems
has its own design challenges and problems. A balanced approach is required to find a best
possible medium mix, rather than selecting just one primary medium.

1.2 Types of Graphic Applications
Now you will learn about different types of Graphic applications.

1.2.1 Understanding Graphic Types
The different graphic types are as follows:

Bitmap
In computer graphics, a bitmap or pixmap is a type of memory organization or image file
format used to store digital images. The term bitmap comes from the computer programming
terminology, meaning just a map of bits, a spatially mapped array of bits. Now, along with
pixmap, it commonly refers to the similar concept of a spatially mapped array of pixels. Raster
images in general may be referred to as bitmaps or pixmaps, whether synthetic or photographic,
in files or in memory.

!
Caution In some contexts, the term bitmap implies one bit per pixel, while pixmap is used
for images with multiple bits per pixel.

Many graphical user interfaces use bitmaps in their built-in graphics subsystems; for example,
the Microsoft Windows and OS/2 platforms’ GDI subsystem, where the specific format used is
the Windows and OS/2 bitmap file format, usually named with the file extension of .BMP (or
.DIB for device-independent bitmap). Besides BMP, other file formats that store literal bitmaps
include InterLeaved Bitmap (ILBM), Portable Bitmap (PBM), X Bitmap (XBM), and Wireless
Application Protocol Bitmap (WBMP). Similarly, most other image file formats, such as JPEG,
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TIFF, PNG, and GIF, also store bitmap images (as opposed to vector graphics), but they are not
usually referred to as bitmaps, since they use compressed formats internally.

Notes

Vector Graphics
Vector graphics is the use of geometrical primitives such as points, lines, curves, and shapes or
polygon(s), which are all based on mathematical equations, to represent images in computer
graphics.
Vector graphics formats are complementary to raster graphics, which is the representation of
images as an array of pixels, as it is typically used for the representation of photographic
images. There are instances when working with vector tools and formats is best practice, and
instances when working with raster tools and formats is best practice. There are times when
both formats come together. An understanding of the advantages and limitations of each
technology and the relationship between them is most likely to result in efficient and effective
use of tools.
Figure 1.1: Effect of Vector Graphics versus Raster Graphics

The original vector-based illustration is at the left. The upper-right image illustrates magnification
of 7x as a vector image. The lower-right image illustrates the same magnification as a bitmap
image. Raster images are based on pixels and thus scale with loss of clarity, while vector-based
images can be scaled indefinitely without degrading.

Overview of Vector Graphic
Computer displays are made up from small dots called pixels. The picture is built up from these
dots. The smaller and closer the dots are together, the better the quality of the image, but the
bigger the file needed to store the data. If the number of pixels is kept constant, the size of each
pixel will grow and the image becomes grainy when magnified, as the resolution of the eye
enables it to pick out individual pixels.
Vector graphics files store the lines, shapes and colours that make up an image as mathematical
formulae. A vector graphics program uses these mathematical formulae to construct the screen
image, building the best quality image possible, given the screen resolution. The mathematical
formulae determine where the dots that make up the image should be placed for the best results
when displaying the image. Since these formulae can produce an image scalable to any size and
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detail, the quality of the image is only determined by the resolution of the display, and the file
size of vector data generating the image stays the same. Printing the image to paper will usually
give a sharper, higher resolution output than printing it to the screen but can use exactly the
same vector data file.

Did u know? JPEG images don’t support transparency.

Editing Vector Graphics
Vector graphic drawing software is used for creating and editing vector graphics. The image can
be changed by editing screen objects which are then saved as modifications to the mathematical
formulae. Mathematical operators in the software can be used to stretch, twist, and colour
component objects in the picture or the whole picture, and these tools are presented to the user
intuitively through the graphical user interface of the computer. It is possible to save the screen
image produced as a bitmap/raster file or generate a bitmap of any resolution from the vector
file for use on any device.
The size of the file generated will depend on the resolution required, but the size of the vector
file generating the bitmap/raster file will always remain the same. Thus, it is easy to convert
from a vector file to a range of bitmap/raster file formats but it is much more difficult to go in
the opposite direction, especially if subsequent editing of the vector picture is required. It might
be an advantage to save an image created from a vector source file as a bitmap/raster format,
because different systems have different (and incompatible) vector formats, and some might not
support vector graphics at all. However, once a file is converted from the vector format, it is
likely to be bigger, and it loses the advantage of scalability without loss of resolution. It will
also no longer be possible to edit individual parts of the image as discrete objects.
Vector formats are not always appropriate in graphics work. For example, digital devices such
as cameras and scanners produce raster graphics that are impractical to convert into vectors, and
so for this type of work, the editor will operate on the pixels rather than on drawing objects
defined by mathematical formulae. Comprehensive graphics tools will combine images from
vector and raster sources, and may provide editing tools for both, since some parts of an image
could come from a camera source, and others could have been drawn using vector tools.

Standards
The W3C standard for vector graphics is SVG. The standard is complex and has been relatively
slow to be established at least in part owing to commercial interests. Many web browsers now
have some support for rendering SVG data but full implementations of the standard are still
comparatively rare.

Applications
One of the first uses of vector graphic displays was the US SAGE air defense system. Vector
graphics systems were only retired from U.S. en route air traffic control in 1999, and are likely
still in use in military and specialized systems. Vector graphics were also used on the TX-2 at the
MIT Lincoln Laboratory by computer graphics pioneer Ivan Sutherland to run his program
Sketchpad in 1963.
Subsequent vector graphics systems, most of which iterated through dynamically modifiable
stored lists of drawing instructions, include Digital’s GT40. There was a home gaming system
that used vector graphics called Vectrex as well as various arcade games like Asteroids and
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Space Wars. Storage scope displays, such as the Tektronix 4014, could display vector images but
not modify them without first erasing the display.

Notes

Modern vector graphics displays can sometimes be found at laser light shows, where two fastmoving X-Y mirrors are used to rapidly draw shapes and text on a screen.
The term “vector graphics” is mainly used today in the context of two-dimensional computer
graphics. It is one of several modes an artist can use to create an image on a raster display. Other
modes include text, multimedia, and 3D rendering. Virtually all modern 3D rendering is done
using extensions of 2D vector graphics techniques. Plotters used in technical drawing still draw
vectors directly to paper.

Did u know? JPEGs lose quality every time they are opened, edited and saved.

Vector Operations
Vector graphics editors typically allow rotation, movement, mirroring, stretching, skewing,
affine transformations, changing of z-order and combination of primitives into more complex
objects.
More sophisticated transformations include set not operations on closed shapes (union, difference,
intersection, etc.).
Vector graphics are ideal for simple or composite drawings that need to be device-independent,
or do not need to achieve photo-realism. For example, the PostScript and PDF page description
languages use a vector graphics model.

3D Modeling
In 3D computer graphics, vectorized surface representations are most common (bitmaps can be
used for special purposes such as surface texturing, height-field data and bump mapping). At the
low-end, simple meshes of polygons are used to represent geometric detail in applications
where interactive frame rates or simplicity are important.
Figure 1.2: 3D Modelling
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At the high-end, where one is willing to trade-off higher rendering times for increased image
quality and precision, smooth surface representations such as Bézier patches, NURBS or
Subdivision surfaces are used. One can, however, achieve a smooth surface rendering from a
polygonal mesh through the use of shading algorithms such as Phong and Gouraud.
Figure 1.3: Another Example of 3D Modeling

Source: Sastra/MCA/STMCA502/Graphics and Multimedia/Chapter13

1.2.2 Meaning of Graphic Design
Graphic Design is an interdisciplinary, problem-solving process which combines visual
sensitivity with skill and knowledge in areas of communications, technology and business.
Graphic designers specialize in the structuring and organizing of visual information to assist
communication and orientation. The graphic design process is a crisis handling activity, one
that requires substantial creativity, innovation and technical expertise. An understanding of a
client’s product or service and goals, their competitors and the target audience is translated into
a visual solution created from the manipulation, combination and utilization of shape, space,
typography, imagery and color.

1.2.3 Working of Graphic Designer
Graphic designers create visual concepts, by hand or using computer software, to communicate
ideas that inspire, inform, or captivate consumers. They help to make an organization recognizable
by selecting color, images, or logo designs that represent a particular idea or identity to be used
in advertising and promotions.
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A graphic designer is a professional within the graphic design and graphic arts industry who
assembles together images, typography or motion graphics to create a piece of design. A graphic
designer creates the graphics primarily for printed, published or electronic media, such as
advertising and brochures. They are also sometimes responsible for illustration, typesetting,
web design, user interfaces or take a teaching position. A core responsibility of the designer’s
job is to present information in a way that is both accessible and unforgettable.

Notes

1.2.4 Types of Graphic Design
Graphic designers use a wide variety of communication tools, mainly typography and image, in
order to convey a message on behalf of client to particular viewers.

Image-based Design
Designers develop images to represent the ideas their clients want to communicate. Images can
be extremely influential and convincing means of communication, conveying not only
information but also moods and emotions. People react to images instinctively based on their
personalities, associations, and previous experience. For example, you know that a green dot
means vegetarian, and this knowledge in combination with the image creates a visual pun.
Figure 1.4: The Image based Graphic Design

In the case of image-based design, the images must transmit the entire message; there are few if
any words to help. These images may be photographic, painted, drawn, or graphically rendered
in many different ways. Image-based design is used when the designer determines that a picture
is indeed worth a thousand words.

Type-based Design
In some cases, designers rely on words to express a message, but they use words in a different
way from what writers do. To designers, what the words look like is as important as their
meaning. They can arrest your attention on a poster, identify the product name on a package or
a truck, and present running text as the typography in a book does. Designers are experts at
presenting information in a visual form in print or on film, packaging, or signs.
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Figure 1.5: Type based Graphic Design

When you look at an “ordinary” printed page of running text, what is involved in designing
such a seemingly simple page? Think about what you would do if you were asked to redesign
the page. Would you change the typeface or type size? Would you divide the text into two
narrower columns? What about the margins and the spacing between the paragraphs and lines?
Would you indent the paragraphs or begin them with decorative lettering? What other kinds of
treatment might you give the page number? Would you change the boldface terms, perhaps
using italic or underlining? What other changes might you consider, and how would they affect
the way the reader reacts to the content? Designers evaluate the message and the audience for
type-based design in order to make these kinds of decisions.

Image and Type Based
Designers often combine images and typography to correspond a client’s message to an audience.
They explore the creative possibilities presented by words (typography) and images
(photography, illustration, and fine art). It is up to the designer not only to find or create
appropriate letterforms and images but also to establish the best balance between them.
Figure 1.6: Image and Type based Graphic Design

Designers are the link between the client and the audience. On the one hand, a client is often too
close to the message to understand various ways in which it can be presented. The audience, on
the other hand, is often too large to have any direct impact on how a message is presented.
What’s more, it is usually difficult to make the audience a part of the creative process. Unlike
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client and audience, graphic designers learn how to construct a message and how to signify it
successfully. They work with the client to understand the content and the purpose of the message.
They often collaborate with market researchers and other specialists to understand the nature of
the audience. Once a design concept is chosen, the designers work with illustrators and
photographers as well as with typesetters and printers or other production specialists to create
the final design product.

Notes

Symbols, Logos and Logotypes
Symbols and logos are special, highly condensed information forms or identifiers. Symbols are
conceptual representation of a particular idea or identity. For example, The Twitter “bird” and
the WWF “panda” are symbolic forms, which we learn to recognize as representing a particular
concept or company. Logotypes are corporate identifications based on a special typographical
word treatment. Some identifiers are hybrid, or combinations of symbol and logotype. In order
to create these identifiers, the designer must have a clear vision of the corporation or idea to be
represented and of the audience to which the message is aimed.
Figure 1.7: Twitter and WWF Logo

Source: http://www.aiga.org/guide-whatisgraphicdesign/

1.2.5 Graphic Design Process
A good graphic design process is planned around ensuring the client gets the highest quality
solution and service appropriate to their business, marketing or communication problem. There
are four main steps involved between client and designer.

Briefing
The briefing stage may consist of either or both of the following:
z

Initial informal discussions between the client and the designer – covering project
objectives, timing and budget.

z

Formal meetings to discuss the project in detail and clarify any technical issues including
budget, timetable and corporate identity guidelines.

Design
z

The designer reviews the brief, background material and identity standards to ensure
understanding of the project context and your corporate requirements.
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z

The designer develops the draft concepts and preliminary designs and selects the most
suitable options for further development.

z

The designer presents visual solutions and explains design decisions.

z

Together one will evaluate the visual presentation against the brief.

Notes Following your review and feedback, the designer amends the material as required
and, if necessary, presents you with new design(s).

Artwork
z

Your designer prepares the artwork files and provides a proof (email or hardcopy).

z

You either approve the artwork by signing the proof, or mark-up changes you’d like to
make.

z

A further proof is provided if required.

z

Any “author’s corrections” (client requested changes to content already provided which
may include additional charges: these should be detailed in any quote conditions provided
with your initial quote).

Production
The designer forwards the artwork to a commercial printer.
z

The designer views the printer’s proof and passes the proof on to the client for approval.

z

In some cases, the designer can conduct a “press check” of the printed sample while the job
is running on the printing press.

Task Design any graphic logo for accompany of your choice in paint.

Self Assessment
State whether the following statements are true or false:
1.
2.

The term bitmap comes from the computer programming terminology, meaning bits of
map.
Vector graphics is the use of geometrical primitives such as points, lines, curves, etc.

3.

Computer displays are made up from small cubes called pixels.

4.

The W3C standard for vector graphics is SVG.

5.

To designers, in Type based design, what the words look like is as important as their
meaning.

1.3 Multimedia Computer and IDS
As you now know different types of graphic design, you will understand the different means
requires to create them
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1.3.1 Configuration of a Multimedia Computer

Notes

A good multimedia system should have a Dual Core Processor (or the one with similar
capabilities) onwards processor, at least 1GB of RAM, 320 GB onwards hard disk drive, 15 inch
onwards SVGA monitor 1Gb N-Vidia or ATI Radeon Graphics card, DVD drive, a 64-bits sound
card, keyboard, optical mouse and a 56k fax data voice modem. The combination is dependent
on the nature and contents of the multimedia project you are dealing with.

!
Caution There is no set rule to define the exact hardware combination of a good multimedia
computer.

1.3.2 Integrated Design Software
Multimedia authoring tools provide the framework for organizing and editing the elements of
a multimedia project. Authoring software provides an integrated environment for combining
the content and functions of a project. It enables the developer to combine text, graphics, audio,
video, and animation into an interactive presentation/project. Authoring systems include editing
tools to create, edit, and convert multimedia elements such as animation and video clips. There
are four basic type of authoring tools, viz. Page-based tools (like Tool book), Icon-based authoring
tools (like Icon Author), and Time-based authoring tools (like Macromedia Director) and Object
Oriented tools (like Media Forge).

Notes Designers or teachers are aided by computer-based tools for Instructional Design
(ID) to perform one or more of the various activities that can be prepared according to the
ADDIE model that is the Analysis, Design, Development or production, Implementation
and Evaluation of instructional systems. The history of computer-based ID Tools is closely
associated to the history of computer-based instruction. After it was decided to use the
computer as the primary instructional medium, it was an apparent move to use the
computer not only for the delivery but also for the production of the instruction.
Consequently, authoring tools for the development or production of computer-based
instruction still dominates the research and development work in the field of ID tools.
Many of those softwares are commercially available (e.g. ToolBook, Macromedia Director,
Authorware, etc.). Currently the most popular form of computer-based instruction is
dedicated systems for authoring Web-based instruction.
Page-based tools provide a simple and easily understood metaphor for organizing multimedia
elements. It contains media objects such as buttons, text fields and graphic objects. It provides a
facility for linking objects to pages or cards. Icons or objects based authoring tool is the simplest
and easiest authoring process. Icon-based, event-driven tools simplify the organization of your
project and typically display flow diagrams of activities along branching paths. In complicate
structures, this charting is particularly useful during development. In Time based authoring
systems, elements and events are organized along a timeline, with resolutions as high or higher
than 1/30 second. Time based tools are best to use when you have a message with a beginning
and an end. Sequentially organized graphic frames are played back at a speed that you can set.
Other elements are triggered back at a given time or location in the sequence of events. The
more powerful time based tools let you program jumps to any location in a sequence, thereby
adding navigation and interactive control. Object-oriented tools organize the elements in a
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hierarchical order as related Objects. These tools make these objects execute according to properties
assigned to them.

Self Assessment
Fill in the blanks:
6.

A good multimedia system should have a Dual Core ………………………

7.

Multimedia authoring tools provide the ……………………… for organizing and editing
the elements of a multimedia project.

8.

……………………… systems include editing tools to create, edit, and convert multimedia
elements such as animation and video clips.

9.

Page-based tools provides a facility for linking ……………………… to pages or cards.

10.

Object-oriented …………… organize the elements in a hierarchical order as related Objects.

1.4 Web and Window based Graphics
The following are the concepts of the Web and Window based graphics.

1.4.1 Web based Graphics
In the early days of the Web, each individual web page was delivered to the client as a static
document, but the sequence of pages now could provide an interactive experience, as user input
is returned through web form elements embedded in the page markup. Practically, Web
application projects cover everything from filing taxes to sharing photos.

Defining Web Application
A web application is an application that is accessed by users over a network such as the Internet
or an intranet. The term may also mean a computer software application that is coded in a
browser-supported programming language (such as JavaScript, combined with a browserrendered markup language like HTML) and dependent on a common web browser to make the
application executable. Web applications can provide the same functionality and gain the benefit
of working across multiple platforms.
Example: A web application can act as a word processor, storing information and allowing
you to ‘download’ the document onto your personal hard drive.

1.4.2 Windows based Graphics
Somewhere at the end of the 90’s, Major companies began introducing a new technology on the
market, namely the Liquid Display Technology (LCD). The new technology used a grid of liquid
crystals, placing three transistors behind each crystal. Monitors featuring LCD panels came in a
slimmer form factors and with lower radiation emissions. They were a step up in design compared
to the bulky CRT monitors people were so used to.
The further evolution of LCDs solved the problem of slow response time and, contrast ratios
and brightness improved with each new generation of displays. Together with the evolution of
LCDs came a new video interface called DVI (Digital Video Interface). Compared to the analog
VGA connection, this solution was no longer bound to the quality and length of the cable. DVI
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provided for a complete digital transfer of information between the graphics adapter and the
monitor. Today’s monitors range from 15 to 30-inch LCDs, with resolutions matching 2560 x
1600 pixels. They are outfitted with webcams, USB hubs and audio speakers. The biggest challenge
of using such systems is picking the user interface metaphor. Although one might be tempted to
use a traditional window and mouse based environment, it is not clear that it is the most
appropriate design for this environment. Designing visualizations for large displays differs
from designing for desktop monitors due to a variety of factors, including size, resolution,
brightness, contrast and orientation. Designing the interface is equally cumbersome, since large
displays are difficult to use with a tethered mouse or keyboard. Group applications and tasks are
also very different from single-user applications.

Notes

Self Assessment
State whether the following statements are true or false:
11.

Initially, each individual web page was delivered to the client as a static document.

12.

A web application is an application that is accessed by users in a computer.

13.

LCD means Laser Display Technology.

14.

Digital Video Interface is a new kind of display device.

15.

Designing visualizations for large displays differs from designing for desktop monitors.

Case Study

Dodds (Corporate Identity)

A

fter many years of service, Dodds & Partners felt it was time to retire their existing
Identity, which was to also coincide with a rebranding to ‘Dodds Solictors LLP’.
They were wanting a fresh rebrand – something modern but which carried on
some similarities with the previous identity so as not to break the link with the previous
branding.
Solution
Dodds have always used a deep blue as their corporate colour combined with a basic Serif
font (Times). We kept the blue dark but picked a richer tone, and swapped out their
existing serif font for one that isn’t so common, but still carried a distinguished, ‘trustful
feel’. The logomark uses an organic ‘stone shape’ to catch the eye in conjunction with a
looped line to convey the idea of unity whilst also forming a lower case ‘d’.
Result
The new logo has positioned Dodds to take the next step in their growth. Without trying
to look too youthful and avoiding looking part of the industry termed ‘Ambulance Chasers’,
Dodds now have an identity which exudes tradition and security as well as modernity,
which befits a company of their stature. The rebranding has been followed by an increase
in new clients, as well as giving them an identity to continue to successfully compete in
the marketplace.
Testimonial
As a firm of solicitors Dodds Solicitors LLP are used to helping people with their problems
but had no idea of how to market ourselves. Thanks to the very friendly team at Adtrak we
Contd...
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now have a company we can trust with all of our advertising needs. We recently wanted
to rebrand and were delighted with Adtrak’s new and fresh ideas. We have had a lot of
comments on our new logo and are confident that it will help us get noticed in such a busy
industry.
Question:
How has new logo helped Dodds in their growth?
Source: http://www.adtrak.co.uk/case-studies-graphic-design.php

1.5 Summary
z

In computer graphics, a bitmap or pixmap is a type of memory organization or image file
format used to store digital images.

z

Vector graphics is the use of geometrical primitives such as points, lines, curves, and
shapes or polygon(s), which are all based on mathematical equations, to represent images
in computer graphics.

z

In 3D computer graphics, vectorized surface representations are most common.

z

Graphic Design is an interdisciplinary, problem-solving process which combines visual
sensitivity with skill and knowledge in areas of communications, technology and business.

z

Graphic designers create visual concepts, by hand or using computer software, to
communicate ideas that inspire, inform, or captivate consumers.

z

In image-based design, the images must transmit the entire message.

z

In type-based design, what the words look like is as important as their meaning.

z

Symbols and logos are special, highly condensed information forms or identifiers.

z

A good graphic design process is planned around ensuring the client gets the highest
quality solution and service appropriate to their business, marketing or communication
problem.

z

Multimedia authoring tools provide the framework for organizing and editing the elements
of a multimedia project.

1.6 Keywords
Authoring: This means creation of programs and databases for computer applications such as
computer-assisted learning.
Bitmap: A bitmap is a map of dots, or bits that look like a picture as long you are sitting a
reasonable distance away from the screen.
Guidelines: A statement or other indication of policy or procedure by which to determine a
course of action.
Multimedia: An extension of hypertext allowing the provision of audio and video material
cross-referenced to a computer text.
Pixels: A minute area of illumination on a display screen, one of many from which an image is
composed.
Raster Graphics: It is a dot matrix data structure representing a generally rectangular grid of
pixels, or points of color, viewable via a monitor, paper, or other display medium.
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Typography: The art or process of setting and arranging types and printing from them.

Notes

W3C Standards: They define an Open Web Platform for application development that has the
unprecedented potential to enable developers to build rich interactive experiences, powered by
vast data stores that are available on any device.

1.7 Review Questions
1.

What are the different Graphic types?

2.

How is bitmap different from vector graphics?

3.

Explain the process of editing vector graphics.

4.

Write a short note on 3D Modeling.

5.

What do you mean by Graphic Design?

6.

Explain the profile of Graphic Designer.

7.

Elaborate on different types of Graphic Designs.

8.

Write a short note on Graphic Design Process.

9.

What are Multimedia authoring tools? Explain its different types.

10.

How are Web Based Graphics different from Window Based Graphics?

Answers: Self Assessment
1.

False

2.

True

3.

False

4.

True

5.

True

6.

Processor

7.

Framework

8.

Authoring

9.

Objects

10.

Tools

11.

True

12.

False

13.

False

14.

False

15.

True

1.8 Further Readings

Books

Harrington S, Computer Graphics: A Programming Approach, McGraw Hill 1983.
Foley J D and Van Dam A, Fundamentals of Interactive Computer Graphics, Addison
Wesley.
Hearn D and Baker PM, Computer Graphics, Prentice Hall.

Online links

http://psd.tutsplus.com/articles/web/50-totally-free-lessons-in-graphic-designtheory/
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http://desktoppub.about.com/od/graphicdesign/Graphic_Design_
Tutorials.htm
http://graphicdesign.about.com/od/graphicdesignbasics/tp/essential_
tools.htm
http://www.tips-tricks.com/gph_tools2.asp
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Objectives
After studying this unit, you will be able to:
z

Elaborate upon the meaning of Desktop publishing (DTP)

z

List the tools for designing

z

Explain the basics of Photoshop, CorelDraw, Illustrator, PageMaker, InDesign

Introduction
Desktop publishing started in 1983 with a program developed by James Bessen at a community
newspaper in Philadelphia. That program, Type Processor One, ran on a PC using a graphics
card for a WYSIWYG display and was offered commercially by Best info in 1984. (Desktop
typesetting, with only limited page makeup facilities, had arrived in 1978–79 with the introduction
of TeX, and was extended in the early 1980s by LaTeX). The DTP market exploded in 1985 with
the introduction in January of the Apple LaserWriter printer, and later in July with the introduction
of PageMaker software from Aldus which rapidly became the DTP industry standard software.
The term “desktop publishing” is accredited to Aldus Corporation founder Paul Brainerd, who
wanted a marketing catch-phrase to describe the small size and relative affordability of this
suite of products in contrast to the expensive commercial phototypesetting equipment of the day.
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By today’s standards, early desktop publishing was a primitive affair. Users of the PageMakerLaserWriter-Macintosh 512K system endured frequent software crashes, cramped display on the
Mac’s tiny 512 x 342 1-bit monochrome screen, the lack of ability to control letter spacing,
kerning (the addition or removal of space between individual characters in a piece of typeset
text to improve its appearance or alter its fit) and other typographic features, and discrepancies
between the screen display and printed output. However, it was a revolutionary combination at
the time, and was received with considerable acclaim.
During its early years, desktop publishing had a bad status as a result of untrained users who
created poorly-organized ransom note effect layouts — similar criticism would be levied again
against early Web publishers a decade later. However, some were able to realize truly professional
results.
Once considered a primary skill, increased accessibility to more user-friendly DTP software has
made DTP a secondary skill to art direction, graphic design, multimedia development, marketing
communications, administrative careers and advanced high school literacy in thriving economies.
DTP skill levels range from what may be learned in a few hours (e.g. learning how to put clip art
in a word processor) to what requires a college education and years of experience (e.g. advertising
agency positions). The discipline of DTP skills ranges from technical skills such as prepress
production and programming to creative skills such as communication design and graphic
image development.

2.1 Meaning of Desktop Publishing (DTP)
Desktop publishing (DTP) is the making of documents using page layout skills on a personal
computer. When used capably, desktop publishing software can create text and images with
attractive layouts and typographic quality comparable to traditional typography and printing.
This technology allows individuals, businesses, and other organizations to self-publish a wide
range of printed matter (from menus and local newsletters to books, magazines, and newspapers),
sometimes without the prohibitive expense of commercial printing.
Desktop publishing combines a personal computer and WYSIWYG page layout software to
create publication documents on a computer for both large scale publishing or small scale local
multifunction peripheral output and distribution. Desktop publishing methods provide more
power over design, layout, and typography than word processing does. However, word processing
software has evolved to include some of the capabilities previously available only with
professional printing or desktop publishing.

2.1.1 Text
Since the advent of desktop publishing, DTP is used to create a simple document. The first DTP
software appeared in 1985. As it was created by Aldus Corporation, it also had the advantage of
being WYSIWYG. The ease of use remained despite DTP programs becoming more sophisticated.
There are numerous fonts to select from when creating DTP documents. The user is also helped
by the uniformity of DTP programs when it comes to adjusting text size and margins.

2.1.2 Images
One major advantage of DTP is being able to import images into a document. This is of huge
assistance to people who create any printed matter and has only a small print run. Before DTP,
the cut-paste method was most commonly used, or a stencil was used through a duplicator.
Through DTP, simplest graphic or a color photograph, that too, in fine detail can be imported
into a document.
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2.1.3 Printing
Computer printers revolutionized publishing as a whole around the world. Users could print
black and white as well as color photographs and artwork on their own computer at home. All
one had to do to turn their computer into a small scale publishing house was to own a home
computer, the DTP software and a printer. A printer prints a DTP document at a very high speed
at which, for example, hundreds of leaflets can be printed in less than an hour.

2.1.4 Design
Other than for text, photographs and art, the DTP is also used for design purposes. Experienced
users can utilize this area of DTP. Some easy designs can be created with shapes and fills, but
more difficult effects take a higher degree of skill to use. With the combination of text, images
and design, an impressive document can be created for notices and professional correspondence
by a modest DTP program.

Self Assessment
State whether the following statements are true or false:
1.

Desktop publishing (DTP) is the making of documents using printing techniques on a
personal computer.

2.

Desktop publishing methods provide more power over design, layout, and typography
than word processing does.

3.

One major advantage of DTP is being able to import images into a document.

4.

Computer monitors revolutionized publishing as a whole around the world.

5.

Other than for text, photographs and art, the DTP is also used for design purposes.

2.2 Tools for Designing
Now you will learn about different tools of designing.

2.2.1 Basics of Photoshop
Adobe Photoshop is one of the most powerful software applications for image editing, touch up,
color correction, and painting and drawing. You can use it to work with images that have been
digitized on flatbed or film/slide scanners, or to create original artwork. The image files you
create in Photoshop can be printed to paper or optimized for use in multimedia presentations,
web pages, or animation/video projects.

Work Area in Photoshop
The work area can be intimidating to work with because of all the complex functionality but
with a quick breakdown of the available features and their uses, you will be ready to comfortably
navigate the work area with ease. The work area in Photoshop has the following basic functionality
and features:
z

Menu Bar – this is where you can access most of the commands and features in Photoshop

z

Drawing Palette – where the image being worked on will appear
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z

Options bar


Content sensitive display of tool options – changes as different tools are selected



Display using Window > Options or Click a tool in the toolbox. Lasso options bar

z

Tool box - for creating an editing images (display or hide using Windows > Tools)

z

Palettes - to monitor and modify images (there are 5 palettes by default)

z

Palette Well - to organize palettes in work area


Drag a palette’s tab into the palette well to store it in the palette well



Once in the palette well click on the palette tab to use it
Figure 2.1: Work Area in Photoshop

Source: http://www.cutehits.com/wp-content/uploads/2011/08/work_area1.jpg

Photoshop File Formats
.PSD
Of all the file formats that Photoshop supports, the PSD format is probably the most significant.
PSD stands for “Photoshop Document”, and as the name implies, it’s Photoshop’s native file
format. PSD is one of the few file types that fully support all of the powerful features that
Photoshop gives us, like layers, layer masks, adjustment layers, channels, paths, and so on. It
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also serves as your working file. When we open an image in Photoshop, regardless of which file
type the image was originally using, Photoshop temporarily converts it into a PSD file behind
the scenes so one can work on it with all of Photoshop’s tools, commands and features at our
disposal.

Notes

PSD files are your best choice to serve as your master files and for archiving to CD, DVD or an
external hard drive for safe keeping. If you’ve done any sort of editing work on an image and
there’s even the least chance you’ll need to come back to it again at some point in the future, save
your work as a Photoshop PSD file. There’s no loss in image quality no matter how many times
you reopen and re-save a PSD, and all of your layers, layer masks, adjustment layers and so on
will be saved as part of the file, allowing you to go back at any time and make changes to the
image or continue working from where you left off.
You can easily print your pictures at home with Photoshop directly from the PSD file, and many
commercial printers are now able to accept PSDs as well, although some may still require an EPS
or TIFF version of the file instead, so it’s always best to check with your printer to make sure
you’re giving them the format they need. One of the newer advantages with PSD files is that
they can now be imported directly into Adobe InDesign, giving you complete access to the
individual layers in the file as you’re designing your page layouts. You can even reopen a PSD
file in Photoshop directly from InDesign, make changes to the file, save it, and have the changes
immediately update in your layout!
The only real disadvantage to PSD files is that the file size can get very large, especially if you’re
working on an image with hundreds or even thousands of layers. But with computer hard drives
and memory being so cheap these days, it’s a small price to pay for the creative freedom that
Photoshop and its native PSD file format give us. Bottom line, your PSD file is the most important
file you can have, so be sure to save yourself a master copy of your work as a PSD file so you can
always return to it in Photoshop when you need it!

.JPEG
The JPEG (Joint Photographic Expert Group) format has been around for practically 20 years
now and has come to be the most prevalent and widely utilized file format for review and
offering computerized photographs. It upholds 24-bit color, which means it can reproduce
roughly 16.7 million shades, and even the shabbiest digital cameras can catch pictures as JPEG
documents. Most high end digital SLR cameras give you the choice of capturing pictures in
either the JPEG or RAW form.
It’s important, however, not to confuse “prevalent” and “widely “ with “professional value”.
JPEG is what’s called a lossy file format in light of the fact that it compresses the pictures, which
basically means it takes some of your picture details and tosses it out the virtual window, never
to be perceived again. It does this to lessen file size, the more compression you use; the more
terrible your pictures look. You control the amount of compression being applied to the file
using the Quality setting that appears in Photoshop when you go to save it. A sufficiently high
Quality setting can even now produce awesome looking pictures yet your file size will be
larger. Lower Quality settings can generate exceptionally modest file sizes, however set too low
and you’ll present appalling and obvious compression artifacts.
The most amazing quality of JPEG records is convenience. They’re normally minor enough that
they can effectively be transferred and displayed on web pages, or on photograph imparting
destinations like Facebook and Flickr, and messaged to family and companions. Internet printing
aids for the most part need your photographs to be transferred as JPEG records. The downside to
JPEGs is that the reduced quality initiated by picture layering methods they’re not a great
decision for choice when picture value is your essential concern, and they’re likewise not a good
choice for archiving your originals. Depending on if you’re capturing JPEG files in your camera,
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verify you’re capturing the largest, highest quality images possible. Check your camera’s
instruction manual to find out where the image quality option is in your camera’s menu system.
The highest quality setting is usually labeled “Large”.
One thing you need to abstain from doing whenever plausible is re-saving JPEG files repeatedly..
Every time to open and re-save it, you’ll add significantly more compression to the image, and
it doesn’t take long for things to get ugly. Once the picture part is gone, you can never get it back.

.GIF
The GIF file format, which stands for Graphics Interchange Format, has been around even
longer than JPEG, and its the format of choice for web illustrations. Notice I stated web
illustrations, not web photographs. GIF records can just show up to 256 shades, far less than the
many colors would have been wise to convincingly duplicate a photographic picture (and far
less still than the millions of shades backed by the JPEG organization).
In terms of web design, however, the GIF arrangement is basic. The files are decently suited for
site page layouts, banners and buttons, especially if they contain large areas of solid color. All
major web browsers support GIF files and their small file sizes load quickly on the screen. GIF
also allows web designers to create simple animations. One major advantage GIF has over the
JPEG arrangement, and an additional reason for why its so reason why it’s so essential for web
designers is that it upholds transparency, even though it upholds a single level of transparency,
significance a pixel is either transparent or its definitely not. This can result in harsh edges
around graphics if the edge color contrasts from the color of the background it’s placed over. For
higher quality transparency effects, a better choice is the PNG format.

.PNG
PNG (Portable Network Graphics) was originally meant to replace the GIF format (PNG also
stands for “PNG not GIF”). That never happened and GIF files are still in wide use today, yet the
PNG format improves upon the GIF format in nearly every way. It even improves on the JPEG
format. While JPEG files support 24-bit color (16.7 million colors), PNG files support up to 48-bit
color, giving us more than 1 billion possible colors! That may sound impressive, but even JPEG
files support more colors than the human eye can see, so any real world differences between 24
and 48-bit color are minimal at best.
The biggest advantage over JPEG is that PNG is a lossless file format, meaning that even though
it still compresses images to reduce file size, the compression method it uses does not result in
a loss of image quality. You can even re-save the same PNG file multiple times without degrading
its quality, whereas JPEG files look worse each time you re-save them. With over a billion
possible colors and lossless compression, PNG is a great choice for saving digital photos as high
quality originals. The downside, though, is that PNG is not as widely supported as the JPEG
format, and PNG does not support CMYK color, which means commercial printers can’t use
them. For everyday viewing and sharing of your digital photos, the JPEG format is still more
useful and convenient, even if the image quality isn’t as good.
PNG’s main advantage over GIF files, besides far exceeding GIF’s 256 color limit, is that it can
reproduces full 256 levels of transparency compared with GIF’s single level, giving us smooth
transitions around edges without having to worry about matching the edges with the background
color. PNG files are also usually smaller than GIF files, so they’ll load even faster in a web
browser. Unfortunately, older web browsers may not support the PNG format, which means
GIF is still the safest choice when browser compatibility is your main concern. Also, while GIF
supports animations, PNG does not. PNG files are most often used in multimedia programs like
Flash as well as Keynote and PowerPoint presentations.
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TIFF
Like PSD files, TIFF (Tagged Image File Format) is one of the few file types that support all of
Photoshop’s features and is another great choice for archiving your images, with lossless
compression that allows you to save photos with the highest possible image quality. The quality
comes at a price though, as TIFF files can be very large, especially when compared with JPEG
files. TIFF is the universally accepted standard for images destined for commercial printing and
is compatible with virtually all page layout programs like QuarkXPress and InDesign.
Even though TIFF files are capable of storing all of the layers, adjustment layers and other
elements you’ve added in Photoshop, it’s generally recommended that you save all those elements
in your master PSD file, then use the TIFF format to save a flattened version of the image for
print. This makes it easy to tell just from looking at the file extension which version of your
image is the master working file (.psd) and which is the flattened, print-ready version (.tif).
Also, many commercial printers will ask for a flattened version of your TIFF file.
With InDesign now being able to import and work directly with layered Photoshop PSD files,
and both the PSD and PDF formats gaining popularity in the print community, TIFF isn’t quite
as important as it once was, but it remains the print industry standard and enjoys widespread
support.

EPS
EPS (Encapsulated PostScript) is another print industry standard format that’s been around for
quite a while, but its use has been in decline over the years. EPS files are not really image files
in the traditional sense. Instead, they contain a series of instructions for how a printer should
reproduce the image. They can be imported into most page layout programs, but the
“encapsulated” part means the files are essentially locked and can no longer be modified unless
they’re reopened in Photoshop. A preview image must be embedded in the EPS file when you
save it in Photoshop if you want it to be viewable onscreen when working in your page layout
program, otherwise you won’t be able to see it until the layout is printed. While EPS remains an
industry standard format, you probably won’t use it very often unless it’s the format specifically
requested by your commercial printer.

PDF
Finally, while most people are familiar with PDF files for viewing, sharing and printing electronic
documents (hence the name Portable Document Format), PDF is also gaining in popularity as a
great choice for saving images destined for print. Like the PSD and TIFF formats, PDF supports
and preserves all of Photoshop’s features, including the ability to use spot colors, something the
EPS format does not support. PDF gives you the choice of either JPEG compression, complete
with a Quality setting to balance image quality with file size, or lossless ZIP compression. And
the PDF format benefits from the fact that anyone with the free Adobe Reader installed on their
computer can view the image.

2.2.2 Basics of CorelDraw
The Corel Draw application is used to design advertisements, logos, cards, brochures, newsletters
and so on, for print or for the Web. It is a part of CorelDraw Graphics Suite 12. Any artwork
developed in CorelDraw is known as a drawing. Every component created in a drawing such as
a line, curve, text, symbol or image is called an object. Each object in a drawing stores its own
attributes, such as shape, size, position, and color. You can modify an object without affecting
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the image quality. The CorelDraw is ideal for creating drawings, in which objects are created
and modified again and again while designing.
The CorelDraw is a top supplier of graphics software, including the very popular CorelDraw
program. Both creating and editing images can be done using the tools of CorelDraw. The type
of project determines the type of desktop publishing tools that you will use. CorelDraw is one
of the finest Desktop publishing software that allows users to create illustrations containing
text, graphics and photographs. Corel has a wide range of tools which facilitate the user to edit
any shape or character effortlessly with precision, create custom color separations and fit text to
curves. It is developed and marketed by Corporation of Ottawa. All the files of Adobe PageMaker,
Microsoft Publisher and Word can be opened using this tool and other programs can print
documents to Adobe PDF using the Writer printer driver, which such software can then open
and edit every part of the initial layout and designs.
The software contains a huge range of over 1,000 fonts, provided in both TrueType and PostScript
Type 1 format. Corel is different from its opponent because of:
z

It is more of a graphics suite, rather than just a vector graphics program.

z

Users can adjust contrast, color balance, change the format from RGB to CMYK, add
special effects such as vignettes and special borders to bitmaps using a wide range of
editing tools.

z

One can open the bitmap directly from Corel, expansively edit the same using Corel
Photo Paint, and return to the program after saving.

z

It also provides a laser to cut out any drawing.

It is believed by the experts that it was the first of the Windows-based drawing programs and
had built on this early start to become far-and-away the dominant drawing package on the PC.
Its biggest Advantage and its biggest potential disadvantage is its all-encompassing approach.
In early times, this had led to accusations of unfocused bloating, but Corel has addressed the
criticisms with a far tighter and better rationalized program with version 7.0. Even though,
there’s still a huge range of functionality to cover.

2.2.3 Basics of Illustrator
Adobe Illustrator is a vector graphics editor developed and marketed by Adobe Systems. It has
varied applications, from creating print to web graphics and, for our purposes, posters. The
program is complex and requires a considerable amount of time to master. But still it is quite
easy to learn the basics and create professional quality work. To design a poster, one just
requires have the patience to get familiar with the program. As it is recommended for most
computer applications, using the trial-and-error methodology is the best way to figure out the
ins and outs of this program.

Did u know? Adobe Illustrator was first developed for the Apple Macintosh in 1986 (shipping
in January 1987) as a commercialization of Adobe’s in-house font development software
and PostScript file format.

Photoshop recognizes individual dots each with a color value and a location in space. The
program makes images out of pixels. In contrast, Adobe Illustrator is a charting program which
deals with objects such as squares, circles and irregular shapes. It saves these shapes in files as
geometric equations with an associated size, color and location value. These objects can be
recoloured, resized and moved in correlation to each other. This is called scalable vector graphics.
When you select an object in Illustrator, you can move that object in front or behind other objects
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present in the image or change the size of the object with respect to the other objects in the
image. Illustrator is an ideal program to use for drawing illustrations and charts or creating
posters with drawings and a lot of different size lettering.

Notes

Create New Document
Go File>New Document to create your first document. Type in a Name for the document and click
Advanced to select RGB for Color Mode as we will be working for the screen. Click Ok after that.
Figure 2.2: New Document Dialog Box

Source: http://www.vectordiary.com/isd_post/2008/day02/new-document.gif

Illustrator Workspace
Below is the workspace and some common terms for calling it. If you are using the latest Adobe
Illustrator CS3, you will notice to new design for Floating Palette. The rest looks about the same.
Figure 2.3: Workspace in Illustrator

Source: http://www.vectordiary.com/isd_post/2008/day02/illustrator-interface.jpg
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Toolbox
This is the handy toolbox which will be often used. By default, it comes in one single column as
shown in the screenshot above. To switch it back to the old 2 columns toolbox, you can simply
click the top left mini arrow to toggle it into 2 columns.

Notes Some of the tools like Rectangle have more tools hidden. To expand, just click and
hold the icon to reveal all the similar tools under that group.
Figure 2.4: Illustrator Toolbox

Source: http://www.vectordiary.com/isd_post/2008/day02/illustrator-toolbox.gif

Floating Palette
This is the floating palette which contains properties for our shapes. It is commonly used for
changing colors and stroke width.
Figure 2.5: Floating Palette

Source: http://www.vectordiary.com/isd_post/2008/day02/floating-palette.gif
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Saving AI Files
Let’s select the type and click on the artboard and type some text. After that go to File>Save.
Select Adobe Illustrator (*.AI) for file type and name it “First Drawing”. Click Ok after that.
Leave the rest of the settings at default. You have successfully saved your first file. To make any
more changes you can simply open the Adobe Illustrator file.

Selection Tools
There are two types of selection tool in Illustrator used for selection objects.
z

Selection Tool: Used for selecting and moving a shape. It can also be used to resize a shape.

z

Direct Selection Tool: Selects a single anchor point instead of the whole shape. Used for
editing anchor point of a shape. Click once on a point to select and hold Shift to select
multiple anchor points.
Figure 2.6: Selection Tool vs. Direct Selection Tool

Selection Tool

Direct Selection Tool

Source: http://www.vectordiary.com/isd_post/2008/day03/selection-tool.gif

Shape Tools
Now let’s work on the Shape Tools. When you go to the Tool Palette and hold the Rectangle
Tool, a list of shape tools will expand out for you to pick. We will start with the default Rectangle
Tool.
Figure 2.7: Selecting Rectangle Tool

Source: http://www.vectordiary.com/isd_post/2008/day03/rectangle-tool.gif
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Understanding Fill & Stroke
Click and drag out a Rectangle as shown. By default, it has a white fill and black stroke. (Stroke
is the border of the shape)
Figure 2.8: Selecting Fill and Stroke

Source: http://www.vectordiary.com/isd_post/2008/day03/rectangle-fill.gif

Changing Fill Color
Let’s start changing the fill color for the rectangle. Double click the Fill from the Tool Palette. It
will pop up the Color Picker. Drag the slider to blue and select a deep blue color. Click Ok after
that.
Figure 2.9: Changing Fill Color

Source: http://www.vectordiary.com/isd_post/2008/day03/color-picker.gif

28

LOVELY PROFESSIONAL UNIVERSITY

Unit 2: Designing and Desktop Publishing Tools

Notes

Removing Stroke
Click the Stroke in the Tool Palette once to swap it above Fill. Click the None icon boxed up in
red to set the Stroke to None. The black stroke will disappear.
Figure 2.10: Removing Stroke

Source: http://www.vectordiary.com/isd_post/2008/day03/remove-stroke.gif

Constrain Proportions
To draw a perfect square, we will select the Rectangle Tool. Hold Shift and drag to draw a square.
Same for the circle, we will select the Ellipse Tool and hold Shift to drag out a circle.
Figure 2.11: Using different Shape Tools

Source: http://www.vectordiary.com/isd_post/2008/day03/square.gif

Resizing Shapes
To resize shapes, select the shape using the Selection Tool and a bounding box will appear. Drag
the corner anchor point to resize it. To constrain to proportion while resizing, hold Shift as you
resize. Also hold Alt/Option if you want to resize from the same position.
Figure 2.12: Resizing Shapes

Source: http://www.vectordiary.com/isd_post/2008/day03/resize_shape.gif
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Rotating Shapes
Select the shape with the Selection Tool and a bounding box will appear. Move your cursor near
the anchor corner and a rotation icon will icon, click and turn it to rotate the square. To snap at
45 degrees increment, hold Shift and turn.
Figure 2.13: Rotating Shapes

Source: http://www.vectordiary.com/isd_post/2008/day03/rotate-square.gif

More Options for Shape Tools
Select the Star Tool. Click once on the artboard and an option will pop up. Enter the same values
below and click Ok. It will draw a star burst shape. This method can be used to bring out more
options for shape tools.
Figure 2.14: Different Options for Shape Tools

Source: http://www.vectordiary.com/isd_post/2008/day03/star-burst.gif

Drawing Straight Lines
Select the Pen Tool and click once to add the first anchor point. Move your mouse to the next
position and click again to create the second point. The two anchor points will be connected
together. Continue doing this to create a W shape as shown. To draw a new line, click the
Selection Tool (The Black Arrow Icon) and click back the Pen Tool again.
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Figure 2.15: Drawing Straight Lines

Notes

Source: http://www.vectordiary.com/isd_post/2008/day05/pen-straight-lines.gif

Closing a Path
To close a path, click back the starting point to close the shape.
Figure 2.16: Closing a Path

Source: http://www.vectordiary.com/isd_post/2008/day05/close-path.gif

Drawing a Curved Line
Click and drag to put out the handles to create a smooth anchor point.
Figure 2.17: Drawing a Curved Line

Source: http://www.vectordiary.com/isd_post/2008/day05/pen-curve.gif
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Changing Path Directions
Click and drag to create a smooth anchor point. Without releasing your mouse, hold Alt/Option
and drag the handle up to change the path direction.
Figure 2.18: Changing Direction of a Path

Source: http://www.vectordiary.com/isd_post/2008/day05/pen-curve2.gif

Drawing a Circular Path
Click and drag to create a smooth anchor point. Continue adding points and click back the
starting point to close the path.
Figure 2.19: Drawing a Circular Path

Source: http://www.vectordiary.com/isd_post/2008/day05/pen-circle.gif
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Adding Anchor Points
With the Pen Tool selected, go near the path where you want to add a new anchor point. A plus
sign will appear next to the pen, click on the path to create a new anchor point.
Figure 2.20: Adding Anchor Points

Source: http://www.vectordiary.com/isd_post/2008/day05/add-anchor-point.gif

Removing Anchor Points
To remove point, move your Pen Tool close to an anchor. A minus sign will appear next to the
pen. Click on the anchor point to delete it.
Figure 2.21: Removing Anchor Points

Source: http://www.vectordiary.com/isd_post/2008/day05/delete-anchor-point.gif

Converting Anchor Points
To convert a smooth anchor point to a sharp anchor point, move your Pen Tool near the anchor
and hold Alt/Option and your Pen Tool will change to an arrow shape. Click on the smooth
anchor to convert it to an anchor point. Click and drag on the anchor point again to change it
back to a smooth anchor point.
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Figure 2.22: Converting Anchor Points

Source: http://www.vectordiary.com/isd_post/2008/day05/convert-anchor-point.gif

Moving Anchor Points
Select the Direct Selection Tool and click and on anchor you want to move. Click and drag to
change positions.
Figure 2.23: Moving Anchor Points

Source: http://www.vectordiary.com/isd_post/2008/day05/move-anchor-point.gif

Changing Anchor Directions
With the Pen Tool, you can quickly change the anchor directions. Hold Ctrl/Command to
quickly change the Pen Tool to Direction Selection Tool. Select the anchor point you want to
edit. The anchor handle will appear. Now release Ctrl/Command and hold Alt/Option to
change it to Convert Anchor Tool. Click and drag the handles to change the direction.
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Figure 2.24: Changing Anchor Directions

Notes

Source: http://www.vectordiary.com/isd_post/2008/day05/change-anchor-handle.gif

Tips for Using Pen Tool
z

Use as little anchor points your need to create your shape

z

Add anchor points where there is a change in direction of the line/curve

z

Use shortcuts like Alt/Option or Ctrl/Command to quickly swap to other tools to edit
your path

z

Hold shift to lock your path while adding new anchor point for 45-degree increments.

2.2.4 Basics of PageMaker
PageMaker was one of the first desktop publishing programs, introduced in 1985 by Aldus
Corporation, initially for the then-new Apple Macintosh and in 1987 for PCs running
Windows 1.0.

How to Create a New Document?
z

Upon starting PageMaker you will see a screen offering you a variety of initial choices of
templates upon which to base your publication. In our case, we will start with a blank
presentation. After becoming familiar with PageMaker we can always choose one of the
templates to create our publication. Close the templates-options screen by clicking on the
Close button located on the top right corner of the screen.

z

Go to: File 4 New. A dialogue box showing the Document Setup similar to Figure 2.25 will
appear. Here we can specify the page dimensions, orientation, margins, number of the
pages, etc. Set the inside margin to “1”, all other margins to “.75” and the page size to
“Letter”.
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Figure 2.25: Document Setup Dialog Box

Source: http://handouts.tamu.edu

When done, click OK. We can return to this window by clicking on: File4Document Setup, and
change or modify any of the settings at a later stage. We now have a new document open in
PageMaker. The top and bottom boundaries of the page are indicated by pink lines and the left
and right boundaries of the page are indicated by blue lines. We must be careful to remain
within these boundaries at all times, i.e. we must place our graphics and text within these
margins.

The Different Windows in PageMaker
A number of windows are open in the default PageMaker window. Figure 2.26 shows them with
their names. We will touch upon them briefly as all these windows provide us with important
tools.
Figure 2.26: Pagemaker Windows

Source: http://handouts.tamu.edu
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1.

Tools Palette: This window displays tools that are used for drawing, entering and editing
text, selecting and dragging objects on the page and zooming in and out of the page. We
have to click on a particular tool icon to select that tool.

2.

PageMaker Tools Window: This window can also appear as a shelf on the top of the main
PageMaker window as shown in Figure 2.25. It displays additional PageMaker tools as
convenient icons.

3.

Control Palette: This window is used for making precise changes to text and graphics.

4.

Styles and Colors Palette: This window displays the predefined paragraph styles and
colors.

5.

Plug-in Palettes, e.g. Picture Palette: This window contains the links to readymade graphic
images that can be inserted into the document.

Notes

We can minimize these windows at any time if the screen gets too cluttered. They can be
maximized selectively for a less cluttered screen and more efficient work.

How to Insert an Image into a PageMaker Document?
Now that we have a new document open and are familiar with the different windows we will
start by making a cover page for the report, consisting of the title and a small logo. The logo can
be drawn using graphic elements like squares, circles and lines or can be an existing image. To
insert any image in a PageMaker document we have to “place” it in the document. For this, go
to File 4 Place. A dialogue box prompting you for the location of the image file to be inserted
appears (Figure 2.27).
Figure 2.27: Place Dialog Box

Source: http://handouts.tamu.edu

1.

Placing the image: Locate and open the image file you want to place in the document. The
pointer changes to a loaded graphic icon. Position the graphic icon where you want the
upper left corner of the graphic to appear and click on the page to place the image. There
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are eight square graphic handles displayed at the corners and edges of the image indicating
the image is selected.
2.

Resizing the image: The graphic handles at the corners and edges of the image make it
possible to resize the image horizontally, vertically or both. To resize the image select the
image, then select the pointer tool in the Tools Palette. Click on one of the corner handles
and drag towards the center of the image to reduce its size. We can drag the corner handle
anywhere on the page and the graphic will get resized accordingly. To scale the image
proportionately, hold down the Shift key and then drag the handle.

3.

Moving the image: To move the image, with the pointer tool selected in the Tools Palette,
Click in the center of the image until the pointer changes to an arrowhead. With the mouse
button still held down, drag the image to any location on the page. For our report we will
place this logo near the bottom-right corner of the page. To move the image horizontally
or vertically in a straight line hold down the Shift key and then drag.

Now that we have an image placed on the cover page of our report (Figure 2.28) we will add
some text and graphic elements (squares, circles etc.) and complete the cover.
Figure 2.28: Image on the Cover Picture

Source: http://handouts.tamu.edu

How to Draw Graphic Elements?
The logo can be completed by drawing graphic elements like squares, circles and lines. We will
make a circle and place it behind the image already on the cover.
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1.

To draw the circle go to the Tools Palette and click on the circle tool (or the ellipse tool).
The pointer changes to a crosshair icon.

2.

We can make the circle by clicking on the page and holding down the Shift key as we drag.
Clicking on the circle displays the graphic handles around it, indicating it is selected.

3.

To scale the circle up or down drag the graphic handles on the page.

4.

To move the circle around the page, select the circle, click anywhere within the boundaries
of its eight handles and drag it around the page.
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5.

To change the color of the circle, go to the Colors Palette and choose the desired color.
Here we have chosen yellow as the circle’s color.

6.

To bring to circle on top of the image already placed on the page, drag it on top of the
image with the left mouse button.

7.

To make the circle go behind the image go to Element 4 Arrange 4 Send to back. Now the
circle lies behind the image (Figure 2.29).

Notes

Figure 2.29: Drawing Graphic Elements

Source: http://handouts.tamu.edu

8.

To align the image and the circle in a certain manner with respect to each other select both
the circle and the image and go to Element 4 Align Objects. A window similar to Figure
2.30 will appear. The red, green and blue rectangles shown in the white box in this window
shows a preview of how the chosen objects are currently placed with respect to each other.
We can choose from the various Align and Distribute buttons to get the result you want.
Figure 2.30: Aligning Objects

Source: http://handouts.tamu.edu
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9.

After getting the right alignment click OK. We now have the circle perfectly centered
behind the image as shown in Figure 2.31. This was done using the horizontal and vertical
alignment
Figure 2.31: Adjusted Cover Picture

Source: http://handouts.tamu.edu

Similarly we can draw the other basic geometric shapes given as options in the Tools Palette. By
default the shapes drawn are filled. If we want the shapes to be simple outlines we can go to
Element 4 Fill 4 Paper. Going to Element 4 Fill 4 Solid creates a filled solid once again. Select the
shape and try out the other options listed under Element 4 Fill and Element 4 Stroke for interesting
effects.

How to Work with Text?
Text can be inserted into PageMaker documents in numerous ways. One way is typing it directly
in the document. Other ways include inserting text created in other word-processing applications
such as Word, Word-Perfect, etc. or copying and pasting text from other sources on the computer.
For creating the caption of our report we will type it directly in PageMaker instead of importing
it from elsewhere.
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1.

Select the Text tool from the Tools Palette and click it anywhere on the page to establish an
insertion point. A blinking cursor appears and we can now type in the caption. The typed
text may appear too big or too small for the cover page depending on the text settings. We
can change the size, face, spacing, style, etc. of the font by changing the options in the
Control Palette.

2.

We can also change the font by going to Type 4 Font.

3.

We can change the font size by going to Type 4 Size.

4.

We can change the font style by going to Type 4 Type Style. Check out all the other
options available under Type for playing around with the look of the text and getting the
desired look.

5.

To change the color of the text, select the text and click on the color of your choice in the
Colors Window. We can have the text in different tints of the chosen color, too. To do this,
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select the part of the text you want in a different tint and go to the drop-down box that says
Tint in the Colors Palette. Choose a tint of, say, 40% of the original color. We will notice
the tint of the chosen text lightens considerably. In Figure 2.32, the text has two different
colors and two different tints for the blue color.

Notes

Figure 2.32: Final Image

Source: http://handouts.tamu.edu

How to Insert more Pages in the Report
Now that we are done with the cover page of the report we will add more pages and content
to it.
1.

To add more pages go to Layout 4 Insert Pages. A dialogue box similar to Figure 2.33 will
appear. Here we can specify the number of pages we want to add to the report. If we are
not sure of the final number of pages we will have in the report we can always repeat this
process to add more pages. We will add 2 more pages to the report after the current page.
We have the option of adding pages before or after the current page, as shown in Figure 2.33
Figure 2.33: Inserting More Pages

Source: http://handouts.tamu.edu
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Now the number of pages has increased to 3 and this is indicated at the bottom bar in the
PageMaker window (Figure 2.32).
2.

By right clicking on any page selected in this bar and clicking on “Remove Pages” we can
remove the page. The remaining pages get renumbered automatically.

How to Work with Columns?
Now that the cover page is done, we will make two columns in the following page and insert
text and graphics into it.
1.

Go to Layout 4 Column Guides. A window similar to Figure 2.34 will pop up. Here we can
specify the number of columns and the spacing we want between the columns.
Figure 2.34: Column Guides Dialog Box

Source: http://handouts.tamu.edu

Figure 2.35: Page Layout

Source: http://handouts.tamu.edu
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Specify the number of columns as 2 and the spacing between the columns as .25 inches. The
page layout changes and now looks like Figure 2.35. PageMaker will place text only
within the specified columns.
2.

We can also place text into a PageMaker document from any other word processing
application. For instance, create a document in Microsoft Word and copy the text you want
in the report by selecting the text and pressing Ctrl + C. Now click anywhere within the
column bounds in the PageMaker document, and paste the text there by going to Edit 4
Paste or by pressing Ctrl + V. The selected text gets pasted into the column and now our
page looks like Figure 2.35.

3.

The text is not easily readable at small fonts, but what we are seeing on the PageMaker
screen is not the actual size of the text. To see how the text will actually look go to View 4
Actual Size. Now the text looks like Figure 2.36. This is the actual text size and if we want
to change it we can do so by selecting the text tool in the Tools Palette, selecting the text we
want to resize and changing its size in the Control Palette.

Notes

Figure 2.36: Actual Display

Source: http://handouts.tamu.edu

4.

Another way of inserting text into a PageMaker document is to “place” a text file in it. Go
to File 4 Place. A dialogue box that looks like Figure 2.37 will appear. We choose the text
file we want to put into the document and click Open.
Figure 2.37: Place Dialog Box

Source: http://handouts.tamu.edu
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The pointer changes to a loaded graphic icon. We position the graphic icon within the
bounds of the column where we want the text to begin and click on the page to place the
image. The “placed” text shows up as in Figure 2.38.
5.

We will notice a small red triangle where the text box’s bottom window handle should be.
This indicates that there is more text in the block that has not been placed on the page or
pasteboard. To see this extra text we need to click on the red arrow and drag it downwards
(or upwards if the red triangle is out of the column bounds). The extra text will immediately
appear in the column.

6.

If we pull the red triangle to the bottom boundary of the column and it still remains red,
it indicates that there is still some more text to be placed. To place this text we click once
on the red triangle. The pointer changes to a loaded graphic icon again. Now we can
position this graphic icon at the top left corner of the next column. On clicking, the
remaining text gets placed there.

7.

To place larger amounts of text in the PageMaker document, or to have text flow
automatically into the next column, we can activate the Autoflow option. For this go to
Layout 4 Autoflow. To turn Autoflow off go to Layout 4 Autoflow again.
Figure 2.38: The “Placed” Text

Source: http://handouts.tamu.edu

How to Wrap Text around an Image?
One of the most useful features of PageMaker is wrapping text around graphics in various ways.
Example:
1.

44

Insert a new page with one column in the PageMaker document (by default the number of
columns in an inserted page is 1). Paste some text on the top of the image and then place
any image on the page on top of the text. The image lies on top of the text, and hides the
text below it. We can send the image behind the text by going to Element 4 Arrange 4 Send
to back. Now the image is behind the text as shown in Figure 2.39.
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Figure 2.39: Wrapping Text Around Image

Notes

Source: http://handouts.tamu.edu

2.

To get both the text and the image to show up and have the text wrap around the image,
click on the selection tool in the Tools Palette. Select the image and go to Element 4 Text
Wrap. A dialogue box similar to Figure 2.39 comes up. This Text Wrap dialogue box lets us
specify how we want the text to flow around the graphic boundary of the selected object.
It also gives us options for the Standoff, i.e. the distance between the text and the image
after wrapping.
Figure 2.40: Text Wrap Options

If we click on the second icon in this dialogue box (rectangular wrap) and click OK the text
flows around the image as shown in Figure 2.40. We can similarly wrap text around any
image or drawn graphic element.
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2.2.5 Basics of InDesign
Adobe InDesign is a desktop publishing software application produced by Adobe Systems. It
could be utilized to make works for example notices, flyers, leaflets, magazines, daily papers
and books. InDesign can likewise distribute content suitable for tablet units in conjunction with
Adobe Digital Publishing Suite. Graphic designers and production artists are the chief clients,
making and laying out periodical circulations, publications, and print media. It also supports
export to EPUB and SWF formats to create digital publications, and content suitable for utilization
on tablet machines.

!
Caution The Adobe InCopy word processor utilizes the same formatting engine as
InDesign.

Starting an InDesign Document
Load Adobe InDesign and you should receive the InDesign Start Screen, which has the four
labelled segments indicated.
Figure 2.41: InDesign Startup Screen

Source: http://indesignsecrets.com/wp-content/uploads/2007/06/offlinetipb.png

When you start a new InDesign document the program ought to know the needed page
estimations.
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Figure 2.42: New Document Dialog Box

Notes

Source: http://arrowprintinginc.com/system/2011/help-center/layout-templates/guidelines/
screenshots/Indesign_New_File_Dialog_02.gif

Looking at the InDesign Screen
1.

Check out the labelled chart at the highest point of the following page and refer to regularly
until you are acquainted with the different segments of the InDesign screen.

2.

At the moment you are looking at the FIT PAGE IN WINDOW screen. That is, the page has
been reduced to fit the size of the screen.

Task Create a flyer for your college/school using InDesign.
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Figure 2.43: InDesign Workspace

Source: http://www.gct.com.au/Sample%20Files/InDesignCS4/IDcs4_ch2.pdf

InDesign has various screen sizes which might be chosen from the View menu or by holding
down the Ctrl key on the Windows framework, or the Command key on the Macintosh
framework, and pressing a number.
Figure 2.44: Zooming in InDesign

Source: http://www.gct.com.au/Sample%20Files/InDesignCS4/IDcs4_ch2.pdf

Press Ctrl or Command a couple of times to zoom out. Hold down the Ctrl or Command key
and press 1. The screen view will be changed to show the page in Actual (or 100%) size.
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Notes Use the Ctrl or Command key to try the following screen sizes:
Ctrl+5 or Command+5

50% view

Ctrl+1 or Command+1

100% view

Ctrl+2 or Command+2

200% view

Ctrl+4 or Command+4

400% view

Ctrl+0 or Command+0

Fit page in window

The Tools Panel
Look at the Tools panel at the left of the screen. These tools allow you to create and control how
objects are placed in a document.
Figure 2.45: Control Panel and Tools Description

Source: http://www.gct.com.au/Sample%20Files/InDesignCS4/IDcs4_ch2.pdf

InDesign incorporates many of its functions in collapsed panels at the right of the screen. You
can add or remove panels from the Panel group.

Did u know? Adobe InDesign is the direct competitor to QuarkXPress.
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Figure 2.46: Displaying Panels

Source: http://www.gct.com.au/Sample%20Files/InDesignCS4/IDcs4_ch2.pdf

Figure 2.47: Click on the Panel Tab or Panel Label to Collapse it

Source: http://www.gct.com.au/Sample%20Files/InDesignCS4/IDcs4_ch2.pdf

Click on the Double arrows again to collapse all the panels in the Panel Group.
Figure 2.48: Adding or Removing Panels

Source: http://www.gct.com.au/Sample%20Files/InDesignCS4/IDcs4_ch2.pdf
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Figure 2.49: The Panel can then be Closed Using its CLOSE BOX

Notes

Source: http://www.gct.com.au/Sample%20Files/InDesignCS4/IDcs4_ch2.pdf

!
Caution In the event that you click a frame that holds text or graphics while importing text,
the text swaps the existing text or graphics.

Self Assessment
Fill in the blanks:
6.

Adobe Photoshop is one of the most powerful software applications for image
……………………

7.

PSD stands for “Photoshop ……………………”.

8.

JPEG It supports 24-bit ……………………, which means it can reproduce roughly 16.7
million shades.

9.

JPEG is what’s called a …………………… file format in light of the fact that it compresses
the pictures.

10.

The GIF file format is the format of choice for web ……………………

11.

The …………………… application is used to design advertisements, logos, cards, brochures,
etc.

12.

Adobe Illustrator is a …………………… program which deals with objects such as squares,
circles and irregular shapes.

13.

…………………… Tool is used for selecting and moving a shape and can also be used to
resize a shape.

14.

PageMaker was one of the first desktop …………………… programs, introduced in 1985
by Aldus Corporation.

15.

…………………… can likewise distribute content suitable for tablet units in conjunction
with Adobe Digital Publishing Suite.
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Case Study

Incisive Media Ltd. Delivers Design-rich Content for
Print, Web, and Mobile in real-time with a
Cost-effective Editorial System Based on QuarkXPress

I

ncisive Media is a leading global provider of specialty business news and information,
inprint, in person, and online. The company’s principal markets include financial
services, legal and accounting services, marketing services, technology, and risk
management. With a dynamic publishing solution based on QuarkXPress and Quark
Publishing System, Incisive Media is now able to improve collaboration among its authors
and publishers to different platforms seamlessly. Thanks to the versatility of Quark
Publishing System, IncisiveMedia can decide which desktop publishing software best
suits the needs of each publication and still have a single unified workflow system.
Cost-savings and Intelligent Content
With Quark Publishing System, Incisive Media is able to produce intelligent content so
that it can be easily reproduced and reused. This means that all the manual, error-prone
work is a thing of the past and the company can fully reap the benefits of dynamic publishing
publish more with less.
Ron Doobay, Head of Business Systems at Incisive Media, confirms: “We definitely require
significantly fewer resources now to create more. Back in 2004 we were just creating print,
now we are ready to deliver content in print, Web, produce e-Books and publish to the
iPad. I can categorically say that QPS enables a company to deliver the 21st century
requirements with a minimum cost base. With QPS Quark is delivering excellent value for
money.”
”As a global provider of information we need to deliver accurate content for print, web
and mobile almost in real time to always be competitive in an increasingly tough market.
We have also had a long-standing aim to be neutral in terms of desktop publishing
solutions, to be able to use the programme most appropriate to the needs of our very
varied product portfolio, but to do this within a top class workflow system. Quark offered
us the opportunity to achieve this, reducing our costs, improving productivity and
maximising revenues through syndication with Quark’s dynamic publishing solutions”
said David Worsfold, Group Editorial Services Director at Incisive Media.
Challenge
z

Content-reuse based on labour-intensive and error-prone practices

z

Need for immediate, real-time updates to content across all platforms

z

Working with different formats for different publications

Quark Solutions
z

Dynamic publishing solution based on QuarkXPress and Quark Publishing Systemenabling a status-based work flow.

Results
•

Improved collaboration among authors
Contd...
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•

Easy content sharing and repurposing

•

Agile content syndication and solid DRM functionality for increased revenues

•

Flexibility to meet changing market dynamics

•

Multi-channel publishing and effortless XML extraction

•

Desktop Publishing Software neutrality for a varied portfolio of publications.

Notes

Questions:
1.

Give details of the Incisive Media Company’s principal markets.

2.

State the use of QuarkXPress in publishing sector.

2.3 Summary
•

Desktop distributing (DTP) implies the practice of producing high quality printed output.

•

The simplest graphic or a color photograph that is in fine detail can be imported into a
document through DTP.

•

Some straightforward yet impressive designs can be created with shapes and fills, but the
more complex design effects require a greater degree of ability.

•

Photoshop is a graphics based program made with pictures regarded as raster graphics.

•

Raster graphics contains a raster (a framework) of tiny squares called pixels.

•

CorelDraw application is utilized to outline ads, logos, cards, handouts, updates, etc. for
print or for the Web.

•

A full collection of altering tools permit the client to adjust contrast, color offset, change
the format from RGB to CMYK, include enhanced effects for example vignettes and unique
outlines to bitmaps.

•

Designing a poster does not need any unique imaginative talent or abilities; it just it just
requires having the patience to get familiar with the illustrator.

2.4 Keywords
AutoCAD: It is a modifying requisition for workstation-helped configuration (CAD) and drafting.
CorelDraw: It is Desktop publishing software that enables clients to make illustrations holding
design, message and photos.
Desktop Publishing: It is a term authored after the infrastructure of a particular sort of
programming. It is about utilizing that software to join together and adjust content and pictures
and making advanced documents.
Illustrator: It archives the aforementioned shapes in indexes as geometric size, location and
colour value. This is called scalable vector graphics.
Photoshop: Image altering software developed by Adobe Systems Inc.
Printing: The symbolization, methodology, or business of preparing printed material by method
of inked sort and a printing press or by comparative means.
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2.5 Review Questions
1.

What is DTP and explain its significance in today’s world.

2.

What are the different tools of designing?

3.

Explain the different formats used in Photoshop.

4.

Write a short note on Photoshop DCS 1.0 and 2.0.

5.

What is CorelDraw and what are its advantages?

6.

Elaborate on Basic Illustrator Functions.

7.

Why was Pagemaker created?

8.

What is InDesign and where is it used?

9.

Explain the different elements of the InDesign screen.

10.

How is Indesign different from Pagemaker?

Answers: Self Assessment
1.

False

2.

True

3.

True

4.

False

5.

True

6.

Editing

7.

Document

8.

Color

9.

Lossy

10.

Illustrations

11.

Corel Draw

12.

Charting

13.

Selection

14.

Publishing

15.

InDesign

2.6 Further Readings

Books

K.S.V. Menon , Desktop Publishing for Everyone, Film City Productions.
Sandee Adobe Creative Team, Adobe InDesign CS6 Classroom in a Book, Adobe
Press Publications.

Online links

http://www.tips-tricks.com/gph_tools2.asp
http://www.photoshopessentials.com/basics/
http://lifehacker.com/5758404/learn-the-basics-of-photoshop-the-completeguide
http://www.umass.edu/art/prospective_students/application_guide/
indesign_basics.pdf
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Objectives
After studying this unit, you will be able to:
z

Explain the photoshop workspace

z

Describe working with images

z

Discuss cropping and color mode in photoshop

Introduction
Adobe Photoshop is an industry standard for raster graphic manipulation, creation and altering.
As a professional image editing software bundle, it accompanies various tools for modifying
photographs. It could be utilized by specialists and beginners alike. It offers a huge number of
filters and plugins which enable you to add cool effects to your pictures. Likewise, it has a
premium set of image transformation tools. In addition to all else things, the most cutting edge
Photoshop version accompanies enhanced vector graphics and 3D altering capabilities. You can
effectively make vector-based 2D pictures, for instance website logos, and then apply them to a
3D object with brilliant results.
Photoshop was released as a commercial graphic editing program in 1990. Since its first release,
it has become more and more complex. Each new version accompanies new effective features.
The current version of Photoshop - CS4, is significantly more than an altering program for your
computerized pictures. It backs a tremendous number of tools for creating graphics for your
site. With Photoshop, web designers can effortlessly make an online site’s layout utilizing a set
of vector based tools – distinctive shapes, styles, gradients and masks are available. Once the site
outline is completed, Photoshop allows you to “slice” up your image for use in your website.
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Additionally, you can ‘Save for web’ all your .PSD projects in various web optimized formats
including the popular .JPG and .GIF.
In this unit, you will be learning some basic tips on using the tools available in
Photoshop

3.1 Photoshop Workspace
The work region of Photoshop can be intimidating to work with because of all the complex
functionality yet with a brisk breakdown of the accessible features and their utilization; you
will be ready to comfortably navigate the work area with ease.
The Photoshop workspace comprises of five primary components: Toolbox, Palettes, the
Application Bar, the Options Bar and the Document Window. An excellent aspect regarding
utilizing Photoshop is that its workspace interface is exceptionally comparative to that of different
features in the Adobe Creative Suite, for instance Indesign and Illustrator.

Toolbox
This contains selection tools, painting and editing tools, foreground and background color
selection boxes, and viewing tools. To select, simply click on the icon on the toolbox (the name
of each tool will appear by positioning the pointer over the icon). A small triangle at the bottom
corner of the icon indicates the presence of additional hidden tools.
Figure 3.1: The Toolbox

Source: http://www.mediacollege.com/adobe/photoshop/tool/images/toolbox.gif

Palettes
It controls the behavior of its tools. Windows menu displays a list of available palettes. When
selected, the palette will appear as a floating window on the opened workspace. To activate a
palette click on its tab.
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The following are the common palettes:
z

Color: Displays the color values for the currently selected foreground and background
colors

z

Swatches: Displays a generic set of colors, but the true value of the Swatches palette is in
its ability to load custom swatch collections

z

Layers: Displays all the layers in an image

z

History: Records and displays individual changes made to an image and allows for
changes to be undone.
Figure 3.2: The Palette Tabs

Source: http://www.adorama.com/alc/files/

The Application Bar
The Application Bar, new to Photoshop CS4, is located across the top of the screen. It contains the
old menu bar, along with a number of other controls, for example a dropdown zoom menu, a
button for launching Adobe Bridge, and a button for viewing extras. The menu bar contains
controls for managing and editing files, manipulating images, managing layers, and more.
Figure 3.3: The Application Bar

Source: http://www.adorama.com/alc/files/e502011150c1379a0e3700e09a2674d8.jpg
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Options Bar
The Options Bar is located below the Application Bar. The options change depending on the tool
you have selected. For example, when you select the Type tool, options pertaining to text
editing will appear across the bar.
Figure 3.4: The Options Bar

Source: http://www.adorama.com/alc/files/

Document Window
The Document Window displays the file you’re working on.

Self Assessment
State whether the following statements are true or false:
1.

Windows menu displays a grid of available palettes.

2.

The Application Bar is located across the bottom of the screen. It contains the old menu
bar, along with a number of other controls.

3.

The Options Bar is located below the Application Bar.

3.2 Working with Images
To create a new image, follow these steps:
Click File from the Application Bar.
Click New. A dialog box will open, allowing you to define the following elements of your
image:
z

Name - allows you to name your picture.

z

Size - permits you to decide ahead of time the width and height of your picture. Photoshop
offers preset extents for measuring your picture, or you can modify your particular size
utilizing numerous sorts of estimations incorporating pixels, centimeters, inches, and
millimeters.

z

Resolution - permits you to set the picture resolution. A resolution of 72 ppi (pixels for
every inch) is for the most part utilized for Internet pictures. Depending on if you wish to
utilize your pictures for print or film, they will be a higher resolution.

z

Color Mode - permits you to control the color mode of your picture. The standard color
mode is RGB (Red Green Blue). You can likewise decide to make your picture in grayscale,
bitmap, and then some. Certain modes will restrict your color range.

z

Background Content - you to pick the initial background color of your picture.

When you are done with your selections, click OK.
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Figure 3.5: New Image Dialog Box

Notes

Source: http://whatis.techtarget.com/WhatIs/images/

To open an existing image, follow these steps:
1.

Click File from the Application Bar.

2.

Click Open.

3.

Navigate to your saved file.

4.

Click Open.

To save an image, click File and then click Save.

3.2.1 Hue, Saturation and Brightness
Hue, saturation, and brightness are parts of color in the red, green, and blue (RGB) plan. The
aforementioned terms are most frequently utilized as a part of reference to the color of every
pixel in cathode ray tube (CRT) monitors. All conceivable colors could be specified as hue,
saturation, and brightness (also called brilliance ), all in all as colors could be represented as the
R, G, and B components.
Most sources of visible light contain energy over a band of wavelengths. Hue is the wavelength
within the visible-light spectrum at which the energy output from a source is greatest. This is
shown as the peak of the curves in the accompanying graph of intensity versus wavelength. In
this example, all three colors have the same hue, with a wavelength slightly longer than 500
nanometers, in the yellow-green portion of the spectrum.
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Figure 3.6: The RGB Graph

Source: http://whatis.techtarget.com/WhatIs/images/hsb.gif

Saturation is the concentration of the color, measured in percent from the center of the cone (0)
to the surface (100). At 0% saturation, hue is meaningless. Here, the red curve represents a color
having low saturation, the green curve represents a color having greater saturation, and the
blue curve represents a color with fairly high saturation. As saturation increases, colors appear
more “pure.” As saturation decreases, colors appear more “washed-out.”
Brightness is a relative expression of the intensity of the energy output of a visible light source.
It can be expressed as a total energy value (different for each of the curves in the diagram), or as
the amplitude at the wavelength where the intensity is greatest (identical for all three curves). In
the RGB color model, the amplitudes of red, green, and blue for a particular color can each range
from 0 to 100 percent of full brilliance. These levels are represented by the range of decimal
numbers from 0 to 255, or hexadecimal numbers from 00 to FF.

3.2.2 Types and Characteristics of Digital Images
Different digital image types and characteristics are:

60

z

Bitmap (raster) and Vector:A bitmap graphic is composed of many tiny parts, called
pixels. They are often of many different colours and it is possible to edit each individual
pixel. Vector graphics are created in graphics packages and consist of shapes called objects.
It is possible to edit each object separately, for example, change the shape, colour, size and
position.

z

Bit Depth: It is determined by the number of bits used to define each pixel.

z

Colour Mode: The colour mode of a picture indicates which fundamental set of colours is
utilized to make up a picture. Some regular fundamental sets of colours used to make up
full colour pictures are Red, Green, and Blue (RGB mode) and Cyan, Magenta, Yellow, and
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Black (CMYK mode; Black is stood for by the letter K). Colours inside colour modes are
saved in their particular colour channels. You can see the channels in the Channels palette.
z

Notes

File Format: A file format defines the structure and type of data stored in a file. It is a
standard way that digital image is encoded for storage in a computer file. Commonly
used file formats are JPEG, GIF, TiFF, etc.

3.2.3 Bitmap (Raster) and Vector Images
Bitmaps
A bitmap image is a computer file used to store a picture. It consists of tiny blocks called pixels:

a 4 x 3 pixel image = 12 pixels total

Example: The picture above comprises of only 12 pixels so in all actuality might show up
as no more than a modest grey dot. The gaps you see between the pixels don’t truly exist – they
are only indicated for clarity.
Imagine each pixel to be like a tiny square light bulb. Each pixel can be any colour you want and
any brightness.
You can’t illuminate part of a pixel. Real images are of course a lot more complex and consist of
many more pixels.
Example: The example below is still rather blocky and crude, but you can begin to see
how a picture can be made up from pixel building blocks:
Figure 3.7: A Magnified Bitmap Image
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Squint at the image, or step back from your monitor and you will see it is a close up image of an
eye. In real bitmap images, the pixels are tiny dots so the illusion of a smooth and realistic image
is created:
Figure 3.8: The Squint Image of the above

Vectors
Programs like Flash draw using vectors. A very simple vector drawing might look like this:
Figure 3.9: A Simple Vector Image

In a vector drawing, you create control points. The lines in a vector drawing are created by the
software and join up the control points that the user has drawn. There are 4 control points in the
drawing above (3 are little white squares, the last one is dark to indicate that it is being worked
on). There is far more to be explained about vector graphics, but hopefully the illustration above
will be enough for you to see immediately how vector graphics differ from bitmap graphics.
That concludes our brief look at the difference between bitmap and vector graphics.
Be aware that although almost every graphics program you encounter will be primarily a
vector (“drawing”) or bitmap (“painting”) program, it will probably offer both types of graphic
and the chance to mix them together.

3.2.4 Resolution and Size
Resolution, or DPI refers to the number of dots, or pixels, on a linear inch of an image. The web
displays graphics at 72 DPI, yet sometimes your client will hand you a 450 dpi image. PhotoShop
can help you make the transition from a clunky, slow downloading file to speedy 72 DPI.
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PhotoShop can also help you resize an image. Lets face it, things arent always the way we want
them. You can shrink or stretch an image to fit your liking, or you can cut out a small part of an
image and make it larger.

Notes

Resolution
As previously mentioned, all web images should be set at 72 dots per inch. This can be achieved
through scanning, or by manually changing DPI settings in PhotoShop.
Adding or subtracting pixels is easy. Deciding what color to make the new pixels is another
story.

Notes PhotoShop is just a computer program, so it doesn’t even know if a new pixel is part
of a line, or if its part of someone’s face. PhotoShop doesn’t even know what a face is!
When changing resolution, PhotoShop runs complicated algorithms on an image to decide
exactly how to change it. PhotoShop does an amazing job of adding and subtracting pixels, but
it isn’t magic. Usually you can only move up or down in resolution by about 1/3 before the
image really suffers.

Changing Resolution (but not size) for Web Images
Sometimes you’ll have an image that was scanned at a higher or lower resolution than you need.
Its size is fine, you’ll only need to change the resolution.
1.

Click Image-> Image Size
Figure 3.10: Image Size Dialog Box

Source: http://www.awdsf.com/courseware/photoshop/ps2_ImageSize_Resolution_files/
image002.jpg
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2.

Uncheck Resample Image

3.

Change the Resolution to 72

Image Size
When you instruct PhotoShop to change the size of an image, it merely spreads out or scrunches
the image pixels. Pixels spread outimage gets bigger.
On the other hand, if you’re trying to make an image larger, and still keep your current dpi, well
then PhotoShops got its work cut out for it. To make an image larger, PhotoShop must spread
pixels apart. To keep resolution the same while stretching, PhotoShop must add new pixels to
the image and decide what color they should be. When shrinking an image, PhotoShop must
decide which pixels to remove.
PhotoShop is really good at adding and removing pixels, but you can generally only increase or
decrease size by about 1/3 before images start looking yucky.

Work on a Copy when Changing Sizes
Changing image size actually changes the color information in the image, so you might want to
save a copy before resizing an image forty times to decide how you like it. Every time PhotoShop
changes the image, it removes or adds pixels, slightly lowering image quality.

Changing Size, but not Resolution for Web Images
1.

Click Image -> Image Size

2.

Make sure there is a check in Resample Image ”
Resample Image” instructs PhotoShop to keep the resolution the same, no matter what
you do to the size. If you make an image bigger, PhotoShop will have to add pixels. If you
shrink the image, PhotoShop will have to remove pixels. There are three resample image
choices. Use “Bicubic” its the best.
Figure 3.11: Image Size Dialog Box

Source: http://www.awdsf.com/courseware/photoshop/ps2_ImageSize_Resolution_files/
image004.jpg
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3.

Change the Pixel Dimensions of the image, not the print size.

4.

Click OK

Notes

!
Caution PhotoShop was designed for both print and web work. Thus, the program gives
you the option to change print dimensions or pixel dimensions. As a web designer taking
a web design course, you don’t care about print size; your only concern is pixel Dimensions.
Don’t bother changing the print dimensions.

Self Assessment
Fill in the blanks:
4.

Color Mode permits you to control the …………………… mode of your picture.

5.

Most sources of visible light contain energy over a band of ……………………

6.

Saturation is the …………………… of the color, measured in percent from the center of the
cone to the surface.

7.

…………………… is a relative expression of the intensity of the energy output of a visible
light source.

8.

Real images are of course a lot more …………………… and consist of many more pixels.

9.

When changing resolution, PhotoShop runs complicated …………………… on an image
to decide exactly how to change it.

3.3 Cropping and Color Mode in Photoshop
Cropping is the process of removing portions of an image to create focus or strengthen the
composition. You can use the Crop tool to select an area of an image and discard everything
outside this area. The tool is located third from the top in the Photoshop Toolbox, on the left
side. Although cropping reduces the dimensions of an image, it is not the same as resizing.
Whereas resizing reduces or enlarges the entire image and everything in it, cropping does not
alter the size of the image content at all. The following steps will demonstrate how to crop an
image in Photoshop.

Open an Image
To practice with the crop tool, open an image in Photoshop; click “File>Open,” browse for the
image on your computer, and click “Open.” For the purposes of this tutorial, a photo will work
well, though any type of image will do.
Figure 3.12: Open an Image

Source: http://graphicdesign.about.com/od/howto/ss/photoshop_crop_all.htm
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Choose the Crop Tool
Click on the crop tool icon on the Photoshop toolbar (pictured). You can also use the keyboard
shortcut “c.” When you roll over your photo, the cursor will resemble the crop tool icon, unless
you have your cursors set to “precise” in the Photoshop preferences.
Figure 3.13: Choose the Crop Tool

Source: http://graphicdesign.about.com/od/howto/ss/photoshop_crop_all.htm

Select the Crop Area
Position your cursor where you want to start your crop, which will depend on what you want to
cut out of your photo. Left-click and drag to select the area that you want to remain in your
photo. If you want to adjust the starting point of your crop, you can hold down the spacebar to
move the selected area, then release it to continue drawing your crop square.
Figure 3.14: Select the Crop Area

Source: http://graphicdesign.about.com/od/howto/ss/photoshop_crop_all.htm
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Remember the area you are selecting is the part of the photo that will be kept…the rest will be
removed. Release the mouse button to finish selecting your crop area. You can now click and
drag your crop square to move it, and drag the corners to adjust it. To cancel the crop, hit the
“Esc” key on your keyboard.

Notes

Crop the Photo
Notice that the area outside of your crop is darker. This will be “cut out” when you crop your
photo. To complete the crop, double-click inside of your crop area or hit the “enter” key on your
keyboard. You are left with your newly cropped photo.
Figure 3.15: The Cropped Photo

Source: http://graphicdesign.about.com/od/howto/ss/photoshop_crop_all.htm

Resizing Images with the Crop Tool
The crop tool is also handy for resizing images, without using the “Image>Image Size…”
command. With the crop tool still selected, notice the toolbar at the top of your screen has blank
fields for width, height and resolution (pictured). You can fill these fields in with dimensions of
your choice, then crop the image to immediately resize it to those dimensions. For example,
enter a width of “300 px” and a height of “200 px” with a resolution of “72.” Try to crop your
photo and notice the aspect ratio is stuck to fit your dimensions. Finish the crop and you have a
72 dpi 300x200 photo. Here you are achieving both a crop and a resize in one step. You can also
fill in only one or two of these fields, allowing you to crop photos to a specific width or height
and let the other dimension work out for itself.
Figure 3.16: Enter Your Dimensions

Source: http://graphicdesign.about.com/od/howto/ss/photoshop_crop_all.htm
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Notes You can also enter inches by using the abbreviation “in” instead of “px.” This is
helpful for cropping a photo to a common size for printing, such as 4x6 inches at 300 dpi.
Remember you don’t actually have to crop anything out of your photo to use this resize
function, simply enter your dimensions and select the entire image with your crop tool,
and it will still be resized. Be careful about selecting dimensions that are larger than your
actual photo, which would result in a loss of image quality.
Source: http://graphicdesign.about.com/od/howto/ss/photoshop_crop_all.htm

Task Crop a HD Image to the resolution of 420X340.

3.4 Color Modes in Photoshop
There are numerous modes used to measure and depict color. The RGB color model is dependent
upon the hypothesis that every visible color could be made utilizing the primary additive
colors red, green and blue. The aforementioned colors are regarded as primary additives since
when joined in equivalent measures they generate white. The point when two or three of them
are joined in distinctive measures, different colors are produced. For instance, joining red and
green in equivalent measures makes yellow, green and blue makes cyan, and red and blue
makes fuchsia.
You can specify the colour mode in the Image ->Mode menu. Colours within most colour modes
are stored in colour channels.
The colour modes available in Photoshop are:
z

RGB Colour Mode: There are various types of color modes through which one can work in
Photoshop. One of the most prominent color modes in Photoshop and the other graphic
softwares is the RGB color mode. RGB refers to Red, Blue and Green which are the primary
colors.
Figure 3.17: The Mode of this Document is RGB Color, so it Contains three Channels

Source: http://www.graphics.com/sections/peachpit/2012/colormodels/2.jpg
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Combining these 3 colors in different colors can create a total of 16.8 million colors. RGB
mode is used when the images are published for the internet and have to be displayed on
the computer screen. All the colors have a value of 255 each and hence changing the value
from 0 to 255 for each color produces 16.8 million colors. If all the 3 values are equal then
a neutral gray is produced. If the value of a color is higher than the other colors then a
color created has more tones or tints of the color having the highest value
z

Notes

CMYK Colour Mode: The CYMK color scheme or mode is another very popular color
scheme in Photoshop. The CYMK color scheme is generally used when the image or the
graphic created is to be printed on paper. This scheme is based on the light absorbing
quality on paper. CYMK images comprises of colors produced from the combination of 4
colors of cyan, magenta, yellow and black. Like the RGB mode, the user has to enter values
for each color to get the desired color.
Figure 3.18: We Converted the Document to CMYK Color Mode,
which Upped the Number of Channels to Four

Source: http://www.graphics.com/sections/peachpit/2012/colormodels/3.jpg
z

Lab Color Mode: It is a three-channel mode, was developed for the purpose of achieving
consistency among various devices, such as between printers and displays. Lab Color files
are device-independent, meaning their color definitions stay the same regardless of how
each output device defines color. The channels represent lightness (the image details), the
colors green to red, and the colors blue to yellow. The lightness and color values can be
edited independently of one another. Although Photoshop uses Lab Color to produce
conversions between RGB and CMYK Color modes internally, Photoshop users like us
rarely, if ever, need to convert files to this mode.

z

Multichannel images: It contain multiple 256-level grayscale channels. If you convert an
image from RGB Color to Multichannel mode, its Red, Green, and Blue channels are
converted to Cyan, Magenta, and Yellow (as a result, the image may become lighter and
the contrast reduced). Some Photoshop pros assemble individual channels from several
images into a single composite image by using this mode.

z

Apart from Grayscale mode there are the monotone, duotone, Tritone and the Quadtone
modes. The Monotone mode refer to the use of only one color, the Duotone mode refers to
the use of only two colors, the Tritone mode refers to use of only 3 colors and the Quadtone
mode refers to the use of four colors.
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Self Assessment
State whether the following statements are true or false:
10.

Cropping is the process of adding portions of an image to create focus or strengthen the
composition.

11.

The crop tool is also handy for resizing images.

12.

Combining red, yellow and blue in different colors can create a total of 16.8 million
colors.

13.

Lab Color Mode is a three-channel mode, was developed for the purpose of achieving
consistency among various devices, such as between printers and displays.

14.

Multichannel images contains multiple 16-level grayscale channels.

15.

The Tritone mode refers to use of only 3 colors.

Case Study

The History of Adobe Photoshop

A

dobe Photoshop has become the standard for graphic editing applications and is
one of the bestselling graphic editing software programs to date. Since its release
in 1991, Photoshop has enjoyed enormous popularity in both the professional
and consumer markets; so much in fact, that the word photoshopping has become a verb.
Learn about the history of Photoshop and how the software went from being a college
student’s personal program to an industry leader in little over a decade.
History of Adobe
Founded in 1982 by two former Xerox employees, Charles Geschke and John Warnock,
Adobe was an early pioneer in the software field. Adobe was located in Northern California
in what is now known as Silicon Valley. The company’s first venture was into desktop
publishing with the development of PostScript, a programming language for printing
and font applications. Soon after selling PostSricpt to Microsoft, Adobe, in conjunction
with Apple, began working on its first graphic application, Illustrator. Originally designed
for use on Macintosh systems, Illustrator is a vector-based drawing application that features
pinpoint accuracy.
Notes Development of Photoshop
Thomas Knoll, a college student in Michigan, designed a graphics application that could
be used on his computer in 1987. He named the program Photoshop and his brother John
brought the program to California the following year, where he demonstrated it for
executives from Adobe and Apple. Adobe bought the program and hired the brothers to
continue working on it, developing add-ins and fine tuning the programming language.
Photoshop Versions
The first version of Photoshop was only compatible with Apple’s Macintosh computer
line. Compared with later versions, the first Photoshop was rather limited in its abilities.
Users could alter a photograph or graphic on the pixel level and use the edited image in
media-based forums such as computers, television and film. In 1992, Adobe released a
version that was compatible with computers running the Windows system. The following
Contd...
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year, they released a version that could be used on IRIX and Solaris, operating systems
used mainly by programmers. Adobe eventually released 10 versions of the program
using the Photoshop name, ending with version 7.0.1, which was released in 2002.
Subsequent versions of the program were renamed Photoshop CS and were bundled with
other products in Adobe’s Creative Suite.

Notes

Photoshop CS
The first version of Photoshop CS was released in 2003 and came bundled with Bridge,
Illustrator, InDesign and Version Cue; the premium edition also included Acrobat,
Dreamweaver and GoLive. Photoshop CS2 was released in 2005 and CS3 came out in 2007.
CS3 included the addition of three Macromedia programs, Dreamweaver, Flash and
Fireworks.CS4 was released in 2008 and contained several more media programs. All of
the programs in the CS bundle are designed to be used as cross platforms. For example, a
document created in Photoshop can be exported to Flash for animation and imported into
a webpage using Dreamweaver.
Photoshop Elements
Photoshop Elements is a budget version of Photoshop; it can perform many of the same
functions as the original version but at a much lower cost. Elements was designed primarily
for photograph editing, but it does not have all of the exportation functions found in the
CS line of products. Photoshop Elements was first introduced in 2001 and the application
is regularly upgraded with new features.
Questions:
1.

Who was the designer of Photoshop? And in which year it was used for first time.

2.

Explain the Photoshop product and its features.

3.5 Summary
z

When you instruct PhotoShop to change the size of an image, it merely spreads out or
scrunches the image pixels.

z

To keep resolution the same while stretching, PhotoShop must add new pixels to the
image and decide what color they should be.

z

Changing image size actually changes the color information in the image, so you might
want to save a copy before resizing an image forty times to decide how you like it.

z

Every time PhotoShop changes the image, it removes or adds pixels, slightly lowering
image quality.

z

Whereas resizing reduces or enlarges the entire image and everything in it, cropping does
not alter the size of the image content at all. The following steps will demonstrate how to
crop an image in Photoshop

z

To practice with the crop tool, open an image in Photoshop; click “File>Open,” browse for
the image on your computer, and click “Open.” The RGB color model is dependent upon
the hypothesis that every visible color could be made utilizing the primary additive
colors red, green and blue.

z

One of the most prominent color modes in Photoshop and the other graphic softwares is
the RGB color mode.

z

All the colors have a value of 255 each and hence changing the value from 0 to 255 for each
color produces 16.8 million colors.
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z

If the value of a color is higher than the other colors then a color created has more tones or
tints of the color having the highest value CMYK Colour Mode: The CYMK color scheme
or mode is another very popular color scheme in Photoshop.

z

Although Photoshop uses Lab Color to produce conversions between RGB and CMYK
Color modes internally, Photoshop users like us rarely, if ever, need to convert files to
this mode.

z

If you convert an image from RGB Color to Multichannel mode, its Red, Green, and Blue
channels are converted to Cyan, Magenta, and Yellow (as a result, the image may become
lighter and the contrast reduced).

z

Some Photoshop pros assemble individual channels from several images into a single
composite image by using this mode The Monotone mode refer to the use of only one
color, the Duotone mode refers to the use of only two colors, the Tritone mode refers to
use of only 3 colors and the Quadtone mode refers to the use of four colors.

3.6 Keywords
Brightness: It is a relative expression of the intensity of the energy output of a visible light
source.
CYMK: It is a subtractive color model, used in color printing, and is also used to describe the
printing process itself.
DPI: It is a measure of spatial printing or video dot density, in particular the number of individual
dots that can be placed in a line within the span of 1 inch.
Hue: The property of colors by which they can be perceived as ranging from red through yellow,
green, and blue, as determined by the dominant wavelength of the light.
Palettes: A panel or palette is a box (usually located on the right hand side of the screen, but
moveable) that allows you to change options associated with a Photoshop feature.
Quadtone: It is a mode of working in image manipulation software that permits printing of
image with four inks, each with its own reproduction curves.
Resolution: It is the term used to describe the number of dots, or pixels, used to display an
image.
RGB: It is an additive color model in which red, green, and blue light are added together in
various ways to reproduce a broad array of colors.
Saturation: It refers to the actual amount or strength of color that is apparent in a photograph.

3.7 Review Questions
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1.

Explain the different components of the Photoshop workspace.

2.

What is the importance of Palettes in Photoshop?

3.

What are the different attributes required in opening a new image in Photoshop?

4.

Write a short note on Hue, Saturation, and Brightness.

5.

What are the different characteristics of Digital Images?

6.

Differentiate between bitmap and vector images.

7.

Explain the concept of Resolution in Photoshop.
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8.

What do you mean by Image Size?

9.

Elaborate on the process of cropping in Photoshop.

10.

Write a short note on Color Modes.

Answers: Self Assessment
1.

False

2.

False

3.

True

4.

Color

5.

Wavelengths

6.

Concentration

7.

Brightness

8.

Complex

9.

Algorithms

10.

False

11.

True

12.

False

13.

True

14.

False

15.

True

3.8 Further Readings

Books

Peter Bauer, Photoshop CS6 for Dummies, Wiley Publishing Inc.
Barbara Obermeier, Ted Padova, Photoshop Elements 10 for Dummies, Wiley
Publishing Inc.
Steve Johnson, Adobe Photoshop CS6 on Demand, Perspection Inc.

Online links

http://www.photoshop.com/tutorials
http://www.smashingmagazine.com/2008/12/07/50-excellent-digitalphotography-photoshop-tutorials/
http://www.good-tutorials.com/tutorials/photoshop
http://psd.tutsplus.com/
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Objectives
After studying this unit, you will be able to:
z

Explain how to make selections

z

Discuss how to edit selections

z

Discuss the painting tools

Introduction
Learning about Photoshop is also a good way to learn imaging concepts. Whether you are
working on a webpage, Powerpoint presentation, or a document to be printed, Photoshop can
be used to enhance your images. Participants will learn about image file types, cropping images,
compositing (putting several images together), ghosting images (for use as webpage
backgrounds), using layers, creating masks, applying filters, and formatting text with bevels
and other effects.

4.1 Making Selections
The selection tools are used to facilitate the process of making selections of shapes, colors, and
objects inside of Photoshop, and positioning them in the working image area. With tools like
the magnetic lasso and magic wand, Photoshop packs a powerful array of selection gadgets.
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In Photoshop, selections are used to work in a specified area, while not altering any of the area
around it. In many regards, a selection is a lot like a stencil. You basically are enabling yourself
to only paint in one area while the rest of your canvas is left unaffected.

Notes

4.1.1 The Marquee Tools
The Marquee tool creates geometric, selection shapes like squares, rectangles and circles. Select
either the elliptical marquee tool or the rectangular marquee tool, then click and drag to create
rectangles and ellipses. Use the keyboard shortcut “M” or Shift M to select the marquee tool.
Figure 4.1: The Marquee Tool

Fill a selection with any foreground color by quickly pressing Alt+Backspace or
Option+Backspace for the Mac.
Figure 4.2: A Selection

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueetoolselection.png

Alternating white and black dashes indicated what has been selected. Click away from a selection
to immediately start another selection.
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Marquee Options Bar
Located at the top of the stage are the options available for this tool. The first four icons seen here
allow one to add or subtract additional selections from a prior selection. Move the mouse over
each icon to see which does what.

Marquee Tool Options
Figure 4.3: Marquee Tool Options

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueetooloptions.png

The basic options available in the Marquee Tool are:
z

Create a New Selection

z

Add to a Selection

z

Subtract from Selection

z

Intersect with Selection

Now we will learn about each option in detail.

Selection Options
The first option is the selection option which is used to create a new selection. The steps to follow
are given below:
z

Create any selection: Alternating white and black dashes indicated what has been selected.
Click away from a selection to immediately start another selection.
Figure 4.4: First Step to Create a Selection

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueecreatenewselection.png
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z

Add another selection to an existing selection: This is used to add a new selection to an
existing one. Figure 4.5 shows the addition of a new selection to the one in figure 4.4.

Notes

Figure 4.5: Adding a Selection

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueeaddtoselection.png
z

Subtract a selection: We can also remove or subtract a selection from a given image.
Figure 4.6 shows the deletion of a rectangular selection from the selection in figure 4.5.
Figure 4.6: Subtracting a Selection

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueesubtractselection.png
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z

Select the Intersecting Pixels: This option is used to select the intersecting pixels of an
image.
Figure 4.7: Selecting the Intersecting Pixels

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marqueemarqueeselectinter
secting.png

Feathering Box
A “feathered” option exists and an anti-aliased checkbox. Feathering nicely blends the edges of
a selection with pixels of the background, which in turn softens the transition.
Figure 4.8: Feathering Box

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueefeatheredbox.png

Anti-Alias Box
Anti-aliasing prevents your round selections from having rough, square-like edges. Think back
to the graphics that existed in the 1980s. Drawings and computer graphics had pixilated, edges
especially curves and circular edges.
Figure 4.9: Anti-Alias Box

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueeantialiasbox.png
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Marquee Style Box
The style box is a drop-down list with three options. Normal allows you to create selections as
you please. A fixed-ratio selection forces every selection to match that ratio. Ratios of 1:1 make
squares and perfect circles. The fixed height allows you to specify a height and width (in pixels)
for each new selection made.
Figure 4.10: Marquee Style Box

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueestylebox.png

Elliptical Marquee Tool
As the name states, this tool can create selections in the form of ellipses and circles. While
dragging with the elliptical marquee tool, pressing down the shift key creates a perfect circle.
Figure 4.11: A Perfect Circle

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueeperfectcircle.png

Use the space bar to drag the selection into place while still holding down the mouse button.
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Rectangular Marquee Tool
Use this tool to create selections in the form of rectangles or squares. While dragging a new
selection you may also press shift or option to create a perfect square. Also pressing the space
bar, will stop resizing the selection and instead allow you to move the whole selection about the
canvas. Use this technique to reposition and select geometric shapes.
Figure 4.12: Create a Perfect Square

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/marquee/
marqueeperfectsquare.png

4.1.2 Lasso Tools
The Lasso Selection Tools allow you to make selections of irregular shapes. Using the ordinary
lasso tool, simply click and drag a freehand selection with your mouse.
The polygonal lasso tool exists as a secondary tool to the original lasso tool. With the Polygonal
Lasso Tool, click to make various points which will define a selection, and finish your selection
by clicking the starting point. Press shift+L to alternate through the lasso tools until you have
the polygonal lasso tool selected. This tool is great for extracting pieces of photos that have
straight edges or a semi polygonal shape to them
Figure 4.13: Lasso Tool

Source: http://artist.tizag.com/screencaptures/photoshop/toolcaptures/lassotool/
polygonalextraction.png
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The Magnetic Lasso Tool sort of combines the first two tools mentioned here. You click once,
and begin to drag a freehand selection around the object you wish to select. The magnetic lasso
tool tries to automatically create points itself while you follow the edge of your object (you can
define points by clicking if needed). The end result is a much smoother selection than the
polygonal lasso tool will make.

Notes

Figure 4.14: Magnetic Lasso Tool

http://photolesa.com/sites/default/files/2012/teeth_1.jpeg
Figure 4.15: Figure Edited Using Magnetic Lasso Tool

Source: http://mediamilitia.com/wp-content/uploads/2009/12/extract/ml_1.jpg
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Now we have a general idea of how to make selections of various shapes in Photoshop. There is
also a way to select objects and areas based on color.

Magic Wand Tool
The Magic Wand Tool is unlike the rest of the selection tools, in that is selects areas based on
color. To use the Magic Wand Tool, you simply point and click the color you want to select in the
active image area.
Take the diagram below for example. Using the Magic Wand Tool, it simply takes one click in
the white area to make a selection of that space.
Figure 4.16: Magic Wand Tool

Source: http://tutorial9.s3.amazonaws.com/uploads/2008/04/magic-wand-tool.gif

Notes While using the Magic Wand Tool, it’s possible to select a wider (or more narrow)
range of colors when making your selection by adjusting the Tolerance value in the
options bar. The higher the value, the more similar colors will be selected.

Combining Selections
Sometimes, it’s necessary to combine multiple selections in order to select the ENTIRE area you
want to work with. In times like these, it’s possible to combine multiple selections using an easy
keyboard shortcut.
Working from an existing selection, simply hold shift and create a new selection. This will add
your new selection to the existing selection.
Figure 4.17: Combining Selections

Source: http://tutorial9.s3.amazonaws.com/uploads/2008/04/combine-selections.gif
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Subtracting and Intersecting Selections

Notes

Just like it is possible to add to an existing selection, you can also subtract from a selection (Hold
Alt when drawing a new selection) and intersect selections (Hold Shift and Alt while drawing a
new selection).

Move Tool
The Move Tool is used for moving selected areas of an image, layers, shapes, and other objects.
To move a selected part of an image, simply select the move tool, and then click and drag your
selection as you please. This will Cut the selection out from its current location, and reposition
it to wherever you release the mouse button.
Figure 4.18: Move Tool

Source: http://tutorial9.s3.amazonaws.com/uploads/2008/04/move-tool.gif

!
Caution The right tool is very essential in order to create the perfect picture.

Self Assessment
State whether the following statements are true or false:
1.

The Marquee tool creates geometric, selection shapes like squares, rectangles, and circles.

2.

Use the keyboard shortcut Alt+M is used to select the marquee tool.

3.

Fill a selection with any foreground color by quickly pressing Alt+Backspace.

4.

Feathering nicely blends the edges of a selection with pixels of the background, which in
turn softens the transition.

4.2 Editing Selections
After getting the general outline of your selection or mask down pat, Photoshop provides the
help in order to perfect your selections at the single pixel level.
Basically all selections are actually gray scale masks underneath, you need to use the right tools
that can control the boundaries of a mask in order to make your selections more precise.

4.2.1 Refine Edge
Refine Edge is a very useful tool for all kinds of users like photographers and home users. It
easily helps you replace tricky backgrounds and fine details (soft edges and hair) from a photo.
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The Refine Edge dialog box can be accessed from multiple locations in the Photoshop user
interface, some of them new to CS4.
1.

Use Quick Selection Tool (W) to select the subject from your photograph. Make use of the
Add for Selection and Subtract from Selection buttons in order to select your subject
nicely. Less selection is advised when dealing with soft areas like hair.
Figure 4.19: Subject with Selection

Source: http://www.twin-pixels.com/wp-content/uploads/crop1.jpg

Your image should resemble the image above.
2.

Next open the Refine Edge dialog box. Some of the settings here includes – the View Mode
which includes the background selected based on the photograph chosen, Edge Detection
where you need a small radius number which should not be too high, Adjust Edge to
experiment with the edges and finally how we save the photo we worked on (Output to),
and you’ll have a list to choose from. The box “Decontaminate colors” should be ticked at
all times, and the amount at 100%. The color “spill” from background to your subject is
extremely useful.
Figure 4.20: Refine Edge Dialog

Source: http://www.twin-pixels.com/wp-content/uploads/crop2.jpg
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Notes The Remember Settings box is good if ticked.
3.

There are a number of tricks you can do in Photoshop. For instance to draw over tricky
edges we can select the three objects on the left of the settings box: a magnifier (zooming),
a hand (moving if you zoom in a bit), and a brush. Click right on the brush and you have
a list there.
Figure 4.21: Refine Edge Tool

Source: http://www.twin-pixels.com/wp-content/uploads/crop3.jpg

The brush size should be small to prevent too much selection. This will be treated as “transition”
area between the inside and outside selection and will do help to figure out what to keep and
what not.
Figure 4.22: Area that Needs Refinement

Source: http://www.twin-pixels.com/wp-content/uploads/crop4.jpg

Figure 4.23: Final Result

Source: http://www.twin-pixels.com/wp-content/uploads/crop5.jpg
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There are three options inside Rene Edge that are explained belowz

Smooth: To smoothen out jagged edges of a selection. It is very useful in selection made
using the Magic Wand as it leads to weird bumps along the edge of a selection.

z

Feather: Using a specific pixel number it can be used to feather out a selection. This proves
very helpful when creating a vignette. It also allows you to visualize the amount of
feathering which is better than guessing the pixel radius.

z

Contract/Expand: Can be used to move your selection inward (contract) or outward
(expand).

Self Assessment
Fill in the blanks:
5.

The keyboard shortcut …………………… is used to select the marquee tool.

6.

The four options of the marquee tool are ……………………, ……………………,
…………………… and ……………………

7.

The Magic Wand Tool selects areas based on ……………………

8.

There are three options inside Rene Edge are ……………………, …………………… and
……………………

4.3 The Painting Tools
Photoshop provides several tools for painting images. We can draw and color using the Brush
tool and the Pencil tool. Tools like the Eraser tool, Blur tool, and Smudge tool can be used to
modify the existing colors in the image. You can set how color is applied to an image and choose
from preset brush tips from the options bar in each of these painting tools.

4.3.1 Paint and Edit Tool Options
Presets available for the tool are present in the Options bar. Some of them include:
Mode: To blend the color you paint with the underlying existing pixels. Available modes change
with the currently selected tool. Paint modes are similar to layer blending modes.
Opacity: To Set the transparency of color you apply. As you paint over an area, the opacity does
not exceed the set level no matter how many times you move the pointer over the area, until you
release the mouse button. If you stroke over the area again, you apply additional color, equivalent
to the set opacity. Opacity of 100 percent is opaque.
Flow: Sets the rate at which color is applied as you move the pointer over an area. As you paint
over an area, keeping the mouse button down, the amount of color builds up based on the flow
rate, up to the opacity setting.
Example: If you set the opacity to 33% and the flow to 33%, each time you move over an
area, its color moves 33% toward the brush color. The total will not exceed 33% opacity unless
you release the mouse button and stroke over the area again.
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Notes Press a single number key to set a tool’s opacity in multiples of 10% (pressing 1 sets
it to 10%; pressing 0 sets it to 100%). Press two number keys to set a specific opacity. To set
Flow, press Shift and number keys.
Some options of the Paint and Edit Tools are described below –

Airbrush
As you move the pointer over an area, paint builds up as you hold down the mouse button.
Brush hardness, opacity, and flow options control how fast and how much the paint is applied.
Click the button to turn on or off this option.

Auto Erase
Paints the background color over areas containing the foreground color.

Tablet Pressure Buttons
Use stylus pressure to override opacity and size settings in the Brush panel.

Brush Tool or Pencil Tool
To paint the current foreground color on an image we can use the Brush tool and the Pencil tool.
The Brush tool creates soft strokes of color and the Pencil tool creates hard-edged lines.

Notes Rotation tool rotates the canvas, which can facilitate easier painting.
The steps to be followed to create and paint an image are given below1.

Choose a foreground color.

2.

Select the Brush tool

3.

Choose a brush from the Brush Presets panel.

4.

Set tool options for mode, opacity, and so on, in the options bar.

5.

Do one or more of the following:

or Pencil tool

.



Click and drag in the image to paint.



To draw a straight line, click a starting point in the image. Then hold down Shift, and
click an ending point.



When using the Brush tool as an airbrush, hold down the mouse button without
dragging to build up color.

The Brushes Palette
The Brushes Palette allows us to select an appropriate brush size for the Painting and Editing
tools.
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Figure 4.24: Brush Palette

A: Brush Settings - Various settings for the selected brush tip, B: Brush Stroke Preview - A
preview of the current brush stroke will look when used, C: Selected Brush Tip - The
currently selected brush tip, D: Brush Tip Shapes - A list of all brush tip shapes available,
E: Brush Options - Options for modifying the currently selected brush tip. Changes will
not be permanent unless a new brush preset is saved.
Source: http://3.bp.blogspot.com/-XnXfyW-_5Qc/UGGtOwFHjII/AAAAAAAAA9Y/gY-cnoUPnNg/
s640/brush-palette.gif

To display the Brushes palette, Choose Window > Brushes, or click the palette button on the
right side of the options bar for the painting tools, erasing tools, toning tools, and focus tools.
The options in the Brushes palette can be shown by first selecting an item name on the left side
of the palette and then choosing from the available options for the selected item which appear
on the right side of the palette.

Notes Click the checkbox to the left of the item name to enable or disable the item without
viewing its options.

4.3.2 Drawing
Photoshop’s drawing tools are very powerful in their own way, but if you want to create and
draw an image from scratch. Photoshop uses raster graphics Raster graphics store picture data as
a matrix of pixels (dots). When you zoom in on the picture, the pixels become enlarged, resulting
in a fuzzy, jagged picture with visible pixels.
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Drawing Tools
The main drawing tools are located on the Tools Palette: the Pen Tool, Shapes Tool and the Path
Selection tool.
Figure 4.25: Tools Palette

Source: https://wiki.brown.edu/confluence/download/attachments/4438/Photoshop_tools.gif?
version=1&modificationDate=1152823763000

To expand the options for a tool, hold the mouse down on the tool icon.
Figure 4.26: Options of the Tools Palette

Source: http://www.surrealpsd.com/wp-content/uploads/2012/04/photoshop_selections_
tutorial_1.png
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z

Pen Tool: Use the Pen tool to create drawing paths. You can create custom shapes and
complicated curves that can be scaled easily. By accessing the expanded Pen tool, you can
add, delete and covert points on your drawing path.
Figure 4.27: Pen Tool in Tools Palette

Source: http://www.washington.edu/lst/help/graphics/photoshop/drawing
z

Path Selection Tool: Use the Path Selection tool to select an existing drawing path. You can
also use it to move, resize, copy, or delete paths. Use the Direct Selection tool to reshape a
path, or to delete a component of a path.
Figure 4.28: Path Selection Tool in Tools Palette

Source: http://www.washington.edu/lst/help/graphics/photoshop/drawing
z

Shape Tool: Use the Shape tool to create paths with a certain shape. It creates the same path
points that the Pen tool does. Each shape can be modified with the Path Selection tool.
Figure 4.29: Shape Tool in Tools Palette

Source: http://www.washington.edu/lst/help/graphics/photoshop/drawing
z

Type Tool: Use the Type tool to add text to your image. For more information on using the
Type tool, visit the Type page.
Figure 4.30: Type Tool in Tools Palette

Source: http://www.washington.edu/lst/help/graphics/photoshop/drawing
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4.3.3 Retouching Tools
Photoshop offers a large selection of tools and features for retouching photographs and images.
Further in this book you’ll learn how to use the common touch-up tools.

Core Retouching Tools
Retouching in this context means making changes to the content of the image beyond global
changes to tone or color of the image.
Pixels are modified, moved, scrunched, and smoothed in various ways to create a slightly new
variation of your image.

!
Caution Use the retouching tools in a way that does not produce out-of-place or unrealisticlooking images.

After a retouch the images will differ as per the effects we apply. The pictures below show the
difference.
Figure 4.31: The Image Before and After Retouching

Source: http://www.republicofcode.com/tutorials/photoshop/retouch/

Let us discuss in detail about the various retouching tools available.
The retouching tools in Adobe Photoshop are: Clone Stamp, Pattern Stamp, Healing Brush,
Patch and Color Replacement.
These tools repair damaged images, apply repeated patterns, or replace colors in an image.
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The following illustration shows the arrangement of these tools in the toolbar.
Figure 4.32: Retouching Tools

Source: http://akvis.com/en/photoshop-tips/retouch-tools.php

If two or more tools occupy the same cell (the icon for the tool last used is always shown), in
order to choose another tool, right-click the mouse on the arrow next to the icon and choose
another tool from the menu that appears. This menu will also appear if you click on the icon and
press it for some time.

Clone Stamp
The Clone Stamp tool and Healing Brush clone (copy) pixels from one part of an image to
another, to another layer or even to another image. The difference between the Healing Brush
and the Clone Stamp tool is, the Healing Brush in Photoshop takes into account the texture,
illumination and shadows of the processed image. As a result, the fragment processed by the
Healing Brush blends more easily into the rest of the image.
To clone an area with the Clone Stamp or Healing Brush, follow these steps:
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z

Step 1. Choose the tool from the Toolbar.

z

Step 2. Set the parameters for the tool in the Options panel: size, blending mode, the
amount of opacity and others.

z

Step 3. Check Use All Layers, if you need to work with several layers at once.

z

Step 4. Check Aligned to create one clone selected from the area around a starting point.
The mouse button can be released and new fragments selected. Also, the mode and size of
the tool can be changed. If Align is unchecked, then each application of the tool will create
a clone from the same starting point.

z

Step 5. Set a starting point. Do this by holding ALT, and then left-clicking on the point
from which the clone will be taken.

z

Step 6. Move the cursor to the location where you want to copy the fragment.

z

Step 7. Press the left mouse button and the clone will be applied. If the Healing Brush is
used, then the cloned fragments, texture, luminance, and shadows, will be processed in
relation to the pixels of the background image.
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Figure 4.33: A Copy Created using the clone Stamp Tool

Notes

Source: http://www.filebuzz.com/fileinfo/120063/Free_Clone_Stamp_Tool.html

Patch Tool
The Patch tool repairs an area with pixels copied from another area or image. Like the Healing
Brush, the Patch takes into account the texture, luminance, and shadows of the background
image.
This tool can be used in one of two ways:
Define the place where the clone will be applied, then drag the tool to the source point.
Follow these steps:
z

Step 1. Choose the Patch tool from the Toolbar.

z

Step 2. Choose the shape and size of the tool in the Options panel, and select Source in
Patch’s options.

z

Step 3. Draw a line with the Patch tool around the part of the image that needs to be
restored.

z

Step 4. Drag the selected area to a new spot, from which the clone will be created.

Define the source, then drag the tool to the damaged area.
Follow these steps:
z

Step 1. Choose the Patch tool from the Toolbar.

z

Step 2. Choose the tool’s size and shape in the Options panel, and in Patch’s options select
Destination.

z

Step 3. Draw a line with the Patch tool around the part of the image that will be cloned.

z

Step 4. Drag this area over the part of the image that needs repair.
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Figure 4.34: Patch Tool use on an Image

Source: http://photo.net/photodb/photo?photo_id=7286548

Pattern Stamp
The Pattern Stamp tool works by drawing with a repeating pattern. This tool can be used to
create a frame or design for wallpaper or for retouching the texture of part of an image. A
pattern is selected from the Pattern Palette in the Options Panel.
To use this tool, follow these steps:
z

Step 1. Choose the tool from the Toolbar.

z

Step 2. Set a pattern, by choosing it from the Pattern Palette in the Options Panel.

z

Step 3. Choose the size and shape, blending mode, amount of pattern opacity and other
parameters for the tool in the Options Panel.

z

Step 4. Press the left mouse button and drag the tool into the image.

Healing Brush
A repeating pattern can also be used with the Healing Brush and Patch tool. To do this with the
Healing Brush, in the tool’s options select Pattern for the Source and choose a pattern from the
Pattern Palette. To do this with the Patch tool – begin by using the tool to draw a line around an
area (or use a previously selected area), then choose a pattern from the Pattern Palette and press
the Use Pattern button.
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Figure 4.35: Showing the Use of Healing Brush Tool

Notes

Source: http://www.tutorial9.net/tutorials/photoshop-tutorials/retouch-and-healing-tools/#

Color Replacement
The Color Replacement tool replaces one color in an image with another. This tool can be used,
for example, to repair the “red eye” effect.
Follow these steps to use the tool:
z

Step 1. Choose the tool from the Toolbar.

z

Step 2. Set the color which will be used to replace the intended color in the image.

z

Step 3. Set the parameters for the tool in the Options Panel, such as: size and shape of the
brush, the color’s blend mode, color choice mode, opacity, etc.

z

Step 4. Click on the color in the image to be replaced.
Figure 4.36: Showing the use of the Color Replacement Tool to Change
Shade of the Elements in the Picture

Source: http://sixrevisions.com/graphics-design/35-basic-tutorials-to-get-you-started-with-photoshop/

Self Assessment
Fill in the blanks:
9.

Presets available for the tool present in the Options bar are ……………………,
…………………… and ……………………
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10.

To display the Brushes palette, Choose Window > ……………………

11.

The main drawing tools are located on the Tools Palette: ……………………,
……………………, …………………… and ……………………

12.

The …………………… tool is used to create drawing paths.

Task

1.

Show the steps to paint a frame inside using Brush Tools.

2.

Select an image make its clone image using Healing Brush.

Case Study

Portrait Photoshop Retouching from Lighting to
Finished Product

W

e all have searched the web for ways to accomplish better portrait retouching.
There are more methods and programs that people use, all of which have a
different look and not one is technically better than another. I use different
methods depending on the portrait and look I am going for. Sometimes I use a portrait
retouching program, but most of the time I just use Photoshop.
This is what I am going to explain here. I took a simple self portrait using a single flash
setup in my studio. The set-up can be seen below, a single SB700 flash camera left shot
through a shoot through 423 umbrella. Camera right slightly underneath the model I had
a white reflector disc to push some of the light back up into the model and reduce fall-off.
I wanted a shadow on the side of the face, but not too deep of one.

You can see the camera settings and flash setting in the corner. I had the camera in close to
just shoot a head shot. This is the resulting shot (I am not angry, just my smile pictures just
do not look genuine when I am doing this):
Contd...
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You can see that my skin does look smoother, but not porcelain. The next step for me is
usually whitening the whites of the eyes and the teeth. This example doesn’t have teeth
but you can do the same practice on them as well. Some duplicate the new layer and zoom
into the eyes. Grab the dodge tool and choose an exposure around 15%. Use a small soft
brush and lighten the whites of the eyes a little bit. While doing this, also using the same
tool, lighten up the color portion of the eye. Next, grab the burn tool and a small brush and
just darken the outside of the iris since it may have been lightened during the dodge
process and to really add some contrast in the eyes. This can really draw out a model’s
eyes. The second step I take on the eyes is to draw out the color. Create a New Layer and
grab the Eyedropper Tool. Select the color section of the eye. Now grab a soft brush at
100% opacity. The size should be the size of the color portion of the eye. Go to the layer, set
it from Normal to Color and change the opacity to around 55%, depending on how much
you want the eyes to stand out. Even though I did light the image with the shadow in
mind, I wanted to lighten a little bit of the right of my face. This can come in handy when
you want to add highlight to a models skin on the cheeks or above the brow. Add a New
Layer and grab a soft white brush. Set the opacity around 20% and paint the areas you
want lightened. Now in my work flow depending on if I am going to do a color or a black
and white portrait I do two different things. If I am doing a color portrait I adjust the levels
next. But I wanted this portrait in Black and White, so first I add an adjustment layer Black
and White and adjust the color channels how I see fit. Then I go and add a levels adjustment
layer.

Notes

Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://www.lightstalking.com/case-study-portrait-photoshop-retouching-from-lighting-tofinished-product

4.4 Summary
z

Photoshop is also a good way to learn imaging concepts. It can be used to enhance your
images.

z

The selection tools are used to facilitate the process of making selections of shapes, colors,
and objects inside of Photoshop, and positioning them in the working image area. With
tools like the magnetic lasso and magic wand, Photoshop packs a powerful array of
selection gadgets.

z

The Marquee tool creates geometric, selection shapes like squares, rectangles, and circles.

z

The basic options available in the Marquee Tool are: creating a new selection, adding to a
selection, subtracting from selection and intersecting with a selection.

z

The Lasso Selection Tools allow you to make selections of irregular shapes. Using the
ordinary lasso tool, simply click and drag a freehand selection with your mouse. Some of
them are – Magnetic, Polygonal, Magic Wand etc.

z

After getting the general outline of your selection or mask down pat, Photoshop provides
the help in order to perfect your selections at the single pixel level.

z

Refine Edge tool easily helps you replace tricky backgrounds and fine details of a photo.
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z

Photoshop provides several tools for painting images. We can draw and color using the
Brush tool and the Pencil tool. Tools like the Eraser tool, Blur tool, and Smudge tool can be
used to modify the existing colors in the image.

z

Photoshop offers a large selection of tools and features for retouching photographs and
images. The retouching tools in Adobe Photoshop are: Clone Stamp, Pattern Stamp, Healing
Brush, Patch and Color Replacement.

4.5 Keywords
Aliasing: The visual stair-stepping of edges that occurs in an image when the resolution is too
low.
Brush Tool: The Brush tool is a basic painting tool. It works like a traditional drawing tool by
applying the color using strokes. It’s located in the standard Tool Bar and its default shortcut is
the letter B.
Gray Scale Image: A black and white image.
Lasso Selection Tools: They allow you to make selections of irregular shapes.
Marquee Tool: It creates geometric, selection shapes like squares, rectangles, and circles of
painting with water colour.
Opacity: The Opacity value determines the extent of stroke applied with the Brush or Pencil
Tool.
Raster Image: It is made up of pixels (little squares) with a numerical value for their color.
Refine Edge Tool: It helps you replace tricky backgrounds and fine details of a photo.
Wet Edges: This option is available on the left side of the Brushes palette. It provides the effect.

4.6 Review Questions
1.

Discuss the various selection tools available in Photoshop.

2.

Give the steps to draw an image in Photoshop.

3.

What are the retouching in Photoshop?.

4.

Explain the various Marquee Tool Options available in Photoshop.

5.

Elaborate on the lasso tools concept.

6.

Discuss the steps to be followed to paint an image.

7.

What are the options of the Paint and Edit Tools?

8.

Explain drawing tools with examples.

9.

Explain the various tools available for retouching.

10.

What are raster graphics?

Answers: Self Assessment
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1.

True

2.

False

3.

True

4.

True

5.

“M”

6.

Create, Add, Subtract, Intersect
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7.

Color

8.

Smooth, Feather, Contract/Expand

9.

Mode, Opacity and Flow

10.

Brushes

11.

Pen, Shapes and Path Selection tool.

12.

Pen

Notes

4.7 Further Readings

Books

Barbara Obermeier, Photoshop CS5 All-in-One for Dummies
Matt Kloskowski, Layers: The Complete Guide to Photoshop’s Most Powerful Feature
(2nd Edition)
Richard Lynch, The Adobe Photoshop Layers Book
Mike Wooldridge, Teach Yourself Visually: Adobe Photoshop CS5

Online links

http://lifehacker.com/5758404/learn-the-basics-of-photoshop-the-completeguide
http://helpx.adobe.com/photoshop/using/painting-tools.html
http://help.adobe.com/en_US/photoshopelements/using/
WS287f927bd30d4b1f71abaa0b12e28aec742-7fff.html
http://www.tutorial9.net/tutorials/photoshop-tutorials/the-selection-tools
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Objectives
After studying this unit, you will be able to:
z

Explain basic concepts of layers

z

Understand of working of layers

z

Discuss filters of layers

Introduction
You can separate and work independently on different parts of the same image by using layers
even though it still appears to be one whole image. Layers allow us to edit images without
destroying them as we can undo the changes made. One of the most common tasks in Photoshop
includes improving the quality of images.
The basic steps towards better image quality:
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1.

Adjust contrast and brightness levels

2.

Variate the color

3.

Crop and trim Image Size and Canvas Size
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4.

Orient using Rotate.

5.

Repair the image using painting tools and Clone Stamp.

6.

Sharpen the image with Unsharp Mask.

5.1 Basic Concepts of Layers
Layer is the term used to describe the different levels at which you can place an object or image
file. In the program you can stack, merge or define layers when creating a digital image. Layers
can be partially obscured allowing portions of images within a layer to be hidden or shown in
a translucent manner within another image, or you can use layers to combine two or more
images into a single digital image. For the purpose of editing, working with layers allows you
to go back and make changes within a layer as you work.
Use of layers is one of the most powerful and important features of Photoshop which makes it
a superior photo composition and retouching product. Layers concept is easy to explain once
you visualize how layers work. You can consider a layer as an image placed on transparent sheet
which you can lay on another transparent one. Each layer is a separate image which can be
modified independently without affecting images from other layers. The final image (which we
see) is a view of the layer stack from the top down.
Figure 5.1: Layers Representation

Source: http://www.dvd-replica.com/photoshop/102.1.php
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The picture shown below is composed by combining four separate layers. The topmost layer
contains a set of horizontal lines toward the bottom of the image. The next two layers have the
image of a ring and a red flower. And finally, a coloured background layer at the bottom of the
layer stack.
The Layers palette in the figure 5.2 shows four layers labelled Lines: Ring, Flower, and Background
corresponding to each layer in the layer stack as displayed above in figure 5.2. The layer “Lines”
is at the top of the stack while the layer “Background” is at the bottom. The current or selected
layer is highlighted (Background). All commands and editing tools apply only to the current
layer without modifying any other layers in the document. Only one layer can be selected as the
current layer by clicking on its label or icon.
Figure 5.2: Layers Palette

Source: http://www.dvd-replica.com/photoshop/102.1.php

Photoshop provides the Layers palette to manage each layer present in a Photoshop document.
The final image can have a completely different appearance simply by displaying or hiding one
or more layers, or by rearranging the layer order of the layer stack.

Did u know? ImagePro was the original name of Photoshop but could not be used as it was
already taken.

Each layer is displayed with a small thumbnail and a label to help identify the layer quickly. We
can show or hide a layer by turning the corresponding layer visibility on or off. The eye icon to
the left of each layer controls its visibility. Depending upon the contents of each layer and its
position on the layer stack, changing its visibility can completely alter the appearance of the
final image.

5.1.1 Getting Images and Image Parts onto Separate Layers
We will now discuss how to get images and parts of the images in different distinct layers.
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In the figure given below we have two pictures:

Notes

Figure 5.3: Layers Representation

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/

Notes If your pictures are opening in tabbed documents rather than in floating document
windows follow the steps as given below:
1.

Go up to the Window menu at the top of the screen

2.

Choose Arrange

3.

Chose Float All in Windows
Figure 5.4: Layers Representation

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/

Even though we’re seeing two document windows on the screen, Photoshop works with one
document at a time. The one we’re working on is known as the “active” document. The currently
active document can be found by looking in the Layers panel.
Example: If we look in my Layers panel right now, we can see that the Background
layer’s preview thumbnail is displaying the photo of the woman looking through the curtains,
which means it’s the active document:
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Figure 5.5: The Preview Thumbnail Shows us what’s on the Layer

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/

To switch between documents and make a different one active, all we need to do is click anywhere
inside of it.
Figure 5.6: With a Different Document Now Active, the Layers Panel
shows a Different Image

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/

Notes Only one photo at a time was appearing in the Layers panel, not both, and that’s
because each photo is open in a completely separate document.
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You can see them both on the screen, but that’s the end of it as far as Photoshop is concerned. For
Photoshop there are two totally independent documents that have nothing to do with each
other.

Notes

To blend these two photos together, you have few methods that can be used.

Method 1: Drag and Drop
The easiest and most common way to move an image between documents is to simply drag it.
To do that, we need Photoshop’s Move Tool, which you can access by clicking on its icon at the
top of the Tools panel.
Figure 5.7: Move Tool

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/

With the Move Tool active, click inside the photo you want to move. Then, with your mouse
button still held down, drag it into the other photo’s document window.
Figure 5.8: Drag and Drop Images

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/
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When you release your mouse button, Photoshop drops the photo into the other document:
Figure 5.9: A Copy of the Photo Appears Inside the Other Photo’s Document

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/

Tip: Photoshop simply dropped the photo at the spot where mouse button was released. A better
way to move a photo is to hold down your Shift key as you’re dragging from one document to
another.
Figure 5.10: The Photo Now Appears in the Center using the Shift Key

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/
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If we look in the Layers panel, we see that we’ve successfully copied the photo into the other
photo’s document, as both photos are now showing, one on top of the other. The original photo
is sitting on the Background layer, and Photoshop placed the water drops photo on its own new
layer above it:

Notes

Figure 5.11: When You move a Photo from one Document to Another, Photoshop
Automatically Adds a new Layer for the Photo

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/

The next way that can be used to move photos is the copy and paste method.

Method 2: Copy and Paste
For this first click inside the document that contains the photo you want to move. Then, go up to
the Select menu at the top of the screen and choose All as shown in the image below:
Figure 5.12: Go to Select > All

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/
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This selects the entire photo. A selection outline will appear around its edges in the document
window:
Figure 5.13: Select the Photo You Want to Move

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/

With the photo selected, go up to the Edit menu and choose Copy which copies the photo to the
clipboard.
Click inside the document you want to copy the photo into to make it the active document, then
go back up to the Edit menu and choose Paste.
Photoshop pastes the photo into the new document, and once again in the Layers panel, we see
that the photo has been placed on its own layer above the original image on the Background
layer:
Figure 5.14: One Photo has been Copied and Pasted into the other Photo’s Document

Source: http://www.photoshopessentials.com/basics/moving-photos-between-documents/
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Resizing Images on Layers
Now we’ll learn how to resize images in order to get the perfect dimensions that are needed.
Figure 5.15: The Original Photo

Source: http://www.photoshopessentials.com/essentials/image-resizing/

To resize an image in Photoshop, we use the Image Size command which we can get to by going
up to the Image menu in the Menu Bar along the top of the screen and choosing Image Size.
This will bring up the Image Size dialog box, as shown below:
Figure 5.16: The Image Size Dialog Box

Source: http://www.photoshopessentials.com/essentials/image-resizing/

LOVELY PROFESSIONAL UNIVERSITY

109

Graphic Tools

Notes

The dialog box is divided into two main sections – Pixel Dimensions and Document Size, each
showing different measurements. We will discuss the Pixel Dimensions section, since it’s the
one that controls the actual, physical dimensions (in pixels) of the photo.
The current file size of the image below is 14.6 M (the “M” stands for megabytes, or “millions of
bytes”):
Figure 5.17: The Current File Size is Displayed to the Right
of the Words “Pixel Dimensions”

Source: http://www.photoshopessentials.com/essentials/image-resizing/

If you click on either the word “pixels” or the arrow to the right of the word, a drop-down menu
will appear which lets you change the measurement type to percent.
Figure 5.18: Changing the Measurement Type from Pixels to Percent

Source: http://www.photoshopessentials.com/essentials/image-resizing/

!
Caution 50 percent does not equal to 50 pixels. Be cautious while giving values while
resizing a picture.

After resizing the height and width by 50 percent, our final image is as follows:
Figure 5.19: The Image after Resizing the Width and Height by 50 Percent

Source: http://www.photoshopessentials.com/essentials/image-resizing/
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Self Assessment
State whether the following statements are true or false:
1.

Layer is the term used to describe the different levels at which you can place an object or
image file.

2.

The currently active document can be found by looking in the Layers panel.

3.

Move Tool can be accessed by clicking on its icon at the top of the Tools panel.

4.

To resize an image in Photoshop, we use the Size command.

5.2 Working of Layers
Let us now discuss how to work with the various layers in Photoshop.

5.2.1 Showing and Hiding of Layers
Hiding a layer is helpful when we need to work on the layers underneath it, or hide all other
layers so you can concentrate on the current layer. You can do all this using the little “eye” icons
next to each layer in the Layers palette:
Figure 5.20: The Eye Icon in the Layers Palette

Source: http://www.washington.edu/lst/help/graphics/photoshop/working-with-layers

The steps to hide/show a layer are given below:
z

To hide a layer, click once on the eye icon. The eye will disappear and the layer will
become invisible.

z

To show the layer again, click again on the eye icon. The layer will reappear.

z

To hide all layers except one, Alt+click on the eye icon for the layer you want to keep.
Alt+click on the eye again to reveal all the layers.

5.2.2 Deleting of Layer
If you want to delete a layer, find the layer in the Layers palette and drag it down to the little
trash can icon. Or select Delete Layer from the Layer menu.
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To Delete Linked Layers do one of the following:
z

To delete the linked layers with confirmation, choose Delete Linked Layers from the
Layers menu or the Layers palette menu. Alternately, Ctrl-click the Trash button.

z

To delete the linked layers without confirmation, Ctrl-Alt-click the Trash button.

To Delete Hidden Layers, choose Delete Hidden Layers from the Layers menu or the Layers
palette menu.

5.2.3 Repositioning of Layers
You can reposition the contents of layers and layer sets using the move tool. You can also align
and distribute the contents of layers using commands in the Layers menu.
To align the contents of layers do one of the following:
z

To align the content of a layer to a selection border, make a selection in the image. Then
select a layer in the Layers palette.

z

To align the contents of multiple layers to a selection border, make a selection in the
image. Then link together the layers you want to align in the Layers palette. To align the
contents of layers to the content of the active layer, link the layers you want to align to the
active layer.

z

Choose Layer > Align Linked or Layer > Align To Selection, and choose a command from
the submenu:


Top Edges to align the top pixel on the linked layers to the top pixel on the active
layer or the top edge of the selection border.



Vertical Centre to align the vertical centre pixel on the linked layers to the vertical
centre pixel on the active layer or the vertical centre of the selection border.



Bottom Edges to align the bottom pixel on the linked layers to the bottom pixel on
the active layer or the bottom edge of the selection border.



Left Edges to align the left pixel on the linked layers to the left pixel on the active
layer or the left edge of the selection border.



Horizontal Centre to align the horizontal centre pixel on the linked layers to the
horizontal centre pixel on the active layer or the horizontal centre of the selection
border.



Right Edges to align the right pixel on the linked layers to the right pixel on the
active layer or the right edge of the selection border.

5.2.4 Flattening of Layer
Merging all visible layers into the background layer to reduce file size is called flattening of
layers.

112

LOVELY PROFESSIONAL UNIVERSITY

Unit 5: Working with Layers in Photoshop

Figure 5.21: The image on the left shows the layers palette and file size before
flattening. The unflattened file size is 16.6 MB, and the file has three layers. The
image on the right shows the Layers palette after flattening. The flattened file
size is 10.9 MB and has only one layer

Notes

Source: http://www.adobe.com/designcenterarchive/keyconcepts/articles/concept_flattening.html

Self Assessment
State whether the following statements are true or false:
5.

To hide all layers except one, Ctrl+click on the eye icon for the layer you want to keep.

6.

Select Delete Layer from the Layer menu to delete a layer.

7.

You can reposition the contents of layers and layer sets using the position tool.

8.

Merging all visible layers into the background layer to reduce file size is called flattening
of layers.

5.3 Filters of Layers
Filters are the ready-made effects that you can apply to the image that you are working with.
Photoshop offers a wide variety of filters. They can be accessed from the Filters menu in the
Photoshop Menu Bar. When you use any of the filter options available, a dialog box will open
through which you can see a preview of the effect that you are going to apply on the image. This
gives you information on how the image result will look after application.
Here are the many filter options on Photoshop:
Artistic - This filter enables you to achieve artistic effects. You can get some of the most distinct
effects through this option.
Blur - This filter enables you to soften the look of an image. It can be used to soften the look of
an entire image part of an image. You can use it to reduce the hard edges of an image.
Brush Strokes - This filter enables you to create artistic effects using brush strokes.
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Distort - This filter enables you distort the image so that you can get a unique effect on the
original image. This is one of the most interesting Photoshop effects to try out.
Noise - This filter is used for creating textures. Many texture effects can be added using the
options available here.
Pixelate - It creates small cells in the image that you are working with, based on color similarity.
Render - This bring about cloud and light effects in the image that you are selecting.
Sharpen - This sharpens the soft edges in the image by increasing pixel contrast.
Sketch - This works much like the artistic filter, excepting here you get a hand draw effect on the
image.
Stylize - This option enables you to create special stylish effects on the image.
Texture - This option enables you to create various types of texture effects that can really enhance
the way your image looks.
Video - When you have image captured through video, you can use this command to smoothen
them out.
Digimark - You have to use this option when you want to add a digital watermark to the image.
Each of the filters enables you to create unique and stylistic effects on your image document.
You can carry out so many variations in the image that you are working with and bring out
some of the best results.

Task Check out the results of each filter and carefully experiment with as many variations
as possible.

5.3.1 Previewing Filter Effects
To preview the effect of the filters applied to a photo, click and drag within this window to pan
and scroll to different parts of your image. Or, if you move your mouse outside of the dialog
box, you can click anywhere in your main image window to focus the Preview window around
that part of your image.
You can also change zoom levels within the Preview window by clicking on the + and – buttons,
although leaving the zoom at least at 100%, so you can see an accurate representation of the
effect on your image.
Most of the filters’ dialog boxes offer the option to preview the filter in the main image window
by enabling the Preview check box. As you adjust the filter’s options, the main image display
updates continually, giving you a big-picture view of your changes.

Notes That some filters take longer than others to update; in these cases you will notice a
progress indicator blinking underneath the Zoom value in the dialog box. If you are
working on a slow computer, you can disable the Preview check box to speed things
along.
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Figure 5.22: Previewing the Window Effects

Notes

Source: http://www.dummies.com/how-to/content/how-to-work-in-photoshop-cs6s-filter-gallery.html

5.3.2 Repeatedly Applying Filters
To reapply the most recently used filter, either in the same document or in a different document,
press Ctrl+F or select the first menu item from the Filters menu. This reapplies the filter with the
most recently used settings. Press Ctrl+Alt+F to display the dialog box for the most recently
used filter, so you can apply it again, but with different options.

5.3.3 Using the Filter Gallery
The Filter Gallery provides a preview of many of the special effects filters. You can apply
multiple filters, turn on or off the effect of a filter, reset options for a filter, and change the order
in which filters are applied. When you are satisfied with the preview, you can then apply it to
your image. Not all filters in the Filter menu are available in the Filter Gallery.
Figure 5.23: The Filter Gallery Dialog Box

Source: http://help.adobe.com/en_US/photoshop/cs/using/WSfd1234e1c4b69f30ea53e4
1001031ab64-7986a.html
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Filter Gallery dialog box includes the following options:
A.

Preview

B.

Filter category

C.

Thumbnail of selected filter

D.

Show/Hide filter thumbnails

E.

Filters pop up menu

F.

Options for selected filter

G.

List of filter effects to apply or arrange

H.

Filter effect selected but not applied

I.

Filter effects applied cumulatively but not selected

J.

Hidden filter effect

Task Try all the options of the Filter Gallery dialog box and notice the changes on your
photo.

5.3.4 Fading and Blending Filters
The Fade command changes the opacity and blending mode of any filter, painting tool, erasing
tool, or color adjustment. The Fade command blending modes are a subset of those in the
painting and editing tools options (excluding the Behind and Clear modes). Applying the Fade
command is similar to applying the filter effect on a separate layer and then using the layer
opacity and blending mode controls.

Notes The Fade command can also modify the effects of using the Liquify command and
Brush Strokes filters.
To apply the fade filter follow the steps below,
1.

Apply a filter, painting tool, or color adjustment to an image or selection.

2.

Choose Edit > Fade. Select the Preview option to preview the effect.

3.

Drag the slider to adjust the opacity, from 0% (transparent) to 100%.

4.

Choose a blending mode from the Mode menu.

5.

Click OK.

Notes The Color Dodge, Color Burn, Lighten, Darken, Difference, and Exclusion blending
modes do not work on Lab images.
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Self Assessment
Fill in the blanks:
9.

Photoshop provides the …………………… palette to manage each layer present in a
Photoshop document.

10.

Each layer is displayed with a small …………………… and a label to help identify the
layer quickly.

11.

To blend these two photos together we can either use …………………… or ……………………
method.

12.

The two sections of the image dialog box are …………………… and ……………………

Case Study

PES 2013 Photoshop and Cinema 4D

W

e are accustomed to seeing the final result of a design and then judging whether
it’s good or bad. Most of the time we forget to think about the back and forth
of ideas and countless iterations from the brief to the final product. That is
what differentiates design from art and that is what we here at Abduzeedo always try to
illustrate in our posts. Enter this amazing case study from Diego L. Rodríguez.
Graphic created for the promotion event in Madrid of Konami’s PES 2013 video game. The
initial brief indicated to create a digital image of Cristiano Ronaldo emerging to the video
game from a glass wall.
Project process was absolutely crazy, with several changes of brief and a very limited
time. The image was used in the main event for banners, flags, deluxe edtion boxes,
promotions and web. Unfortunately the agency didn’t provide me any of those products.
Asset
We are accustomed to seeing the final result of a design and then judging whether it’s
good or bad. Most of the time we forget to think about the back and forth of ideas and
countless iterations from the brief to the final product. That is what differentiates design
from art and that is what we here at Abduzeedo always try to illustrate in our posts. Enter
this amazing case study from Diego L. Rodríguez.
Graphic created for the promotion event in Madrid of Konami’s PES 2013 videogame. The
initial brief indicated to create a digital image of Cristiano Ronaldo emerging to the
videogame from a glass wall.
Project process was absolutely crazy, with several changes of brief and a very limited
time. The image was used in the main event for banners, flags, delluxe edtion boxes,
promotions and web. Unfortunately the agency didn’t provide me any of those products...
Effects
These renders were created for dynamic cupping masks and to emphasize the destruction
of the player’s body parts. In the beginning the brief indicated more destruction, glass
effects and broken parts, but it was changed several times during the process. Steps can be
choosing between headings and backgrounds.
Contd...

LOVELY PROFESSIONAL UNIVERSITY

117

Graphic Tools

Notes

Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://abduzeedo.com/pes-2013-photoshop-and-cinema-4d-case-study

5.4 Summary
z

Layers allow us to edit images without destroying them as we can undo the changes made.

z

Photoshop provides the Layers palette to manage each layer present in a Photoshop
document.

z

To blend these two photos together we can Drag and Drop or Copy and Paste images.

z

The image dialog box is divided into two main sections – Pixel Dimensions and Document
Size.

z

We can resize images via pixels or percent parameters.

z

We can delete linked layers and hidden layers and also flatten them.

z

Photoshop allows us to reapply the filters used, fade and blend them too using various
options in the Filter Gallery Dialog Box.

5.5 Keywords
Artistic: This filter enables you to achieve artistic effects. You can get some of the most distinct
effects through this option.
Blur: This filter enables you to soften the look of an image. It can be used to soften the look of an
entire image part of an image. You can use it to reduce the hard edges of an image.
Brush Strokes: This filter enables you to create artistic effects using brush strokes.
Clipboard: The clipboard is a software facility that can be used for short-term data storage and/
or data transfer between documents or applications, via copy and paste operations.
Digimark: You have to use this option when you want to add a digital watermark to the image.
Fade Command: It changes the opacity and blending mode of any filter, painting tool, erasing
tool, or color adjustment.
Flattening: Merging all visible layers into the background layer to reduce file size.
Layers: They allow us to edit images without destroying them as we can undo the changes made.
Pixel: The smallest addressable element in a picture.
Pixelate: It creates small cells in the image that you are working with, based on color similarity.
Unsharp Mask: Used to create an image that is less blurry than the original one.

5.6 Review Questions
1.
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Give the basic steps towards achieving a better image quality.
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2.

Discuss the steps to be followed to open pictures in floating document window and not in
tabbed documents.

3.

Explain the two methods used to blend images together.

4.

What are filters? Why do we need them?

5.

Give the steps to get images and image parts onto Separate Layers.

6.

How do you resize Images on Layers?

7.

Discuss the steps to Show and Hide of Layers.

8.

How do you delete a layer?

9.

What are the ways to reposition a layer?

10.

Explain Fading and Blending Filters.

Notes

Answers: Self Assessment
1.

True

2.

True

3.

True

4.

False

5.

False

6.

True

7.

False

8.

True

9.

Layers

10.

Thumbnail

11.

Drag-drop, copy-paste

12.

Pixel Dimensions, Document Size

5.7 Further Readings

Books

Barbara Obermeier, Photoshop CS5 All-in-One For Dummies.
Matt Kloskowski, Layers: The Complete Guide to Photoshop’s Most Powerful Feature (2nd
Edition).
Richard Lynch, The Adobe Photoshop Layers Book,
Mike Wooldridge, Teach Yourself Visually: Adobe Photoshop CS5.

Online links

http://www.photoshopessentials.com/basics/moving-photos-betweendocuments/
http://wegraphics.net/blog/tutorials/photoshop/photoshop-for-beginnersunderstanding-layer-mask/
http://www.photoshopessentials.com/essentials/image-resizing/
http://www.adobe.com/designcenter-archive/keyconcepts/articles/
concept_flattening.html
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Objectives
After studying this unit, you will be able to:
z

Explain the basics of CorelDraw

z

Discuss the toolbar of CorelDraw

z

Understand menus in CorelDraw

Introduction
Corel Draw is a PC-based graphic suit and not just a vector graphics program. You can use Corel
Draw to create anything from simple graphics and headlines to sophisticated artwork and
technical drawings. It can be used to tackle a wide variety of projects - from Illustration and logo
creation to Web graphics or multi page marketing brochures, or eye-catching signs. You can
also Draw shapes, work with text, add color and effects. Corel Draw is a very flexible vector and
graphic package and is a part of CorelDraw Graphics Suite 12.

6.1 Basics of CorelDraw
The end product of CorelDraw is referred to as a drawing. A drawing may consist of a line, text,
curve, symbol or image which are called object. Each object in a drawing stores its own properties
to describe them like shape, size, position, and color. These attributes can be modified to create
the required drawing.

6.1.1 To Open a Drawing
You need to install CorelDraw on your system and then follow the steps given below:
1.

When CorelDraw is loaded, a new section is created on the Start Menu. To open DRAW,
click the Start button from the Taskbar. This opens the Windows Start menu.

2.

Select Programs from the list

3.

This opens up the program with the CorelDraw welcome screen. If you have used the
program before, you may have turned off this screen.
Figure 6.1: CorelDraw Welcome Screen

Source: http://www.sulfurcreek.com/classes/CDclass/dr12Bch1.htm
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4.

Choose Open Graphic or use the Open command on the File menu.
New Graphic creates a new, one page document. Open Last Edited opens the last document
you had open. The splash screen will show the names of the files over the icon. The
Template icon allows you to access many professionally created templates you can then
modify for your own projects.

Did u know? The CorelTutor gives you a brief overview of how to use the program and
What’s New? shows you all the improvements from Version 11.

5.

Direct the Explorer to your hard drive and the folder where you saved the class files.

6.

Choose the file Open 1st.cdr .
If the Panose Screen appears listing fonts that are not loaded, click the OK button. This
utility allows you to load fonts for a document when you open the document.

!
Caution You must have the Font Navigator utility loaded and active for the fonts to install
automatically.

6.1.2 CorelDraw Interface
The basic screen where the user works upon with CorelDraw is the interface screen as shown
below:
Figure 6.2: The CorelDraw Interface

Source: http://www.acp.com/support_coreldraw_interface.htm

122

LOVELY PROFESSIONAL UNIVERSITY

Unit 6: Introduction to CorelDraw

Notes

6.1.3 Component Description
The figure above consists of the following options:
Tool Box: Consists of tools for modifying objects
Title Bar: The area indicating the title of the currently open drawing along with the minimize,
maximize and close options.
Menu Bar: The area containing menu commands like File, Text, etc.
Standard Tool Bar: It contains shortcuts to Windows commands.
Drawing Window: The area outside the drawing page.
Property Bar: Contains commands that relate to the currently selected tool or object.
Docker: Window that contains available commands for the current object.
Ruler: Show the current mouse cursor location as you move in the work area.
Document Navigator: The area that contains controls for moving between pages and editing
pages
Drawing Page: The printable area in which you create a drawing.
Status Bar: Used to give you information about cursor movements or symbol properties such
as the fill or size.
Navigator Button: A button that opens a smaller display to help you locate an object or area of
your drawing.
Color Palette: The Color Palette by default is located to the right of the work window. Like the
Toolbars, it can also be relocated. You can choose from a preset palette of colors, or use a specific
color system such as Pantone Spot Colors.

Self Assessment
Fill in the blanks:
1.

A drawing may consist of a line, text, curve, symbol or image which are called
……………………

2.

The …………………… icon allows you to access many professionally created templates
you can then modify for your own projects.

3.

…………………… consists of tools for modifying objects.

4.

A button that opens a smaller display to help you locate an object or area of your drawing
is called ……………………

5.

…………………… is the area that contains controls for moving between pages and editing
pages.

6.2 Toolbox
The Toolbox is located in the left hand side of the window. It consists of drawing and editing
tools necessary to create objects for an illustration. Tools containing a small triangle in the
corner produce a Flyout.
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Did u know? Flyouts contain additional tools, or tool options.

The tools in the toolbox are discussed below:
Pick Tool: Selects objects or groups of objects. Once selected, you can use the Pick Tool of move,
stretch, scale, rotate and skew objects.
Shape Tool: Used to reshape objects by moving nodes, lines and control points.
Zoom Tool: Changes the current view of the drawing. You can also select magnification options
from the Property Bar in the Zoom mode.
Freehand Tool: Draws lines and curves. You can also use this tool to trace bitmaps.
Smart Drawing Tool: Converts the freehand strokes you draw to basic shapes and smoothed
curves.
Rectangle Tool: Draws rectangles and squares. Squares are created by using the Control key
while drawing.
Ellipse Tool: Draws ellipses and circles. Circles are created by holding down the Control key as
you draw.
Graph Paper Tool: Draws a collection of boxes that simulates a sheet of graph paper.
Perfect Shapes Tool: A collection of objects which you can add to your drawing. They include
such things as arrows, stars, talk bubbles, and flow chart symbols.
Text Tool: Adds either Artistic or Paragraph text to your drawing.
Interactive Blend Tool: The Blend Tool allows you to merger objects together through a series
of steps. The flyout gives access to several more interactive tools that are described on the
following pages.
Eyedropper Tool: The Eyedropper Tool allows you to select a color within an object, especially
a bitmap, and allows you to apply that color to another object. You can also capture the color for
a customized palette. The flyout gives access to the paint bucket that applies the color.
Outline Tool: Sets the outline style of an object or a line. This includes the line type, ends, color,
and weight. The flyout gives quick access to some changes.
Fill Tool: Assigns the fill style of any object. Fills are only visible on closed objects. The flyout
gives access to control dialogs for each type of fill.
Interactive Fill Tool: Allows you to apply Fountain fills (gradients) using the mouse. The flyout
gives access to the Mesh fill Tool.

Task Compare and contrast Freehand Tool and Smart Drawing Tool.

6.2.1 Property Bar
The Property Bar is located just under the Standard Toolbar. It is an interactive command center.
The options on the Property Bar change depending on the current task or command.
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To select the Property Bar follow the steps below1.

Select the Pick Tool.

2.

Place the cursor indicator on top of the purple rectangle and click. Small black handles
appear designating a selection.

3.

Select the text. Again, new options display for working with text.

Notes

Figure 6.3: Property Bar

Source: http://www.unleash.com/retlab/cd8lev1/chap03/

6.2.2 Dockers
Twenty-four functions of CorelDraw12 display in a dialog window called a Docker. Dockers are
placed into the interface or “docked” as are Tool Bars or the Property Bar. They are accessed by
clicking on the tabs at the right of the working window. Dockers can also float or be closed so
only the tabs show. Dockers replaced Roll-Ups from earlier version of DRAW. To access the
Dockers, go to the Windows menu ->Dockers.
Figure 6.4: Docker

Source: http://www.flyertutor.com/corel-draw-tutorials/flyer-tutor/fall-fest1.asp
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6.2.3 Status Bar
It shows the fill pattern, outline, location, movement and absolute coordinates of a selected
object. The Status Bar changes dynamically depending on the action.

!
Caution You can customize the Status Bar to show different kinds of information.

Figure 6.5: Customizing a Status bar

Source: http://www.unleash.com/retlab/cd8lev1/chap03/

6.2.4 Colour Palette
CorelDraw comes with 18 color systems and gives you the ability to create your own palette
too. The palette can be floated or parked. The type of palette can be changed with the Windows
menu, or the Color Palette Browser Docker. You may have several palettes open at once.
The main color palettes include HKS Colors, Trumatch Colors, Uniform Colors, Web Safe
Colors, and the complete Pantone Matching System including the system that was shipped with
CorelDraw. In addition, the Color Palette Browser Docker includes some specific color systems
such as human skin colors and natural color systems. Here is also where any custom palettes you
build will be stored.
Figure 6.6: Color Palette

Source: http://www.sulfurcreek.com/classes/CDclass/dr12Bch1.htm
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Notes When you hold down a chip on the color palette, a box with shades of that color
displays. By dragging to one of the shades of the first color, you can choose a shade of a
color quickly and apply it to a line or fill an object.
The following describes how to choose a colour from the default colour palette:
1.

To choose a fill colour for a selected object clicks a colour swatch.

2.

To choose an outline colour for a selected object right-click a colour swatch.

3.

To choose from different shades of a colour click and hold a colour swatch to display a
pop-up colour picker, and click a colour.

4.

To view more colours in the default colour palette click the scroll arrows at the top and
bottom of the colour palette.

6.2.5 Customizing the Workspace
You can create a custom workspace as per your requirements like customized color palettes or
toolbars.

6.2.6 Using Multiple Workspaces
A workspace specifies the arrangement of buttons and command bars when you open the
application. You can customize them as per need and also reset the current workspace to the
default settings.

6.2.7 To Reset the Current Workspace
Hold down F8, and start the application. A dialog box appears asking if you want to overwrite
the current workspace with the factory default. Click Yes. The application will start using the
default settings for the currently selected workspace. You will lose any workspace customisation
that you have done.

6.2.8 Customizing Toolbars
Options dialog helps us customize our toolbars,. All it takes is a click-drag action while holding
these keys:
z

Move a button/command Hold Alt while dragging to a new toolbar or menu.

z

Delete a button/command Hold Alt while dragging away from the toolbar or menu.

z

Copy a button/command Hold Ctrl+Alt while dragging to a different toolbar or menu.

z

Create a new toolbar Hold Ctrl+Alt while dragging from a toolbar or menu.

It’s important to press and hold the modifiers before you begin your mouse action.

6.2.9 To Add or Remove an Item on a Toolbar
Let us illustrate adding an item to a toolbar with an example:
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1.

In the workspace, use the custom Source and Target toolbars. Press and hold your Alt key
and click-drag any toolbar button from the Source toolbar to the Target toolbar as shown
in the figure 6.7 below.
Figure 6.7: Toolbar Customisation

Source: http://citysoftech.blogspot.in/2012/12/customize-coreldraw-graphics-suite-to.html

2.

Notice as you dragged the toolbar button an I-beam indicating the new button position
appeared on the Target toolbar and the button migrated from the Source toolbar.
Try the same operation using a different tool but press and hold Ctrl+Alt as the modifier
keys. Notice this time the button is copied to the Target toolbar.
Figure 6.8: Toolbar Customisation

Source: http://citysoftech.blogspot.in/2012/12/customize-coreldraw-graphics-suite-to.html

3.
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Hold Ctrl+Alt, click to reveal the contents of the File menu, and click-drag the New
command to the Target toolbar. Notice the command is copied to the Target toolbar as a
button instead of text.
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4.

Hold Ctrl+Alt and drag the Pick Tool button from the Source toolbar to an open space in
your document window (as shown below). Notice a new toolbar is instantly created.

Notes

Notes For more practice, copy other tools to your new toolbar. Notice the new toolbar is
automatically named New Toolbar 1 by default.
Figure 6.9: Toolbar Customisation

Source: http://citysoftech.blogspot.in/2012/12/customize-coreldraw-graphics-suite-to.html

5.

To change your new toolbar’s name, open the Options dialog (Ctrl+J), click Customisation
> Command Bars to view the Command Bars list, locate your new toolbar, click slowly
two times on the toolbar name, and type a new name (as shown below).
Figure 6.10: Toolbar Customisation

Source: http://citysoftech.blogspot.in/2012/12/customize-coreldraw-graphics-suite-to.html

6.

The workspace you’re using includes a third new toolbar. Place a check mark next to the
Precision Drawing toolbar and click OK to close the dialog. Notice this toolbar include
elements from various command bars demonstrating that you can mix and match elements
from any existing toolbar or menu.
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Figure 6.11: Toolbar Customisation

Source: http://citysoftech.blogspot.in/2012/12/customize-coreldraw-graphics-suite-to.html

6.2.10 Toolbar Items Arrangement
To arrange items on the toolbar follow the steps given below:
1.

Click on Tools menu ! Customisation.

2.

Click Commands.

3.

On the toolbar in the application window, drag the toolbar item to a new position. If you
want to move a toolbar item to another toolbar, drag the toolbar item from one toolbar to
the other.

6.2.11 Creating Custom Color Palettes
To create a custom color palette, follow the steps given below:
1.

Click on Window menu ! Color palettes ! Palette editor.

2.

Click on New palette.

3.

Give a filename.

4.

Click Save.

6.2.12 To Edit a Custom Color Palette
In order to edit the customized color palette, follow the steps given below:

130

1.

Click Window menu ! Color palettes ! Palette editor.

2.

Choose a palette from the list box.

3.

Modify the required colors.
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Self Assessment
Fill in the blanks:
6.

Tools containing a small triangle in the corner produce a ……………………

7.

…………………… Tool converts the freehand strokes you draw to basic shapes and
smoothed curves.

8.

The …………………… Tool allows you to merger objects together through a series of
steps.

9.

…………………… shows the fill pattern, outline, location, movement and absolute
coordinates of a selected object.

10.

…………………… dialog helps us customize our toolbars.

6.3 Menus in CorelDraw
It is similar to any of the standard menu bars you usually see in CorelDraw. It consists of file,
edit, view, layout, arrange, effects, bitmaps, text, table, tool, windows and help menu. Each of
these menus have further sub menus that defines its use and effect on your graphics.
Example: File menu may contain sub menus to open a new file, close a file, save a
file, etc.

6.3.1 File
This menu contains options related to a file. It can be accessed via the keyboard shortcut Alt+F.
The submenus of the file command includesNew: Creates a new drawing, represented by a blank Drawing page. If you already have a
drawing open, the new drawing opens over top current drawing. The new drawing uses the
same program settings that were in effect for the previous drawing.
New from Template: Open a New File Graphic Document with readymade designs.
Open: Opens the Open Drawing dialog box, which allows you to select a file which has been
created earlier. If you already have a drawing open, the drawing opens over to of the current
drawing.
Close: Closes the current drawing. If you’ve made any changes since you last saved your file,
CorelDraw prompts you to save the file before closing.
Save: Saves your drawing under the name displayed in the Title Bar. If you have not saved the
drawing yet, the Save Drawing dialog box appears, prompting you to enter a name.
Revert: Removes all changes to the active Graphic Document since you last saved it. Use this
command when you want to undo all changes you have made since you last saved the drawing
including turning, deleting or inserting pages, printing and or pasting object to the Clipboard.
Export: To copy the picture in the new format.
Steps to Export a Corel Draw drawing
1.

Select the drawing

2.

Click on file to Export
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3.

Type the name; select the format in which you want to save the file

4.

Select the drive or directory in which you want to save then click on Export

Print Preview: Opens the Print Preview Setup dialog box, which allows you to see how your
drawing will look before it is printed.
Print Setup: Opens the Print Setup dialog box which allows you to change the printer and
printer properties such as paper size.
Document Info: It is used to display the information of opened Graphic Document.
Example: File name, type, location, size, etc.
You can print and save this information for future reference.
Exit: Ends the current CorelDraw session. If you’ve made any changes since you last saved your
file, CorelDraw prompts you to save the file before exiting.

Task Discuss the use of Revert command.

6.3.2 Edit
Undo: Reverses the action you just performed. The name of the command depends on the action
you performed most recently.
Redo: Restore changes reversed by the Undo command. Redo becomes available immediately
after you click the Undo command.
Repeat: Repeats your last command or action, if possible. The name of the command depends on
the action you performed most recently.
Delete: Removes selected text, objects or nodes.
Duplicate: Adds a copy of the current selection to your drawing.
Clone: When we clone (duplicate) any object or text, the changes made on original (parent)
object like changing line thickness, filling color it effects on other (clone) object.
Select all: To select all the objects or text or Guidelines displayed on the current page.
Copy properties from: Opens the Copy Properties dialog box, which allows you to copy properties
from one object to another.

6.3.3 View
Simple Wireframe: Shows only outline of objects.
Wire frame: Hides fills and display monochrome bitmaps, extrusions, contours and intermediate
blend shapes, i.e. Objects display in skeleton form without fills or outlines.
Normal: Shows all fills, except Postscript, all objects, and high resolution bitmaps.
Full screen preview: To display your drawing in full size of the screen. You can also switch to the
preview screen by pressing F9.
Preview selected only: This command is similar to the full screen preview command but here
you have to select a drawing which you want to view in full size.
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Color palette: The color palette is the quickest way to add colors to an selected object. The color
palette is a tool bar that display a series of color.

Notes

Scrapbook: The scrap book is a small window which allows you to browse through the folder
that notes the collection of clipart, photos, 3D-models, and preset fills and outline as well as any
File Transfer Protocol (FTP)
Favourite fill and outlines: You can apply these fills and outlines to objects just by selecting the
object and double click on the fill or outline which you want to apply.
Roll-ups: Roll-up is a floating dialog box that contains a set of related CorelDraw controls.
Unlike the dialog Boxes, The Roll-ups remain on the screen after you apply the commands
contained by that roll-up.
Dockers: A Docker window is a dialog box that contains similar operations as most of the dialog
boxes for e.g. Checkboxes, list, etc.
Toolbars: A Toolbar is a group of buttons that provides quick access to a series of related commands.
Property Bar: The property bar will contain the overall drawing options such as the page size,
orientation if no object is currently selected and if Pick tool is in use.
Status bar: Status Bar is an on-screen display area that display various information about your
working environment, such as the colors used for fills and outlines, the position of your cursor,
and the type of object that appears in the drawing window.
Rulers: Ruler is a measuring tool which is displayed on the left side and along the top of the
Corel Draw application window. This ruler are very useful in changing the size and position of
the objects in your drawing .

6.3.4 Layout
Insert pages: open the insert page dialog box, which allows you to add blank pages. Pages can be
added either before or after the current page.
Delete pages: This command allows you to delete pages. When a page is deleted, all the object on
that page is also deleted.
Rename page: Opens the rename page dialog box, which allows you to change name of the
current page.
Go to page: Opens the Go to page dialog box, which allows you to move from one page to
another in the same document.
Page setup: Opens the options dialog box, which lets you set the page size, layout, orientation,
and more.

6.3.5 Arrange
The object can be rotated, moved, tilted, transformed and combined using this submenu.

6.3.6 Effects
Effects, contours and perspectives can be applied on objects via this option.

6.3.7 Bitmaps
Bitmaps menu set the effects of colour and texture bitmap object.
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6.3.8 Text
Text menus and set the display format of the text .

6.3.9 Tools
The Tools menu is used to display various menus and options associated with the object and
setting the document.

6.3.10 Window
This menu is useful when we open more than one document at once. Some of the menu under the
Window pull-down menu function set the display documents that, whether stratified (Cascade),
on the bottom row (Tile Horizontally), or adjacent (Tile Vertically).

6.3.11 Help
Last row this true pulldown menu that is most important is the menu is the Help menu. This
menu is used for find out how or understanding of a term in the program application.

Self Assessment
Fill in the blanks:
11.

A …………………… is a group of buttons that provides quick access to a series of related
commands.

12.

…………………… menu set the effects of colour and texture bitmap object.

13.

The …………………… menu is used to display various menus and options associated with
the object and setting the document.

14.

The object can be rotated, moved, tilted, transformed and combined using
‘……………………’ submenu.

15.

…………………… opens the options dialog box, which lets you set the page size, layout,
orientation, and more.

Case Study

Corel WebMaster

I

t is increasingly possible to produce professional websites
with the minimum of staff. One South African company
is using Corel products to advertise its expertise Shakari
Creations was founded in Sandton, near Johannesburg, in
1995. The company was initially established to create
multimedia presentations for local corporations including
staff training, corporate profiles and catalogue
demonstrations.

Contd...
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During the past few years, Shakari has established a service designing web pages. The
company has recently built sites for organisations such as Stratford Engineering,
Measuretronic and Saftronics, as well as hosting the finished products on their own server.

Notes

A number of Corel products are used in the creation of clients’ web pages including
CorelDRAW 8 and the WebMaster suite of applications. As a small business, Shakari
Creations competes against organisations with more staff and resources. Company founder,
Ludi Harmsen, explains the appeal of Corel products: “As a small business, I find that
Corel products give me the edge. Their ease of use, excellent documentation and
professional output ensures increased productivity.”
WebMaster contains a number of different applications, many of them scaled down versions
of current Corel products. These include art packages such as WEB.DRAW and
WEB.PhotoPaint, animation applications WEB.MOVE and WEB.WORLD, database program,
WEB.DATA, and a web page editor, WEB.DESIGNER.
Instead of using WebMaster’s built-in art packages, Ludi Harmsen creates the components
for client web pages with the more familiar CorelDraw 8. This standalone package offers
a number of Internet features including the ability to compose pages and export them as
HTML files.
First, images are created or manipulated within the program and then combined with text
and corporate logos. These images are then imported into other Corel packages to add
picture frames and transparencies. HTML pages containing these images and text are
generated using CorelDRAW’s “Publish to Internet” feature, a tool that also exports images
as GIF files for use on the Internet.
Next, material contained within the web pages that is not supported by standard web
browsers can be removed using the CorelDraw’s “Make HTML Compatible” feature.
Once the basic pages have been created they are imported into WEB.DESIGNER, a module
of the WebMaster suite, consisting of a WYSIWYG web page editor. This program allows
Shakari Creations to edit the web pages in the same format that would appear in a browser
window. In WEB.DESIGNER, hyperlinks to other parts of the site are produced and
embedded in the page. Metatags describing the content of each page are also created in
WEB.DESIGNER.
Finally, WEB.DESIGNER is used to upload the finished website onto Shakari’s server
where the site is hosted.
Harmsen has recently used this system to create Shakari Creations’ own website, which he
claims to have produced alone and within five hours. “It is simply astonishing at what can
be created for the Internet using CorelDraw and Web.Designer, and then just clicking a
couple of buttons,” says Harmsen.
By using a series of compatible applications, Shakari Creations have achieved their goal
of professional website design with only a small number of staff. Ludi Harmsen has noted
some obvious benefits. “Products created using these applications have ensured longterm relationships with our clients and many referrals.”
Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://www.computerweekly.com/feature/Case-Study-Corel-WebMaster
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6.4 Summary
z

The end product of CorelDraw is referred to as a drawing. A drawing may consist of a line,
text, curve, symbol or image which are called object.

z

The basic screen where the user works upon with CorelDraw is the interface screen. The
Toolbox is located in the left hand side of the window. It consists of drawing and editing
tools necessary to create objects for an illustration.

z

Tools containing a small triangle in the corner produce a Flyout.

z

The Property Bar is located just under the Standard Toolbar. It is an interactive command
center.

z

Twenty-four functions of CorelDraw12 display in a dialog window called a Docker.

z

Status Bar shows the fill pattern, outline, location, movement and absolute coordinates of
a selected object.

z

Menus in coreldraw consists of file, edit, view, layout, arrange, effects, bitmaps, text, table,
tool, windows and help menu.

6.5 Keywords
Artistic Text: The text on which special effects such as shadows can be applied is called artistic
text.
Bitmap: Bitmap is the Image created from a grid of dots (popularly known as pixels in computer
terminology).
Docker Window/Palette: It is the window which contains available commands and settings
relevant to a specific tool or task.
Drawing: It refers to the work created with Corel Draw application like artwork, logo, banner,
poster, newsletter, etc.
Flyout: It is a button that opens a group of related tools or menu items.
Object: Any single element used in a drawing like line, curve, shape, symbol, etc. is known as an
object.
Paragraph Text: It is a type of text to which formatting options can be applied and also can be
edited in large blocks.
Vector Graphic: It refers to image which is generated from some mathematical information like
position, length, direction, etc.

6.6 Review Questions
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1.

What is CorelDraw? Discuss the steps used to install CorelDraw on your system.

2.

Explain the various components of CorelDraw Interface.

3.

Describe the use of various tools in the toolbox.

4.

What are dockers? Illustrate how to access dockers.

5.

Make distinction between status bar and property bar.

6.

Illustrate with example the steps used in adding or removing an Item on a Toolbar
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7.

What are menus? Discuss various submenus of the file command.

8.

Discuss the concept of customizing toolbars.

9.

Illustrate the use of Interactive Blend Tool with example.

10.

Describe how to choose a colour from the default colour palette.

Notes

Answers: Self Assessment
1.

Objects

2.

Template

3.

Tool Box

4.

navigator button

5.

Document Navigator

6.

Flyout

7.

Smart Drawing

8.

Blend

9.

Status bar

10.

Options

11.

Toolbar

12.

Bitmaps

13.

Tools

14.

Arrange

15.

Page setup

6.7 Further Readings

Books

Linnea Dayton, Shane Hunt and Sharon Steuer, The CorelDraw Wow!
Steve Bain, Coreldraw 12: The Official Guide

Online links

http://www.sulfurcreek.com/classes/CDclass/dr12Bch1.htm http://
knowledgeoverflow.com/corel-draw-tutorial-for-beginners/
http://tools.devshed.com/c/a/Web-Development/CorelDraw-introduction/
http://www.indg.in/primary-education/coraldraw-1/Introduction%20
CorelDRAW%20-%20its%20tools.pdf/
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Objectives
After studying this unit, you will be able to:
z

Understand drawing and selecting in CorelDraw

z

Explain working with text and images in CorelDraw

z

Work with the page layout and background

z

Discuss the concepts like layers and gradient in CorelDraw

Introduction
CorelDraw Graphics Suite is a software package of design tools designed to run on Windows
operating systems. The main application in this large package of tools is CorelDraw, which is
used for vector designs and layouts. Its versatile and helps you creatively and professionally
express ideas for any media. Corel’s mantra is, “If you can dream it, you can design it”

7.1 Drawing and Selection
Even if you use a graphics tablet and stylus, you’re still drawing freehand, and using a mouse
introduces even less precision when it comes to vector drawing. Fortunately, the Smart Drawing
tool takes the guesswork out of drawing polygonal and rounded objects—in a nutshell, you
sketch an approximation of what you intend, tune the options for the Smart Drawing tool a
little, and in a jiffy you have a precise object of the proportions you need.
Pictured here on the toolbox, the Smart Drawing tool instantly translates rough drawings into
shapes you’d usually consider drawing with the Rectangle tool or Ellipse tool—or with other
tools that require more effort and skill.
Figure 7.1: Smart Drawing Tool

Source: http://my.safaribooksonline.com/book/-/9780071745178/creating-basic-shapes-applyingtransformations/ch08lev1sec1

Its located in the toolbox between the curve tools and the rectangle tools or you can press the S
hotkey for speedy selection.
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As shown below we can convert a free hand drawing to a perfectly shaped one using this tool.
Figure 7.2: Free Hand Drawing

Source: http://www.epiloglaser.com/tl_smartdrawing.htm

Figure 7.3: Final Image after the Use of Smart Drawing Tool

Source: http://www.epiloglaser.com/tl_smartdrawing.htm
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The Smart Drawing tool will recognize a variety of different shapes, including all of the ones
listed in the figure below. If your drawing appears to be close to any of these shapes, they will
be adjusted to be perfect images.

Notes

Figure 7.4: List of Shapes Recognized by the Smart Drawing Tool

Source: http://www.epiloglaser.com/tl_smartdrawing.htm

7.1.1 Drawing Tools
Shape Recognition
You can use the Smart drawing tool to draw freehand strokes that can be recognized and converted
to basic shapes. Rectangles and ellipses are translated to native CorelDraw objects; trapezoids
and parallelograms are translated to Perfect Shapes objects; lines, triangles, squares, diamonds,
circles, and arrows are translated to curve objects. If an object is not converted to a shape, it is
smoothed. Objects and curves drawn with shape recognition are editable. You can set the level
at which CorelDraw recognizes shapes and converts them to objects. You can also specify the
amount of smoothing applied to curves.

Smart Smoothing
Convert freehand strokes to basic shapes or smoothed curves. The shortcut key for the same is
Shift + S. The values are set from Lowest
(less smoothing applied) to Highest (more smoothing applied), with Medium as the default.
Some of the shapes recognized by the Smart drawing tool are:
Ovals and Circles: Translate as native ellipse objects.
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Boxes and Squares: Translate as native rectangle objects.
Lines: Translate as curve objects (either straight or curved depending on how they are sketched).
Triangles: Translate as curved objects or as perfect triangle shapes (either isosceles or equilateral).
Diamond: A sketched shape resembling a skewed square will translate into a perfect diamond
shape.
Parallelogram: A roughly sketched four-sided shape whose opposite sides are parallel and
equal will translate into a perfect parallelogram shape.
Trapezoid: A roughly sketched four-sided shape that has two parallel sides and two non-parallel
sides will translate into a perfect trapezoid shape.
Arrows: Two roughly sketched open paths that resemble an arrow pointing will translate into
a Perfect Shape arrow.
Figure 7.5: The Various Shaped Converted by the Smart Drawing Tool

Source: http://www.orchardoo.com/rev/rev103.htm

7.1.2 Drawing Power of the New Smart Drawing Tool
The steps to be followed to create a perfect drawing from a free hand sketch are as follows:
1.
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To use the Smart Drawing tool, click on the tool in the menu bar on the left side of your
screen (circled in red at the right).
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Figure 7.6: Step 1

Notes

Source: http://www.orchardoo.com/rev/rev103.htm

2.

With the Smart Drawing tool selected, you can draw any shape you want. The tool will
change the shape to one of the objects it recognizes.
In the image to the right you can see that when we drew a circle, the tool smoothed the
edges into a perfect circle.
Figure 7.7: Step 2

Source: http://www.orchardoo.com/rev/rev103.htm
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3.

If you draw an object that the tool does not recognize, it will create a series of lines and
curves from your drawing.
The new drawing will be a smoothly drawn form of your image.
Figure 7.8: Step 3

Source: http://www.orchardoo.com/rev/rev103.htm

4.

One of the tools you can use to adjust the Smart Drawing tool is the Shape Recognition
Level.
Using this tool, you can adjust how strictly the Smart Drawing tool will associate shapes
to your drawing.
Figure 7.9: Step 4

Source: http://www.orchardoo.com/rev/rev103.htm
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5.

In the image below, you will see three different drawings.

Notes

Image A is the original drawing.
Image B shows how the Smart Drawing tool changes the image using the lowest level of
shape recognition. The resulting shape is very similar to the object we drew.
In Image C, you can see how the highest level of shape recognition changed the same
image into a perfect triangle.
You’ll have to play with these settings and see which level works best for your drawing.
Figure 7.10: Step 5

Source: http://www.orchardoo.com/rev/rev103.htm

7.1.3 Perfect Shapes and Glyph Nodes
Using the Perfect Shapes collection, you can draw predefined shapes. Certain shapes, specifically
basic shapes, arrow shapes, banner shapes, and call-out shapes contain glyphs. You can drag a
glyph to modify the appearance of a shape.
Using the Shape tool, you can drag a glyph to alter a shape and you can add text to the inside or
outside of the shape.
Example: You might want to put a label inside a flowchart symbol or a call-out.

To Draw a Predefined Shape
1.

In the toolbox, click one of the following tools:


Basic shapes



Arrows shapes



Flowchart shapes



Banner shapes



Call-out shapes
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2.

Open the Perfect Shapes picker on the property bar, and click a shape.

3.

Drag in the drawing window until the shape is the size you want.

To Modify a Predefined Shape
1.

Select a shape that contains a glyph

2.

Drag a glyph until you achieve the shape you want.

Did u know? The right-angle, heart, lightning bolt, explosion, and flowchart shapes do not
contain glyphs.

To Add Text to a Predefined Shape
1.

Click the Text tool

.

2.

Position the cursor inside the shape’s outline until it changes to a text cursor

3.

Type inside the shape, choose a font, and format the text.

.

7.1.4 Perfect Shape with the Smart Drawing Tool
By using the Basic Shapes tool, users have the ability to draw basic shapes.
1.

In order to do so, choose a shape from the Perfect Shapes picker on the property bar.

2.

Then, drag in the drawing window until the shape is the desired size.
Figure 7.11: Step 1 to draw Perfect Shape with the Smart Drawing Tool

Source: http://grok.lsu.edu/article.aspx?articleid=10464

3.

In order to adjust the basic shape, drag its glyph.
Figure 7.12: Step 2 to draw Perfect Shape with the Smart Drawing Tool

Source: http://grok.lsu.edu/article.aspx?articleid=10464
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7.1.5 Smarter Drawing Tool Functions

Notes

Smart Drawing tool has a very important feature – delay time interval. It is the time between the
moment you finishing sketching a shape and the moment CorelDraw determines a recognizable
shape. You can reduce this delay time to sketch several separate lines or shapes in succession and
allowing CorelDraw to recognize them as a single compound path.
Example: If you finish sketching a complete shape, then begin sketching a second shape
within the time delay interval, the two shapes will be recognized as a single object.
Figure 7.13: Shape 3 Created by Time Delay from Shape 1 and 2

Source: http://logonose.blogspot.in/2011/05/create-aqua-logo-in-coreldraw.html

Double-click the Smart Drawing tool button in the toolbox to open the Options dialog box in
order to access the option that controls time delay. The Drawing Assistance Delay slider can be
set between 0 and 2 seconds. The higher you set the delay time, the more time you’ll have to
keep drawing and so a lower delay time will make your sketching sessions more productive.
To correct your sketched shapes on the fly to improve the accuracy of your drawing hold Shift as
the modifier key to interactively erase your drawing path in reverse. As you hold the Shift key,
the Smart Drawing tool cursor will invert interactively to erase your sketched lines. Releasing
the Shift key enables you to resume your sketching operation.

7.1.6 Pick Tool
Pick Tool is one of the most important tools used in Corel Draw for selection and editing of the
graphic. It lets you select and size, skew, and rotate objects.
1.

Open Corel DRAW. Select Rectangle Tool from the toolbox (marked with dark circle).
Figure 7.14: Selecting Rectangle Tool

Source: http://www.insidegraphics.com/corel_basics/corel_pick_tool.asp
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2.

Draw rectangle. Once you draw it, it is selected by default.
Figure 7.15: Drawing Rectangle Tool

Source: http://www.insidegraphics.com/corel_basics/corel_pick_tool.asp

3.

Now select Pick Tool (marked with dark circle).
Figure 7.16: Pick Tool

Source: http://www.insidegraphics.com/corel_basics/corel_pick_tool.asp

4.

Click anywhere outside the rectangle. It will get deselected.
Figure 7.17: Rectangle Deselected

Source: http://www.insidegraphics.com/corel_basics/corel_pick_tool.asp
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5.

Click on the like of the rectangle. It will get selected.

Notes

Figure 7.18: Rectangle Selected

Source: http://www.insidegraphics.com/corel_basics/corel_pick_tool.asp

6.

Keep the pick tool within rectangle it will change the cursor into move icon (marked with
green circle).
Figure 7.19: Move Icon

Source: http://www.insidegraphics.com/corel_basics/corel_pick_tool.asp

7.

Press and drag the mouse button to move the rectangle: Pick tool has various properties.
To view them, right click on the Pick Tool to open a pop-up menu. Choose Properties. You
can control personal choices for the Pick Tool from this screen. Choose Treat All Objects as
Filled for easy selection of objects with no fill. If you are just learning CorelDraw, it is
advised to leave the other features as they are. Tutorials and the manuals assume the
default settings are in place.
Figure 7.20: Pick Tool Properties

Source: http://www.webreference.com/graphics/corel101/4/2.html
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Self Assessment
Fill in the blanks:
1.

Using the …………………… tool, you can drag a glyph to alter a shape and you can add
text to the inside or outside of the shape.

2.

…………………… is the time between the moment you finishing sketching a shape and
the moment CorelDraw determines a recognizable shape.

3.

…………………… Tool lets you select and size, skew, and rotate objects.

7.2 Working with Text
Working with text in Corel Draw is really interesting experience because you can create and edit
the text in so many ways. Steps to start working with text are given below:
1.

Open Corel DRAW. Select Text Tool (marked with green circle). The icon is A (Capital A).
Figure 7.21: Text Tool

Source: http://www.insidegraphics.com/corel_basics/corel_text_tool.asp

2.

Click the cursor on the page and type the text. It may be very small so stretch it by pulling
its corner point using Pick Tool.
Figure 7.22: Writing the Text with Text Tool

Source: http://www.insidegraphics.com/corel_basics/corel_text_tool.asp

3.

Move it anywhere using Pick Tool again.

4.

Pull other points using pick Tool, to stretch the text horizontally and vertically
Figure 7.23: Horizontal Stretch

Source: http://www.insidegraphics.com/corel_basics/corel_text_tool.asp
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Figure 7.24: Vertical Stretch

Notes

Source: http://www.insidegraphics.com/corel_basics/corel_text_tool.asp

5.

Filling text with color is just a click away. Keep the text selected. Click on any color from
the color palette at right hand side. The text is filled with the selected color.
Figure 7.25: Add Color to Text

Source: http://www.insidegraphics.com/corel_basics/corel_text_tool.asp

6.

If you click on the cross icon in the color palette, there will be no color in the text.

7.

You can apply outline to the text in Corel DRAW. Different types of effects can be created
using outline. Click the cursor on the page and type the text. Stretch it to bigger size by
pulling corner point. Keep it selected. We have removed the color from the text.
Figure 7.26: Outline Text

Source: http://www.insidegraphics.com/corel_basics/corel_text_tool.asp

8.

Now right click on any color in the color palette.
Figure 7.27: Adding Color to Outline of the Text

Source: http://www.insidegraphics.com/corel_basics/corel_text_tool.asp

9.

This will apply the outline to the text of the same color you have right clicked.

10.

If you Right click on the cross icon in the color palette, there will be no outline to the text.

11.

Let us try to change outline thickness of the text. It creates astonishing effects. Keep the text
selected.
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12.

Press Outline Tool. In the fly out menu click on 2 point outline (Thin). The outline is
thicker than the default. Try different types of available thickness.
Figure 7.28: Change Thickness of the Text

Source: http://www.insidegraphics.com/corel_basics/corel_text_tool.asp

Task Make distinction between pick tool and text tool.

7.2.1 Etching and Cutting Text
Keep text solid black if you want to etch it. If you want to cut out the outline of the text (cut out
a letter) turn off the fill (black) and turn on a Red Hairline outline.
Figure 7.29: Outline Tool

Source: http://www.webreference.com/graphics/corel101/6/2.html

To outline in red for cutting: select text, click on Outline Tool (on the left side third from
bottom), click on Outline Tool that pops up, a box pops up inside the box select outline width of
Hairline and make the outline coloured.
Now you need to remove the black fill so it doesn’t etch to do that, make sure text is selected,
then click on the Fill tool a bar will pop up with an X click the X to remove the fill.
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Self Assessment
Fill in the blanks:
4.

Keep …………………… solid black if you want to etch it.

5.

If you want to cut out the …………………… of the text turn off the fill (black) and turn on
a Red Hairline outline.

7.3 Working with Images
With CorelDraw we can create, select, edit and fill effects to our pictures with ease.
Let us first understand bitmaps. Bitmaps are images that store a location and description of
pixels. Pixels are nothing but dots. So rather than defining images in terms of curves and lines,
bitmap images are defined as dots.
Example: The steps to follow to convert a picture into gray scale are given below:
z

Open CorelDraw and open the image you wish to convert.

z

Click “Bitmap” followed by “Convert to Bitmap.” A menu will pop up. Select “96 dpi” for
the resolution and “Gray scale” for the color. Check that “Transparent Background” is on.
Click “OK.”

z

Click “Effects,” then “Adjust.” Adjust the contrast of the image to between 30 and 45. Click
“Brightness/Contrast/Intensity.”

z

Click “Bitmap,” “Color Transform,” then “Halftone.” You will see two versions of the
image, the original and the halftone.

z

Click “Preview.” Use the “Max Dot Radius” slider to adjust the halftone effect as desired.
Click “Preview” every time you adjust the slider.

z

Click “Bitmap” and “Convert to Bitmap” again. Change the color of the image to 24 bit.
You can now add color to the image.

z

Click “Save” when you are done editing the image.
Figure 7.30: Original Image

Source: http://www.gimp.org/tutorials/Color2BW/
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Figure 7.31: Gray Scale Image

Source: http://www.gimp.org/tutorials/Color2BW/

Notes Bitmap images can also have different numbers of colors. Those include black and
white images, 8-bit grayscale (256 shades of gray), and 8-bit paletted (256 colors). Other
color modes exist as well, but these are sufficient to use with most bitmap images that you
will work within CorelDRAW.

Self Assessment
Fill in the blanks:
6.

Bitmaps are images that store a location and description of ……………………

7.

…………………… images can also have different numbers of colors.

7.4 Page Layout and Background
You can specify settings for the size, orientation, and layout style of the page. The options you
choose when specifying the page layout can be used as a default for all new drawings you create.
You can also adjust the page size and orientation settings to match the standard paper settings
for printing.

7.4.1 Changing the Page Size
There are two options for specifying a page size: choosing a preset page size and creating your
own.
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Figure 7.32: Page Layout

Notes

Source: http://www.webreference.com/graphics/corel101/2/index.html

You can choose from many preset page sizes, ranging from legal-size paper and envelopes to
posters and Web pages. If a preset page size does not meet your needs, you can create a custom
page size by specifying a drawing’s dimensions.
Figure 7.33: Page Size

Source: http://www.webreference.com/graphics/corel101/2/index.html

You can save custom page sizes as presets for later use, and you can delete any custom preset
page sizes that you no longer need.
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7.4.2 Changing Page Orientation
The orientation of the page can be landscape or portrait. In landscape orientation, the drawing’s
width is greater than its height, and in portrait orientation, the drawing’s height is greater than
its width. Any pages you add to a drawing project will have the current orientation; however,
you can give a different orientation to single pages in a drawing project.
Figure 7.34: Page Orientation

Source: http://www.webreference.com/graphics/corel101/2/index.html

7.4.3 Working with Layout
When you use the default layout style (Full Page), each page in a document is considered a single
page and prints on one sheet. You can choose layout styles for multipage publications, such as
booklets and brochures. The multipage layout styles — Book, Booklet, Tent Card, Side-fold
Card, Top-fold Card, and Tri-fold Brochure split the page size into two or more equal parts. Each
part is considered a separate page. The advantage of working with separate parts is that you can
edit each page in upright orientation, and in sequential order in the drawing window, regardless
of the layout required to print your document. When you are ready to print, the application
automatically arranges the pages in the order required for printing and binding.

7.4.4 Creating the Background
Let us show how to create a background for a CorelDraw based poster:
1.

Create a new document and set the page size, Portrait and primary color mode and
resolution

2.

Double click the Rectangle tool to add a page frame and give it a Black fill.

3.

Select the Interactive fill tool and click and drag it on the page.

4.

Next, from the Interactive Property bar, select Radial.

5.

Select the Last Fill Color on the Interactive Property bar (it will be white) and change it to
Grass Green.

Did u know? If you hold down the SHIFT key, while selecting a color in the color palette,
you will see the color name.
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6.

Position the Last Fill Color control handle, centered in the top 1/3 of the page and the
Black control handle in the center of the page.

Notes

Figure 7.35: The Background Created

Source: http://corel.force.com/pinnacle/articles/en_US/Master_Article/Poster-Design-inCorelDRAW?
retURL=%2Fpinnacle%2Fapex%2FpselectProduct%3Flang%3Dit&popup=true

7.4.5 Importing Images
We can easily import images into our CorelDraw document by following the simple steps
below:
1.

Launch CorelDraw

2.

Click on the “New Document” icon. A “Create a New Document” window appears.

3.

Click the “OK” button on the bottom of window. A transparent canvas will appear on the
background of the application.

4.

Click on the “File” menu item.

5.

Click “Import ...” to open up an Explorer window.
Figure 7.36: Import Option

Source: http://www.webreference.com/graphics/corel101/9/index.html
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6.

Navigate to the directory containing the photo you want to import

7.

Click on the desired photo file. The name of the file will appear in the “Filename” text box.

8.

Click on the “Import” button.

9.

Size the photo on the document by dragging with your left mouse button. The photo is
now imported on the canvas.
Figure 7.37: The Figure Added to the Background

Source: http://corel.force.com/pinnacle/articles/en_US/Master_Article/Poster-Design-inCorelDRAW?
retURL=%2Fpinnacle%2Fapex%2FpselectProduct%3Flang%3Dit&popup=true

Did u know? Not all importing options are available for all file formats.

7.4.6 Creating Text
What is a poster without some text to explain it. We now add text to our poster through the steps
below:
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1.

Select the Text tool and click the upper left corner and type the text.

2.

Right click on the text and select Object Properties.

3.

In the Object Properties docker set the Font, color, Point size, Center Justified and select
Stylistic Set 7.

4.

On the Interactive Property bar, rotate the text 30 degrees counter clockwise.
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Figure 7.38: Text Added to the Background

Notes

Source: http://corel.force.com/pinnacle/articles/en_US/Master_Article/Poster-Design-inCorelDRAW?
retURL=%2Fpinnacle%2Fapex%2FpselectProduct%3Flang%3Dit&popup=true

The final image created looks as in the picture below:
Figure 7.39: The Final Poster

Source: http://corel.force.com/pinnacle/articles/en_US/Master_Article/Poster-Design-inCorelDRAW?
retURL=%2Fpinnacle%2Fapex%2FpselectProduct%3Flang%3Dit&popup=true
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7.4.7 Creating the Circles
Like other shapes we can create circles in our CorelDraw document. To do this, we follow the
steps below:
1.

Open a blank drawing space in CorelDraw and select the “Ellipse Tool” (circle shape)
from the toolbox toolbar.

2.

Hold down the “Ctrl” key while left-clicking and dragging to create a circle shape. When
you have created the desired size of your shape, release the mouse key. This draws a
perfect circle. If you would rather draw an offset sphere, such as the shape of Planet Earth,
then drag the shape without holding down the “Ctrl” key.

3.

Select the “Fill Tool” from the Toolbox and click “Fountain Fill.”

4.

In the pop-up box that appears for “Fountain Fill,” click the “Type” drop-down menu and
select “Radial.”

5.

In the “Horizontal” percentage box, type “-14” and in the “Vertical” percentage box type
“14.”

6.

In the “Color blend” section of the “Fountain Fill” pop-up, select the color red in the
“From:” drop-down palette, and leave the color white in the “To:” drop-down palette.

7.

Click “OK.” This creates your colorful sphere with depth.
Figure 7.40: The Circle Created

Source: http://www.insidegraphics.com/corel_basics/corel_draw_window.asp
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7.4.8 Importing Text
In case we need to import text from an external source, we can do that easily using the steps
below:
1.

Using the Text tool, position the cursor in the text frame where you want to import the
text.

!
Caution If you do not have a text frame in the document, skip step 1 and proceed to step 2.

2.

Click File Import.

3.

Choose the drive and folder where the file is stored.

4.

Click the filename.

5.

Click Import.

6.

In the Importing/Pasting text dialog box, choose one of the following options:

7.



Maintain fonts and formatting



Maintain formatting only



Discard fonts and formatting

Do one of the following:


Position the import cursor in the drawing page, and click.



Click and drag on the drawing page to define the size of the text frame.



Press the Spacebar to place the imported text in the default location.
Figure 7.41: Importing Text

Source: http://coreldraw.com/forums/t/15212.aspx
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If you want to apply CMYK black to the imported black text, enable the Force CMYK black
check box. This check box is available when you choose an option that maintains text formatting.

Self Assessment
Fill in the blanks:
8.

If a preset page size does not meet your needs, you can create a …………………… page size
by specifying a drawing’s dimensions.

9.

In …………………… orientation, the drawing’s width is greater than its height, and in
portrait orientation, the drawing’s height is greater than its width.

7.5 Layers
Layers provide a very effective way to organize the objects you create with CorelDraw. You can
reduce your work time using them and make it easier to handle the job at hand, and increase the
accuracy level of your designs.

7.5.1 Working with Layers in CorelDraw
We have multiple options while working with layers. Some of them are discussed below:

Create a Layer
To create a layer:
1.

Click Tools % Object manager.

2.

Click the flyout button, and click New layer.

To create a master layer:
1.

Click Tools % Object manager.

2.

Click the flyout button, and click New master layer

To use a layer in the drawing, you must first make the layer active. In the Object manager
docker, the active layer is highlighted in red. When you start a drawing, the default layer (Layer
1) is the active layer. When you create a master layer, it moves to the master page.

Delete a Layer
To delete a layer:
1.

Click Tools % Object manager.

2.

Click the name of a layer.

3.

Click the flyout button, and click Delete layer.

!
Caution When you delete a layer, you also delete all the objects on it. To keep an object on
the layer you’re deleting, move it to a different layer first. You can delete any unlocked
layer except the three default layers of the master page (Grid, Guides and Desktop).
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Self Assessment
Fill in the blanks:
10.

…………………… provide a very effective way to organize the objects you create with
CorelDraw.

11.

When you delete a layer, you also delete all the …………………… on it.

12.

When you create a master layer, it moves to the …………………… page.

7.6 Gradients
Gradients are also called fountain fills in CorelDraw. They can fill objects with a smooth transition
between two (or more) colors, and they come in various styles. Many commercial pieces of
artwork are created today that imitate the traditional airbrush (popular in the mid–20th century)
by using fountain fills.
Figure 7.42: Fountain Fill

Source: http://www.webreference.com/graphics/corel101/7/3.html

7.6.1 Choose Fill Type
We can chose different fill types depending upon the requirement. They are illustrated below:

Linear Fountain Fills
Linear fountain fills blend color from edge to edge. The samples to the left show a linear fill
from medium green to a light green. The lower sample shows a 45 degree rotation of the fill.
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Figure 7.43: Linear Fountain Fill

Source: http://www.webreference.com/graphics/corel101/7/3.html

Radial Fountain Fills
Radial fountain fills blend color in a circular pattern. You can create instant 3D spheres with a
couple of steps with radial fills. In the illustration to the left, the upper circle is filled with default
settings. The lower circle has the center point adjusted, the fill blend moved towards the lighter
color and a pad of solid edge color added to it.
Figure 7.44: Radial Fountain Fill

Source: http://www.webreference.com/graphics/corel101/7/3.html
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Conical Fountain Fills
Conical fountain fills create a cone like appearance with the conical point appearing higher than
the edges. In the illustration to the left, the top sample is filled with default conical fill settings.
The bottom sample has had the color midpoint, the center offset and the fountain angle adjusted.
Figure 7.45: Conical Fountain Fill

Source: http://www.webreference.com/graphics/corel101/7/3.html

Square Fountain Fills
Square fountain fills apply color blends in a square pattern. In the sample to the left, the top text
is set with default values. The lower sample fill has adjusted center point, color midpoint, angle
and color edge padding.
Figure 7.46: Square Fountain Fill

Source: http://www.webreference.com/graphics/corel101/7/3.html
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7.6.2 Choose Your Color
Fountain fills really start to get exciting when you add more colors to the blending mix. In the
sample to the left, a simple linear fill comes to life with the addition of two complementary
colors. The lower sample has been further enhanced by changing the angle of the fill and
creating a solid color edge padding.
Figure 7.47: Adding Color

Source: http://www.webreference.com/graphics/corel101/7/3.html

You can have as many colors as you want in your picture.
Example: To apply a two-color fountain fill follow the steps given below:
1.

Select an object.

2.

In the toolbox, click the Interactive fill tool.

3.

Choose a fountain fill from the Fill type list box on the property bar.

4.

Open the Fill dropdown picker on the property bar, and click a color.

5.

Open the Last fill picker on the property bar, and click a color.

6.

Specify the settings you want.

Task Fill a pentagon with various color blends using fountain fill.

7.6.3 Set Fill Angle, Centre Point and Edge Pad
Angle option affects the direction of the fill but it’s not available for Radial. Edge Pad affects the
smooth mixing of two color and continuous gradation. Let us explain this through an example:
1.
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Open Corel DRAW. Draw rectangle. Keep it selected.
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Figure 7.48: Drawing a Rectangle

Notes

Source: http://www.insidegraphics.com/corel_basics/corel_fountain_angle.asp

2.

Click “Fountain Fill Dialog” from Fill Tool. Select “Square” fill type and also select Red
color for “From” and Yellow for “To” under color blend. Keep midpoint value 50.
Figure 7.49: Coloring the Rectangle

Source: http://www.insidegraphics.com/corel_basics/corel_fountain_angle.asp

3.

In the option, change angle to 45.
Figure 7.50: Change Angle Option

Source: http://www.insidegraphics.com/corel_basics/corel_fountain_angle.asp
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4.

You can observe change in the fill. It rotates.
Figure 7.51: Rectangle Rotates

Source: http://www.insidegraphics.com/corel_basics/corel_fountain_angle.asp

5.

Try Linear and Conical types with different angle values.

6.

Go back to the first step where we have plain rectangle. Select “Linear” fill type and also
select Red color for “From” and Yellow for “To” under color blend. Keep midpoint value
50. Keep default angle value 0.
Figure 7.52: Rectangle with Midpoint Value 50

Source: http://www.insidegraphics.com/corel_basics/corel_fountain_angle.asp

7.

In the option, change Edge Pad to 49 which is the maximum value.
Figure 7.53: Rectangle with Edge Pad Value 49

Source: http://www.insidegraphics.com/corel_basics/corel_fountain_angle.asp
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Notes

You get two distinct colors, Red and Yellow in the fill.
Figure 7.54: Final Image

Source: http://www.insidegraphics.com/corel_basics/corel_fountain_angle.asp

Notes As you go on decreasing the value, you get smooth gradation. At 0, you get the
uniform fill of the two properly blend colors. Please do not change any other settings.

Self Assessment
Fill in the blanks:
13.

…………………… are also called fountain fills in CorelDraw.

14.

…………………… fountain fills blend color in a circular pattern.

15.

…………………… fountain fills apply color blends in a square pattern.

Case Study

CorelDRAW makes Quilting Easy

A

CorelDRAW not only saves me a lot of time, Barbara Webster lives on a 30-acre
mountain farm in the Blue Ridge Mountains in western North Carolina with her
husband and two dogs. For many years she worked as a graphic designer in an
office, creating brochures and other publications using AdobePageMaker.
After she moved to the mountains from Charlotte, NC in 1994, she decided to start making
quilts. She obviously had a talent for it – her first quilt won Best First Quilt in the Asheville
Quilt Show. This event launched her new career as founder and principal owner of quilt
designing company Starforest Quilts. “In the early days you could only use photographic
images on your quilts by using heat-transfer methods. It wasn’t a very rewarding
process – you couldn’t really print the images on natural fabrics, the image had a rubbery
texture and the quilts were not washable. I also found out I was allergic to the fumes,” says
Barbara with a sigh.
Contd...
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The combination of new wide-format, specialized printers from companies like Mimaki
and the rapid advancement of computer processing power made it possible for quilt
designers like Barbara Webster to print high-resolution photographic images in vivid
color on 100% cotton fabric.
“I remember casually watching somebody over the shoulder as they were playing with
CorelDRAW a few years ago,” says Barbara. “They inserted photos into different shapes,
like squares and triangles, and flipped them around and manipulated them with such
remarkable ease. I stopped dead in my tracks and I knew that this would enable me to
create exactly the quilts I could see inside my head.”
Barbara bought a copy of CorelDRAW Graphics Suite the next day and started to create her
own quilt designs immediately. She typically starts by taking photos of nature scenes
with her 5 mega-pixel digital camera Nikon Coolpix 5700. After importing the image files
into CorelDRAW, she starts to place the images in different patterns to see if she can come
up with an interesting composition.”
DRAW has some amazing features I use every day. They save me hours, she explains over
the phone. The first one is PowerClip, I just love how easy it is to insert an image into a
shape and position it exactly where I want. Another feature is Snap To Object. I could try
to line up all the hundreds of shapes in my quilt designs by hand, but it would take forever
and it wouldn’t be nearly as accurate.
Some quilt designers use special quilt-making software like Electric Quilter and Quilt Pro,
but according to Barbara Webster, many professional quilt designers use CorelDRAW.
“There’s no comparison in my mind,” says Barbara.”You can’t really use photos in those
other applications. The preview window is tiny, making it very hard to get an idea of what
the final quilt will look like. They’re just not very user-friendly if you want to use photos.
The only advantage is that they calculate yardage automatically, but I don’t really need
that feature anyway. CorelDRAW not only saves me a lot of time, it actually helps me
come up with the designs. It’s like having a design partner.”
Once she has created her design in CorelDRAW, she exports her files as 300 dpi TIFFs and
burns them on a CD. The CD is then sent to a friend who owns a large format Mimaki inkjet printer. This specialty printer is designed to handle thicker fabrics in wide formats –she
can print images up to 55" wide and 3 yards long! Says Barbara: “You can actually print
longer than 3 yards. We have discovered, however, that 3 yards is all that will fit reasonably
well into the steamer; so we limit the runs to 3 yards.”
“I prefer to use images I’ve taken myself, because I really need high-quality, high resolution
images in order to get a good result,” says Barbara. “Every single shape in my quilts
contains a 300 dpi TIFF image. My quilt ‘Spring in the Smokies’ for instance, consists of
over 500 triangles. The final DRAW file was over 1.8 GB in size – I had to buy a new DVDburner to back it up!”
Barbara Webster fits the profile of a dedicated quilter pretty well. (According to a 2003
study, 99% of quilters in the US are women.) A typical quilter seems to be a well-educated
woman in her fifties who has more than 12 years quilting experience and a higher thanaverage household income.
Barbara was recently commissioned to create a quilt for the Holy Cross Hospital in Silver
Spring, Maryland. Her 69"x54" quilt “Approaching Summer” is based on photos she took
at the nearby Brookside Gardensand machine quilted by her friend and colleague Heather
Rogers.
Contd...
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“It hangs on a concave wall in the lobby of the Oncology Unit at the hospital,” Barbara
says. “The Brookside Gardens is such a beautiful and inspirational park and the center of
the quilt includes a large image of a pond that I think captures the tranquility of the place.
It has been very well received by staff and patients alike. It makes me happy to think that
something I have created, can comfort other people.”

Notes

Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://www.corel.com/content/pdf/profiles/CGS12_Barbara_Webster.pdf

7.7 Summary
z

CorelDraw Graphics Suite is a software package of design tools designed to run on
Windows operating systems.

z

The Smart Drawing tool instantly translates rough drawings into proper shapes and
recognizes a variety of different shapes.

z

The Smart Drawing tool uses Shape Recognition and Smart Smoothing to convert images.

z

Using the Shape tool, you can drag a glyph to alter a shape and you can add text to the
inside or outside of the shape.

z

Smart Drawing tool has a very important feature – delay time interval. It is the time
between the moment you finishing sketching a shape and the moment CorelDraw
determines a recognizable shape.

z

Pick Tool is one of the most important tools used in Corel Draw for selection and editing
of the graphic. It lets you select and size, skew and rotate objects.

z

You can specify settings for the size, orientation, and layout style of the page.

z

Layers provide a very effective way to organize the objects you create with CorelDraw.
When you delete a layer, you also delete all the objects on it.

z

Gradients are also called fountain fills in CorelDraw. They can fill objects with a smooth
transition between two (or more) colors, and they come in various styles.

z

Angle option affects the direction of the fill but it’s not available for Radial. Edge Pad
affects the smooth mixing of two color and continuous gradation.

7.8 Keywords
Angle Option: Angle option affects the direction of the fill but it’s not available for Radial.
Edge Pad: Affects the smooth mixing of two color and continuous gradation.
Glyph Nodes: Affect certain aspect of the shape.
Gradients: Fill objects with a smooth transition between two or more colors.
Layers: Provide a very effective way to organize the objects you create with CorelDraw.
Pick Tool: It lets you select and size, skew and rotate objects.
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Shape Tool: With Shape tool, you can drag a glyph to alter a shape and you can add text to the
inside or outside of the shape.
Smart Drawing Tool: The Smart Drawing tool instantly translates rough drawings into shapes
you’d usually consider drawing with the Rectangle tool or Ellipse tool—or with other tools that
require more effort and skill.

7.9 Review Questions
1.

Explain the steps to be followed to create a perfect drawing from a free hand sketch with
Smart Draw Tool.

2.

Describe the shapes recognized by the Smart drawing tool.

3.

Discuss the steps used to draw a predefined shape.

4.

What are the functions of Smarter Drawing Tool? Discuss.

5.

Illustrate the steps used for working with text.

6.

How can we convert a picture into gray scale?

7.

Elaborate the use of Pick tools in CorelDraw.

8.

Describe how to create a background for a CorelDraw.

9.

Angle option affects the direction of the fill but it’s not available for Radial. Comment.

10.

What are the different types of fill types available in Fountain Fill? Discuss.

Answers: Self Assessment
1.

Shape

2.

Delay time interval

3.

Pick

4.

Text

5.

outline

6.

Pixels

7.

Bitmap

8.

Custom

9.

landscape

10.

Layers

11.

objects

12.

Master

13.

Gradients

14.

Radial

15.

Square

7.10 Further Readings

Books

CorelDRAW 12: Basic Instructor’s Edition - Axzo Press.
CorelDRAW 12 Unleashed by Foster D. Coburn III.

Online links

http://coreldraw.helpmax.net
http://www.photoshop-flash-coreldraw-seo-help.com/coreldraw-help-tutorials
http://www.webreference.com/graphics/corel101/2/index.html
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Objectives
After studying this unit, you will be able to:
z

Explain the creation tool and its features

z

Discuss the logo making process of CorelDraw

z

Explain the business card making steps in CorelDraw

Introduction
Corel Corporation, from the abbreviation “Cowpland Research Laboratory” is a software
company specializing in graphics processing. It is known for producing software titles such as
CorelDraw which is an enormously powerful graphic design package used to create newsletters,
brochures, logos and web graphics. All characters on the “South Park” TV show are originally
created using CorelDraw and then exported to other graphics programs for animation.

8.1 Creation Tools
We will now discuss about the various types of tools used in CorelDraw to help create a vector
based graphic.
z

Artistic Media Tool: The Artistic media tool treats a path as though it’s a skeleton to which
you can apply any number of CorelDraw preset skins. There are five different types of
artistic media brushes, some with preset variations (the Preset, Brush, and Sprayer artistic
media types) and some without presets (Calligraphic and Pressure artistic media types). It
helps to think of a paintbrush metaphor; by dragging strokes, you’ll wind up with anything
from complex filigree strokes to elegant calligraphic handwriting. The underlying path to
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artistic media strokes can be changed at any time, which changes the corresponding look
of the media—and you can see the dynamic changes for accurate visual feedback as you
work. You can draw while an artistic media effect is enabled, and you can also apply these
painterly strokes to existing lines. The Artistic media tool is located in the toolbox with
other line-drawing tools.
With the Artistic media tool selected, the property bar offers five different line-drawing
modes to choose from each of which has its own options.

Notes You have additional options on the property bar, directly to the right of your choice
of artistic media, and the options change, depending on the media type you choose.
Figure 8.1: Artistic Media Tool

Source: http://kreasilugie.blogspot.in/2012/05/tutorial-coreldraw-x6-how-to-create.html
z

Live Smoothing: The Tools Property Bar has a slider to allow users to determine the
smoothness that can be applied with lines drawn with the freehand and artistic media
tools. The next line drawn will be smoothed according to the last setting.

z

Mesh Fills: The Mesh Fill Tool allows users to add color to a certain section of an image or
photograph by using a grid-like pattern. It offers you the power to solve many types of
realistic illustrative challenges with a minimum of objects.
Figure 8.2: Mesh Fill Tool

Source: http://clubweb.interbaun.com/~mward/a_plus/mesh_fills.pdf
z
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Eyedropper: Eyedropper Tool is the tool with which you can easily do a variety of things:
from simply copying solid colours to copying gradients, shapes and other properties
from one object into another one.
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Figure 8.3: Eyedropper Tool

Notes

Source: http://anastasiia-ku.com/2011/02/17/eyedropper-tool-in-coreldraw/
z

New Eraser Nib Shape: The Eraser tool in CorelDraw contains a square nib to allow users
edit work in a limited space. This feature lets users create knock outs from an object.

z

Enhanced Line Segment Functionality: A segment is a line of two nodes. There are two
types of segment: Line which is a straight segment and Curve in which the nodes have
control handles for adjustment. Users can join or add to selected line segments with cursor
feedback. Selecting a line segment and then the freehand tool lets the user select the start
or end node of the fine segment and extend it by drawing with the freehand tool.

z

Perspective Drop Shadow: Drop shadows simulate light falling on an object from one of
five particular perspectives: flat, right, left, bottom and top. You can add drop shadows to
most objects or groups of objects, including artistic text, paragraph text, and bitmaps.
Drop shadows created in CorelDraw are ideal for printed outputs, but are not appropriate
for output to devices such as vinyl cutters and plotters.
Figure 8.4: Drop Shadow Applied to an Object

Source: http://product.corel.com/help/CorelDRAW/540240626/Main/en/Doc/wwhelp/wwhimpl/
common/html/wwhelp.htm?context=CorelDRAW_Help&file=CorelDRAW-Creating-dropshadows.html
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z

Interactive Contour Tool: Contour effects add evenly spaced shape inside or outside the
border of the main object. You can also specify the numbers and the distance between
outlines.
Figure 8.5: Interactive Contour Tool

Source: http://www.insidegraphics.com/corel_draw/corel_contour_tool.asp

Task Compare and contrast Artistic Media Tool and Eyedropper Tool.

8.1.1 Internet Features
Map Text to HTML Style
Cascading Style Sheets (CSS) are very helpful as it helps the users to convert the CorelDraw text
styles to HTML when used as a layout. The HTML files produced are more accurate and editable
and allow the export of Web documents.

Enhanced HTML Export
Export of Web documents is enhanced by reducing the size of the Web site by allowing the files
with duplicated bitmap images to contain only one copy of the bitmap image. All references to
the bitmap image point to one file.

Automatic Web Link Update
The Help menu gives users the latest list of internet links from Corel through the update
command option. These links includes program update information, news, special offers and
opportunities from Corel.

Live Hyperlinks
To preview the target of hyperlink, the users can right-click an object with an associated hyperlink.
To ensure that hyperlinks point to the correct location the users can choose jump to hyperlink in
browser option.

Web Statistics Page
Users can automatically generate a statistics page by enabling the create statistics page check
box in the Publish to internet dialog box.
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Notes
Example: You can check text statistics to count text elements, including the number of
lines, words, characters, and the names of the fonts and styles used. You can display statistics
either for selected text objects or for the entire drawing. If no text is selected, all text elements in
the drawing, including tab and space characters, are counted.

Menu Links
Users can access useful information and download it via online links available in menus of
CorelDraw.

8.1.2 Compatibility and Integration Features
CorelDraw is compatible with numerous features that include the following:

Support for Corel PHOTO-PAINT and Adobe Photoshop File Formats
CorelDraw also external linking of CPT (Corel photo-paint) and PSD(Adobe Photoshop) files
preventing users to convert them to another file format.

Ixla Digital Camera Interface
IXLA’s Digital Camera Interface enables Corel software developers to implement direct camera
support for over 120 digital cameras via the plug-and-play interface of CorelDraw. Images can
be acquired directly from digital cameras thus eliminating the need for a third-party interface to
move images from camera to computer before editing.

!
Caution It makes the edited image files easy to be sent back to digital cameras for storage,
sharing, and review.

8.1.3 Bitmap Features
Bitmap is a mapping from some domain (for example, a range of integers) to bits (values zero or
one). It is also called a bit array or bitmap index.

Increased Rasterization Limit
For users creating who create large media, CorelDraw allows them to convert to a bitmap
image with a resolution value as high as 10,000 dots per inch (dpi).

Enhanced Convert to Bitmap Dialog Box
CorelDraw has logical and consistent bitmap image conversion resolutions, enhancing the
application’s consistency with Corel photo-paint.

Corel TRACE Integration
To convert bitmap image to vector graphics users can send images to Corel trace. For this rightclick on a new context menu item, or click a button on the Bitmap toolbar.

LOVELY PROFESSIONAL UNIVERSITY

177

Graphic Tools

Notes

Bitmap Crop
To crop a bitmap image in CorelDraw the Bitmap Crop feature comes in handy. It prevents the
users to crop bitmap images in Corel photo-paint.

8.1.4 Bitmap Effects
Many of the bitmap effects features used in Corel photo-paint are now available in CorelDraw.
Some of them are:

Art Strokes
Charcoal: It makes an image look like a black-and-white charcoal drawing. It not only de
saturates all colours from an image, it produces soft outlines in high contrast areas and also adds
a slightly rough canvas bump map appearance under the entire image.
Figure 8.6: The Charcoal Art Stroke

Source: http://www.visionary-voyager.com.au/corel/photopaint/Photofun/artstrokes/1-charcoal.htm

Conte Crayon: It can create a wide range of painted effects, from full colour impressionist style
images, black and white drawing style images, even painted duotone and limited tone style
images.
Figure 8.7: The Conte Crayon Art Stroke

Source: http://www.visionary-voyager.com.au/corel/photopaint/Photofun/artstrokes/2-conte_
crayon.htm
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Crayon: It makes an image look like a wax crayon drawing. You can specify the crayon pressure
and create dark outlines around elements in the image.

Notes

Figure 8.8: The Crayon Art Stroke

Source: http://www.visionary-voyager.com.au/corel/photopaint/Photofun/artstrokes/3-crayon.htm

Cubist: It groups similarly coloured pixels into squares to produce an image that resembles a
cubist painting. You can specify the square size, the amount of light, and the paper colour.

Did u know? Cubist seems to work best on larger images with fewer objects and low
complexity, due mainly to the visual ‘chaos’ it creates using rather large brush strokes.

Fine detail within images is generally lost using this effect, making finely detailed photographs
difficult to interpret after its use. But on images with fewer, larger foreground objects and little
or no background, then effect it produces can be quite stunning.
Figure 8.9: The Cubist Art Stroke

Source: http://www.visionary-voyager.com.au/corel/photopaint/Photofun/artstrokes/4-cubist.htm

Impressionist: It makes an image look like an impressionist painting. You can customize the
dabs of colour or the brush strokes and specify the amount of light in the image.
Figure 8.10: Impressionist Painting

Source: http://www.visionary-voyager.com.au/corel/photopaint/Photofun/artstrokes/6impressionist.htm
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Palette Knife: It creates the impression that an image was created by spreading paint on a canvas
with a palette knife. You can specify the amount of smudging and the size and direction of the
brush strokes.
Figure 8.11: The Cubist Art Stroke

Source: http://www.visionary-voyager.com.au/corel/photopaint/Photofun/artstrokes/7-palette_
knife.htm

Colour Adjustment Effects
Deinterlace: lets you remove lines from scanned or interlaced images.
Desaturate: converts the image into gray scale without changing the mode. This is done by
assigning the equal Red, Green and Blue value to each pixel in the RGB image.
Figure 8.12: Original Image

Source: http://www.insidegraphics.com/digital_art/photoshop_digital_desaturate.asp
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Figure 8.13: Image after Desaturation

Notes

Source: http://www.insidegraphics.com/digital_art/photoshop_digital_desaturate.asp

Level Equalization: It can adjust shadow, midtone, and highlighted areas by redistributing
shades from darkest to lightest, preserving shadow and highlight detail.
Replace Colours: Lets you replace one bitmap color with another color. A color mask is created
to define the color to be replaced. Depending on the range you set, you can replace one color or
shift an entire bitmap from one color range to another. You can set the hue, saturation, and
lightness for the new color.
Selective Colour: Selective Colour dialog box allows the users to modify colour by increasing
and decreasing the percentage of the magenta, yellow, and black pixels that make up each colour
in the spectrum.
Tone Curve: It lets you perform color corrections precisely, by controlling individual pixel
values. By changing pixel brightness values, you can make changes to shadows, midtones, and
highlights.
Sample/Target Balance: It lets you adjust color values in a bitmap with sample colors taken from
the image. You can choose sample colors from the dark, midtone, and light ranges of an image
and apply target colors to each of the sample colors.

3D Filters
Cylinder: It converts an image to a cylindrical shape. The percentage slider takes positive and
negative values that lets users set the amount to which the image needs to be mapped.
Sphere: It wraps an image around the inside or outside of a sphere. Positive values in the
percentage slider expands the central pixels towards the image’s edge resulting in a spherical
shape and negative values compress pixels towards the centre of the image to conform the
image to a concave sphere.
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Blur Filters
Low Pass: Its used to delete sharp edges and detail from an image allowing smooth gradients
and low-frequency detail.

!
Caution Users can control the percentage and radius of the effect using the sliders.

Jaggy Despeckle: To minimize distortion of an image we use the Jaggy Despeckle filter. It creates
a soft and blurred final image.
Directional Smooth: It is used to find out the direction in which we need to apply the greatest
amount of smoothing, subtly smoothing edges and surfaces.
Zoom: The zoom filter lets users create an effect that blurs pixels outward from a center point on
an image. The amount of zoom can be handled at the user’s end.
Radial Blur: It gives an image a blurred effect that radiates from a central point. Users have the
options of repositioning the centre point, setting the intensity of the effect, choosing a blur node,
and setting the quality of the output.
Soften: Used to blur an image a little thereby retaining a high level of detail. The filter can be
applied to the entire image, or to part of it using a lens.

Colour Transform Filters
Bit Planes: To analyze gradients in images, we use the Bit Planes tool which reduces the image
to basic Red Green Blue (RGB) components and emphasizes tonal changes.
Halftone: It is an image that has been converted from a continuous tone image to a series of dots
of various sizes to represent different tones. In order to produce a wider range of colours the
screen angles can be adjusted.

Contour Filters
Find Edge: It locates and converts edges in an image to soft or solid fines. Soft fines create a
smooth, blurred outline, while solid lines create a sharp, crisp outline.
Trace Contour: It traces image elements using a 16-color palette. Users can set threshold level
and edge type.

Creative Effects
Crafts: It replaces image colors with puzzle pieces, gears, marbles, candy, ceramic tiles, or poker
chips.
Crystallize: It transforms images into crystal formations creating a geometric pixilation of
images in polygon forms.
Fabric: It reconstructs images by sampling main image colours and replacing them with
needlepoint stitches, quilt patches, rug hooking, strings, ribbons, or a tissue collage.
Frame: It applies irregular vignette borders to objects or images, resulting in a specified
background colour or transparency. It eliminates the need for extensive masking.
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Figure 8.14: Image after Framing

Notes

Source: http://www.visionary-voyager.com.au/corel/photopaint/Photofun/frames/frame1.htm

Kid’s Play: It reconstructs images by sampling main colour images and replacing them with lite
pegs, building blocks, finger paints, or paint by numbers.
Mosaic: The mosaic effect gives images the appearance of being created with mosaic tiles. Users
can also choose to have the tiles form a vignette pattern.
Particles: It creates stars or bubbles across an image, resulting in the appearance of star fields,
dust, or carbonated soda.
Stained Glass: Users can determine pane and solder size, and can simulate outdoor lighting
through a luminosity setting to create a stained glass image through a 3D lighting check box in
the stained glass dialog box.
Weather: It adds natural elements and atmosphere to images, ranging from a snow flurry to a
snowstorm, drizzling rain to a downpour, and misty fog to pea-soup fog.

Distort Filters
Blocks: It divides an image into scrambled block pieces. The block size, distance between them,
and the background colour can be altered.
Ripple: It distorts an image with one or more waves. The strength of the can be adjusted as to
increase or decrease the distortion level.
Tile: It converts an image similar to a group of tiles on a grid.
Whirlpool: It applies a fluid, swirling pattern across images. The customisable options are
smear length, spacing, twist, and streak details.
Wind: It blurs an image in a specific direction, creating the effect of wind blowing across an
image. The strength and direction of the wind effect can be altered.

Noise Filters
Diffuse: It is used to spreads out the pixels of an image to fill in blank spaces and remove noise.
The level of diffusion can be set for the effect to appear smooth or blurry, or produce a soft,
double-edged look.
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Dust and Scratch: It removes dust and scratch faults in an image and reduces image noise by
averaging pixel values, causing adjacent pixels to bleed into each other.
Maximum: It removes noise by adjusting pixel values based on the maximum pixel value of
neighboring pixels.
Median: It removes noise and detail by averaging the colours of adjacent pixels in image. The
median filter blurs an image to a greater extent than the dust and scratch filter.
Minimum: It darkens an image by adjusting pixel values based on the minimum pixel values of
neighboring pixels.

Did u know? The radius slider and percentage slider are used to control the darkening.

Remove Moire: It removes undesired wave patterns created by conflicting dot patterns that
occur when halftone screens or two different frequencies are superimposed in an image.

Sharpen Filters
High Pass: It makes an image into a glowing one by eliminating low-frequency detail and
shading. It emphasizes the highlighted and luminous areas of an image.
Directional: It is used to analyze pixels of similar shades to determine the direction in which to
apply the greatest amount of sharpening.
Adaptive Unsharp: It enhances edge detail by analyzing the pixel value of neighboring pixels,
preserving more image detail than other sharpening effects.

Task Make a report on Blur Filters used in CorelDraw.

Self Assessment
Fill in the blanks:
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1.

The …………………… tool treats a path as though it’s a skeleton to which you can apply
any number of CorelDraw preset skins.

2.

The …………………… tool allows users to add color to a certain section of an image or
photograph by using a grid-like pattern.

3.

A …………………… is a line of two nodes.

4.

The …………………… tool in CorelDraw contains a square nib to allow users edit work in
a limited space.

5.

The …………………… filter lets users create an effect that blurs pixels outward from a
center point on an image.

6.

…………………… is an image that has been converted from a continuous tone image to a
series of dots of various sizes to represent different tones.

7.

…………………… filter distorts an image with one or more waves.

8.

…………………… can adjust shadow, midtone, and highlighted areas by redistributing
shades from darkest to lightest, preserving shadow and highlight detail.

LOVELY PROFESSIONAL UNIVERSITY

Unit 8: Tools Working with CorelDraw

9.

…………………… converts an image similar to a group of tiles on a grid.

10.

…………………… filter traces image elements using a 16-color palette.

11.

…………………… simulate light falling on an object from one of five particular
perspectives.

Notes

8.2 Creating Logo in CorelDraw
A logo is a graphical representation of a company or an individual that can be used on business
cards, letterhead, and other promotional materials. Logos often incorporate an element of the
company’s name or indicate in some way what the company does.
Example: A logo for a coffee shop may include an image of a coffee cup.
CorelDRAW 10 includes many powerful creative tools that can help you create an imaginative
and beautiful logo.

Notes By experimenting with these tools, you can produce a wide variety of different
looks and creative effects quickly and easily, and then you can choose the logo you like
best.
We will now discuss a step by step methodology to create a logo that will finally look like the
figure 8.15 below:
Figure 8.15: Final Logo

Source: www.nairaland.com/12208/corel.draw-step-creating-n-n
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Step 1: Draw a Circle using the Eclipse Tool (F7) with Width & Height both 4.514 inches.
Figure 8.16: Ellipse Tool

Source: www.nairaland.com/12208/corel.draw-step-creating-n-n

Step 2: Select your rectangular tool or press (F6) and draw a rectangle set the Width to 0.479 &
Height to 5.718
Step 3: Press Ctrl+A to Select the two Objects drawn
Step 4: Go to Arrange > Align and Distribute, click on the Align Tab if not selected, In the Align
to Option, Check on Center of Page then Click ok
Step 5: Now, Select only the rectangle object, by clicking on it.
Figure 8.17: Select the Rectangle Object

Source: www.nairaland.com/12208/corel.draw-step-creating-n-n

Step 6: Now go to Arrange > Transformations > Rotate or Press (Alt+f8) use the following
setting as shown in figure 8.18.

186

LOVELY PROFESSIONAL UNIVERSITY

Unit 8: Tools Working with CorelDraw

Figure 8.18: Transformation Dialog Box

Notes

Source: www.nairaland.com/12208/corel.draw-step-creating-n-n

Step 7: Then click Apply to Duplicate 5 times.
Figure 8.19: Duplicating the Pattern

Source: www.nairaland.com/12208/corel.draw-step-creating-n-n
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Step 8: Press ctrl + A to select all objects
Step 9: Go to Arrange > Shaping > Weld To
Step 10: Click on weld to on the shaping docker box
Step 11: Then click on any part of the object to apply
Figure 8.20: Select Applied Area

Source: www.nairaland.com/12208/corel.draw-step-creating-n-n

Step 12: Use your eclipse tool () to draw a second circle this time width and height both 3.136"
Sep 13: Go to Arrange > Align and Distribute> Center of Page
Step 14: Select your text tool (f8)
Step 15: Press Crtl + Shift + T a Edit Text Dialog box appear
Step 16: Type in the text “NIGERIAN NATIONAL PETROLEUM CORPORATION” in Upper Case
using font Aerial, Size = 28, Bold
Step 17: Select the text and the second circle, by click on the object (circle) and the text one after
the other while pressing down shift key.
Step 18: Then go to Text > Fit text to path
Figure 8.21: Apply Text to Image

Source: www.nairaland.com/12208/corel.draw-step-creating-n-n
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Step 19: Click on the Text that is in the path of the circle

Notes

Step 20: Click on the text again, Go to Arrange>Break text apart
Step 21: Click on the circle again and colour it red
Step 22: Draw a third circle, width =2.295" height=2.295", colour it blue and centralize it
arrange>Align and Distribute > Center of page
Step 23: Colour the Gear Circle Yellow
The final logo is created.

Self Assessment
State whether the following statements are true or false:
12.

A logo is a graphical representation of a company or an individual that can be used on
business cards, letterhead, and other promotional materials.

13.

Logos does not incorporate an element of the company’s name.

8.3 Creating a Business Card in CorelDraw
A business card presents information about a business or an individual working for a business.
Typically, a business card includes the company logo, the name and job title of an individual,
and contact information such as telephone numbers and email addresses.
CorelDRAW includes many tools that can help you create business cards.
After a logo design, let us now try to create a simple business card. All you need is to follow the
steps given below:
Step 1: Create a new document and add the settings as shown belowFigure 8.22: Apply Text to Image

Source: http://coreldrawtips.com/tutorials/sites/default/files/wtutorials/pdf/CreatingABusiness
Card.pdf
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Step 2: Double click on rectangle tool to make a ship as per your document size.
Figure 8.23: Create a Shape

Source: http://coreldrawtips.com/tutorials/sites/default/files/wtutorials/pdf/CreatingABusiness
Card.pdf

Step 3: Using Ellipse tool create a perfect circle using CTRL+drag. Release your left mouse and
set the dimensions to 5"x5".
Figure 8.24: Create an Ellipse

Source: http://coreldrawtips.com/tutorials/sites/default/files/wtutorials/pdf/CreatingABusiness
Card.pdf

Step 4: While the circle is selected, set the x and y coordinates as shown below:
Figure 8.25: Setting Coordinates

Source: http://coreldrawtips.com/tutorials/sites/default/files/wtutorials/pdf/CreatingABusiness
Card.pdf

Step 5: Select Smart fill tool and choose Orange as the fill color in the Fill color box.
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Figure 8.26: Fill Color

Notes

Source: http://coreldrawtips.com/tutorials/sites/default/files/wtutorials/pdf/CreatingABusiness
Card.pdf

Step 6: While your Smart fill color is active, click lower part of the rectangle
Figure 8.27: Select the Area of the Rectangle

Source: http://coreldrawtips.com/tutorials/sites/default/files/wtutorials/pdf/CreatingABusiness
Card.pdf

Step 7: Select big circle and set x coordinate as 3 and y as 3.2. You will see a white space above
your orange curves. Repeat step 5 with milder shades of orange.
Step 8: Repeat step 6. Left click on the white space. Select the big circle and delete it.
Select your 2 curves, right click on the X square to at top of your color palette to remove the
outline.
Figure 8.28: Final Background

Source: http://coreldrawtips.com/tutorials/sites/default/files/wtutorials/pdf/
CreatingABusinessCard.pdf
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Step 9: Type all necessary information.
Figure 8.29: Final Card

Source: http://coreldrawtips.com/tutorials/sites/default/files/wtutorials/pdf/CreatingABusiness
Card.pdf

Self Assessment
State whether the following statements are true or false:
14.

A business card presents information about a business or an individual working for a
business.

15.

It is possible to create logo and business cards with CorelDraw.

Case Study

CorelDRAW Graphics Suite X3 Helps Bring
Hollywood Events to Life

A

n Original Occasion is a Los Angeles-based special events production company
renowned for its fabulous themed events that have hosted American presidents
and Hollywood’s elite. Whether they are working on movie premieres, social
functions, or corporate events, the creative team at the company relies on CorelDRAW
Graphics Suite X3 to win business and deliver their award-winning projects. David Merrell,
president and founder, has used CorelDRAWGraphics Suite exclusively since he was
introduced to the powerful design package seven years ago by his Creative Director
Cindy Wiedenheft, and swears it is a key component of his success. “Since we started using
CorelDRAW, we’ve noticed a marked increase in the number of our proposals that are
being accepted. With this software, we are able to provide proposals filled with detailed
graphics that fully illustrate the vision we have for the event. CorelDRAW Graphics Suite
allows us to bring a room to life on paper—which absolutely convinces our clients that we
can master their event.”
Great Graphics Create a Competitive Advantage
A staple in the Hollywood events scene, An Original Occasion uses graphics to communicate
the company’s vision to clients. Event planning, David explains, is a very conceptual and
competitive business. “It’s really hard to convey just what you intend for an event with
words. You can use all the adjectives in the dictionary, but a client can still imagine
Contd...
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something completely different than what you intended. Visuals are key to success. By
using CorelDRAW Graphics Suite X3 to provide a complete layout, we can easily convey
our intentions and iron out the details within minutes. When presenting a proposal that
provides a realistic picture of the room complete with props, decor and lighting effects, it
takes a massive burden off the client. They know we’re really interested – and most
importantly highly capable.”

Notes

To ensure that the customer has a clear idea of the team’s vision during the planning and
proposal process, an Original Occasion often uses both applications in the suite, CorelDRAW
and Corel PHOTO-PAINT , together to create realistic illustrations for a client’s
consideration. Starting with a photo of the room or venue, the designer uses Corel PHOTOPAINT to optimize the photo, improving details like its color, brightness and size. The
improved image is then imported into CorelDRAW where vector graphics of the planned
elements like chairs, tables, and props are added. The end result? An Original Occasion is
able to provide the customer with an accurate image of the final look and feel of the event,
ensuring that everyone can visualize the proposed end result right from the start”
An event plan is an intangible product. Using CorelDRAW in the proposal process has
tripled our closing percentage!
David says that the realistic portrayal of space continues to differentiate his company
from the competition. When competing in this multi-million dollar business, clients want
to be impressed. An event plan is an intangible product. Using CorelDRAW in the proposal
process has tripled our closing percentage! Some event planners use industry-specific
event planning software or CAD products for layout and design. However, these tools
don’t give the same level of detail. We are really able to personalize our plans using
CorelDRAW, down to the very last detail. I’d recommend CorelDRAW Graphics Suite to
anyone with an interest in realistic design!
In addition to creating powerful proposals, the team at An Original Occasion can create
graphics to be used throughout planning and coordination. “We are completely dependent
on CorelDRAW to execute an event. Whether rendering props and decor or creating a
schematic with the layout of the event on a grid to scale, we use the software at every step
along the way. It makes project execution wildly simple.”
CorelDRAW Graphics Suite X3 also helps An Original Occasion be flexible when working
on projects that may be planned in rural areas or in a location far from LA—saving the
company significant time and money. The company’s graphically rich plans are so detailed
and complete that the event planner can confidently hand off the “on location” work to
local staff to execute. “With our very detailed schematics, everything is outlined for the
local staff, with no need for the planner to ever visit the site, saving many travel hours.
This increases my capacity to build and manage the business.”
“When I teamed up with Cindy seven years ago,” David says, “she told me we simply
must use CorelDRAW for event preparation. Now, we wouldn’t turn back. CorelDRAW is
an essential part of our business.” CorelDRAW Graphics Suite X3 has become such an
integral part of An Original Occasion that each new recruit must learn the program to join
the company. “In order to transform a room in keeping with a client’s theme, our employees
must use CorelDRAW to show every little detail and present a plan that will make a
lasting impression.” He says that CorelDRAW Graphics SuiteX3 has the added benefit of
being easy to use, so new staff are able to get up to speed quickly. By offering ease of use
and powerful graphics capabilities, CorelDRAW Graphics Suite X3 has helped an Original
Occasion grow its business by delivering some of the most well-respected events in the
industry.
Contd...
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Whether they are creating proposals or executing on a client’s vision down to every last
detail, David says, “in so many ways, CorelDRAWGraphics Suite X3 aids in the success of
our business immensely”.
Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://www.corel.com/cdgsx3/an_original_occasion_case_study/CDGSX3_An_Original_
Occasion_Case_Study.pdf

8.4 Summary
z

CorelDraw is an enormously powerful graphic design package used to create newsletters,
brochures, logos and web graphics.

z

The Artistic media tool treats a path as though it’s a skeleton to which you can apply any
number of CorelDraw preset skins.

z

Live Smoothing, Mesh Fills, Eyedropper, New Eraser Nib Shape are some tools available
to apply different types of effects on a CorelDraw document.

z

CorelDraw can Map Text to HTML Style and provide enhanced internet features.

z

It supports Corel PHOTO-PAIN, Adobe Photoshop File Formats and Ixla Digital Camera
Interface.

z

To crop a bitmap image in CorelDraw the Bitmap Crop feature comes in handy. It prevents
the users to crop bitmap images in Corel photo-paint.

z

Many of the bitmap effects features used in Corel photo-paint are now available in
CorelDraw now. For example, art strokes like charcoal, crayon, etc.

z

CorelDraw can make use of features like 3D filters, blur filters, Colour Transform Filters,
Contour Filters, etc. to provide multiple effects to its images and text.

8.5 Keywords
Artistic Media Tool: It treats a path as though it’s a skeleton to which you can apply any number
of CorelDraw preset skins.
Bitmap: It is a mapping from some domain (for example, a range of integers) to bits (values zero
or one).
Deinterlace: It lets you remove lines from scanned or interlaced images
Eyedropper Tool: It is the tool with which you can easily do a variety of things: from simply
copying solid colours to copying gradients, etc.
Halftone: It is an image that has been converted from a continuous tone image to a series of dots
of various sizes to represent different tones.
Jaggies: They are stair like lines that appear where there should be smooth straight lines or
curves.
Mesh Fill Tool: It allows users to add color to a certain section of an image or photograph by
using a grid-like pattern.
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Trace Contour: It traces image elements using a 16-color palette. Users can set threshold level
and edge type.

Notes

8.6 Review Questions
1.

Discuss the various types of tools used in CorelDraw to help create a vector based graphic.

2.

Discuss various bitmap features.

3.

Give a detailed explanation about the various art strokes available in CorelDraw.

4.

Write a short note on the various filters that are used in CorelDraw.

5.

What are the internet features provided by CorelDraw.

6.

Explain steps to create a logo using CorelDraw.

7.

Illustrate the steps to create a business card using CorelDraw.

8.

Make distinction between Mesh Fill Tool and Interactive Contour Tool.

9.

Explain the Deinterlace and Desaturate effects on bitmap images.

10.

Describe various noise filters used in coreldraw.

Answers: Self Assessment
1.

Artistic media

2.

Mesh Fill

3.

Segment

4.

Eraser

5.

Zoom

6.

Halftone

7.

Ripple

8.

Level Equalization

9.

Tile

10.

Trace Contour

11.

Drop shadows

12.

True

13.

False

14.

True

15.

True

8.7 Further Readings

Books

David Brickley, Coreldraw! Special Effects,
Gary David Bouton, CorelDRAW X5 The Official Guide.

Online links

http://tag.wonderhowto.com/make-logo-with-corel-draw/
http://www.entheosweb.com/tutorials/coreldraw/classic_logo.asp
http://product.corel.com/en/draw/10/tutorials/draw/html_docs/
Business_Card/d_bus_01.htm
http://www.coraltreewebdesign.com/PDFs/Creating%20Business%20Cards%
20in%20CorelDRAW.pdf
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Objectives
After studying this unit, you will be able to:
z

Explain the basics of HTML

z

Elaborate the head elements

z

Explain the block oriented elements

z

Discuss the Uniform Resource Locators (URL)

Introduction
The Internet is a network of networks that consists of millions of private, public, academic,
business, and government networks, of local to global scope, that are linked by a broad array of
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electronic, wireless and optical networking technologies. The Internet carries an extensive range
of information resources and services, such as the inter-linked hypertext documents of the
World Wide Web. A web browser is a software application for retrieving, presenting and
traversing information resources on the World Wide Web. In this unit, we will discuss the
concept of web designing.

Notes

9.1 Document Overview
We come across a document typically written in plain text along with formatting instructions of
Hypertext Markup Language. Such a page is called a webpage. A set of related web pages served
from a single web domain constitutes a website. A website is hosted on at least one web server,
accessible via a network such as the Internet or a private local area network through an Internet
address known as a Uniform Resource Locator. All publicly accessible websites collectively
constitute the World Wide Web.

9.1.1 Working of Web Pages
A web browser is a software application for retrieving, presenting and traversing information
resources on the World Wide Web. It connects with the server where the website’s contents are
hosted through a set of rules called Hypertext Transfer Protocol (HTTP). Generally, we notice
the prefix “Error! Hyperlink reference not valid.” when we access a webpage which tells the
browser the protocol to use to execute the particular URL request.
HTML or XHTML format allows easy structuring of information of the and reduces the overhead
of the client’s web browser. To control the way our page looks, we can use CSS (Cascading Style
Sheets). They determine the layout, typographic elements, colour scheme and navigation of the
page. CSS instructions can be either embedded within the HTML web page (valid for that
particular page) or can be included in a separate external file (valid for the whole site).

9.1.2 HTML
Hyper Text Markup Language is the main markup language for creating web pages and other
information that can be displayed in a web browser. It is written in the form of HTML elements
consisting of tags enclosed in angle brackets (like <html>), within the web page content. A web
browser is responsible to read HTML documents and compose them into visible or audible web
pages. The browser does not display the HTML tags, but uses the tags to interpret the content of
the page. The major advantage of HTML is that it is platform independent language that can be
used on any platform such as Windows, Linux, Macintosh, and so on. Users can link documents
Hypertext Links or Hyperlinks.
A simple HTML example:
<html>
<head>
<title>Hello!</title>
</head>
<body>
<p>Hello World!</p>
</body>
</html>
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The text between <html> and </html> describes the web page, and the text between <body> and
</body> is the visible page content. The markup text ‘<title>Hello HTML</title>’ defines the
browser page title.
Figure 9.1: The Output of the Example Given Above

Source: http://www.mygeekpal.com/php-syntax-variables-echo-statement/

9.1.3 Advantages of HTML
HTML has the following advantages which makes it widely used:
z

It is easy to use and understand

z

Almost all browsers support HTML

z

It is free

z

It has a loose syntax and hence very flexible

z

It is similar to XML syntax, which is increasingly used for data storage.

9.1.4 Limitations of HTML
z

Being too flexible makes it hard to maintain in cases of complex structuring

z

Can only create static web pages

z

You have to keep up with deprecated tags, and make sure not to use them.

z

It is not very secure

z

Many tags are now deprecated

Did u know? The latest version of HTML is HTML 5 which can handle multimedia and
graphical content on the web without having to resort to proprietary plugins and APIs.

Self Assessment
Fill in the blanks:

198

1.

A set of related web pages served from a single web domain constitutes a ……………………

2.

All publicly accessible websites collectively constitute the ……………………
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3.

…………………… is the main markup language for creating web pages and other
information that can be displayed in a web browser.

Notes

9.2 Head Elements
A web page has headings that to inform the search engine of various page attributes.
Page headings are created with the <hn> tag, in which ‘n’ is a number between 1 and 5 depicting
the different sizes for the headings. <h1> defines the most important heading. <h6> defines the
least important heading.
Example:
Figure 9.2: The Different Heading Styles

Source: http://www.blogtechnics.com/wordpress/how-to-use-h1-h2-h3-h4-heading-tags-on-wordpressblog

We can create a page with headings and sub-headings as shown below:
<h1>Main Heading</h1> Main Heading
<p>First paragraph content</p> First Paragraph content.
<h2>Sub Heading</h2> Sub Heading
<p>Second paragraph content</p> Second paragraph content.

Heading tags can have many attributes.
Example: <h1 align=”center”>Main Heading</h1>
Every header leaves a blank line above and below it when displayed in browser.

Notes We can view the source of a web page by right-clicking in the page and selecting
“View Source” (IE) or “View Page Source” (Firefox), or similar for other browsers. This
will open a window containing the HTML code of the page.
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9.2.1 Use of Heading Tags
Using a heading in a document is necessary for many reasons as stated below:
z

Search engines use your headings to index the structure and content of your web pages.

z

Since users may skim your pages by its headings, it is important to use headings to show
the document structure.

z

Heading tags will be recognized by browsers which do not recognize style sheets

z

Screen readers and magnifiers (for the visually impaired) rely on headings to navigate the
page.

z

Heading tags make it easy to make global changes to headings.

Typically H1 headings should be used as main headings, followed by H2 headings, then the less
important H3 headings, and so on.

HTML Tags
The document enclosed within the HTML tags is identified as a web page. To create a web page
do the following:
1.

Open a notepad

2.

Type <html>

3.

Press the Enter key thrice from the keyboard

4.

Type </html> to close the tag

5.

Save the web page with a name and .html as the extension

When we open this web page in a browser, the output will be as given in figure 9.3.
Figure 9.3: A Blank Web Page

Source: http://www.mycomputerforum.com/tutorials/what_is_html.html
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9.2.2 Head Tags
These tags are used to store information about the web page. For example, page. To create a head
tag follow the steps below:
1.

Open a notepad

2.

Type <html>

3.

Type <head> exactly below the <html> tag

4.

Press the Enter key twice

5.

Type </head > to close head tag

6.

Type </html> to close the tag

7.

Save the web page with a name and .html as the extension

Title Tags
They are used to provide a Title for the web page. The title consists of an alphabet and/or
number. To see how to write a title tag, follow the steps below:
1.

Open a notepad

2.

Type <html>

3.

Type <head>

4.

Type <title> exactly below the <head> tag

5.

Type a title for the web page

6.

To end the title tag, type </title> after the title you have typed

7.

Type </head > to close head tag

8.

Type </html> to close the tag

9.

Save the web page with a name and .html as the extension

Body Tags
Leaving the title, all other contents of the web page should be enclosed within the Body Tags.
The body tags can contain paragraph , images, text, lists, etc.
1.

Open a notepad

2.

Type <html>

3.

Type <head>

4.

Type <body> exactly below the </head> tag.

5.

Type This is the Sample Document after the <body> tag.

6.

Type </body> to close the Body tag.

7.

Type </head > to close head tag

8.

Type </html> to close the tag

9.

Save the web page with a name and .html as the extension
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Task Create a simple HTML page using the tags described above.

Self Assessment
Fill in the blanks:
4.

Page …………………… are created with the <hn> tag, in which ‘n’ is a number between 1
and 5 depicting the different sizes for the headings.

5.

…………………… tags are used to store information about the web page.

6.

…………………… tags are used to provide a Title for the web page.

9.3 Block Oriented Elements
These elements are used to format the document as text blocks. Most of the structure of a web
page constitutes the block-oriented elements. Some of the block oriented elements are discussed
below:

Using paragraph tag: <P></P>
Creates a paragraph, perhaps the most common block level element.

Using Line Break Tag: <BR>
It is used to add line breaks in a document. It is a tag that works even without a closing tag and
hence is called an empty tag.

Using Preformatted Text Tag: <PRE></PRE>
Text within this element is typically displayed in a non-proportional font exactly as it is laid out
in the file. Whereas browsers ignore white space for other HTML elements, in pre, white space
should be rendered as authored.

Notes This tag can be used, where it requires total control over spacing and line breaks
such as typing a poem.

Using Horizontal Rule Tag: <HR>
This empty tag is used to draw horizontal rules and lines. It can be used to separate two sections
of text. It accepts following attributes:
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z

SIZE: This pixel value determines the thickness of the horizontal rule.

z

WIDTH: Specifies an exact width of HR in pixels, or a relative width as percentage of the
document width.

z

ALIGN: Set the alignment of the rule to LEFT, RIGHT and CENTER.
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z

NOSHADE: It specifies that the horizontal rule should not be shaded at all.

z

COLOUR: Set the colour of the Horizontal rule.

Notes

Example: <HR SIZE=”3" WIDTH= “50%” ALIGN=”LEFT” NOSHADE COLOR=”BLUE”>

9.3.1 Character Formatting Tags
They are used to specify how a particular text should be displayed when the user sees the
webpage. The most common character formatting tags are:
z

Boldface <B></B>: displays text in BOLD

z

Italics <I></I>: displays text in Italic

z

Subscript <SUB></SUB>: displays text in Subscript

z

Superscript <SUP></SUP>: displays text in Superscript

z

Small <SMALL>: displays text in smaller font as compared to normal font

z

Big <BIG>: displays text in larger font as compared to normal font

z

Emphasize <EMP></EMP>: defines text that should be emphasized. Most browsers will
display it in italics. It can be nested with other tags.
Figure 9.4: Character Formatting Tags

Source: http://www.webbasedprogramming.com/How-to-use-HTML-3.2/ch5.htm

Font Colours and Size:<FONT> </FONT>
Font tag is used when we need to specify the colours, size, font of the text on the web page.
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Example: <FONT> Your text goes here </FONT>
The font tag takes up the following attributes:
z

Color: Sets the color of the text that will appear on the screen. It can be set by giving the
value as #rr0000 for red(in RGB hexadecimal format), or by name.

z

Size: Sets the size of the text

z

Face: Specifies the font of text
Example:

<font size= “3" color=”red” face=”times new roman” >This is some text!</font>
<font size=”3" color=”#rr0000" face=”times new roman” >This is some text!</font>
Output- This is some text!
This is some text!

Using Some Special Characters
There are certain special characters that can be used while creating document.

!
Caution Special characters must end with a semicolon ;

Some of them are:
z

&quot;- quotation mark “

z

&copy; – copyright symbol ©

z

&reg; - registered symbol ®

z

&amp; -ampersand symbol &

z

&gt; - greater than symbol >

Self Assessment
Fill in the blanks:
7.

…………………… tag is used to add line breaks in a document.

8.

…………………… tags are used to specify how a particular text should be displayed when
the user sees the webpage.

9.

…………………… tag is used when we need to specify the colours, size, font of the tex on
the web page.

9.4 Lists
We can add lists in out HTML web page. The most commonly used lists are:
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z

Ordered List or Numbered List

z

Unordered List or Bulleted List
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9.4.1 Ordered List <OL></OL>
An ordered list is used to display a numbered list of items in the order. It must begin with the
<OL> tag followed by an <LI> list item tag.

The <OL> tag takes up the following attributes:n
z

Compact: render a list in compact form.

z

Start: used for lists that need to start at values other than 1.

z

Type: allows marking list items with different types. By default the list Item markers are
set to numbers 1, 2, 3… so on.

Other values of Type attribute are:
Type = A - Capital letter e.g. A, B, C...........
Type = a - Small letter e.g. a, b, c,..........
Type = I - Uppercase Roman Numbers e.g. I, II, III..........
Type = i - Lowercase Roman Numbers e.g. i, ii, iii...........
Type = 1- e.g. 1, 2, 3............
Example:
<html>
<body>
<ol type=”I”>
<li>Coffee</li>
<li>Tea</li>
<li>Milk</li>
</ol>
</body>
</html>
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Output:
I.

Coffee

II.

Tea

III.

Milk

Task Try the remaining combinations of the attributes for the ordered lists for a HTML
page.

9.4.2 Nested Order List
An ordered list that contains one or more ordered list is called as nested order lists.
Example: A
<html>
<body>
<ol>
<li>Sweet</li>
<li>Salty</li>
<ol>
<li>Very Salty</li>
<li>Lightly salted</li>
</ol>
<li>Bitter</li>
<li>Sour</li>
</ol>
</body>
</html>

Output:
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1.

Sweet

2.

Salty


Very Salty



Lightly salted

3.

Bitter

4.

Sour
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9.4.3 Unordered List <UL> </UL>

Notes

An unordered list starts with the <ul> tag. Each list item starts with the <li> tag.

!
Caution The list items are marked with bullets (typically small black circles).

Example:
<ul>
<li>Coffee</li>
<li>Milk</li>
</ul>

Output:
Coffee
Milk
The unordered lists can have many kinds of bullets:

Self Assessment
Fill in the blanks:
10.

An …………………… is used to display a numbered list of items in the order.

11.

An ordered list that contains one or more ordered list is called as …………………… order
lists.

12.

An unordered list starts with the …………………… tag.

9.5 Uniform Resource Locators
A URL or a web address is a specific string of characters that constitutes a reference to a resource.
In most web browsers the URL of a web page is displayed on top inside an address bar.
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Example: “http:// www.google.com”
There are fixed characters and numbers allowed in an URL.
z

Unreserved
A B C D E F G H I J K
A B C D E F G H I J K
0 1 2 3 4 5 6 7 8 9 - _ . ~

z

L
L

M
M

N
N

O
O

P
P

Q
Q

R
R

S
S

T
T

U
U

V
V

W
W

X
X

Y
Y

Z
Z

Reserved
! * ‘ ( ) ; : @ & = + $ , / ? % # [ ]

A URL consists of three parts:
Figure 9.5: Parts of a URL

Source: http://www.asu.edu/ecure/2002/mcgovern/

Service Descriptor: The Protocol i.e. a set of rules and standards that computers use to exchange
information to be used. Some of them are, HTTP, FTP and FILE.
Internet Address: The address where the file containing the required page can be found.
Source Address: It contains the path for the destination where the file actually lies.

Did u know? Right now there are almost 644 million active websites on the Internet
according to Netcraft!

9.5.1 Types of URLs
The length of the URL depends on the location of the document to which you’re linking. If the
file is on the World Wide Web, the URL is longer and the one on your local computer or server
has a shorter URL.
Basically, URLs fall into two categories:

Absolute URL
It is an independent address that points directly to the file you have looked for.
Example: “sitename.com/images/welcome.gif” is an absolute URL as it specifies that an
image file welcome.gif located in the images directory, under your sitename domain.
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Relative URLs
A relative URL points to a file/directory in relation to the present file/directory.
They have shorter URLs as they refer to the root directory/subdirectory.
Example: ../image/welcome.gif is a relative URL (The initial two periods (..) in the URL
instruct the server to move up one directory (which is the root directory), then enter images
directory and finally point at welcome.gif file)

Self Assessment
Fill in the blanks:
13.

A …………………… is a specific string of characters that constitutes a reference to a resource.

14.

…………………… is an independent address that points directly to the file you have
looked for.

15.

A …………………… points to a file/directory in relation to the present file/directory.

Case Study

The Impact of HTML Delay on Mobile Business Metrics

W

hen I gave my talk about mobile performance and business KPIs at Velocity
Berlin a couple weeks back, one of the areas I got the most questions about
later was the experiments we were able to do in which we delayed HTML on a
customer’s site and tracked the results over a 12-week period. I thought it might be useful
to break some of this out into its own post.
As I mentioned at Velocity, I was insanely jealous of Google and Bing a couple years ago,
when they revealed their own in-house experiments with HTML delay. Most of us in the
performance community would kill for that kind of experimentation platform. So I was
extremely happy and grateful when one of our customers at Strangeloop expressed an
interest in figuring out the value of time for their business.
Methodology
We conducted a split test over the course of 12 weeks, in which we segmented mobile
traffic into four groups: fully optimized, 200 ms delay, 500 ms delay, and 1000 ms delay.
We monitored four metrics: bounce rate, conversion rate, cart size, and page views. We
also monitored and analyzed user behavior for 6 weeks after the test ended, to gauge the
long-term impact, if any, of slow performance even after users begin to receive an
accelerated site.
Results
The results of the 200 ms delay weren’t significant, but the customer and I were both taken
by the dramatic impact of the 500 ms and 1000 ms slowdown. Our customer was blown
away that they were losing 3.5% percent of their conversions when their site was delayed
by just one second on a mobile device. This was a major epiphany for them, and it’s
already helped them change their business and how they view mobile.

Contd...
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I’m including this next graph to reinforce the connection between load time and user
behavior.

Over the 12 weeks, you can see that, while the HTML delays were constant — 500 ms and
1000 ms — users’ reaction to these delays fluctuated. The drop in bounce rate ranged from
around –2% and –12% for users who experienced a 1000 ms delay, and 0% and –6% for
those who experienced a 500 ms delay. While the bounce rate may have varied, the one
thing that was constant was the fact that the behavior trends are strongly linear for both
groups, and the bounce rate for the 1000 ms group was consistently worse.
Finally, and most interestingly to me, we wanted to look beyond just the effect of delay in
the timeframe of the experiment. We know that slower pages have an immediate impact
on user behavior and customer satisfaction. We wanted to find out if there was any longterm impact on customer satisfaction.
So we looked at our traffic data for the 6 weeks immediately after the experiment —
specifically at the behavior of returning visitors. As any site owner will tell you, repeat
customers are the bread and butter of an e-commerce vendor. These are the people you
need to keep happy. If you look at the graph below, you can see that, even after the
experiment was over and the shoppers in the 500 ms and 1000 ms group started to be
served the same accelerated site as the baseline group, they were significantly less likely
to return to the site. By the end of the 6-week period, you can see that return traffic is
slowly improving as visitors seem to finally be recovering from their poor experience.
Contd...
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Conclusion
As I’ve already mentioned, these findings have been a huge revelation to the company
that owns this site. It’s had a major impact on how they’re tackling performance on their
mobile platform. The most important over-arching takeaways from this experiment were:
z

Mobile shoppers are now fully engaging with e-commerce sites in significant
enough numbers that we can analyze their behavior as a group.

z

Even a 500 ms delay has a major impact on metrics. For mobile sites, which can
suffer excruciating load times (the latest Keynote index is about 12 seconds), this is
a wake-up call that they need to take a hard-line approach to optimizing their pages.

z

The damage of poor performance is lasting.

Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://www.webperformancetoday.com/2011/11/23/case-study-slow-page-load-mobilebusiness-metrics/

9.6 Summary
z

The Internet is a network of networks which carries an extensive range of information
resources and services, such as the inter-linked hypertext documents of the World Wide
Web.

z

A web browser is a software application for retrieving, presenting and traversing
information resources on the World Wide Web.

z

We come across a document typically written in plain text along with formatting
instructions of Hypertext Markup Language. Such a page is called a webpage.

z

A set of related web pages served from a single web domain constitutes a website.

z

A website is hosted on at least one web server, accessible via a network such as the Internet
or a private local area network through an Internet address known as a Uniform Resource
Locator.
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z

Hyper Text Markup Language is the main markup language for creating web pages and
other information that can be displayed in a web browser.

z

A web page has headings that to inform the search engine of various page attributes.They
range from h1 to h6.

z

There are many kinds of html tags – head, body, title, etc.

z

Font tag is used when we need to specify the colours, size, font of the text on the web page.

z

Absolute URL is an independent address that points directly to the file you have looked
for. A relative URL points to a file/directory in relation to the present file/directory.

9.7 Keywords
Absolute URL: Absolute URL is an independent address that points directly to the file you have
looked for.
Empty Tag: Tag without a closing tag is known as an empty tag.
HTML: Hyper Text Markup Language (HTML) is the main markup language for creating web
pages and other information that can be displayed in a web browser.
Internet: The Internet is a network of networks which carries an extensive range of information
resources and services.
Relative URL: A relative URL points to a file/directory in relation to the present file/directory.
URL: URL is a specific string of characters that constitutes a reference to a resource.
Web Browser: It is a software application for retrieving, presenting and traversing information
resources on the World Wide Web.
Website: A website is a set of related web pages served from a single web domain.

9.8 Review Questions
1.

Explain the concept of HTML with example.

2.

Discuss the advantages and disadvantages of HTML.

3.

Illustrate the steps used to create a webpage.

4.

Describe the use of title tags and body tags in HTML.

5.

Describe the block oriented elements of HTML with examples.

6.

Elaborate the Character Formatting Tags in HTML.

7.

Make distinction between Ordered and Unordered lists in HTML.

8.

Illustrate the concept of Nested Order List with example.

9.

The length of the URL depends on the location of the document to which you’re linking.
Comment.

10.

Compare and contrast Absolute URL and Relative Task.

Answers: Self Assessment
1.
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Website

2.
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3.

Hyper Text Markup Language

4.

Headings

5.

Head

6.

Title

7.

<BR>

8.

Character formatting

9.

Font

10.

ordered list

11.

nested

12.

<ul>

13.

URL

14.

Absolute URL

15.

relative URL

Notes

9.9 Further Readings

Books

Jennifer Niederst Robbins, Learning Web Design: A Beginner’s Guide to HTML,
Graphics and Beyond.
Elisabeth Robson, Eric Freeman, Head First HTML with CSS & XHTML, O’Reilly
Media.

Online links

www.w3schools.com/html/
http://learn.shayhowe.com/html-css/terminology-syntax-intro
http://www.tn.gov/agriculture/marketing/Agritourism%20pdfs/LearnHTML
andCSS_AnAbsoluteBeginnersGuide.pdf
http://www.htmlquick.com/reference/tags.html
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Objectives
After studying this unit, you will be able to:
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z

Explain the concept of hypertext links in Web designing

z

Discuss the use of images in Web designing
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z

Create tables in Web designing

z

Define frames in Web designing

z

Explain forms in Web designing

Notes

Introduction
Web Design is an art of content presentation to an end user through World Wide Web. Website
utilizes multiple disciplines such as animation, graphics, interaction design and information
architecture. It is a form of electronic publishing. Everything about your website – including the
content, the way it looks, and the way it works – is determined by the website design. Web
design is a process of conceptualizing, planning, and building a collection of electronic files that
determine the layout, colors, text styles, structure, graphics, images, and use of interactive
features that deliver pages to your site visitors. Professional web design helps to make your
business appear credible online.

10.1 Hypertext Links
Hypertext is text that references other text that the reader can tour, return to and reference
usually by a mouse click, key press or by touching the screen. It can be used to describe tables,
images and other presentational content forms using links between information called Nodes.
Hypertext defines the structure of the World Wide Web. It enables an easy-to-use and flexible
connection and sharing of information over the Internet. Hypertext documents can either be
static (prepared and stored in advance) or dynamic (changing in response to user input). Static
hypertext is what we generally to cross-reference collections of data in documents, software
applications, or books on CDs.
Mostly hyperlinks cause the target document to replace the document being displayed. Others
are marked to cause the target document to open in a new window. Another way that the
hyperlinks work is using the concept of transclusion which is the inclusion of a document or part
of a document into another document by reference.
Figure 10.1: B is Transcluded in the Document A

Source: http://en.wikipedia.org/wiki/Transclusion
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To find information on the hundreds of millions of Web pages that exist, a search engine
employs special software robots, called spiders to build lists of the words found on Web sites.
When a spider is building its lists, the process is called Web crawling.
To create a hyperlink, we require the two elements:
z

The text, image or any other component that is to be converted to a hyperlink, so that
when the user clicks on it, some other web page or some other portion of the same web
page opens up.

z

The URL (address) of the web page to be opened by the link. Any text, image or figure in
a web page may be converted to a hyperlink.

Did u know? Googlebot is the name of Google’s Web Crawler that enables its searches to
be super fast!

Figure 10.2: Hyperlinks

Source: http://bid.ankara.edu.tr/yardim/www/guide/guide.02.html

There are two types of Hyperlinks which are discussed below.

10.1.1 Implicitly Anchored Hyperlink
It is the link that opens some other web page in the web browser when clicked by the user. An
anchor refers to the position in the target document that the visitor will see as a result of clicking
on the link.
Example:
<A name=”coffee” href=” http://somesitename/imagename.png”>Coffee</A>
A tag is used to create hyperlinks. The implicitly anchored hyperlinks require the HREF attribute
which is used to specify the URL of the web page to be opened by the hyperlink.
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10.1.2 Explicitly Anchored Hyperlink

Notes

It is the link that opens up portion or section of the same web page when clicked. This type of
hyperlinks is particularly useful when a web page is too lengthy or has various sections. In these
links we use the ‘name’ attribute instead of the href attribute. The value of the name attribute
becomes a label that identifies a location to which a hyperlink can point.
Example:
<a href=”#C4">See also Chapter 4.</a>

The above link when clicked opens up Chapter 4 available on the same document which is
shown below:
<h2><a id=”C4">Chapter 4</a></h2>
<p>This chapter explains ba blab la</p>

10.1.3 Why Links Fail?
You might have seen an error message like the one shown in the figure 10.3 when you click on
a hyperlink.
Figure 10.3: Error

Source: http://www.404errorpages.com/

This error message could be of one of the following two types:
z

The first type of error message tells you that the file could not be found. This means that
the URL doesn’t points to the file you wanted. This can occur when the URL mentioned
was incorrect, the owner of the file targeted by the URL has moved the file to a different
location or the file does not exist any longer.
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z

The second error message says that the URL does not have a DNS entry. This means that
the server whose name appears in the URL could not be found by the browser. The name
that appears in the URL that identifies the server must be translated to its IP address by
requesting a name server. The reason for the error can be that the name servers on the
Internet have no IP address for the given name or that the name sever does not respond
within a predetermined time.

10.1.4 Node
Hypertext can be seen as a network of nodes. A node is a collection of data organized around a
specific topic. This node is linked to another node, forming a network. Node is a fundamental
unit of hypertext. Other synonyms for node include frame, work space, card and lexia. On the
World Wide Web, a node is simply termed a Web page.

10.1.5 Link
Links connect related concepts or nodes. They can be bidirectional thus facilitating backward traversals.
They are anchored in at their departure point to provide users with some explicit object to
activate in order to follow the link. The destination point is reached by activating the anchor.
Links may have other characteristics such as name, author, creation date and access rights.

10.1.6 Semantic Network
It is a network which represents semantic relations between concepts. This is often used as a
form of knowledge representation. They support of semantic typing of links.
Example: The relationship between “cat” and “mamma;” might be described as “is A”.
Figure 10.4: A,B,C,D are the Nodes of a Semantic Network
Joined by the Arrows called Links

Source: http://jrdodds.blogs.com/blog/2005/08/hypertext_and_a.html

Self Assessment
Fill in the blanks:
1.
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…………………… is text that references other text that the reader can tour, return to and
reference usually by a mouse click, key press or by touching the screen.
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2.

An …………………… refers to the position in the target document that the visitor will see
as a result of clicking on the link.

3.

…………………… connect related concepts or nodes.

Notes

10.2 Images
In order to make a web page more attractive and clear we often make use of images.

The HTML Image Tag
The image tag is used to add an image to a web page. This can be done as follows:
<img src=”image1.jpg” alt=”coffee”>

The src attribute informs the browser which image is to be placed and where is it located. The alt
attribute on the other hand displays the text defined in it when the image doesn’t load on the
webpage.
Images are not technically inserted into an HTML page but are linked to HTML pages. The
<img> tag creates a holding space for the referenced image.
To link an image to another document, simply nest the <img> tag inside <a> tags.

10.2.1 Size Attributes
The size attributes define the width and height of the image as pixels. These are optional attributes
and they help the browser arrange the page efficiently.
Example:

<html>
<body>

<img src=”smiley.gif” alt=”Smiley face” width=”42" height=”42">

</body>
</html>

Output:

10.2.2 Resizing the Image
We can change the size of an image by setting different values for its height and width attributes.
This does not affect the image file itself, just the way it is displayed in the page.

LOVELY PROFESSIONAL UNIVERSITY

219

Graphic Tools

Notes

If you do not know the height and width of an image, choose any one of the options given
below:
z

Import the image into any graphics program and select “Image Size” from the menu.

z

Open the image files in a browser, right-click the image, then select “Properties”.

Example: <img src=”http://www.echoecho.com/rainbow.gif” width=”60" height=”60">
This tag will cause my picture to look like figure 10.5:
Figure 10.5: Before Resizing

Source: http://www.echoecho.com/htmlimages03.htm

<img src=”http://www.echoecho.com/rainbow.gif” width=”120" height=”120">

Changed size dimensions make my image look like figure 10.6.
Figure 10.6: After Resizing

Source: http://www.echoecho.com/htmlimages03.htm

10.2.3 Alt and Title Tags
The Alt attribute is designed to be an alternative text description for images. Alt text displays
before the image is loaded in the browser. Alt is a required element for images and can only be
used for image tags because its specific purpose is to describe images.
In contrast, you can use the Title attribute for just about any page element like links, tables,
individual table rows, and other structural HTML elements.

Did u know? If both attributes are specified, the title tag will override the alt tag.
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Figure 10.7: Alt Tag

Source: http://www.dezinerobotics.com/seo-checklist-for-developers/when-mousing-over-an-image-thealt-tag-will-appear/

If no alt or title tag is specified, the results vary depending on the browser and user settings.
Some will show nothing, some will show the file name.

10.2.4 Spacing Attributes
If we need to add a spacing between the image and surrounding text, we can do so by defining
vertical and horizontal space as shown below:
Example: <IMG SRC=”pumpkin.gif” ALT=”picture of a pumpkin” HEIGHT=100
WIDTH=100 ALIGN=LEFT>
Figure 10.8: Before hspace

Source: http://www.htmlcodetutorial.com/images/_IMG_HSPACE.html
<IMG SRC=”pumpkin.gif”
HSPACE=50 ALIGN=LEFT>

ALT=”picture

of

a

pumpkin”

HEIGHT=100

WIDTH=100

Figure 10.9: After hspace

Source: http://www.htmlcodetutorial.com/images/_IMG_HSPACE.html
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10.2.5 Alignment
An image can be aligned using the <align> tag. The alignment options available are – left, right,
top, middle, bottom, absmiddle, absbottom, baseline and texttop.
Example:
<img src=” pumpkin.gif” align=”right”>

This picture is right aligned.
Figure 10.10: After Alignment

Source: http://www.htmlcodetutorial.com/images/_IMG_HSPACE.html

10.2.6 Border Size
The border attribute places a border around the image.
<img src=”image.jpg” border=”1">

Notes When the image is used as a hyperlink, a 1-pixel border is applied automatically.

Self Assessment
Fill in the blanks:
4.

The …………………… attribute informs the browser which image is to be placed and
where is it located.

5.

The …………………… attribute is designed to be an alternative text description for images.

6.

The size attributes define the width and height of the image as ……………………

10.3 Tables
A table consists of head, rows, columns and cells. Data can be put in the table using the various
tags. Rows are horizontal and Columns are vertical. It makes the data much clearer to understand
and maintain.
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Figure 10.11: Table Structure

Notes

Source: http://reference.sitepoint.com/css/tableformatting

10.3.1 Main Tags of Table
The basic tags used to make a table are:
<TABLE>: This tag is used to tell the browser that “this is a table”, along with some attributes
like size, border width and a few other things.
<TH>: This is used to give a table heading
<TD>: This is used to enter table data
<TR>: This gives row breaks
Example:
<html>
<body>
<tr>
<th>Month</th>
<th>Savings</th>
</tr>
<tr>
<td>January</td>
<td>$100</td>
</tr>
<tr>
<td>February</td>
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<td>$80</td>
</tr>
</table>
</body>
</html>

Output

The table tag includes many more attributes. Some of them are discussed below:

Borders
They are used to provide borders to a table.
Example: <TABLE BORDER=2>

Table Size
This attribute controls the size of the table.
Example: <TABLE WIDTH=50%>

Alignment
You can control the position of data in the table cell.
Example: <TD ALIGN=”center”>HTML</TD>

Images in Table
Images can also be used and manipulated in a table data cell.

!
Caution Save the image in the folder where you have placed your table HTML file.

Example: <TD ><IMG SRC=”HTML.gif’ WIDTH=50 HEIGHT=50 </TD>
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Cellpadding and Cellspacing
Cellpadding specifies the space between the cell wall and the cell content.
Example: A
<html>
<body>
<p>Table without cellpadding:</p>
<table border=”1">
<tr>
<th>Month</th>
<th>Savings</th>
</tr>
<tr>
<td>January</td>
<td>$100</td>
</tr>
</table>

<p>Table with cellpadding:</p>
<table border=”1" cellpadding=”10">
<tr>
<th>Month</th>
<th>Savings</th>
</tr>

<tr>
<td>January</td>
<td>$100</td>
</tr>
</table>

</body>
</html>
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Cellspacing controls the space between table cells.
Example:
<html>
<body>

<p>Table without cellspacing:</p>
<table border=”1">
<tr>
<th>Month</th>
<th>Savings</th>
</tr>
<tr>
<td>January</td>
<td>$100</td>
</tr>
</table>

<p>Table with cellspacing:</p>
<table border=”1" cellspacing=”10">
<tr>
<th>Month</th>
<th>Savings</th>
</tr>
<tr>
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<td>January</td>
<td>$100</td>
</tr>
</table>

</body>
</html>

BGCOLOR for Table Notes
It specifies the background color for a table.
Example: <TABLE BGCOLOR= “#FFCC66”>
<TABLE BGCOLOR= “red”>
<TABLE BGCOLOR= “rgb(x,y,z)”>

Colspan and Rowspan
It is possible to have data to be in more than one cell, either horizontally or vertically. These tags
are the Colspan and Rowspan tags. Colspan attribute defines the number of columns a cell
should span and Rowspan attribute defines the number of rows a cell should span.
Example: <td colspan=”number” rowspan=”number”>

Nested Table
We can create a table within another table. Let us show this through an example.
Example:
<table>
<tr>
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<td>First cell in first table. The cell to the right has the second table
in it.</td>
<td>
<table>
<tr><td>nested table</td></tr>
<tr><td>nested table</td></tr>
</table>
</td>
</tr>
</table>

Colgroup
This tag specifies a group of one or more columns in a table for formatting. It is useful for
applying styles to entire columns, instead of repeating the styles for each cell, for each row.

Notes The <colgroup> tag must be a child of a <table> element, after any <caption>
elements and before any <thead>, <tbody>, <tfoot>, and <tr> elements.
Example: A
<html>
<body>
<table border=”1">

<colgroup>
<col span=”2" style=”background-color:red”>
<col style=”background-color:yellow”>
</colgroup>

<tr>
<th>ISBN</th>
<th>Title</th>
<th>Price</th>
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</tr>

<tr>
<td>3476896</td>
<td>My first HTML</td>
<td>$53</td>
</tr>
<tr>
<td>5869207</td>
<td>My first CSS</td>
<td>$49</td>
</tr>
</table>

</body>
</html>

Self Assessment
Fill in the blanks:
7.

…………………… tag is used to enter table data.

8.

…………………… specifies the space between the cell wall and the cell content.

9.

…………………… tag specifies a group of one or more columns in a table for formatting.

10.4 Frames
Frames divide a browser window into several pieces or panes, each pane containing a separate
HTML document. You can load and reload single panes without having to reload the entire
contents of the browser window. Also we can prevent typing common content in multiple
pages. A collection of frames in the browser window is known as a frameset.
The window is divided up into frames in a similar pattern to the way tables are organized: into
rows and columns. The simplest of framesets might just divide the screen into two rows, while
a complex frameset could use several rows and columns. But there are still few browsers who do
not support frame technology.
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!
Caution Use frames with care. Too many of them can make it very tough for the users as
they tend to get lost.

Frame has the following properties:
z

It loads the URL independently of other frames.

z

It can be accessed via the name given to it and so allows HTML contents to be targeted by
other URL’s.

z

It resizes itself dynamically in response to changes in the size of the visible area.

10.4.1 Tags for the Frame
There are two major tags available for the use of frames. We will discuss them in detail below.

Frameset
The <frameset> tag replaces the <body> element in frameset documents. It defines how to
divide the window into frames. Each frameset defines a set of rows or columns. If you define
frames by using rows then horizontal frames are created else with columns vertical farms are
created. The values of the rows/columns indicate the amount of screen area each row/column
will occupy. Each frame is created by <frame> tag and it defines which HTML document to put
into the frame.
Let us now illustrate the use of the frameset and frame tags.
<html>
<head>
<title>Frames example</title>
</head>
<frameset rows=”10%,80%,10%”>
<frame src=”/html/top_frame.htm” />
<frame src=”/html/main_frame.htm” />
<frame src=”/html/bottom_frame.htm” />
<body>
Frames
</body>
</frameset>
</html>

Now create three HTML files called top_frame.htm, main_frame.htm and bottom_frame.htm to be
loaded into three frames with some content.
Following are important attributes of <frameset> tag:
z

cols: specifies how many columns are contained in the frameset and the size of each
column. You can specify the width of each column in one of four ways:
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Example: To create three vertical frames, use cols=”100, 500, 100".
A percentage of the browser window.



Example: To create three vertical frames, use cols=”10%, 80%, 10%”.
Using a wildcard symbol.



Example: To create three vertical frames, use cols=”10%, *,10%”. In this case wildcard
takes remainder of the window.
As relative widths of the browser window.



Example: To create three vertical frames, use cols=”3*,2*,1*”.
z

rows: attribute works just like the cols attribute and can take the same values, but it is used
to specify the rows in the frameset.
Example: To create two horizontal frames, use rows=”10%, 90%”.

You can specify the height of each row in the same way as explained above for columns.
z

border: attribute specifies the width of the border of each frame in pixels.
Example: Border= “5.”

z

frameborder: specifies whether a three-dimensional border should be displayed between
frames. This attribute takes value either 1 (yes) or 0 (no).
Example: Frameborder= ”0” specifies no border.

z

framespacing: specifies the amount of space between frames in a frameset. This can take
any integer value.
Example: Framespacing= “10” means there should be 10 pixels spacing between each

frames.

Frame Tag
The <frame> element indicates what goes in each frame of the frameset. It should always carry
one attribute, src to indicate the page that should represent that frame.
Frame tag consists of certain attributes. Some of them are described below:
z

src: indicates the file that should be used in the frame. Its value can be any URL.
Example: src=”/html/top_frame.htm” will load an HTML file available in html directory.

z

name: attribute allows you to give a name to a frame. It is used to indicate which frame a
document should be loaded into.
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z

frameborder: attribute specifies whether or not the borders of that frame are shown; it
overrides the value given in the frameborder attribute on the <frameset> element if one
is given, and the possible values are the same. This can take values either 1 (yes) or 0 (no).

z

marginwidth: allows you to specify the width of the space between the left and right of the
frame’s borders and the frame’s content. The value is given in pixels.
Example: marginwidth=”10".

z

marginheight: allows you to specify the height of the space between the top and bottom of
the frame’s borders and its contents. The value is given in pixels.
Example: marginheight=”10".

z

noresize: By default you can resize any frame by clicking and dragging on the borders of
a frame. The noresize attribute prevents a user from being able to resize the frame.
Example: noresize=”noresize”.

z

scrolling: controls the appearance of the scrollbars that appear on the frame. This takes
values either “yes”, “no” or “auto”.
Example: Scrolling=”no” means it should not have scroll bars.

z

longdesc: allows you to provide a link to another page containing a long description of the
contents of the frame.
Example: longdesc=”framedescription.htm”

Nested Framesets
We can also have a frameset within another frameset.
Let us illustrate this with an example.
<html>
<frameset rows=”50%,50%”>
<frame src=”frame_a.htm”>
<frameset cols=”25%,75%”>
<frame src=”frame_b.htm”>
<frame src=”frame_c.htm”>
</frameset>
</frameset>
</html>
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Figure 10.12: Nested Framesets

Notes

Source: http://www.w3schools.com/html/tryit.asp?filename=tryhtml_frame_mix

Non-Frames Browsers
One of the drawbacks of frames is that some browsers do not support frames. HTML provides an
alternative for these browsers by using the <noframes> tag. The <noframes> section is normally
placed before closing the <frameset> tag.
Example:
<frameset cols=”25%,50%,25%”>
<frame src=”frame_a.htm”>
<frame src=”frame_b.htm”>
<frame src=”frame_c.htm”>
<noframes>Sorry, your browser does not handle frames!</noframes>
</frameset>

Hyperlinks in Frames
One of the advantages of frames is the ability to click on a hyperlink in one frame and change the
document in another frame. When you activate a hyperlink in a frame document, you need to
specify not only what document to load but also where (i.e. in which frame) to put it. The frame
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where the new document is supposed to appear is called the target. There are two types of
targets:
z

Explicit: the name assigned to a frame in the frameset.

z

Implicit: a name which describes the target frame’s relationship to the frame containing
the original hyperlink.

Syntax: <link target=”_blank or _self or _parent or _top or framename”>
_blank - Load in a new window
_self - Load in the same frame as it was clicked
_parent - Load in the parent frameset
_top - Load in the full body of the window
framename - Load in a named frame

10.4.2 Creating a Site using Frames
The concept of creating a site using frames is discussed below.

Inline Frames
An inline frame is used to embed another document within the current HTML document. For
this it makes use of the <iframe> tag in HTML.

Notes To deal with browsers that do not support <iframe>, add a text between the opening
<iframe> tag and the closing </iframe> tag.
The <iframe> tag has the attributes listed below:
z

Name: Specifies the name of an <iframe>

z

Height: Specifies the height of an <iframe> in pixels

z

Width: Specifies the width of an <iframe> in pixels

z

Scrolling: Specifies whether or not to display scrollbars in an <iframe>. It takes in three
value- yes, no and auto.

z

Frameborder: Specifies whether or not to display a border around an <iframe>. It contains
the values 0 or 1.

z

Align: Specifies the alignment of an <iframe> according to surrounding elements. It can
take five values- left, right, top, middle and bottom.

Task Create a website using the frames.
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Self Assessment
Fill in the blanks:
10.

A collection of frames in the browser window is known as a ……………………

11.

The …………………… element indicates what goes in each frame of the frameset.

12.

The frame where the new document is supposed to appear is called the ……………………

10.5 Forms
HTML forms are useful when we need to collect some data from the site visitor.
Example: Registration information: name, email address, credit card, etc.
Form contain many elements like text fields, text area fields, drop-down menus, radio buttons,
checkboxes, etc. which are used to take information from the user. Let us now discuss them in
detail.
Example: A
<form action=”back-end script” method=”posting method”>
form elements like input, textarea, etc.
</form>

10.5.1 Text Controls
To take text as the input from user HTML provides us with 3 kinds of text controls: text fields,
password fields and text areas.

Text Fields
There are actually three types of text input used on forms:
z

Single-line text input controls.

z

Password input controls

z

Multi-line text input controls

We will now elaborate on all of them.

Single-line Text Input Controls
They are created using an <input> element whose type attribute has a value of text.
Example: <form action=”/cgi-bin/hello_get.cgi” method=”get”> First name: <input
type=”text” name=”first_name” /> <br> Last name: <input type=”text” name=”last_name” />
<input type=”submit” value=”submit” /> </form>
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Following is the list of attributes for <input> tag.
z

type: Indicates the type of input control you want to create. This element is also used to
create other form controls such as radio buttons and checkboxes.

z

name: Used to give the name part of the name/value pair that is sent to the server,
representing each form control and the value the user entered.

z

value: Provides an initial value for the text input control that the user will see when the
form loads.

z

size: Allows you to specify the width of the text-input control in terms of characters.

z

maxlength: Allows you to specify the maximum number of characters a user can enter into
the text box.

Password Input Controls
This is also a form of single-line text input controls are created using an <input> element whose
type attribute has a value of password.
Example:
<form action=”/cgi-bin/hello_get.cgi” method=”get”>
Login :
<input type=”text” name=”login” />
<br>
Password:
<input type=”text” name=”password” />
<input type=”submit” value=”submit” />
</form>
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Multiple-Line Text Input Controls
If you want to allow a visitor to your site to enter more than one line of text, you should create
a multiple-line text input control using the <textarea> element.
Example:
<form action=”/cgi-bin/hello_get.cgi” method=”get”>
Description : <br />
<textarea rows=”5" cols=”50" name=”description”>
Enter description here...
</textarea>
<input type=”submit” value=”submit” />
</form>

Following is the detail of above used attributes for <textarea> tag:
z

name: The name of the control. This is used in the name/value pair that is sent to the
server.

z

rows: Indicates the number of rows of text area box.

z

cols: Indicates the number of columns of text area box.

Button
You can create clickable button in HTML using <input> tag. When you use this tag, the type of
button you create is specified using the type attribute.
The type attribute can take the following values:
z

submit: This creates a button that automatically submits a form.

z

reset: This creates a button that automatically resets form controls to their initial values.

z

button: This creates a button that is used to trigger a client-side script when the user clicks
that button.
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Example:
<form action=”http://www.example.com/test.asp” method=”get”>
<input type=”submit” name=”Submit” value=”Submit” />
<br /><br />
<input type=”reset” value=”Reset” />
<input type=”button” value=”Button” />
</form>

Submit and Reset Button
These are special buttons which can be created using <input> tag. When submit button is clicked
then Forms data is submitted to the back-end application. When reset button is clicked then all
the forms control are reset to default state.
Example:
<form action=”/cgi-bin/hello_get.cgi” method=”get”>
First name:
<input type=”text” name=”first_name” />
<br>
Last name:
<input type=”text” name=”last_name” />
<input type=”submit” value=”Submit” />
<input type=”reset” value=”Reset” />
</form>
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Task Try out other controls like checkboxes, radio buttons, etc. and create a student
registration form for a school.

Self Assessment
Fill in the blanks:
13.

HTML …………………… are useful when we need to collect some data from the site
visitor.

14.

…………………… input controls are created using an <input> element whose type attribute
has a value of text.

15.

You can create clickable button in HTML using …………………… tag.

Case Study

Responsive Web Design – Zee

L

ast week we launched the new Zee website – Zee is my company here in Brazil. We
did the site in a single page, presenting the company, our works and keeping the
focus on content and in a simple design. I decided to write this case study because
the main challenge we faced was to develop a totally responsive site, and since lately this
is a strong web subject, I decided to show how was the creative process of the new Zee
layout.
I know this matter is all around the web, but a definition about responsive design always
come handy:
Responsive Web Design (RWD) essentially indicates that a web site is crafted to use CSS3
media queries, an extension of the @media rule, with fluid proportion-based grids (which
use percentages and EMs instead of pixels), to adapt the layout to the viewing environment,
and probably also use flexible images. As a result, users across a broad range of devices
and browsers will have access to a single source of content, laid out so as to be easy to read
and navigate with a minimum of resizing, panning, and scrolling. - Wikipedia
Summarizing: 1 code, 1 CSS and a fluid and optimized layout to all devices.
This is not a tutorial about developing a responsive project, is a case study. But there are a
lot of articles and books about this, so here are a few references:·
z

Livro: Responsive Web Design, de Ethan Marcotte

z

Build a responsive site in a week: designing responsively – .net magazine

z

Responsive Web Design: What It Is and How To Use It – Smashing Magazine

z

Responsive Web Design Techniques, Tools and Design Strategies – Smashing
Magazine

z

A Primer on Responsive Design: From Content to Development – UX Magazine

Contd...
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Breakpoints
The first thing we did was to set the breakpoints, the amount of changes in the layout. It is
almost impossible to do a different design to all resolutions and devices available today,
so we decided the resolutions that would be the base of the design and kept a fluid design
between these resolutions. In our case we are using the following breakpoints: 640px,
1024px e 1280px (remembering that 1280 is the width limit).
Mobile first
As we will have 3 base resolutions, we will have 3 different layouts. With this comes a
common question: which layout I should pick to start? Starting with mobile is much more
interesting and recommended, because this way we can keep the focus on important
things so we can add other elements as the resolutions increase. There are a lot of articles
about this issue and I suggest a really good book from A Book Apart called Mobile First,
Luke Wroblewksi.
Layouts
Now that we created the information architecture it is time to create the layouts. This part
depends on your methodology, I like to do wireframes on paper, because this way I can
correct and try things faster. After defining the base of the architecture is time to go to the
layout. A lot of things change in the moment we create the layout so I don’t see a productivity
advantage in investing time on detailed wireframes.
Media Queries
Layouts are ready, time to work to make some magic happen. In terms of code I used
HTML5 Boilerplate and jQuery. But what actually make the layouts break between
resolutions is the media querie. CSS3 has this fantastic property and the documentations
about this is huge on w3c.org, but to simplify the explanation, here I used basically the
width definition to do the breakpoints.
Widths in “%”. Texts in “em”.
The big thing here is, apart from the media queries, to work with the widths in % because
this keep the fluidity between breakpoints. (Be prepared because in this part math will
take over your brain!). And the texts too, always in “em” instead of pixels.
Result
You can check the result on the website: zee.com.br. In case you can’t test in other devices
use this link: responsive.is.
And remember that Abduzeedo is also responsive! You can try it on iPhone, iPad, Android
or even on this link I shared to see how the site behaves.
Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://abduzeedo.com/responsive-web-design-case-study-zee
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10.6 Summary
z

Hypertext can be used to describe tables, images and other presentational content forms
using links between information called Nodes.

z

Hyperlinks work using the concept of transclusion which is the inclusion of a document
or part of a document into another document by reference.

z

There are two types of Hyperlinks: Implicitly Anchored Hyperlink and Explicitly Anchored
Hyperlink.

z

HREF attribute which is used to specify the URL of the web page to be opened by the
hyperlink.

z

Semantic network is a network which represents semantic relations between concepts.

z

The src attribute in <image> tag informs the browser which image is to be placed and
where is it located. The alt attribute on the other hand displays the text defined in it when
the image doesn’t load on the webpage.

z

Title attribute for just about any page element like links, tables, individual table rows, and
other structural HTML elements.

z

The alignment options available are – left, right, top, middle, bottom, absmiddle,
absbottom, baseline and texttop.

z

Frames divide a browser window into several pieces or panes, each pane containing a
separate HTML document.

z

HTML forms are useful when we need to collect some data from the site visitor.

10.7 Keywords
Hypertext: It can be used to describe tables, images and other presentational content forms using
links between information called Nodes.
HREF: It is the attribute which is used to specify the URL of the web page to be opened by the
hyperlink.
Links: They connect related concepts or nodes in a semantic network.
Web Crawling: When a spider is building its lists, the process is called Web crawling.
Links: Links connect related concepts or nodes.
Cellpadding: Cellpadding specifies the space between the cell wall and the cell content.
Cellspacing: Cellspacing controls the space between table cells.
Frames: Frames divide a browser window into several pieces or panes, each pane containing a
separate HTML document.

10.8 Review Questions
1.

Make distinction between implicitly and explicitly anchored hyperlinks.

2.

Describe the concept of creating a hyperlink.

3.

Explain how to add an image to a web page.

4.

Compare and contrast alt and title tag in an HTML image.
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5.

Discuss the tags used to make a table. Illustrate with example.

6.

Illustrate the use of Colgroup tag with example.

7.

What are frames? Discuss the tags used for frames.

8.

Explain the types of text input used on forms.

9.

Illustrate with example the use of the frameset tag in HTML frames.

10.

Explain the concept of the Semantic Network.

Answers: Self Assessment
1.

Hypertext

2.

Anchor

3.

Links

4.

src

5.

Alt

6.

Pixels

7.

<TD>

8.

Cellpadding

9.

Colgroup

10.

Frameset

11.

<frame>

12.

Target

13.

forms

14.

Single-line text

15.

<input>

10.9 Further Readings

Books

Ian Lloyd, Build your own Web Site the Right Way using HTML & CSS.
Jennifer Robbins, Learning Web Design.

Online links

http://www.roseindia.net/services/webdesigning/corporatewebsitedesign/
What-is-Web-designing.shtml
http://www.tutorialspoint.com/html/html_frames.htm
http://www.echoecho.com/htmlframes.htm
http://www.tizag.com/htmlT/frames.php
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CONTENTS
Objectives
Introduction
11.1 Designer Panel and Toolbar
11.1.1

Creating a New Page

11.1.2

Dreamweaver Window

11.2 HTML Table Fundamentals
11.2.1

Rows

11.2.2

Cells

11.3 Table Properties
11.3.1

Inserting Tables in Dreamweaver

11.4 Navigating with Anchors
11.4.1

Named Anchor

11.4.2

Moving within the Same Document

11.4.3

Using Named Anchors in a Different Page

11.4.4

Creating Null Links

11.5 Frameset
11.5.1

Opening a Web Page into a Frame

11.5.2

Setting Borders

11.5.3

Deleting Frames

11.5.4

Targeting Frame Content

11.6 Summary
11.7 Keywords
11.8 Review Questions
11.9 Further Readings

Objectives
After studying this unit, you will be able to:
z

Discuss the designer panel and toolbar

z

Explain html table fundamentals

z

Define table properties

z

Discuss navigating with anchors

z

Explain frameset
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Introduction
Dreamweaver is a Web design software program that can be used to create pages for display on
the World Wide Web. You can use Dreamweaver to create HTML pages, as well as files in these
formats: CSS, XML, ASP, PHP, JSP and more. It is the most popular Web design program among
professional Web designers. Dreamweaver was originally developed by Macromedia in 1997
and was maintained by them until Macromedia was acquired by Adobe Systems in 2005. It
provides a visual WYSIWYG (What You See Is What You Get) editor and a code editor with
standard features such as syntax highlighting, code completion, and code collapsing as well as
more sophisticated features such as real-time syntax checking and code introspection for
generating code hints to assist the user in writing code.

11.1 Designer Panel and Toolbar
We will now discuss the basics of Dreamweaver step by step.

11.1.1 Creating a New Page
To create a new page follow the steps below:
1.

Click on the ‘File’ option

2.

Select ‘New’ from the dropdown menu

3.

Select ‘Basic Page’ and ‘HTML’ options from the ‘New Document’ dialogue Box

4.

Choose ‘Create’ tab

11.1.2 Dreamweaver Window
The main window of Dreamweaver looks like the one provided in the figure below.
Figure 11.1: Dreamweaver Window

Source: http://etutorials.org/Macromedia/Dream+Weaver+Online+Help/Dreamweaver+Basics/
Exploring+the+Workspace/About+the+Dreamweaver+workspace/The+workspace+layout/
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Page Properties
This can be used to make changes to an entire page. To open the Properties dialog box, select
Page Properties from the Modify menu. It consists of various properties like title, background
image, background color, text color and links.
Figure 11.2: Page Properties Dialog Box

Source: http://flylib.com/books/en/2.836.1.48/1/

Insert Bar and Properties Inspector
The Insert Toolbar provides many buttons that insert elements into your Web page.
Figure 11.3: Insert Bar

Source: http://f-source.com/flash-menu/business-style/

The Properties Inspector, located at the bottom of the Dreamweaver workspace, enables you to
view the properties associated with the object or text that is currently selected in the Document
Window.
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Figure 11.4: Properties Inspector

Source: http://f-source.com/flash-menu/business-style/

If they are not visible on your screen, click on ‘Windows’ and check on ‘Insert’ and ‘Properties’
in the drop down menu or press F4 on your keyboard.

Document Toolbar
The Document toolbar contains buttons that let you toggle between different views of your
document quickly: Code, Design, and a split view that shows both Code and Design view. The
toolbar also contains some common commands and options related to viewing the document
and transferring it between the local and remote sites.
Figure 11.5: Document Toolbar

Source: http://etutorials.org/Macromedia/Dream+Weaver+Online+Help/Getting+Started+with+
Dreamweaver/Dreamweaver+Basics/Getting+to+know+the+Dreamweaver+8+workspace/The+
Document+toolbar/

Page Title
At the top of the page bar is the page title. If you have more than one file open, this allows you
to select which file to edit. If you haven’t saved the file, it will say “Untitled document”. The
number is how many untitled documents you’ve opened in this session.

Task Compare and contrast Insert toolbar and Document toolbar.
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Self Assessment
Fill in the blanks:
1.

The …………………… Toolbar provides many buttons that insert elements into your Web
page.

2.

The …………………… toolbar contains buttons that let you toggle between different views
of your document quickly.

3.

The …………………… enables you to view the properties associated with the object or text
that is currently selected in the Document Window.

11.2 HTML Table Fundamentals
You may want to consider using HTML tables in your website. In addition to creating HTML
tables to present data in rows and columns, you can also create HTML tables to organize
information on your web page.
The basic structure of an HTML table consists of the following tags:
z

Table tags: <TABLE> </TABLE>

z

Row tags: <TR> </TR>

z

Cell tags:

<TD> </TD>

Constructing an HTML table consists of describing the table between the beginning table tag,
<TABLE>, and the ending table tag, </TABLE>. Between these tags, you then construct each row
and each cell in the row. To do this, you would first start the row with the beginning row tag,
<TR>, and then build the row by creating each cell with the beginning cell tag, <TD>, adding the
data for that cell, and then closing the cell with the ending cell tag, </TD>. When you finish all
of the cells for a row, you would then close the row with the ending row tag, </TR>. Then, for
each new row, you would repeat the process of beginning the row, building each cell in the row,
and closing the row.

Did u know? You can also insert a table directly in your code by choosing Insert! Table
Objects! Table or by clicking the Table Tag button in the Tables category of the Insert panel
in the code view.

Code for an HTML Table:
<table border=”1">
<tr title=”You are looking at Row 1" bgcolor=”silver”>
<td>Row 1 Cell 1</td>
<td>Row 1 Cell 2</td>
</tr>
<tr title=”You are looking at Row 2" bgcolor=”aqua”>
<td>Row 2 Cell 1</td>
<td>Row 2 Cell 2</td>
</tr>
</table>
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Source: http://www.tizag.com/htmlT/tables.php

11.2.1 Rows
A table can contain an infinite number of table rows. Each table row is essentially a table
element itself, with an opening and closing tag <tr> </tr>. If you are working directly in Code
view, you can insert a table row by choosing Insert! Table Objects ! TR or by clicking the Table
Row button in the Tables category of the Insert panel.

11.2.2 Cells
Table columns or cells are also considered child elements of HTML tables. Like table rows, an
HTML table may contain an infinite number of table data cells <td> </td>. In Code view, you
can insert a <td>…</td> pair to define a single table cell by choosing Insert !Table Objects ! TD
or by clicking the Table Data button in the Tables category of the Insert panel.

The HTML Table with Column Spanning
<table border=”1">
<tr>
<th>Month</th>
<th>Savings</th>
</tr>
<tr>
<td>January</td>
<td>$100</td>
</tr>
<tr>
<td>February</td>
<td>$100</td>
</tr>
<tr>
<td colspan=”2">Sum: $180</td>
</tr>
</table>
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Source: http://www.w3schools.com/tags/tryit.asp?filename=tryhtml_td_colspan

Column and Row Headings
The <th> tag defines a header cell in an HTML table. An HTML table has two kinds of cells:
header cells – contains header information (created with the <th> element) and standard cells –
contains data (created with the <td> element).
The <caption> tag defines a table caption. It must be inserted immediately after the <table> tag.
You can specify only one caption per table.

Notes By default, the table caption will be center-aligned above a table. You can change
this using the properties “text-align” and “caption-side”.

Self Assessment
Fill in the blanks:
4.

Each table row is essentially a table element itself, with an opening and closing tag
……………………

5.

Table columns or cells are also considered …………………… elements of HTML tables.

6.

The …………………… tag defines a header cell in an HTML table.

11.3 Table Properties
The table consists of many properties using which we can customize it as per our need. Some of
the properties are discussed below:

11.3.1 Inserting Tables in Dreamweaver
Tables are an excellent method of presenting certain types of information on web pages, especially
that content that is best represented in rows or columns.

Adding a Table to the Page
To create a table, use the Insert bar or the Insert menu. You can add text and images to the
table in the same way that you add text and images outside of a table. In the Design view
of the Document window, place the insertion point where you want the table to appear. Select
Insert->Table from the Insert menu or choose the Table button in the Common category of the
Insert Bar.
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Figure 11.6: Inserting a Table

Source: http://www.guidesandtutorials.com/dreamweaver_inserting_tables.html

The Common category on the Insert Bar - Locate the Insert Table button.
Figure 11.7: Inserting a Table from the Insert Bar

Source: http://www.guidesandtutorials.com/dreamweaver_inserting_tables.html

The Insert Table Dialog Box appears. You can navigate from box to box by using the Tab key.

250

LOVELY PROFESSIONAL UNIVERSITY

Unit 11: Dreamweaver

Figure 11.8: Insert Table Dialog Box

Notes

Source: http://www.guidesandtutorials.com/dreamweaver_inserting_tables.html

Complete the dialog box by telling Dreamweaver how many rows and columns you want in
your table. In the Table Width text box, enter a number that will either be in pixels or a percentage
of the page width, then choose the units from the pop-up menu to the right of the text box.
You can also specify other properties. For Border thickness, enter a number in the text box for
the size of the border, in pixels, that will be displayed between cells. For Cell padding, enter a
figure in the text box for the amount of space, in pixels, between the content in the cells and the
cell border around it. For Cell spacing, enter a figure in the text box for the amount of space, in
pixels, between cells.
You can also tell Dreamweaver whether or not the table should include a Header row or column
and where it should be located: Left, Top, or Both.

!
Caution The icons for the headers tell you what each choice looks like.
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Click OK and the table appears in the document.
Figure 11.9: Table Inserted

Source: http://www.guidesandtutorials.com/dreamweaver_inserting_tables.html

Dreamweaver shows green dimension lines above the table to tell you the width of the table in
pixels. The top line shows the width of the table in pixels. Each column shows the width of the
column in pixels if you have set a fixed width for the column. Columns with widths relative to
the table width show green lines without pixel values. To insert a table within a table, place the
insertion point inside a cell of an existing table, then choose either of the table insertion methods:
Insert Table from the Insert Menu or Click on the Table icon on the Insert Bar.

Modifying Tables
Using the he Properties Inspector located at the bottom of the Dreamweaver workspace you can
view and edit the properties associated with the table that is currently selected in the Document
Window.

Selecting Table Elements
You can select an entire table; one or more rows and columns; an individual cell or multiple cells
in order to work effectively with the table. When you move your pointer over a table, row,
column, or cell, Dreamweaver will highlight all the cells in that selection. If you click on the
edge of the table, you will select it. You can tell that a table has been selected because it has a
thick border around its edges with resize handles.

Selecting in Expanded Tables Mode
Dreamweaver offers us many different view modes while working with tables. You can view
these modes in the by selecting the View menu, and then the Table mode option. Inside this
option we can choose the Standard mode, the Expanded Tables mode, or the Layout mode.
Expanded Tables mode adds temporary filling and cell space to a table. It also increases the table
borders to make its editing easier. This mode can be used to select tables elements or to have the
insertion point in the required way, but in this mode we don’t see how the page will be shown.
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Expanded Tables mode is best used on an as-needed basis, and you can quickly toggle between
it and standard mode by pressing F6 (Option+F6).

Notes

Selecting an Entire Table
There are several ways you can select an entire table at once. Click in the upper left corner of the
table, anywhere on the top or bottom edge, or on a row or column border. The pointer changes
to a table grid icon when you can select the table. When a table is selected, Selection handles
appear on the table’s lower and right edges. See the small black boxes in the diagram below.
Figure 11.10: Selecting a Table

Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_selecting_tables.html

Another way to select a table is to click in a table cell, then select the <table> tag in the tag
selector at the lower-left corner of the Document window.
Figure 11.11: Selecting a Table

Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_selecting_tables.html
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You can also click in a table cell, then select Modify, Table, Select Table.
Figure 11.12: Selecting a Table

Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_selecting_tables.html

Task Illustrate the different methods used to select a table.

Selecting a Row or Column
You can select an individual row or column or multiple rows or columns. To select individual or
multiple rows or columns, position the pointer to point to the left edge of a row or the top edge
of a column. You’ll see a small black arrow to indicate the row or column that you are about to
select. When you click on the row or column, it will be selected as indicated by the black
selection lines around it.
Figure 11.13: Selecting a Row

Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_selecting_tables.html
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Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_selecting_tables.html

Do the same to select columns. To select a single column, you can click the column header menu
(the green arrow), and then choose Select Column from the pop-up menu.
Figure 11.15: Selecting a Columns

Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_selecting_tables.html

Selecting Cells
To select a single cell, click in the cell, then select the <td> tag in the tag selector at the lower-left
corner of the Document window.
Figure 11.16: Selecting a Cell

Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_selecting_tables.html
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To select multiple adjacent cells, you can click in one cell and drag from one cell to another,
highlighting and selecting the adjacent cells as you go.

Editing a Table’s Contents
We can modify the contents of a table using the steps given below:
1.

Select a pair of cells, say the bottom left two; look for Properties Inspector button for
“Merge selected...” (looks like two boxes with a dotted line between) and click it; the cells
are merged.

2.

Place your cursor in any other cell; look for Properties Inspector button for “Splits cell...”
(looks like a sideways H) and click it.

3.

Choose Rows or Columns in the Split Cell dialog box and click OK.

4.

The cell is subdivided.

In this way, very complex information layouts can be composed.

Moving Through a Table
You can move between the table cells using the Tab key. To go backward, cell to cell, press
Shift+Tab. When you are in the last cell of a table and press the Tab key, a new row is added with
the same column configuration as the current one. The Home and End keys take you to the
beginning and end, respectively, of the cursor’s current line. You can go to the top of the current
cell by pressing Ctrl+Home (Command+Home) and its bottom by pressing Ctrl+End
(Command+End). Use the arrow keys to navigate from cell to cell.

Self Assessment
Fill in the blanks:
7.

For ……………………, enter a figure in the text box for the amount of space, in pixels,
between cells.

8.

Dreamweaver shows green dimension lines above the table to tell you the width of the
table in ……………………

9.

…………………… mode adds temporary filling and cell space to a table.

11.4 Navigating with Anchors
Dreamweaver makes it easy to create anchors for your page. An anchor is a link to a specific
section of a page, on either the same page as the link or another page entirely. Anchors are
especially handy for long pages that have a lot of text.
Let us now discuss how can we navigate in Dreamweaver using anchors.

11.4.1 Named Anchor
In order to link to a specific location within a document, the destination page needs to contain a
marker called a named anchor. A named anchor is designated by the filename.html#anchorname
if it is in the same Web page as the link.
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Example: <href=”frequentquestions.html#quest16.html”>Question 16: How does one
create a named anchor?</a>
Named anchors are commonly used for long alphabetized or indexed lists.
Example: An index, a glossary, or a list of frequently asked questions.

Notes Instead of requiring users to scroll through the entire list of questions, you can
create a list of the questions at the top of the page that link to the location in the page
containing the answer to the specific question.
The steps to create a named anchor and link it to a document are discussed below:
1.

Click in the Web page where you want the named anchor should go. Click on the Insert
menu and then Named Anchor from the drop-down menu.
Figure 11.17: Step 1 to Create and Link to a Named Anchor

Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_named_anchor.html

Another way to create a named anchor is to click on the Common Insert Panel and choose
the Named Anchor icon. Click on the anchor and the named anchor dialog box will
appear.
Figure 11.18: Alternate Way to Create and Link to a Named Anchor

Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_named_anchor.html
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2.

In the Named Anchor dialog box, place the cursor in the text field and type in the name of
the anchor.
Figure 11.19: Step 2 to Create and Link to a Named Anchor

Source: http://www.guidesandtutorials.com/dreamweaver_tutorial_named_anchor.html

11.4.2 Moving within the Same Document
Once the named anchors are created, you can then link to them like you would any other web
page. In this case you are linking to the same page, but to a specific location on the page. This
page is named dw8.html. In order to create a link to the specific anchor within the page the link
would include a pound sign at the end of the file name plus the name of the named anchor.
Example: <a href=”dw8.html#rss”> Tutorials</a>
The anchor icons that are created in the Web page represent the named anchors, which are
invisible Web page elements. The icons are useful so that you can see that the anchors are there.
To turn off the icons so they aren’t visible, you can click on the Document Toolbar and then click
on Invisible Elements to hide the anchor icons.

11.4.3 Using Named Anchors in a Different Page
You might want to link to an anchor in another file in your web site. To do so, take the following
steps:
z

Highlight the clickable text in the first file.

z

Create a relative link to the second file.

z

Follow the URL with the pound sign and the anchor name from the second file.
Figure 11.20: Named Anchors in a Different Page

Source: http://www.nvcc.edu/home/ataormina/wdc/dreamweaver8/links5.html
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11.4.4 Creating Null Links
Null links are undesignated links. They are needed to attach behaviors to text.
Example: Open a new document and type out the word “link”.
Now, going to the Behavior Panel, click the plus sign (+) to access the drop down menu and
you’ll notice most of the behaviors are unavailable. What if you wanted to launch a pop up
window from the word “link”?
You could type the javascript in by hand but that’s why we’re using Dreamweaver: to avoid
handcoding routine html/javascript.
To access the Behaviors, you need to first create a null link out of the text “link”.
You do this by selecting the word (in this case “link”) and going up to the Properties Inspector,
input the following line in the Link Field:
javascript: void(0) OR you can type the pound sign: #
Figure 11.21: Null Links

Source: http://www.cbtcafe.com/dreamweaver/nulllinks/nulllinks.html

Figure 11.22: Null Links

Source: http://www.cbtcafe.com/dreamweaver/nulllinks/nulllinks.html

Either way will work. Now, after you’ve input either code into the Link Field, go back to your
Behaviors Palette and click the plus sign (+) and notice how many new behaviors are available.
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Figure 11.23: Null Links

Source: http://www.cbtcafe.com/dreamweaver/nulllinks/nulllinks.html

Self Assessment
Fill in the blanks:
10.

An …………………… is a link to a specific section of a page, on either the same page as the
link or another page entirely.

11.

A …………………… is designated by the filename.html#anchorname if it is in the same
Web page as the link.

12.

The anchor …………………… that are created in the Web page represent the named anchors,
which are invisible Web page elements.

11.5 Frameset
The frames panel shows you information about your frames. Specifically the name of the frame.
If a frame doesn’t have a name Dreamweaver will display “(no name)” in the frame.

!
Caution You can use this panel to see the properties for a specific frame. Just click on that
frame in the panel, and the properties pane will change to that frame.
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Notes

Source: http://flylib.com/books/en/4.493.1.62/1/

11.5.1 Opening a Web Page into a Frame
You can load an existing Web page into any frame to prevent creating them from the start. To do
this, select a frame and open the Frame Property inspector. Type the link into the src text box or
click the folder icon to browse for your file or you can position your cursor in a frame (without
selecting the frame) and choose File ! Open in Frame.

11.5.2 Setting Borders
When we work with frames we want to be able to see the borders around each of the frames and
the frameset itself. Sometimes when you open and close a file the frame borders are hidden.
If you cannot see the frame borders select View > Visual Aids >Frame Borders to restore them.
Figure 11.25: Frame Borders

Source: http://bbcfe.net/multimedia/hnmm1/project04/Dream8.Frames.pdf
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The frame borders are the grey lines between (and around the outside) of a frameset.
Figure 11.26: Frame Borders

Source: http://bbcfe.net/multimedia/hnmm1/project04/Dream8.Frames.pdf

We can use frame borders to resize frames and select areas of the frameset.

11.5.3 Deleting Frames
You may need to delete one or more of frames in a frameset. You can do this easily through the
steps given below:
1.

Click the frame border and drag it into the border of the enclosing (or parent) frame.

2.

When no parent frame is present, drag the frame border to the edge of the page.

3.

If the frame being deleted contains any unsaved content, Dreamweaver asks if you would
like to save the file before closing it.

11.5.4 Targeting Frame Content
Frames are also used for navigational control. The frame that acts as the navigation centre,
provides links to various Web pages in a site. When the user selects one of the links, the Web
page appears in another frame on the page. This frame can scroll independently of the navigation
frame. When you assign a link to appear in a particular frame of your Web page, you are said to
be assigning a target for the link. You can target specific frames in your Web page, and target
structural parts of a frameset.

Did u know? The Text and Image Property inspectors are used to assign targets for typical
text or image links.

Self Assessment
Fill in the blanks:
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13.

The …………………… shows you information about your frames.

14.

The frame that acts as the …………..............…………, provides links to various Web pages
in a site.

15.

The Text and Image Property inspectors are used to assign …………………… for typical
text or image links.
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Case Study

Business Solutions

M

arketing holds a key role in promoting a product or service. With strategic
planning & mass advertisement campaigns we can sell products even if the
quality is low. Today there are many ways to market a product/service. One of
the best, cost-effective & targeted advertisement platform is SMS Marketing as mobile has
become an inevitable accessory in our life. Promotional SMS will be delivered right to the
customers’ mobile phones and they can use the information at any time they wish as the
message will be usually saved in the phone.
SMS Marketing is useful for all types of businesses especially in targeting the local
customers. With the help of Bulk SMS Campaigns you can increase your sale by 200% in
just a couple of days during the festivals or promotions.
SMS Marketing service is good for promotions as well as communication with your
customers and convey your brand message or to develop strong brand awareness among
the mass.
Promotional SMS
Suppose if Mr. Rohit is planning to buy a pair of shoes, normally he goes to the market,
search any retailer and buy a pair of shoes. But if Mr. Rohit received a promotional SMS
from your Shop saying “Flat 10% Discount for all Shoes Items” then he would have
definitely come to your shop. This is how Promotional SMS works.
Festival Greeting SMS
Suppose if Mrs. Rani bought some garments from your shop a couple of months ago, and
you have collected her mobile number then. You are sending a greeting SMS the right
time on the eve of a festival season, when people are willing for shopping. Here your
greeting SMS will definitely bring Mrs. Rani and family to your shop again.
Building Customer Database
Building your customer database is very important for a long term and memorable business
relationship. We have sophisticated tools to build and organize your customer database
without comprising on the security measurements. SMS Campaigns works differently for
different category of business; we have short listed few category of business below:
z

Retail Outlets

z

Educational Institutions

z

Educational Consultancies

z

Banking & Financial Sector

z

Travel & Tourism

z

Clubs & Societies

z

Real Estate

z

Media & Entertainment Sector

z

Automobile Industry
Contd...
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z

Stock Market Companies

z

Job Consultancies

z

IT & ITES Service Companies

z

Transport & Logistics Sector

z

MLM Companies

Retail Outlets
We know how difficult it is to boost the sales in this highly competitive market. In
retailing it is the satisfaction of the customers/consumers that counts the most. And the
rate of success depends not merely in attracting but largely on retaining the customers
who are often demanding, and for that should have something more to offer than a rival
product. The existence of competitors necessitates you to provide high quality products
with the best customer care, tempting offers, excellent after sales support, maintain good
long term customer relationship and provide the customer with cutting edge technology.
Here let us see how a retailer can use our platform of SMS Marketing to boost his sales and
maintain long term customer relationship & trust.
z

Send thanking alert message for their purchase.

z

Send Updates on SALE, offers & promotions to the customers

z

Updating customers on the status of their purchase/repairs/delivery, etc.

z

Sending greetings – Festival, Birthday, Anniversary, etc.

z

Announcing New Offers, New Arrivals, Change of Location, etc.

z

Sending day to day sales figure to higher authorities.

z

Conduct SMS based surveys with the customers.

Problem
A textile retailer wants to send a thanking message after the payment of purchase is
received. He also wants to build his own customer database in separate groups, send bulk
SMS on the eve of major festivals and inform selected group of customers regarding the
latest arrivals and offers, but he don’t have a web portal or any customer management
software.
Solution
For Sending Thanking SMS: We advised him to create a template in our Web Interference
Portal which will enable him to send a predefined message to the customer instantly.
For Building Customer Database & Groups: We advised him to collect the customer’s
name and phone number after the purchase and enter it into our Web Interference portal.
He can assign a group for that contact if needed.
Sending Bulk SMS on the Eve of Festivals: We advised him to use “Send to All” option in
our Web Interference Portal, so SMS will be send to all customers just with one click.
Informing Latest Arrivals & Offers to Selected Customers: Select the customer group and
send SMS; SMS will be delivered only to the members in that group.
Educational Consultancies
z

Send Course Lists
Contd...
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z

Send Admission Notification.

z

Send Bulk SMS Campaigns

z

Inform students to prepare for an interview

z

Inform students to submit original mark sheet and documents.

z

Inform the date of joining.

z

Inform/remind the date of journey in case of going abroad for studies.

Banking and Financial Sector
z

Promotional Offers and Special Offers

z

Loan Application Status

z

Loan Approvals

z

Reminding EMI Date.

z

Account Updates/Balance details/Low balance/installments, etc,

z

Transaction details and Cheque bounce

z

Payment Reminder Alerts

z

Insurance/SIP reminders

z

Mutual Funds – Offers NAV, etc.

z

Interest rates/Charges revision

z

Cross Selling partner products

z

Sending Festival Greetings.

Travel and Tourism
z

Send thanking message on ticket or hotel booking.

z

Send confirmations on hotel bookings/Ticket booking/reservations, etc.

z

Informing the tour date

z

Promote special discounts/offers

z

Notification on special events

Clubs and Societies
z

Medical Camp Dates

z

Event updates

z

Membership renewal reminders

z

Invitations

z

Elections

z

Competitions

z

Special Birthday/Anniversary Greetings

Contd...
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Real Estate
z

Promotional campaigns

z

Reminder for installments/payments

z

Reminders to tenants regarding rent, overdue, etc.

z

New property launch, etc.

z

Quick internal advertisement of rental/saleable property

Media and Entertainment Sector
z

Send Urgent Messages to all Crew Members

z

Informing Shooting Date and Location

z

Informing postponed and new dates

z

Bulk promotion of New Cinema/Serial

Automobile Industry
z

Vehicle Service Reminders

z

Service Confirmation Alerts

z

Driving Tips

z

New Vehicle Launch – Test Drive Invitation

z

Promotional Offers – on sales, parts and service

z

Insurance, RTO reminders

z

Festival and Other Greeting messages

Stock Market Companies
z

Trade Transaction details

z

Stock Tips and Advices

z

New IPO and Company Listing

z

Market Watch

z

Market Updates

z

Government Policy and impacts

z

Promotional Campaigns

Job Consultancies
z

New Job Openings

z

Interview Date and Place

z

Interview Confirmation

z

Promotional Campaigns

IT and ITES Service Companies
z

Integration with Websites
Contd...
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z

System failure notifications

z

Inform Virus alerts

z

New Email Alerts

z

Password Retrievals

z

Server/website down alerts

z

Shopping alerts

z

Human verification code for transaction security

Transport and Logistics Sector
z

Alert Booking Details

z

Alert Delivery Report

z

Container tracking

z

Freight charges

z

Account balance and payment reminders

MLM Companies
z

Welcome Message

z

New Binary Alerts

z

Payout Alerts

z

Announce New Plans and Products

z

Inform Meeting and Schedules

z

Festival/Birthday/Anniversary Greetings

z

Integrate with Website and Management Software

Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://dreamweaver.net.in/case-study.html

11.6 Summary
z

Dreamweaver is a Web design software program that can be used to create pages for
display on the World Wide Web.

z

It provides a visual WYSIWYG (What You See Is What You Get) editor and a code editor.

z

The elements of the Dreamweaver Window are Page Properties, Insert Bar and Properties
Inspector, Document Toolbar, etc.

z

We can add HTML tables in your website using the table, row and cell tags. We can also
modify them and select them as per need.
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z

Dreamweaver makes it easy to create anchors for your page. An anchor is a link to a
specific section of a page, on either the same page as the link or another page entirely.

z

Named Anchor are used to link a title to the same document or another one.

z

Null Links are undesignated links and are needed to attach behaviors to text.

z

Frames can be applied to our site using the frameset option of Dreamweaver.

11.7 Keywords
Document Toolbar: The Document toolbar contains buttons that let you toggle between different
views of your document quickly.
Dreamweaver: Dreamweaver is a Web design software program that can be used to create pages
for display on the World Wide Web.
Frames Panel: The frames panel shows you information about your frames.
Insert Toolbar: The Insert Toolbar provides many buttons that insert elements into your Web
page.
Named Anchor: Named Anchor are used to link a title to the same document or another one.
Null Links: Null links are undesignated links which are needed to attach behaviors to text.
Table: Table is used to represent data as rows and columns.
WYSIWYG: It is a ‘What You See Is What You Get’ editor in Dreamweaver.

11.8 Review Questions
1.

Describe all the components of the Dreamweaver Window.

2.

Discuss the steps used to add a table to page in Dreamweaver.

3.

Illustrate with example how to create the HTML Table with Column spanning.

4.

What are the advantages of Expanded Tables mode? Discuss.

5.

Illustrate the concept of moving through a table.

6.

Describe the steps to create a named anchor and link it to a document.

7.

Elucidate the steps used to modify the contents of a table.

8.

Describe how to use named anchors in a different page.

9.

Explain how to create null links.

10.

Explain the use of frames panel in Dreamweaver.

Answers: Self Assessment
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1.

Insert

2.

Document

3.

Properties Inspector

4.

<tr> </tr>

5.

child

6.

<th>

7.

Cell spacing

8.

Pixels

9.

Expanded Tables

10.

Anchor
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11.

named anchor

12.

Icons

13.

frames panel

14.

navigation centre

15.

targets

Notes

11.9 Further Readings

Books

David McFarland, Dreamweaver 8.
Daniel Short, Garo Green, Macromedia Dreamweaver 8 Hands-On Training.
Khristine Page, Macromedia® Dreamweaver® 8.

Online links

http://etutorials.org/Macromedia/Dream+Weaver+Online+Help/Getting+
Started+with+Dreamweaver/
http://www.guidesandtutorials.com/dreamweaver_tutorial_ selecting_
tables.html
http://www.teacherclick.com/dreamweaver8/t_7_3.htm
http://www.internet4classrooms.com/using_dw_basics.htm

LOVELY PROFESSIONAL UNIVERSITY

269

Nisha Sethi, Lovely Professional University

Graphic Tools

Notes

Unit 12: Dreamweaver – Layers and Style Sheets
CONTENTS
Objectives
Introduction
12.1 Layers
12.2 Single Layer
12.2.1

Creating a Layer

12.2.2

Overlapping Layers

12.2.3

Converting Layout Layers to a Table

12.2.4

Converting a Page Formatted by a Table to One with Layers

12.2.5

Tables within Layers

12.3 Layer Properties
12.3.1

Adjusting Properties

12.3.2

Aligning Layers

12.4 Adding Elements into Layers
12.4.1

Putting Text in a Layer

12.4.2

Inserting an Image in a Layer

12.4.3

Text and Images in the Same Layer

12.5 Style Sheets
12.5.1

Significance of Cascading Style Sheets (CSS)

12.5.2

Basics of CSS: Tags, Selectors and Declarations

12.5.3

Cascading Characteristics

12.5.4

Internal Style Sheets using Dreamweaver – Adding Styles to HTML Tags

12.5.5

External Style Sheets using Dreamweaver

12.5.6

Linking External Style Sheets to an HTML File using Dreamweaver

12.5.7

Converting CSS into HTML using Dreamweaver

12.5.8

Grouping Properties

12.5.9

Inheritance of Properties

12.6 Summary
12.7 Keywords
12.8 Review Questions
12.9 Further Readings

270

LOVELY PROFESSIONAL UNIVERSITY

Unit 12: Dreamweaver – Layers and Style Sheets

Notes

Objectives
After studying this unit, you will be able to:
z

Explain the concept of layers

z

Understand layer properties

z

Elaborate layer properties

z

Discuss style sheets

Introduction
Dreamweaver from Adobe is the web development tool that lets you efficiently design, develop
and maintain standards-based websites and applications. It provides a powerful combination of
visual layout tools, application development features, and code editing support. It includes
many new features to help you create and maintain websites that range from basic home pages
to advanced applications that support best practices and the latest technologies. Dreamweaver
integrates CSS (Cascading Style Sheets) with itself that is used to define that page’s style or
presentation. By presentation we mean how content on a page is displayed. Is it displayed as
simple black text on a white background? Or is it displayed in a more complex layout consisting
of images and content divided into columns? Style sheets are capable of specifying that
presentation without interfering with the content of the page. This means that the same content
can be used with many styles without being modified – a separation of presentation and content.
An enhancement of CSS, initially called CSS-P (for positioning), is the foundation for what have
become commonly known as AP elements.

12.1 Layers
Layers can be used for a page layout or to add special effects. They allow pixel specific positioning
of elements in web pages using x,y coordinates similar to a graph except layers start from the
top and left of the page. Layers are like individual web pages and anything that can be placed on
a web page, such as text, graphics, video, and tables, can be placed in individual layers. They
allow overlapping elements on a web page too. Like in a HTML web page there can be two
“layers”, the background and the content.

Notes Layers are not widely viewable in older Web browsers. Only Internet Explorer 4.0
and Netscape 4.0 and above browsers show layers.
You can layout pages using layers and then convert the layers to backward-compatible tables
with a single menu command. You simply place the various parts of your page, such as images
and text blocks, into separate layers—which normally work only on browsers that support
Cascading Style Sheets (CSS), and then select Modify>Layout>Convert Layers To Table from the
main menu.

!
Caution Dreamweaver can’t convert overlapped layers, so you have to make sure the
Prevent Layer Overlaps switch is on.
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Figure 12.1: Use of Layers in Dreamweaver

Source: http://www.sonic.net/mnitepub/pccafe/reviews/macromedia_dreamweaver2/

Self Assessment
Fill in the blanks:
1.

…………………… can be used for a page layout or to add special effects.

2.

Layers are like individual …………………… and anything that can be placed on a web
page can be placed in individual layers.

3.

You can layout pages using layers and then convert the layers to backward-compatible
tables with a single …………………… command.

12.2 Single Layer
Let us now discuss working with a single layer in Dreamweaver.

12.2.1 Creating a Layer
Layers can be created manually by going to the Insert Palette, then going to the Layout tab and
selecting Draw AP Div.
Figure 12.2: Creating Layers in Dreamweaver

Source: http://www.sonic.net/mnitepub/pccafe/reviews/macromedia_dreamweaver2/
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Or you can create a layer by going to Insert > Layout Objects > Div Tag. Then this window will
pop up.

Notes

Figure 12.3: Create a layer in Dreamweaver

Source: http://answers.oreilly.com/topic/292-float-layout-basics-in-dreamweaver-cs/

Figure 12.4: Dreamweaver Window with a Layer

Source: http://www.informit.com/articles/article.aspx?p=355342&seqNum=2
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12.2.2 Overlapping Layers
Layers can be overlapped with one layer partially or completely covering the layer underneath.
They can also be nested. A nested layer is a “parent” layer and a “child” layer and the child layer
is positioned in relation to the parent. Nested layers will move together. Nested layers can be
separate or overlapping.
To create a nested layer:
z

Select the parent layer

z

Hold down the Alt key while dragging the new layer

z

The nested (child layer) will show indented under the parent layer.

To nest existing layers:
z

Select the layer to be nested (child) in the layers panel

z

Hold down the Ctrl key and drag the layer to the parent layer and when you let go the
layer will show indented to signify nesting

When nested, you can still move the child layer, but if you move the parent layer when you let
go of the mouse button the child layer will move into the same relative position.

Did u know? If you delete the parent layer, the child layers also gets deleted.

To un-nest: select the child layer in the layers panel and hold down the Alt key and drag it away
from the parent layer.
Figure 12.5: Nested Layer

Source: http://www.entheosweb.com/dreamweaver/layers.asp
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Notes

You may want to save your page with tables as well as with the layers you have created for
viewers with older browsers. To convert from layers to a table layout, follow the steps below:
z

Open the page to be converted

z

From the Menu choose Modify > Convert > Tables to Layers
Figure 12.6: To Convert Layers to Tables

Source: http://www.awdsf.com/courseware/dreamweaver/dreamweaver3_layers.htm
z

The Convert Layers to Table window will open:
Figure 12.7: Convert Layers to Table Window

Source: http://www.awdsf.com/courseware/dreamweaver/dreamweaver3_layers.htm
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z

Save the file.

All of the layers on the page will be converted into a table.

12.2.4 Converting a Page Formatted by a Table to One with Layers
Dreamweaver can convert a page formatted via a table to the one with layers. To do so, choose
Modify -> Convert -> Tables to Layer. Then uncheck Show Grid and Snap to Grid, if checked.
Then click on the OK button, and you will be back to a page with layers.
Figure 12.8: Convert Table to Layers Window

Source: http://www.awdsf.com/courseware/dreamweaver/dreamweaver3_layers.htm

12.2.5 Tables within Layers
We can place tables within a Dreamweaver layer. To do this, follow the steps below:
1.

Create a new layer.

2.

Insert a table into the layer, with a few rows and columns, and put some text in them.

3.

Preview this in the browser.

4.

Save this page.

5.

Convert it to one formatted by a table, and preview it.

6.

Convert it back to layers.

Self Assessment
Fill in the blanks:
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4.

Layers can be created manually by going to the …………………… Palette, then going to
the Layout tab and selecting Draw AP Div.

5.

A …………………… is a “parent” layer and a “child” layer and the child layer is positioned
in relation to the parent.

6.

To un-nest, select the child layer in the layers panel and hold down the Alt key and drag it
away from the …………………… layer.
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12.3 Layer Properties
The layers have various properties can be set as per the need of the user.

12.3.1 Adjusting Properties
We can adjust various properties of a layer using the Properties window.
Figure 12.9: Properties Window

Source: https://www.msu.edu/course/lbs/126/assignments/assignment7/assignment7.html

12.3.2 Aligning Layers
Dragging the layers is a way to align them. Or you can set their positions in the properties dialog.
It is possible to select several layers at the same time and set their properties.

Self Assessment
Fill in the blanks:
7.

We can adjust various properties of a layer using the ……………………

8.

Dragging the layers is a way to …………………… them.

12.4 Adding Elements into Layers
After creating a layer, we can add elements like text and images into it. Let us discuss how.

12.4.1 Putting Text in a Layer
To add text in your document,
z

In Dreamweaver’s Design view, click in the page where you want to add text.

z

Type the text you want.

12.4.2 Inserting an Image in a Layer
All web sites have a certain number of pages that allow you to improve their look, or just to add
more visual information. To insert an image to a layer,
z

Go to the Insert menu, and then select the Image option.

z

Select an image that you wish to add
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Figure 12.10: Selecting the Image to Add

Source: http://www.teacherclick.com/dreamweaver8/t_6_1.htm

!
Caution If you insert a BMP, it will not appear unless you select All the files in the Type
field.

In the Relative to option you can specify whether the image will be relative to the document or
to the site root folder. It’s better if it’s relative to the Document because if you move the site to
a different location you may not see the image.

12.4.3 Text and Images in the Same Layer
It is possible to have text and image on the same layer. But some formatting and alignment
differences exist.
Example:

278

1.

Select the layer containing the image by clicking on its button.

2.

Drag on the bottom resizing handle.

3.

Now press the cursor-right arrow until the cursor is beneath the graphic, and type the title
“Hello”. Make the text bold and a little bigger than normal.

4.

Now click on the centering icon to centre the text.

5.

Select the layer again, and make it just a little wider than the graphic.

6.

Now the text centres.
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Self Assessment
State whether the following statements are true or false:
9.

If you insert a BMP, it will not appear unless you select All the files in the Type field.

10.

It is not possible to have text and image on the same layer.

12.5 Style Sheets
HTML is the primary markup language for Web development. But HTML does not isolate the
structure and content of a document. The structure of the document deals with how the page is
displayed on the screen, while the content of the Web page is the actual data encapsulated within
the HTML tags. CSS helps to resolve the limitations of HTML by giving a designer more control
over the look and feel of a page.
Features supported by CSS:
z

All font-related properties like size, color, family, etc.

z

Text color, background color and any modification associated with images

z

All related attributes of text such as size, letter spacing and alignment

z

All appearance and formatting associated with tables and frames

z

All spacing attributes like margin, padding and border, along with spacing in horizontal
and vertical directions

12.5.1 Significance of Cascading Style Sheets (CSS)
Cascading Style Sheets (CSS) are a collection of formatting rules that control the appearance of
content in a web page. They are very useful for maintaining a web site since its appearance
(controlled by properties of HTML tags) can be managed from just one file. CSS Styles
also enhance your site’s look, accessibility and reduces file size. Another main advantage is
reusability – instead of defining the properties of fonts, backgrounds, borders, bullets, uniform
tags, etc. each time you use them you can just assign the corresponding CSS style in the class
property. You can store CSS styles directly in each document or, for more control and flexibility,
in an external style sheet.

Notes Versions 3.0 of Opera and Microsoft Internet Explorer and Version 4.0 of Netscape
Navigator support properties for Level 1 CSS, and 4.0 and later versions of all three
browsers support properties for Level 2.

Task Discuss the major features of level 1 CSS and level 2 CSS.

12.5.2 Basics of CSS: Tags, Selectors and Declarations
CSS styles are defined within the <style> tag. If you define the styles embedded within your
current document you will find code similar to the following in your head content:
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Example: A
<style type=”text/css”>
<!—
.bluetext
{
font-family: Verdana, Arial, Helvetica, sans-serif; font-size: 10pt; color:
#000066;text-decoration: none;
}

Apply the CSS above using class property for any tag <p class=”bluetext”>
If you define the style in an external existing or new Style Sheet you will find code similar to the
following in your head content:
Example: B
<link rel=”stylesheet” href=”/styles.css” type=”text/css”>

This code indicates that the document is linking to the external style sheet called styles.css
located under the site root.
If you open the style sheet in notepad you will find code similar to the code for the styles being
embedded in the document. The big advantage of external style sheets is that the web site is easy
to maintain and that when we make changes to the styles applied in the document, only the style
sheet needs to be uploaded and not all the pages accessing it. As a practice, while using
Dreamweaver, link you template(s) to the external style sheet so that all the pages using the
template can use just one style sheet.

12.5.3 Cascading Characteristics
The term cascading in CSS refers to how many style sheets can affect a single document in a
cascading manner. This means that they all come together to create one single style that decides
the overall presentation of the page.

Did u know? If styles between sources conflict, a weighting system is used to decide which
style has precedence.

12.5.4 Internal Style Sheets using Dreamweaver – Adding Styles to
HTML Tags
The CSS palette helps you assign certain properties to a specific HTML tag. To open the CSS
palette, go to Window > CSS palette.
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Figure 12.11: CSS Palette

Notes

Source: http://boxesandarrows.com/dreamweaver-primer/

Click on the arrow and select New. The New Style dialog box will display on your screen. Select
the Redefine HTML Tag radio button in the Type field and for Tag, use the pop-up menu to select
the HTML tag, h1. Click OK.
Figure 12.12: New Style Dialog Box

Source: http://www.uwec.edu/help/Dreamweavercs3/css-create.htm

Style definition for h1 box appears after you click Ok. Use the category Type and chose the
attributes. These attributes will determine the look and feel of elements in h1. Click OK.
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Figure 12.13: CSS Rule Definition Dialog Box

Source: http://www.uwec.edu/help/Dreamweavercs3/css-create.htm

You can view the HTML code in Dreamweaver by selecting window > HTML Source.
HTML style notation encloses the style element content (i.e.!—and __>). This avoids displaying
the style sheet code in old browsers that do not support CSS.

12.5.5 External Style Sheets using Dreamweaver
If you want to apply the same styles to more than one page, you can create an external style sheet
and link to several Web pages.
1.

Open the CSS palette, go to Window > CSS palette. Select the Open Style Sheet icon.

2.

The Edit Style Sheet dialog box will display on your screen.

3.

Use the New button to add the style definitions. You can add multiple CSS.

4.

When all styles are entered, export the CSS by selecting File > Export > Export CSS Styles.

5.

The Export Styles as CSS File dialog box will display on your screen. Name the file with
the CSS extension (for example, style1.css), and then click on the Save button.

Task Make distinction between internal and external style sheets.
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12.5.6 Linking External Style Sheets to an HTML File using
Dreamweaver

Notes

In Dreamweaver, open the HTML document to which you want to link the external style sheet
you previously created.
1.

To open the CSS palette, go to Window > CSS palette. Select the “Open Style Sheet” icon.

2.

The Edit Style Sheet dialog box will display on your screen. Click on Link.
Figure 12.14: Edit Style Sheet Dialog Box

Source: http://faculty-staff.ou.edu/P/Catherine.L.Pierson-1/2011/Classes/DWnotes/dw1/11.htm

3.

The Link External Style Sheet dialog box will display on your screen. Click on the Link
radio button to the right of Add As and then click on Choose.

4.

Choose the name of the CSS you wish to link

5.

Click OK

12.5.7 Converting CSS into HTML using Dreamweaver
You can change CSS into HTML to help with using Dreamweaver. Dreamweaver creates a new
document with HTML, leaving the CSS document in its original form. To convert the document,
select File > Convert > 3.0 Browser Compatible. When the Convert to 3.0 Browser Compatible
dialog box appears, select the CSS Styles to HTML Markup and click OK. Your new document,
written in HTML, will appear on your screen.

LOVELY PROFESSIONAL UNIVERSITY

283

Graphic Tools

Notes

12.5.8 Grouping Properties
CSS allows you to group declarations by separating them with semi-colons.
Example:
p
{
color:blue;
text-align:center;
}

You can group selectors too using commas rather than semi-colons.
Example:
h1,h2,p
{
color:green;
}

12.5.9 Inheritance of Properties
Using inheritance we can apply CSS rules to more than one tag.
For example, if you set <body> tags to the colour blue, then the tags included within a <body>…</
body> tag inherit that property and are also blue in color.
Another use of inheritance is within HTML tags that involve a parent-child relationship, such as
a list. Whether numbered (ordered, <ol>) or bulleted (unordered, <ul>), a list comprises any
number of list items, designated by <li> tags. Each list item is considered a child of the parent
tag, <ol> or <ul>.
Example:
ol {
color:red;
}
ul {
color:red;
}

Self Assessment
Fill in the blanks:
11.
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…………………… are a collection of formatting rules that control the appearance of content
in a web page.
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12.

CSS styles are defined within the …………………… tag.

13.

The term …………………… in CSS refers to how many style sheets can affect a single
document in a cascading manner.

14.

The CSS …………………… helps you assign certain properties to a specific HTML tag.

15.

If you want to apply the same styles to more than one page, you can create an
…………………… style sheet and link to several Web pages.

Case Study

Spry Periodic Table

T

he Spry periodic table takes advantage of many Spry techniques that the Spry
community might be interested in. This document steps through the code section
by section and explains the thinking and methods behind the code. Since this demo
gets away from our common use patterns, it may serve to expand the ways in which Spry
can be used on pages.
You can explore a working version of the Spry periodic table on Adobe Lab.
Basic Functionality
The Spry Periodic Table uses an HTML data set to populate the periodic table. The actual
data source table is on the same page. This allows the page to load faster, allows the page
to degrade gracefully, and gives search engines content to index. HTML tables are easier
to create and edit than XML and you can use visual editors to modify them.
We then use Spry:repeats and Spry:regions, plus a good use of CSS classes to position
things so they look like a periodic table. These classes are also used to highlight the
different sections of the table via the links.
The tooltip widget is used with a detailregion to provide additional information when
mousing over an element.
The Data Table
The data table, located at the bottom of the page, is an HTML table:

No

Atomicweight

1

1.0079

2

4.0026

Name

Symbol

MP

BP

Hydrogen

H

–259

–253

Helium

He

–272

–269

Density
0.09

The header row is used as the data reference names used throughout the page. We use No
(atomic number) frequently as a unique ID. We also use Group, Period, and Element_Type
for additional functionality, explained later.
Using an HTML table made it easy to add columns for additional data points and to find
elements quickly.
Setting up the Page
As with all Spry pages, you need to attach files so you can get started.
Contd...
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<link href=”SpryAssets/atom.css” rel=”stylesheet” type=”text/css” />
<script type=”text/javascript” src=”SpryAssets//SpryData.js”></script>
<script type=”text/javascript” src=”SpryAssets//SpryHTMLDataSet.js”></
script>
<script
script>

type=”text/javascript”

src=”SpryAssets//SpryTooltip.js”></

<script type=”text/javascript” src=”SpryAssets/atom_functions.js”></
script>
z

atom.css contains the bulk of the CSS used in the page functionality.

z

SpryData.js is the main Spry functionality file.

z

SpryHTMLDataSet.js provides the functionality for using HTML tables as data sets.

z

SpryTooltip.js provides the code for the Tooltip widget.

z

atom_functions.js contains the three extra functions used for filtering the data.

The CSS File
A big part of the functionality depends on class names. Open the atom.css file.
You see a set of class names that are named after the different Element_Type references.
This allows us to color the different element types using a data reference, since the value
of the data reference and the class name are identical. Other classes are used for positioning
things correctly within the element div. (The element div is the div tag that contains the
data for a single element.)
Data Sets
The Periodic Table uses four data sets:
<script type=”text/javascript” language=”javascript”>
var ds1 = new
Spry.Data.HTMLDataSet(null,”atoms”);
var types = new
Spry.Data.HTMLDataSet(null,”atoms”,{distinctOnLoad:true,
distinctFieldsOnLoad:[‘Element_Type’]});
var periods = new
Spry.Data.HTMLDataSet(null,”atoms”,{distinctOnLoad:true,
distinctFieldsOnLoad:[‘Period’]});
var groups = new
Spry.Data.HTMLDataSet(null,”atoms”,{distinctOnLoad:true,
distinctFieldsOnLoad:[‘Group’],sortOnLoad:”Group”,sortOrderOnLoad:”asce
nding”}); groups.setColumnType(“Group”,”number”); ...
</script>
z

var ds1 = new Spry.Data.HTMLDataSet(null,”atoms”);

This is the main data set. It defines a standard HTML data set. We use null in the URL
parameter because the table is on the same page. atoms is the ID of the data table.
z

var types = new Spry.Data.HTMLDataSet(null,”atoms”,
{distinctOnLoad: true, distinctFieldsOnLoad:[‘Element_Type’]});
Contd...
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This is only used for the Element Types filter at the top of the page.
distinctOnLoad
allows us to only get an Element type once.
distinctFieldsOnLoad tells Spry to get every distinct value in the Element_Type
column.
z

Notes

var periods = new Spry.Data.HTMLDataSet(null,”atoms”,
{distinctOnLoad:true, distinctFieldsOnLoad:[‘Period’]});

Same as above, this is only used to give us the distinct values for the Period filter at
the top of the page.
z

var groups = new
Spry.Data.HTMLDataSet(null,”atoms”,{distinctOnLoad:true,
distinctFieldsOnLoad:[‘Group’],sortOnLoad:”Group”,
sortOrderOnLoad:”ascending”});

Again, this is only used for getting the values for the Group filters at the top. Because
these are numbers, we have another line
groups.setColumnType(“Group”,”number”);, which tells Spry that these are

numbers. Without this line of code, Spry would treat them as text and may not order
them correctly. The sortOnLoad and sortOrderOnLoad ensures that they display
in the numeric order. If we didn’t set the sort, they would display in the order they
appear in the document.
There is one more function in the <script>:
ds1.addObserver({onPostLoad: function(ds, data) {
Spry.Utils.removeClassName(“mainRegion”, “SpryHiddenClass”); }});

The CSS class SpryHiddenClass only sets display:none; This hides and removes the
element from the flow of the page.
The mainRegion div wraps the entire periodic table (but not the data table) within it. It
has the SpryHiddenClass class applied to it. This is used for two reasons:·
z

When the page is loading, the periodic table will not be visible. This hides the Spry
code before it is ready to go. When the data is loaded and ready to go, the observer
gets the onPostLoad notification and then runs the Spry.Utils.removeClassName.
This removes SpryHiddenClass from mainRegion. This will cause the periodic
table to show, all ready to go.

z

When JavaScript is turned off, the Spry code will not display. This is because it has
the SpryHiddenClass applied to it and Spry will not remove it, since JavaScript is
turned off. This allows the data table to be displayed instead. Because the HTML data
set is using a table on the same page, Spry will hide the data table automatically.

The HTML Markup
The HTML markup for the table is short, but contains a lot of logic for both layout and
filtering. I will start with the main block of the periodic table and then explain the filters.
The Element DIV
The bulk of the periodic table is a single div, which I refer to as the element div since it
contains the actual chemical information.
Using Spry, this one DIV is repeated for every element in the data table. The rest of the
work is simply positioning those element divs correctly, so it looks like a real periodic table.
Contd...
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This element div has many classes applied to it. This allows us to identify each element
and to wrap lines correctly as well as to filter easily.
<div tabindex=”{No}” id=”div_{No}” class=”elementBlock {Element_Type}
{Period} {Name} {Group}” spry:if=”({No} &lt; 58 || ({No} &gt; 71
&amp;&amp;
{No}
&lt;
90)
||
{No}
&gt;
103)”
onmouseover=”ds1.setCurrentRow(‘{ds_RowID}’);” spry:hover=”hover”> <span
class=”number”>{No}</span> <span class=”group”> {Group} </span> <p
align=”center”>{Symbol}</p> <span class=”weight”>{Atomicweight}</span>
</div> </div>

The bulk of the code above is the actual content: The <span> tags and the <p> contain the
Spry data references for Atomic Number {No}, Group Number {Group}, the element
symbol {Symbol} , and the atomic weight {Atomicweight}. The CSS classes number,
group, and weight are defined in atom.css to position these data references within the
element div.
The logic for the element div is in the attributes of the div tag.
z

tabIndex=”{No}” is used to allow tabbing between elements for accessibility
reasons. This gives the tabindex a unique number {No} to allow tabbing in atomic
order.

z

id=”div_{no}” provides a unique ID for each of the element divs. These are used
in the filter functions to gray out the other elements.

z

class=”elementBlock {Element_Type} {Period} {Name} {Group}”


elementBlock is defined in atom.css. It sets the size of the element div, the
border, padding, and font size. Key here is the float:left that lines up the
divs horizontally.



{Element_Type} are all defined in atoms.css. The data reference that adds
the class name that sets the background colors you see on the table.



{Period} and {Group} are added so we can filter on them. They are not

defined in atoms.css. They are only used for logic in filtering the periods and
groups.


{Name} are used so we can define classes for specific elements. For example,
we use specific classes like .Hydrogen to great the gap between it and Helium
correctly.



onmouseover=”ds1.setCurrentRow(‘{ds_RowID}’);” is used for the
tooltip to update the tooltip spry:detailregion. This ensures that the tooltip
always shows details for the current element.



spry:hover=”hover” sets the hover class for changing the text color when
mousing over an element.

The spry:if takes some explanation. The two blue rows at the bottom are special. They
are the Lanthanide and Actinide series. They are always displayed in separate columns
below the main table, but numerically, they are out of order. Note that they have a
Number (upper left corner) of 58–71 and 90–103. Note that on Periods six and seven (click
the Periods filter to highlight them), the number jumps from 57 straight to 72, and from 89
to 104.

Contd...
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So we have to logically not display those in the main table, and ensure they only show up
below. (This separation is the only reason we have to duplicate code in this demo!)

Notes

The spry:if says:
spry:if=”({No} < 58 || ({No} > 71 && {No} < 90) || {No} > 103)”

This is the logic that says: if the Number is less than 58 or greater than 71 and less than 90
but greater than 103, print it here. Note the ( ) that surround the highlighted code. This
separates the logic so everything works correctly. You will see in the other element DIV
block that an inverse condition displays the other two rows.
For the Lanthanide block, the two blue rows at the bottom, twe need to display the
elements that are not displayed above.
We simply repeat the markup from above, with a new s p r y : r e g i o n and
spry:repeatchildren. The only difference in this block is that spry:if is the reverse
of the one above:
spry:if=”({No} &gt;= 58 &amp;&amp; {No} &lt;= 71) || ({No} &gt;= 90
&amp;&amp; {No} &lt;= 103)”

Other than that, the two spry:regions that output the elements are the same. The
Lanthanide div has CSS that positions it left so it lines up vertically correctly. The <br
style=”clear:both;” /> between the two element blocks puts the Lanthanide block
on a new line.
The mainRegion
The mainRegion div wraps the entire periodic table. It is used as the main spry:region
and is used for CSS purposes. The <br> is a critical component of the layout.
<div spry:region=”ds1" spry:repeatchildren=”ds1"
class=”SpryHiddenRegion” id=”mainRegion”> <br spry:if=”({No} == 3)
|| ({No} == 11) || ({No} == 19) || ({No} == 37) || ({No} == 55) ||
({No} == 87)” style=”clear:both;” />

This DIV is the s p r y : r e g i o n for ds1, the main data set. We also set a
spry:repeatchildren on the data set. This is the attribute that causes all the element
divs and the breaks (<br>) to repeat. The SpryHiddenRegion class is used to hide the
div while the page loads. The ID is needed because we use it on the observer described in
the Data sets section above.
So this code repeats the element div, which since it is float:left:, will line up all the
elements in a long horizontal line. In order to make the table look correct, we need to start
a new line at precise times, Helium, Neon, and so on. Every time we hit a green element,
we need to start a new line. We know the element Numbers where this needs to happen.
The <br> has a spry:if that has a “clear:both;”. This clears the float and causes the
remaining content to wrap to the next line.
We use the spry:if to determine when to add a <br> that will cause this break. So we
write a statement that says, “Break when the number {No} equals 3 or 19 or 37 or 55 or 87”.
Note that we actually use the number that is the first element of the new row.
This break, along with the float on the .elementBlock class, are the key components of
getting the layout correct. If we just had that, it would have the correct rows, but we still
need to create that gap in the first three rows (Periods, hence the name periodic table), so the
Contd...
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elements line up correctly vertically. To do this, we take advantage of having the {Name}
class on every element div.
Creating the Horizontal Spacing
In any periodic table, the first three rows (Periods) have a gap between elements because
they need to line up vertically in the correct column (Group). To do this , we create classes
that use a specific element name and contain simple CSS.
To position these three rows correctly, we simply add a large margin to the correct elements.
This pushes the elements to the right so they line up right. The float ensures it stays in line
horizontally.
The atoms.css file contains classes called .Hydrogen, .Beryllium, and .Magnesium. (Note that
they are uppercase because CSS and JavaScript are case sensitive.). The code is:
.Hydrogen { margin-right:928px; } .Beryllium, .Magnesium { marginright:580px; }

This pushes those rows over correctly. This, and a couple other details, are why we pass
the element name as a class name.
The Tooltip
We use a Spry Tooltip widget to show additional information about the element. The
table has much more information in it than we can fit in the element div.
The Tooltip widget works by having a tooltip element, which contains the tooltip content,
and a trigger, which activates the tooltip. Since we want the data to update for each
element, we use a s p r y : d e t a i l r e g i o n
for this. This is tied to the
onmouseover=”ds1.setCurrentRow(‘{ds_RowID}’);” attribute on the element divs.
This causes the detailregion to update on the onmouseover event.
Because the tooltip widget is a detailregion, we need to take steps to make sure it functions
properly. Generally, with widgets and Spry data, we have to reactivate widgets that get
wiped out when the data refreshes. In this case, we use observers to trigger the widget
constructor after the detail region updates.
<div spry:detailregion=”ds1" id=”tooltip” class=”SpryHiddenRegion”>
Name:<strong>{Name}</strong><br /> Type:<strong>{Element_Type}</
strong><br />
Group:<strong>{Group}</strong><br /> Symbol:<strong>{Symbol}</
strong><br />
Period:<strong>{Period}</strong><br />
Boiling Point:<strong>{BP}</strong><br />
Melting Point:<strong>{MP}</strong><br />
Density:<strong>{Density}</strong><br />
Atomic Weight:<strong>{Atomicweight}</strong><br />
Electron Config:<strong>{Electron_configuration}</strong><br />
Year Discovered:<strong>{DiscoveryYear}</strong> </div>
<script type=”text/javascript”>
Spry.Data.Region.addObserver(‘mainRegion’,{onPostUpdate:function(){var
tt1 = new Spry.Widget.Tooltip(‘tooltip’,’.elementBlock’,
Contd...
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{showDelay:750, hideDelay:500});}});
Spry.Data.Region.addObserver(‘Lanthanide’,{onPostUpdate:function(){var
tt2 = new Spry.Widget.Tooltip(‘tooltip’,’.elementBlock’,

Notes

{showDelay:750, hideDelay:500});}}); </script> </div>

The div is a detailregion tied to ds1, the main data set.
The id=”tooltip” is used to identify the tooltip content for the widget.
The SpryHiddenRegion class is used to automatically hide the markup as the page loads.
It is removed when Spry is done loading the page.
The <script> tags are within the detailregion. Spry has code that finds script tags within
regions and executes them after the data is finished loading.
The highlighted regions are observers that recreate the tooltip every time the detail
region updates. We add an observer to elements by their ID. In this case, we attach observers
to the two spry:regions: mainRegion and Lanthanide. The onPostUpdate notification
runs the function() after the data is finished updating in the region.
The function is the actual Tooltip constructor. tooltip is the ID of the tooltip content: the
detailregion .
.elementBlock is the class name that defines the trigger. Every time someone mouses
over an element with a class of elementBlock , the tooltip appears. In this case, the
elementBlock class is attached to every element div. Recall that is the class that sets the

size and border? So now the tooltip will trigger every time you mouse over the element
div. The onmouseover attribute causes the data to update to the current element
information and the observer instantly creates the new tooltip.
Highlighting Functions
At the top of the page, we have the links that highlight the particular part of the table. We
can select element types, groups, or periods. They are highlighted by graying out the
elements that don’t belong to the selection.
We use Spry to output the text and simple custom functions to enable this inverse
highlighting. These two functions are in atom_functions.js. One function does the
highlighting. The other clears any current highlighting. The hasClassName is a utility
function that will be included in the next version of Spry.
function GrayOutTable(activeClass)
{
var rows = ds1.getData(true);
var numRows = rows.length;
for (var i = 1; i <= numRows; i++)
{
var ele = Spry.$(“div_” + i);
if (ele) {
if (!Spry.Utils.hasClassName(ele, activeClass))
Spry.Utils.addClassName(ele,”grayOut”);
Contd...
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else

Spry.Utils.removeClassName(ele,”grayOut”);

}
}
}

There is a class defined in atom.css called grayOut that changes the opacity of an element
to 30%.
We pass in the name of the class that we want to highlight. We loop through the data set
and apply the grayOut class to all those element divs that do not have the class name that
is passed in. We use the id=”ds_{No}” that we set up on the element divs to identify the
divs that need this new class.
This function gets the data in ds1 and from that we get the number of rows (numRows).
We then loop through all the element divs. We use Spry.Utils to find out if the element
does not have the class name we are looking to highlight. If it does not have it, we add the
grayOut class. If it does have the class name we are looking for, we leave it alone. That’s
the inverse highlighting. If it already has the grayOut class applied, we assume it is from
a previous highlight and remove it.
The other function clears any highlighting by looping through the element divs and
removes any instance of the grayOut class.
To use these functions, we use the other data sets. All three work the same way. For
example:
<div> <span class=”redText”>Element Types: </span> <span
spry:region=”types” spry:repeat=”types” class=”SpryHiddenRegion”> <a
href=”#” onclick=”GrayOutTable(‘{Element_Type}’);”>{Element_Type}</
a>&nbsp; </span></div>
z

The div is so we can align this group correctly.

z

The first <span> simply adds the redText class to the initial text.

z

The second <span> defines the spry:region for, in this case, the types data set.
The spry:repeat is tied to the same data set. The SpryHiddenRegion hides the
markup until the page is ready.

z

The <a> has a null href so we get the hand cursor. The onclick attribute is the
actual function. The parameter in the function is the Element_Type data reference
and it is the value we are sending to the function. We want to highlight that Element
Type. The actual text of the link is also the Element Type. The space (&nbsp;) is
used to separate the links when we repeat through the data set.

So this will loop through the data set, which has the distinct Element Types and attaches
the function to each type. This easily creates the list of highlight types.
We use the same code for the groups and periods data sets. They all go to the same
function, since we are attaching those values on the element div as class names. So we can
use these values to pick the right elements to highlight.
Conclusion
This is a nice example of how to use Spry for more complicated web layouts. With a small
amount of markup, some CSS and a couple custom functions, you have a functional,
interactive learning tool.
Contd...
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Hopefully, you have found an interesting technique here or expanded your ideas of how
to use Spry.

Notes

Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://www.adobe.com/devnet/dreamweaver/articles/spry_periodic_case_study.html

12.6 Summary
z

Dreamweaver from Adobe is the web development tool that lets you efficiently design,
develop and maintain standards-based websites and applications.

z

Layers can be used for a page layout or to add special effects.

z

Layers can be overlapped with one layer partially or completely covering the layer
underneath. They can also be nested.

z

We can convert layout layers to a table. We can also have tables within layers.

z

We can adding elements like text and images into Layers.

z

Cascading Style Sheets (CSS) are a collection of formatting rules that control the appearance
of content in a web page.

z

You can change CSS into HTML to help with using Dreamweaver. Dreamweaver creates a
new document with HTML, leaving the CSS document in its original form.

z

Using inheritance we can apply CSS rules to more than one tag.

12.7 Keywords
Cascading: The term cascading in CSS refers to how many style sheets can affect a single document
in a cascading manner.
CSS Palette: The CSS palette helps you assign certain properties to a specific HTML tag.
CSS: They are a collection of formatting rules that control the appearance of content in a web
page.
Dreamweaver: Dreamweaver is the web development tool that lets you efficiently design, develop
and maintain standards-based websites and applications.
External Style Sheet: The CSS files that are linked to a document externally.
Inheritance: The property by which a child adapts the attributes of its parent.
Layers: They are used for a page layout or to add special effects.
Nested Layer: A nested layer is a “parent” layer and a “child” layer and the child layer is
positioned in relation to the parent.

12.8 Review Questions
1.

What is Dreamweaver? Also discuss the advantages of Dreamweaver.

2.

Explain the concept of layers.
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3.

Illustrate how to work with a single layer in Dreamweaver.

4.

Describe the steps used in converting a page formatted by a table to one with layers.

5.

Illustrate how to insert an Image in a Layer.

6.

Explain the concept of CSS.

7.

Discuss the concept of adding styles to HTML tags.

8.

Compare and contrast overlapped and nested layers.

9.

Illustrate how to link external style sheets to an html file using Dreamweaver.

10.

Dreamweaver creates a new document with HTML, leaving the CSS document in its
original form. Comment.

Answers: Self Assessment
1.

Layers

2.

web pages

3.

menu

4.

Insert

5.

nested layer

6.

Parent

7.

Properties window

8.

Align

9.

True

10.

False

11.

Cascading Style Sheets (CSS)

12.

<style>

13.

cascading

14.

Palette

15.

external

12.9 Further Readings

Books

Daniel Short and Garo Green, Macromedia Dreamweaver 8, Peachpit Press, 2006.
Khristine Annwn Page, Macromedia Dreamweaver 8: Training from the Source.

Online links

http://irt.austincc.edu/webdev/documents/dreamweaver8_quickstart.pdf
http://www.siteground.com/tutorials/dreamweaver/css_styles.htm
http://www.teacherclick.com/dreamweaver8/t_13_1.htm
http://www.siteground.com/tutorials/dreamweaver/css_styles.htm
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Objectives
After studying this unit, you will be able to:
z

Explain the concept of forms in Dreamweaver

z

Discuss form insertion in Dreamweaver

z

Understand various form objects of Dreamweaver

z

Elaborate the media elements in Dreamweaver
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Introduction
Web forms are used to collect information and feedback from users. The web page contains
special boxes called “fields” that collect data. The fields can be a text box, check box, radio button
or drop down menu. The form contains a Submit button that calls the script to process the
information entered, and a Reset button to return the form to its default state and erase all
information entered.
Figure 13.1: A Web Form

Source: http://files.sawmac.com/dw8/tutorials/DWForms/signup.html

Forms also serve as major tools for web developers because they can be altered on-the-fly; it’s
possible, for example, for a selection in one drop-down list to determine the contents of another.

13.1 Forms
HTML forms are interactive. That is it takes up values from the user and gives the user a
response in return after processing his request. We come across web forms every day. For
example, filling up a sign up form to create an email, survey form, feedback form, etc.

13.1.1 How HTML Forms Work?
HTML forms are used to pass data to a server. It can contain input elements like text fields,
checkboxes, radio-buttons, submit buttons and more. The <form> tag tells the browser where
the form starts and ends. You can add all kinds of HTML tags between the <form> and </form>
tags.
Syntax:
<form>
input elements
.</form>
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To let the browser know where to send the content we add these properties to the <form> tag:
z

Action: the address to redirect out page to after the form is submitted

z

Method: It can take up two values, post or get

Notes

The address is the URL of the CGI script the content should be sent to. The post and get methods
are simply two different methods for submitting data to the script. If we use the get method, it
appends the data to the URL making it unsafe to carry sensitive information. Unlike get, post
method is more secure and can carry large amount of data too.
Syntax:
<form method=”post” action=”http://www.abc.com”>
<!— Here goes form fields and HTML —>
</form>

The most important form element is the <input> element. The <input> element is used to select
user information. An <input> element can vary in many ways, depending on the type attribute.
An <input> element can be of type text field, checkbox, password, radio button, submit button,
and more.
Example:
<form>
First name: <input type=”text” name=”firstname”><br>
Last name: <input type=”text” name=”lastname”>
</form>

The above code creates a one-line input field that a user can enter text into.

Did u know? The default width of a text field is 20 characters.

The name attribute identifies the control. In the example above, name is assigned a value of
“lastname”. Information input by the user in a control, such as a text field, is sent to the server
along with the value of that control’s name attribute. The message sent to the server would
include the following string:
Last name=abc
Servers send all the information from a form in one long text string to whatever program or
address is specified in the action attribute. It’s up to the program or the recipient of the form
message to parse the string.
lastname=abc&address=a.bc@gmail.com&comment=Age%21
As you can see, the various fields are separated by ampersands (&), and the individual words
within the responses are separated by plus signs. Most non-alphanumeric characters such as the
exclamation mark in the example are represented by their hexadecimal values. Decoding this
text string is called parsing the response.
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Self Assessment
State whether the following statements are true or false:
1.

The web page contains special boxes called fields that collect data from the user.

2.

The <form> tag tells the browser where the form starts and ends.

3.

The <form> tag has only one property called action.

4.

If we use the get method, it appends the data to the URL making it unsafe to carry sensitive
information.

13.2 Inserting Forms
To create a form follow the steps given below:
1.

Change your Insert Panel from Common to Forms by clicking the Forms tab
Figure 13.2: Form Tab

Source: http://www.sph.umich.edu/computing/web/pdf/DreamweaverForms.pdf

The Insert Panel with Forms is selected and Dreamweaver inserts a red, dashed outline
across the Document window to indicate that the form has been created. Your Properties
Panel will also display the properties for your form.

298

2.

Roll your mouse over any icon in the Insert Panel and the object that each icon is associated
with will be displayed.

3.

Set the action property of the form which tells the web browser what to do with the
information that the user types in to the form. Leave the value of the Method property as
“POST”.
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Figure 13.3: Properties Panel

Notes

Source: http://www.sph.umich.edu/computing/web/pdf/DreamweaverForms.pdf

4.

The Target property tells the web browser whether to open a new window after the form
is sent in, or stay in the same window. Leave that field blank.

5.

Give your form a name in the Form Name property box.

There are a few properties applicable to forms that need to be taken care of:
z

Forms can’t be resized by dragging its boundaries.

z

The outline of a form is invisible in a browser; there is no border to turn on or off.

z

You can’t have a form spanning part of a table.

13.2.1 Declaring the Encoding Type (enctype)
The enctype attribute specifies how the form-data should be encoded when submitting it to the
server.

Notes The enctype attribute can be used only if method=POST
Syntax: <form enctype=”value”>
It can take three attribute values:
z

application/x-www-form-urlencoded: It is the default value. All characters are encoded
before being sent to the server. The spaces are converted to “+” symbols, and special
characters are converted to ASCII HEX values.

z

multipart/form-data: No characters are encoded. This value is required when you are
using forms that have a file upload control.

z

text/plain: Spaces are converted to “+” symbols, but no special characters are encoded.

13.2.2 Using Text Fields
Text fields are one of the most common fields you will see on the internet. They are a box on a
web page that visitors are able to select and type text into it. The tag to put a text field on your
web site is:
<input type=”text”>

13.2.3 Inserting Text Fields
To insert a single-line text field in Dreamweaver, you can use any of the following methods:
z

Go to Insert panel -> Forms category ->Text Field button
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z

Drag the Text Field button from the Insert panel to any existing location in the Document
window and release the mouse button to position the text field.

The Input Tag Accessibility Attributes dialogue window will appear.
Figure 13.4: Input Tag Accessibility Attributes Dialogue Window

Source: http://www.sph.umich.edu/computing/web/pdf/DreamweaverForms.pdf

ID: The name for this form field. It should be a single word like “firstName” for first name.
Label: Label is the text that you want to appear next to the text field.
Example: If you want your user to type in their first name, you would want to label the
text “First Name.” Checking the box labeled. Attach label tag using ‘for’ attribute will associate
the label you type in with the text field, making it easier for users with disabilities. You can
position your label before or after the text field.
Once you insert text fields for First Name and Last Name, your form will look like this:
Figure 13.5: Form Created

Source: http://www.sph.umich.edu/computing/web/pdf/DreamweaverForms.pdf

Open the Properties Panel of the text field and change the necessary properties.
Figure 13.6: Properties Panel

Source: http://www.sph.umich.edu/computing/web/pdf/DreamweaverForms.pdf
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Tip: You can also lock your text field from entry and change its appearance with the check of the
Disabled option.

Notes

13.2.4 Creating Password Fields
Password fields are similar to text fields. The difference is that what is entered into a password
field shows up as asterisks or circles on the screen. This is to prevent others from reading the
password on the screen.
<input type=”password”> defines a password field.
Example:
<form>
Password: <input type=”password” name=”pwd”>
</form>

!
Caution Only single-line text fields can be set as password fields.

13.2.5 Inserting Multiline Text Areas
Text areas are text fields that can span several lines. Unlike most other form fields, text areas are
not defined with an <input> tag. Instead you enter a <textarea> tag where you want the text area
to start and a closing </textarea> tag where you want the area to end. Everything written
between these tags will be presented in the text area box.
Example:
<textarea cols=”40" rows=”5" name=”textarea1">
This is my text area
</textarea>

This creates a text field with 5 rows and 40 columns.
We can insert a text area using any of the following methods:
z

Insert a single-line text field on the page as previously described and convert the field to
multiple lines by choosing the Multi line option in the Text Field Properties panel.

z

Choose Insert ! Form ! Textarea or click the Textarea button in the Forms category of the
Insert panel.

13.2.6 Constructing Neat Forms
Tables are a powerful tool for presenting tabular data and for laying out text and graphics on an
HTML page. A table consists of one or more rows; each row consists of one or more cells.
Although columns aren’t usually explicitly specified in HTML code, Dreamweaver enables you
to manipulate columns as well as rows and cells. When you are working on a larger, complex
form tables prove to be extremely useful.
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When you place a multiline text field on a form, you can specify how text entered into that field
should wrap. You indicate this using the wrap field in the Properties panel. The various options
available are:
z

Default: The scrolling characteristics of the multiline text field is determined by the
browser.

z

Off: Text entered into a multiline text field keeps scrolling until the user presses Enter.

z

Virtual: Text on the screen wraps when it reaches the right edge of the text area, but not
when the response is submitted to the server.

z

Physical: Text wraps on the screen and converts the soft returns on the screen to hard
returns when the data is submitted to the server.
Figure 13.7: Wrap Option in Properties Box

Source: http://www.siteground.com/tutorials/dreamweaver/dreamweaver_tables.htm

13.2.7 Grouping Form Controls
The <fieldset> tag is used to group related elements in a form. It draws a box around the related
elements. The <legend> tag defines a caption for the <fieldset> element.
Example:
<form>
<fieldset>
<legend>Personalia:</legend>
Name: <input type=”text”><br>
Email: <input type=”text”><br>
Date of birth: <input type=”text”>
</fieldset>
</form>

Output

Source: http://www.w3schools.com/tags/tryit.asp?filename=tryhtml_fieldset
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To apply the <fieldset> tag in Dreamweaver, select a set of existing controls that you’d like to
group and then clicking the Fieldset button in the Forms category of the Insert panel.

Notes

13.2.8 Providing Checkboxes and Radio Buttons
When the user has options to choose from in your form, checkboxes or radio buttons come in
handy. Checkboxes allow the user to choose multiple but radio button restrict your user to only
one selection from a number of options.

Checkboxes
Setting the type attribute of an <input> tag to checkbox places a checkbox element onto the web
page. A checkbox element can be placed onto a web page in a pre-checked fashion by setting the
checked attribute with a “yes” value. By doing so, this element will now default to a checked
status each time the HTML page is loaded.
Example:
<form action=”http://www.abc.com” method=”post”>
<p>Select your sport</p>
Soccer: <input type=”checkbox” name=”sports” value=”soccer” />
Football: <input type=”checkbox” name=”sports” value=”football”
/>
Baseball: <input type=”checkbox” name=”sports” value=”baseball”
/>
Basketball: <input type=”checkbox” name=”sports” value=”basketball”
</form>

/>

Output

Source: http://www.w3schools.com/html/tryit.asp?filename=tryhtml_checkbox

To create checkboxes in Dreamweaver, select or drag the CheckBox object from the Insert panel
or choose Insert ! Form ! CheckBox.

Radio Buttons
Radio buttons are used when you want to let the visitor select one – and just one – option from
a set of alternatives.
Example: A
<form action=” “ method=”POST”>
<div align=”center”><br>
<input type=”radio” name=”group1"
<input type=”radio” name=”group1"
<input type=”radio” name=”group1"
<hr>
<input type=”radio” name=”group2"
<input type=”radio” name=”group2"

value=”Milk”> Milk<br>
value=”Butter” checked> Butter<br>
value=”Cheese”> Cheese
value=”Water”> Water<br>
value=”Beer”> Beer<br>
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<input type=”radio” name=”group2" value=”Wine” checked> Wine<br>
</div>
</form>

Output

Source: http://www.echoecho.com/htmlforms10.htm

To create radio buttons in Dreamweaver, select or drag the radio button from the Forms category
of the Insert panel, or choose Insert ! Form ! Radio Button and to insert several related radio
buttons at one time, select or drag the Radio Group button from the Forms category of the Insert
panel, or choose Insert ! Form ! Radio Group.

Self Assessment
Fill in the blanks:
5.

The wrap option in the properties of a multiline text field on a form has the following four
available options: ……………………, ……………………, …………………… and
……………………

6.

The …………………… tag is used to group related elements in a form.

7.

The Insert Panel with Forms is selected and Dreamweaver inserts a ……………………
dashed outline across the Document window to indicate that the form has been created.

8.

Radio buttons are used when you want to let the visitor select only ……………………
option from a set of alternatives.

13.3 Form Objects
The Forms panel located in the Insert panel helps the user to create a Web-based form that can
have the Form tag, Text field, List, Buttons Checkbox, Radio buttons and other options.

Data Objects
The Data category of the Insert panel lets you insert dynamic elements such as recordsets,
repeated regions, and record insertion and update forms.
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Figure 13.8: Data Objects

Notes

Source: http://librairie.immateriel.fr/fr/read_book/9780596522926/ch23

Spry Objects
A Spry data set is a JavaScript object that holds a collection of data that you specify. With
Dreamweaver you can quickly create this object and load data from a data source (such as an
XML file or HTML file) into the object. The data set results in an array of data in the form of a
standard table containing rows and columns. As you’re creating a Spry data set with
Dreamweaver, you can also specify how you want to display the data on a web page. You can
think of a data set as a virtual holding container whose structure is rows and columns. It exists
as a JavaScript object whose information is only visible when you specify exactly how to display
it on the web page. You can display all of the data in this holding container, or you might choose
to display only selected pieces of it.
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Figure 13.9: Spry Objects

Source: http://www.extendstudio.com/blog/2010/03/how-to-create-spry-tabs-with-dreamweaver-anddiv-content/

Example: Using Spry validation on a text area field:
1.

Select the field and click the Spry Validation Text Field icon in the Forms Toolbar.
Figure 13.10: Spry Validation Text Field

Source: http://www.sph.umich.edu/computing/web/pdf/DreamweaverForms.pdf

The e-mail address field with Spry validation applied.
2.

You will be prompted to copy supporting files into your current working directory. Click
the OK Button.

3.

Save the form, then preview it again in your browser. Try submitting the form without
filling in the e-mail field. You should see something like this:
Figure 13.11: Spry Validation Text Field: without filling e-mail field

Source: http://www.sph.umich.edu/computing/web/pdf/DreamweaverForms.pdf
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InContext Editing Objects
It creates editable regions which allows content contributors to update web site content remotely
without the need to edit or disturb the original web site files. They are inserted and managed
through the objects found in the Insert panel, InContext Editing category.
Figure 13.12: InContext Editing Objects

Source: http://www.adobe.com/mena_fr/devnet/businesscatalyst/articles/ice_for_admins.html

Text Objects
The text objects represent the most commonly used text formatting HTML tags like <b>, <emp>,
<ul>, etc. They have different characteristics depending on whether you are working InDesign
view or Code view. In the Code view, Dreamweaver surrounds the text selected with the
appropriate HTML tags or else inserts the tag pair at the current text insertion point. InDesign
view also Dreamweaver surrounds selected text with the appropriate tag pair but InDesign
view, if no text is selected when you click one of the text formatting buttons, no tags are added
until you start typing. This feature helps prevent the inclusion of empty tag pairs within your
document.

Favorites
The Favorites toolbar can be customized to contain buttons you use frequently from the other
toolbars; however, it will remain blank until you choose to use it.
Figure 13.13: Customize your Favorites Toolbar

Source: http://www.uwec.edu/help/DreamweaverCS3/env-insert.htm
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To do this follow the steps below:
1.

On the Insert bar, click Favorites

Notes If the toolbar is blank, it will contain the words, “Right-click to customize your favorite
objects.” If the toolbar has already been formatted, it will contain buttons.
2.

Right click anywhere on the toolbar ª select Customize Favorites. The Customize Favorite
Objects dialog box appears.

3.

From the Available objects scroll list, select the button you would like to appear on the
Favorites toolbar.

4.

Click add. The object appears in the Favorite objects list.

5.

Click ok. The objects you selected appear on your Favorites toolbar.

ASP Objects
The ASP category of the Insert panel helps to create Active Server Pages. They have a .asp
extension.

CFML Objects
In order to access to the most frequently used objects in the ColdFusion toolbox, Dreamweaver
provides the CFML category in the Insert panel. The active document needs a file extension of
.cfm or .cfc to access these objects. There are two available options: Flow inserts ColdFusion
markup tags that alter the flow of control through the code and advanced provides many
advanced functions.

JSP Objects
To add code specific to Java Server Pages, the JSP category on the Insert panel has JSP objects.
This category is visible only when the currently active document has a file extension of .jsp.

PHP Objects
If the user wants to insert code used in the PHP server-side scripting language, he can make use
of PHP objects available in the PHP category of the Insert This category is available only if you
are working in a document with the extension of .php, .php3, .php4, or .php5.

XSLT Objects
To create an XSLT page, use the XSLT object category of the Insert panel. This category has the
features that are available from the Insert ! XSLT Objects menu including Dynamic Text, Repeat
Region, Conditional Region, Multiple Conditional Region, and XSL Comment.

Self Assessment
State whether the following statements are true or false:
9.
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The Data category of the Insert panel lets you insert dynamic elements such as recordsets.
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10.

A Spry data set is a JavaScript object that holds a collection of data that you specify.

11.

PHP objects are available only if you are working in any type of document.

12.

The Favorites toolbar cannot be customized.

Notes

13.4 Media Elements
We can insert multimedia elements like Flash animation, a sound and a video in our document
using simple steps in Dreamweaver. Let us discuss these steps below:

13.4.1 Inserting Media Elements
We can add a Flash movie or object, Quicklime or Shockwave movie, Java ActiveX control, or
other audio or video objects in a Dreamweaver document. For this just follow the steps below:
1.

Choose the Insert bar -> Common category and click the Media button.

2.

Select the Flash option for the type of object you want to insert.

3.

In the Select File dialog box, select the Flash file you want to insert.

4.

Click OK. An icon is displayed in your page.

5.

Preview the Flash movie by clicking the Play button in the Property Inspector Panel.
Figure 13.14: Adding Media Elements

Source: http://www.teacherclick.com/dreamweaver8/t_10_1.htm

13.4.2 Creating Flash Buttons
To create flash buttons, follow the steps below:
1.

Open up Dreamweaver and place your cursor where you would like to insert the flash
button. You may prefer to use a table when inserting flash buttons. This will create an
even appearance on your page and you can better control the placement of the buttons.

2.

Go to insert->Media->Flash Button.
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3.

Choose the type of button you would like and edit the text, font, size, where the button
links to, how the linked page opens (target) and background color of the button.

4.

Change each of these settings and click on “apply” to see what the button’s animation is
and what it will look like on your page. Once you are happy with the button you have
created, click on “ok”, and your button will be added to your page. You will be prompted
to name your button after you click ok.
Figure 13.15: Flash Button Settings

Source: http://www.wikihow.com/Image:Picture-3-1.png

5.

If you wanted to change your button once it’s inserted, double click on the button and the
same screen from step 3 will appear. You can make your changes and then click ok again
to insert the button on your page.

13.4.3 Media Element Properties
The Property Inspector Panel helps to access and edit properties of the Flash element you insert.
Some of these properties include:
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z

File: Specifies the path to the Flash object file. Click the folder icon to browse to a file, or
type a path.

z

src: The src box contains the Flash (.fla) source file.

z

Loop: Specifies the number of times the media will play.

z

AutoPlay: Allows the Flash movie to play automatically when the page loads.
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Scale: This property determines how the movie fits into the dimensions as specified in the
Width and Height textboxes.

z

Quality: It sets the quality parameter for the object and embed tags that define the button.
A movie looks better with a high setting, but it requires a faster processor to render
correctly on the screen. Low emphasizes speed over appearance, whereas High favors
appearance over speed. Auto Low emphasizes speed to begin with, but improves
appearance when possible. Auto High emphasizes both qualities at first, but sacrifices
appearance for speed if necessary.

Notes

13.4.4 Commands Menu
It is used to apply advanced features to your Dreamweaver document. Some menu items, such
as the Record commands, eliminate repetitive tasks and others, such as the Clean Up HTML
command, fix common problems in a single sweep.
Figure 13.16: Commands Menu

Source: http://www.adobe.com/support/dreamweaver/extend/creating_simple_cmmd_ext/
creating_simple_cmmd_ext02.html

We will now discuss the options available in this menu.
z

Start/Stop Recording: Records a series of actions that can then be reapplied to other parts
of the document. When you select the Start Recording command, Dreamweaver records
each of your actions until you choose Stop Recording.
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Notes Dreamweaver only retains one recorded command at a time.
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z

Play Recorded Command: Reapplies the most recently recorded command.

z

Edit Command List: Opens a list of all saved commands. You can rename the commands
or delete them permanently.

z

Get More Commands: Opens the Macromedia Exchange for Dreamweaver Web site in a
new browser window so that you can search for and download new extensions or
commands. Extensions are downloaded to your Extension Manager.

z

Manage Extensions: Opens the Extension Manager, a program that lets you manage
extensions you download from the Macromedia Exchange Web site. The Extension Manager
helps you install, delete, and selectively disable extensions.

z

Apply Source Formatting: Changes you make to Dreamweaver’s HTML source formatting
(which is defined in the Preferences window and the SourceFormat.txt file) apply only to
newly created documents. This command, on the other hand, offers a way to apply these
formatting preferences to existing HTML documents.

z

Apply Source Formatting to Selection: Same as the previous command, “Apply Source
Formatting,” but applies only to whatever you’ve selected. In this way, you can make sure
the HTML for a <table> is nicely formatted (by selecting it and applying this command),
while the rest of your finely crafted HTML is left alone.

z

Clean Up HTML/XHTML: Opens a list of options for correcting common HTML problems,
such as empty tags or redundant nested tags. Once you’ve selected what you’d like to fix,
Dreamweaver applies those changes to the current document and, if requested, provides
a log of the number and type of changes made.

z

Clean Up Word HTML: If you import HTML that was generated by Microsoft Word, you
often end up with unnecessary or cluttered HTML tags that can affect your site’s
performance. This command opens a list of options that can correct formatting problems
common in Microsoft Word’s HTML. Dreamweaver applies your selected changes to the
document and, if requested, displays a log of the number and type of changes it made.

z

Add/Remove Netscape Resize Fix: This command lets you insert JavaScript code into your
document that counteracts a bug in version 4 of Netscape Navigator (the bug causes pages
that use layers to display incorrectly when the browser window is resized). The inserted
code makes the page reload every time a browser window is resized.

z

Remove Flash Video Detection: If you’ve added Flash Video to your page, Dreamweaver
inserts some JavaScript code used to help make sure your site’s visitors can view the
video. Unfortunately, if you just delete the movie from your page, the JavaScript code is
left in the page. This command removes it.

z

Optimize Image in Fireworks: Opens the selected image in Macromedia Fireworks’
Optimization window, where you can experiment with different compression settings to
find the best balance between file size and image quality. If you used Fireworks to create
the image in the first place, you can choose to use the original Fireworks PNG file or the
selected image (GIF or JPEG file) as the source image. Dreamweaver then replaces the
selected image with the newly optimized image.

z

Create Web Photo Album: Lets you turn a folder of images into a Web-based photo album.
The Create Web Photo Album window appears; specify a title for your album, the source
folder, and so on.
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Notes This command requires Macromedia’s Fireworks image-editing program, which
creates thumbnail and full-size versions of each image. Dreamweaver then creates a Web
site with one page displaying all of the thumbnail images. The thumbnails are linked to
individual HTML pages containing the full-size images.
z

Format Table: Opens a list of preset formatting options for your HTML table, including
color schemes, text alignment and style, and border measurements. (Unavailable when a
table is in Layout mode).

z

Sort Table: Sorts the information in a selected table. You can choose to sort alphabetically
or numerically, in ascending or descending order. This command cannot be applied to
tables that include rowspans or colspans.

z

Insert Mark of the Web: This is applicable only to Windows XP with Service Pack 2. This
software update inserted code into Internet Explorer to “protect” it from malicious Web
page code.

z

Attach an XSLT Stylesheet: This menu option, available only when working on a XML
file, lets you attach an XSL file, which miraculously transforms cryptic XML into a beautiful,
browser-viewable page.

Creating a Command
We explain the process to create a command with an example given below:
Let’s try typing “Hello”.
1.

Select Commands menu bar option.

2.

Click on Start Recording option.

3.

Do the steps which you want to record as a command. Let us type the word, Hello.

4.

When you finish recording, select Commands menu bar option and click Stop Recording.

Playing back a Recorded Command
To playback a recorded command, click on Command menu bar and choose Play Recorded
Command.

Saving a Recorded Command
We use the following steps to save a recorded command:
1.

Select Commands menu bar option.

2.

Click on Play Recorded Command to play the command back.

3.

Select the Run Command step.

4.

Right click and select Save As Command option.

5.

Enter a name for the command.

6.

Click OK. The command now appears in the Commands menu. You just have to click the
command name in the Commands menu to run the command.
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Self Assessment
Fill in the blanks:
13.

The …………………… Panel helps to access and edit properties of the Flash element you
insert.

14.

To playback a recorded command, click on Command menu bar and choose
…………………… Command.

15.

Preview the Flash movie by clicking the …………………… button in the Property Inspector
Panel.

Case Study

Intranet and Web Design Training for
Met Office Scientists

T

he Met Office, have their own Intranet, known as “MetNet”, and they use it to
publish documents for their scientific staff to read, for better and quicker
communication.

We have been training Met Office staff since 1996, but they first came to Systematix with an
Internet training requirement in 1999.
Their scientists are professionals with high academic and professional achievements, and
several are experienced trainers in their own right, so this is one of the most challenging
requests we have ever had.
The selection of the appropriate dedicated Trainer for this highly demanding group was
crucial to the success of this applied training solution.
Systematix provided the Met Office with a specialist Science graduate who was also a
highly experienced Internet Trainer.
The first course we designed for them was a special one-day session. The training was
carried out at The Met Office College, for up to 8 delegates per session. It covered an
introduction to their preferred web browser Netscape Navigator and also a customised
introduction to HTML, so that they could browse their intranet and the Internet and create
their own documents.
Following the success of this initial Internet training in 1999 we have continued to create
and deliver customised web design courses, on Microsoft FrontPage and in the last few
years Adobe Dreamweaver, Flash and Fireworks, for Scientific Officers, Managers and
Directors from all over the United Kingdom.
Since the move to Exeter in 2003, Systematix have continued to be the preferred training
supplier for bespoke web development training.
Gains for their Business
The training has been highly successful – since 1999 almost 1000 Met Office staff have
attended, with more courses booked for 2007, this take-up rate speaks for itself.
These professional users have been able to go back to their stations throughout the UK
and use MetNet effectively, making it a highly valuable resource for communication
within the Met Office organisation.

Contd...
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Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://www.systematix.co.uk/about-us/met-office-case.htm

13.5 Summary
z

Web forms are used to collect information and feedback from users.

z

The web page contains special boxes called “fields” that collect data.

z

HTML forms takes up values from the user and gives the user a response in return after
processing his request.

z

To let the browser know where to send the content we add action and method properties
to the <form> tag.

z

The enctype attribute specifies how the form-data should be encoded when submitting it
to the server.

z

We can create forms using Text Fields, creating Password Fields and inserting Multiline
Text Areas.

z

When you place a multiline text field on a form, you can specify how text entered into that
field should wrap. You indicate this using the wrap field in the Properties panel. The
various options available are: Default, Off, Virtual and Physical.

z

The <fieldset> tag is used to group related elements in a form. It draws a box around the
related elements.

z

When the user has options to choose from in your form, checkboxes or radio buttons come
in handy. Checkboxes allow the user to choose multiple but radio button restrict your
user to only one selection from a number of options.

z

We have multiple Form Objects to choose from. For example, Data Objects, Spry data
objects, Text Objects, ASP Objects, etc.

z

We can insert various Media Elements in our Dreamweaver document like Flash Buttons
to make them more presentable and interactive.

13.6 Keywords
Action: The address to redirect out page to after the form is submitted.
CGI (Common Gateway Interface): It is computer latin for a program that translates information.
Enctype: It specifies how the form-data should be encoded when submitting it to the server.
Fields: They collect data from the user on a web form.
Spry Data Object: It is a JavaScript object that holds a collection of data that you specify.

13.7
1.

Review Questions
Explain with example the method and action properties of the form tag.
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2.

Differentiate between radio boxes and check boxes with suitable codes.

3.

Elaborate the various form objects available in Dreamweaver.

4.

Give the steps to create a Flash button in Dreamweaver.

5.

What do you mean by the enctype attribute?

6.

What is the reason to use POST and not GET in forms?

7.

Explain the three kinds of text fields that can be added in Dreamweaver.

8.

How do we insert media in a Dreamweaver document?

9.

List the properties of media elements in Dreamweaver.

10.

Briefly discuss the options available in the commands menu.

Answers: Self Assessment
1.

True

2.

True

3.

False

4.

True

5.

Default, Off, Virtual, Physical

6.

Fieldset

7.

Red

8.

One

9.

True

10.

True

11.

False

12.

False

13.

Property Inspector

14.

Play Recorded

15.

Play

13.8 Further Readings

Books

David Sawyer McFarland, Dreamweaver 8: The Missing Manual, O’Reilly Media,
Inc.
Tom Nelson and Mary F. O’Connor, Review of Adobe Dreamweaver CS4.
Daniel Short and Garo Green, Macromedia Dreamweaver 8, Peachpit Press, 2006.
Khristine Annwn Page, Macromedia Dreamweaver 8: Training from the Source.

Online links

http://www.echoecho.com/htmlforms02.htm
http://www.tizag.com/htmlT/forms.php
http://www.calstatela.edu/its/training/pdf/dreamweaver8p2.pdf
http://www.teacherclick.com/dreamweaver8/t_9_1.htm
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Objectives
After studying this unit, you will be able to:
z

Understand the working area of PageMaker

z

Viewing the document

z

Discuss the working of text

z

Explain the use of graphics

z

Define the toolbox

z

Discuss the templates in detail

z

Understand rulers and their types

z

Elaborate the concept of guides

Introduction
PageMaker is a desktop publishing program. It is used to create documents with a complex
layout of text and graphics, such as brochures, pamphlets, newsletters, fliers, reports etc. It offers
certain functionalities of a graphics program, and is therefore more suited to organizing pages
compared to a word processing program (especially when including graphic images in the
document). With Adobe PageMaker, you can work at your own design level to achieve the
superb results you require. You can start with eye-catching templates or design your own
unique layouts, use included stock photographs or incorporate your own multilayer Adobe
Photoshop graphics, or optimize your work for high-end printing or crisp on-screen resolution.
Whatever your publishing needs are, you can count on PageMaker for complete control in
creating persuasive and effective communications.

14.1 Working Area of PageMaker
Let us now discuss about the basics of PageMaker.

14.1.1 Toolbox
The PageMaker Toolbox contains all of the tools you will use for creating and manipulating text
and objects. It also contains two tools to help you view your publication. If the Toolbox is not
visible or if you have closed it and want to redisplay it, then select Show Tools from the Window
menu.
Figure 14.1: The PageMaker Toolbox

Source: http://faculty.carrollcc.edu/bjustice/PageMaker65/pagemaker_toolbox.htm
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Did u know? PageMaker was one of the first desktop publishing programs, introduced in
1985 by Aldus Corporation initially for the then-new Apple Macintosh and in 1987 for PCs
running Windows 1.0.

14.1.2 Control Palette
It offers quick access to commands for the currently selected object.
Figure 14.2: Control Palette

Source: http://www.brighthub.com/multimedia/publishing/articles/9509.aspx

14.1.3 Page in Control Palette
It defines the print area of a publication. We can set the dimensions of the page while creating a
new publication.

14.1.4 Pasteboard in Control Palette
The PageMaker Pasteboard is similar to the old style paste-up or mock-up boards used by
newspapers and magazines to layout pages. In PageMaker, the Pasteboard appears as a large
white space all around the marked off area of the document. It provides a workspace outside the
page where you can store and manipulate elements before positioning them on the page.

14.1.5 Styles and Color Palettes
Color Palette in PageMaker is used to assign spot, process and tints for all objects and text within
the document. Note that placed EPS graphics will import their colors within the color palette.
Figure 14.3: Styles and Colors Palette

Source: http://www.uncp.edu/doit/training/guides/pdf/pagemaker_6_5plus.pdf
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The Style palette contains styles (combinations of typographical means) which are applied to
the corresponding items in the text (e.g. chapter heading, caption) in order to give them their
distinctive appearance in the publication.

14.1.6 Page Icons in Color Palette
The numbered page icons at the bottom left-hand corner of your screen each represent the pages
of the document you are working on. The icon of the particular page that you are viewing will
be highlighted. The L and R icons in the extreme left represent your master pages. Any items on
the master pages appear on all of the document’s pages.

14.1.7 Pasteboard in Color Palette
PageMaker provide a pasteboard area where you can place objects prior to positioning them on
your pages. In PageMaker, the pasteboard area is shared among all pages in a publication. It is
the background that lies behind your PageMaker document. It is a handy element to use if you
need to move text or images between pages. You can also place these items on the pasteboard
until you decide where to position them on the page. Any text or images that you place on the
pasteboard won’t print. If you can’t see the pasteboard, click the Normal View button at the
bottom of the toolbar.
Figure 14.4: Pasteboard

Source: http://www.adobetutorialz.com/articles/1265/1/The-PageMaker-Environment

Toolbox: displays tools you can select to create or edit objects and view a publication.
Margins: appear as dotted pink and purple lines.
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Page icons: show the master pages (L for left, and R for Right) and the regular pages in the
publication. The open page is highlighted. Scroll arrows appear if there are more page icons to
view than can be displayed at one time.

Notes

Rulers: help you align objects on the page.
Color and Styles palettes: are used to add, delete, and edit colors and styles.
Pasteboard: stores items for later use. Items on the pasteboard are visible from any page but do
not print.
Publication Page: is at the center of the pasteboard.
Control Palette: lets you make precise changes to text and graphics without switching to the
toolbox or choosing menu commands.

Preferences
To set preferences, select File, Preferences, General from the menu.

Task Use all the tools and create a sample page for a grocery store.

Self Assessment
Fill in the blanks:
1.

If the Toolbox is not visible or if you have closed it and want to redisplay it, then select
…………………… from the Window menu.

2.

In PageMaker, the …………………… area is shared among all pages in a publication.

14.2 Viewing the Document
To view a document, select View from the menu and choose from Zoom In, Zoom Out, Actual
Size, and Fit in Window or Entire Pasteboard.

14.2.1 Viewing Other Pages
See the bottom of the screen of the PageMaker. You will find icons for each page. A document
may have up to 999 pages and in case there are more page icons than can fit across the screen, a
scroll bar appears. Just simply click on the number of the page that you would like to view.

Notes To make a page appear in Fit in Window view, hold Shift while clicking on a page
icon.

14.2.2 Moving around a Page
Our publication can have multiple pages. In order to move around the various pages we can
choose any of the following options.
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Scroll Bars
The scrollbars in PageMaker are set to the centre of each bar. They scroll the page you are
currently on. You can use the scroll bar on the right side to move up and down and the scroll bar
at the bottom to move left and right.

Hand Tool
Hand tool is used to move the screen. This tool is very useful when you are working with large
documents. It helps you to easily navigate in a large page. To move a screen, just select the hand
tool and click and drag the page to view different parts of the page.
Figure 14.5: Hand Tool

Source: http://bohemiawebsites.com/images/pagemaker/pmhandtool-178.jpg

Master Pages
A master is like a background that you can quickly apply to many pages. Objects on a master
appear on all pages with that master applied. Changes you make to a master are automatically
applied to associated pages. Masters commonly contain repeating logos, page numbers, headers,
and footers. They can also contain empty text or graphic frames that serve as placeholders on
document pages.

Notes Elements on the Left (even-numbered) Master Page will display ONLY on Left
(even-numbered) document pages. Accordingly, Right (odd-numbered) Master Page
elements will display ONLY on Right (odd-numbered) document pages.

Page Numbers
Click on the Left/Right Master Pages icon. Select the text tool from the Toolbox. Use the text tool
to click an insertion point on the page where you want the page number to appear. Type page,
then press Ctrl-Alt-P. This will cause the appropriate page number to appear on each page next
to the word, Page. On the master pages, a page number marker indicates where page numbers
will appear. Copy and place the text on the bottom of the right page.
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Self Assessment
Fill in the blanks:
3.

To view a document, select View from the menu and choose from the four options:
……………………, ……………………, …………………… and ……………………

4.

To move around a page, you can select any option like, ……………………,
……………………, …………………… or ……………………

14.3 Text
Now we will see how to create and add text to our PageMaker publication.

14.3.1 Placing Text
Preparing Text for Placement
The contents of your text sections should be created in a word processor and formatted in
PageMaker.

Using the Command, Place
In order to bring a text or graphic file into your PageMaker document the Place command is
used. For this, go to the View menu and set the Lock Guides and Snap to Guides options. Then
Select the File menu and choose Place. Now, find the document you wish to insert, and click on
Open.

Task Find out the functions of the three text cursors.

Window Shades and Text Flow
Window shades are like sizing handles in that they manipulate the height of a text block. They
are called Window shades because they appear at the top and bottom of text blocks as solid lines
with a small loop, like a traditional rolling window shade. Window shades can be used to
increase or decrease the size of a text block just like regular sizing handles. Simply click on the
loop and drag the shade to make the block bigger or smaller. Window shades are also used to
link and flow text. Information on linking and flowing appears later.

Text Flow into Defined Rectangles
To place text into a text box, load your cursor. Press the mouse button and drag a rectangle.
When completed, release the mouse button and the text will flow into the box. If all the text does
not fit you will need to place the rest of the text or make your text box bigger. This is an alternate
way to place text rather than it just flowing through a document.

Editing and Adding Text
To add and edit text we can use the Text tool from the Toolbox.

LOVELY PROFESSIONAL UNIVERSITY

323

Graphic Tools

Notes

Creating a Text Box
The text tool creates a text box, when used to add text to a PageMaker document. To limit the text
box, click and drag a text box prior to typing. When you release the mouse button to start typing
the outline disappears, but, PageMaker remembers the size and limits your text to that box.

Editing Text
You can edit text in PageMaker in two ways:
1.

In the layout view—you select and edit with the text tool. This is useful when you need to
see how revisions look on the page.

2.

In the story editor—you work only with the text, not the layout, so revising text is easy.
You can apply formatting to text in story editor but you won’t see the changes. You can use
spell check to work in the story editor
(a)

Click in a story with the text tool

(b)

Choose Edit—Edit Story

Altering Text Blocks and Text
Text blocks can be edited in the regular type, cut, and paste method.

Self Assessment
State whether the following statements are true or false:
5.

In order to bring a text or graphic file into your PageMaker document the Place command
is used.

6.

To place text into a text box, load your cursor.

14.4 Graphics
After text we will now discuss the use of graphics in PageMaker.

14.4.1 Repositioning
A graphic can be moved by various methods. Some of them are explained below.

Layering Graphics
We can change the layering of overlapping objects. To do this, select an object (using the Pointer
tool) that you wish to move. Select the Element, Arrange, and choose from Bring to front, bring
forward, Send backward or Send to back.

Moving
Holding down Shift before moving an object sideways constrains movement along a horizontal
line. Holding down Shift before moving an object up or down constrains movement vertically.
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Altering Graphics Resizing
With the help of the Pointer tool, click on a graphic to make the handles appear. Use the handles
to resize a graphic. Hold down Shift to size a graphic proportionally.

Cropping Graphics
The Crop tool is used to crop imported graphic images to the required size. The crop tool only
works on TIFF type of images. Click on the toll and, drag the image handles, to crop the image.
To crop an image, select the Cropping tool from the Toolbox. Click on the graphic you wish to
crop. Handles will appear. Place the cursor over one of the handles and hold down the mouse
button. The cursor will turn into a double-headed arrow. Drag the handle in and/or up to crop
the graphic. Dragging a handle back out with the cropping tool will uncover the cropped area.
To re-frame the graphic inside the new area, click directly on the graphic and hold the mouse
button down. The cursor will turn into the Hand tool. Drag the graphic around in its “frame.”

Create a Frame or Shadow Box
To create a frame, you can use the Frame Rectangle, Frame Ellipse or Frame Polygon tools, or
you can convert a PageMaker-drawn rectangle, ellipse, or polygon to a frame. To do this, select
the object and choose Element>Frame>Change to Frame. A frame can be either a text or graphic
frame depending on its content.

Frames
A frame is similar to a PageMaker graphic object in that it can have: Stroke or line attributes and
Fill attributes. A Frame differs in two ways: A frame can hold content—either text or graphic
and a text frame can be threaded to other text frames so that a single story can flow through
multiple frames.

Finding “Lost” Items
Use Edit, Select All to place handles on all items. This is especially helpful when you have placed
graphics over a text item.

Image Control
It can be used to edit paint-type and scanned images. User can control the lightness, contrast, and
screen pattern. Draw-type and EPS graphics cannot be altered. To open the Image Control dialog
box, Choose Element->Image->Image control.

Special Effects Icons
The whites in Black and White are transparent; the ones in Screened and in Gray are opaque.

Background Graphics
We can place graphics in our document background. For this, place your graphic and select the
Element, Image, Image control, menu options. Select Screen. Lighten by about two-thirds. Click
once on the Lightness “up arrow” then click and drag the dividing line. Click OK and place the
text.
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14.4.2 Placing Graphics
Click on the area where you want to place the graphic. Do not select anything on your page else
it will be replaced with graphic you are trying to insert.

Placing Figure in a Document
To add a figure in your PageMaker document, follow the steps below:
1.

Go to the page on which you want to insert the graphic.

2.

Select one of the three graphics placeholders from the toolbar and position it on the page;
the placeholders are polygons containing an “X”.

3.

Select the placeholder that you positioned on the page.

4.

Go to the File menu and select Place.

5.

Navigate to the graphic file you want to insert in the document.

6.

Select the file and click OK to place the graphic inside the graphic placeholder.

7.

If the placeholder is too small to contain the entire graphic, resize the placeholder by
selecting it, then dragging one of its handles outward.

8.

Resize and reposition placed graphics where you want them to be located.

9.

To resize a graphic, select it, then drag one of its handles (small boxes that are part of the
selection box) outward to enlarge the graphic or inward to shrink the graphic.

10.

To reposition the graphic, drag it into position on the page.

Self Assessment
Fill in the blanks:
7.

Using …………………… we can change the layering of overlapping objects.

8.

Holding down …………………… before moving an object sideways constrains movement
along a horizontal line.

9.

The crop tool only works on …………………… type of images.

Task Create a PageMaker document with the picture of a student along with his personal
information for a school ID card.

14.5 Toolbox
Toolbox contains all the tools used to create a publication in PageMaker. Choose Window and
select ShowTools to display the toolbox. The individual tools are explained below.

The Pointer Tool
Pointer tool is used to pick, drag and drop graphics and text.
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Figure 14.6: Pointer Tool

Notes

Source: http://www.print-templates.com/pagemaker6.5/basic3.php4

The Line and Constrained Line Tools
The line tool is used to make a line. Oblique Line is used to draw slanting lines. To draw a line,
click the oblique line tool, click and drag to draw a line in any direction. Constrained Line tool
will draw lines at 45 degree intervals, i.e., horizontally, vertically or diagonally.
Figure 14.7: Constrained Line Tools

Source: http://ncsmindia.com/wp-content/uploads/2012/04/DTP4.pdf
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The Rectangle Tool
Click on the Rectangle tool. Release the mouse when you get the required size. Change the
shape using a SHIFT key.

The Ellipse Tool
The circle tool enables you to create a circular or oval shape. Select the circle tool, click on the
document. Drag to draw a circle or ellipse.
Figure 14.8: Circle Tool

Source: http://www.print-templates.com/pagemaker6.5/basic4.php4#5

Self Assessment
Fill in the blanks:
10.

…………………… tool is used to pick, drag and drop graphics and text.

11.

…………………… is used to draw slanting lines.

Did u know? There are two different separate tools to create ellipse/circle–Ellipse tool and
circle tool.

14.6 Templates
A template is a file that contains standing elements for use in each issue. Templates help save
time because you do not have to place these elements every time you create a new issue.
Templates also help keep the paper’s style consistent.

14.6.1 Templates versus Publications
The final document created is a publication and when we open it, we work on the original copy.
Whereas a template it a copy of the final document and they can be saved as temporary files that
are yet to be completed.
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14.6.2 Changing the View of a Publication
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We can change the way our publications looks. To do this we have the zoom tool. To use it , opt
for any of the following options:
z

Choose the Zoom tool (magnifying glass in the Tools palette) then click on an area in the
publication. It will zoom to the next larger view size (based on your current magnification).
To zoom out, choose the zoom tool then hold down the Alt key then click on the publication.
When in zoom in mode, your mouse pointer becomes a magnifying glass with a plus sign.
In zoom out mode, the magnifying glass has a minus sign.

z

Switch quickly to the Zoom tool by holding down Cmd+Spacebar (Mac) or Ctrl+Spacebar
(Windows) to zoom in or the Cmd+Opt+Spacebar (Mac) or Ctrl+Alt+Spacebar (Windows)
when using any other tool.

z

Switch to the Zoom tool (using the Cmd/Ctrl+Spacebar keystroke) then click and drag a
rectangular selection box around the area you want to zoom in on and release the mouse
button. PageMaker zooms in on that selection.

z

Use the View menu to Zoom In, Zoom Out, change the view to Actual Size, Fit In Window,
or Entire Pasteboard. Each of these magnifications also have keyboard shortcuts as seen in
the table at the end of this article.

z

Choose Zoom To from the View menu to access the preset zoom or magnification options
of 25%, 50%, 75%, 100%, 200% and 400%. All but 25% have keyboard shortcuts as shown in
the table at the end of this article.

Self Assessment
State whether the following statements are true or false:
12.

The final document created is a publication and when we open it, we work on a copy and
not the original document.

13.

We can change the way our publications looks using the zoom tool.

14.7 Setting Up the Rulers
PageMaker uses nonprinting ruler guidelines to help you align and position objects. The margins
appear on the page as dotted or colored rectangular lines according to the specification chosen
in the File/Page Set up menu. To add ruler guides to position an object or company letterhead
make sure that you check rulers, guides, and snap to guides under Layout/guides and rulers.
PageMaker will pull the pointer into line with each tick mark on the ruler when you have guides
selected. This fact makes exact placement of the rulers possible.
z

With the right mouse button, click on the upper left corner of the page. This action centers
your view in the upper left corner and changes the page to the actual size so you can place
the ruler precisely.

z

Place the pointer on the horizontal ruler across the top of the publication and drag down
to the 11/2 “ mark on the vertical ruler. This will produce a horizontal ruler guide. When
you click on the horizontal ruler, the pointer will change to a two-headed arrow until the
mouse button is released.

z

Create more vertical and horizontal ruler guides as necessary to experiment with page
layout. Note that if you hold down the Alt key and press the left mouse button, the pointer
becomes a grabber which will move the page on the desktop.
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z

Once you have the guides in place, chose Layout/guides and rulers/lock guides to avoid
accidentally repositioning them.

Self Assessment
State whether the following statements are true or false:
14.

PageMaker uses nonprinting ruler guidelines to help you align and position objects.

15.

If you hold down the Alt key and press the left mouse button, the pointer becomes a
grabber which will move the page on the desktop.

14.8 Displaying Guides
Guides are used to help visualize non-printing areas, align text, and align images and other
graphic elements on the page and to each other. Let us see how they work in PageMaker.
z

To select an object and not the guide that overlaps it hold down Command (Mac) or Ctrl
(Windows) while selecting the object.

z

To avoid grabbing the guides instead of other objects on the page go to View > Send
Guides to Back. Do this without a publication open and all new publications will have this
Option already set.
Figure 14.9: Ruler Guides

Source: http://www.ohio.edu/technology/training/upload/PageMaker-Advanced-Reference-Guide.pdf
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z

If you accidentally drag a guide out of position: Immediately after moving a page or
column guide, choose Edit > Undo or press Ctrl+Z (Windows) or if page and column
guides are based on a master page, choose Layout > Copy Master Guides to remove local
guides and replace them with the master guides.

z

To precisely position objects on the page, choose View > Snap to Guides then drag guides
into the desired position. Objects will then snap to the nearest margin, column, and ruler
guides.

z

Adjust the Snap to Zone – that area around the edge of the page and guides within which
objects are considered aligned – in File > Preferences > Layout Adjustment > Snap to Zone.

z

Use Utilities > Plug-ins > Grid Manager for greater control of guides and to save an
arrangement of column and ruler guides for use as a layout grid in other publications.

Notes

14.8.1 Specifying Column Guides
This command makes custom columns. To insert columns,
1.

Click column guides

2.

Insert the number of columns for the left and right page, and the space if you want.

3.

Click Set left and Right pages separately.

4.

Click Adjust Layout. The columns and amount of columns will now be on the correct
pages. Normally, two to three columns is more than enough to give the column effect.
Figure 14.10: Column Guides

Source: http://bohemiawebsites.com/images/pagemaker/pmcolumns.gif

14.8.2 Locking the Guides
From the View Menu choose Lock Guides. To unlock the ruler guides, deselect Lock Guides.
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Figure 14.11: Lock Guides

Source: http://www.ohio.edu/technology/training/upload/PageMaker-Advanced-Reference-Guide.pdf

14.8.3 Placing Text in Column
To place text in a column,
z

From the View Menu select Fit in Window.
Figure 14.12: Text in a Column

Source: http://www.yearbooks.biz/?event=FAQ.Detail&faq=77
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z

From the File Menu choose Place.

z

Select the.doc file and Click OK.

z

Position the loaded text icon at the intersection of the left margin and the 1½ inch vertical
guide.

z

Click to place the text file.

Task Create a brochure for school to describe an upcoming event

Self Assessment
State whether the following statements are true or false:
16.

To select a guide hold down Command (Mac) or Ctrl (Windows) while selecting the
object.

17.

From the View Menu choose Lock Guides to lock the guides.

Case Study

Adobe PageMaker

Anticipating the boom in desktop publishing, Robert Scott, editor of EOS magazine, has
been working with Adobe PageMaker since 1986.
In the early 1980s, publisher, Robert Scott, left his job as editor of a consumer photographic
magazine to start his own independent publication. Scott approached Canon to produce a
magazine for their camera user groups.
Published initially by Cannon under the name Canon User, the first issue was published in
1982 as a subscription only title. Cannon User was initially produced using traditional
methods – (typesetting and paste-up. However, Scott soon became aware of desktop
publishing when he saw a colleague producing a similar camera club newsletter using
computers. In 1986, Scott acquired a Macintosh Plus computer, a LaserWriter printer and
the original release of Adobe PageMaker.
Because computer-based printing services were rare at that time, a black and white magazine
was produced for some years using only the output of the LaserWriter.
In 1993, Canon User was replaced by EOS magazine, dedicated to providing information
on Canon’s EOS range of cameras. Over the years, Scott regularly updated both his Macintosh
system and his PageMaker software. Today, EOS magazine is produced on Adobe
PageMaker version 6.5 and enjoys a current circulation of 18,000.
“PageMaker really started desktop publishing for us,” explains Scott. “Back in 1986 it
really was the only viable package available. Since then, we’ve grown up with PageMaker
and now we do a lot of our own colour scanning.”
EOS magazine combines detailed analysis of products with tips and techniques for Canon
users. Therefore, images that have been sourced from Canon itself are assembled on the
page with images that have been produced in-house. Articles on photographic techniques
Contd...
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often feature a series of photographs of the same subject. These images are then combined,
with advice columns and tables of data, explaining how to reproduce certain effects. Pages
such as these combine material from at least three different sources. Titles and headlines
are also added to the magazine’s cover.
Among Scott’s favourite PageMaker features is the pasteboard. Reminiscent of a traditional
typesetting desk, material can be laid around the page and then laid in or taken out at the
editor’s request. Because this feature was based on the methods Scott had been trained in,
the transition to desktop publishing was relatively simple. “Like a lot of PageMaker
features, it harked back to techniques I’d been using for years. It’s a lot more convenient
but doesn’t alienate people used to traditional publishing techniques.” Scott also makes
frequent use of the package’s frame features. In PageMaker, a series of frames can be
created and filled with either text or images. These frames can also be linked so that a long
piece of text can easily be spread across several frames. Finally, Scott praises the package’s
Story Editor. This feature allows the user to edit content, even after layout has been
completed, and contains word processing tools such as search and replace. “I’m a writer
more than a designer,” Scott says. “So the story editor gives me total control over the
article.”
In the past two years, Scott has employed Anthony Viney as art director for the magazine.
“When Anthony joined he was used to working with Quark Xpress,” says Scott. “But
because we’ve been using PageMaker for 13 years, we asked him to change systems, and
it didn’t take him very long.”
Questions:
1.

Study and analyze the case.

2.

Write down the case facts.

3.

What do you infer from it?

Source: http://www.computerweekly.com/feature/Case-Study-Adobe-PageMaker-65

14.9 Summary
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z

PageMaker is a desktop publishing program. It is used to create documents with a complex
layout of text and graphics, such as brochures, pamphlets, newsletters, fliers, reports, etc.

z

The PageMaker Toolbox contains all of the tools you will use for creating and manipulating
text and objects.

z

We can move around a page by four methods – Scroll Bars, Hand Tool, Master Pages and
Page Numbers.

z

We can add and edit text to our PageMaker document.

z

Like text we can also add, edit and place figure in a document.

z

A template is a file that contains standing elements for use in each issue.

z

PageMaker uses nonprinting ruler guidelines to help you align and position objects.

z

Guides are used to help visualize non-printing areas, align text, and align images and
other graphic elements on the page and to each other.
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14.10 Keywords
Constrained Line: This tool enables you to draw horizontal, vertical and 45-degree angle lines.
Frames: Frames are placeholders that let you design a layout without actual text or graphics.
Graphics: Elements like pictures that can be added on the PageMaker document.
Guides: Lines on the page that allow you line up text and graphic boxes.
Master Page: A Master Page is the page that contains basic formatting information, such as
guides, that you wish to use across a multiple page publication.
Page Icos: Identify the various functionalities of the document.
Pasteboard: The area surrounding the page(s) of your publication on the screen.
Publication: A newsletter, brochure, catalogue or other file that you have created with
PageMaker.
Ruler: They help you align and position objects.
Templates: A template is a predefined layout that you can copy and modify (if desired) for your
publication.

14.11 Review Questions
1.

Explain all the tools available in the toolbox in PageMaker.

2.

Give the steps to place a figure in a document in Pagemaker.

3.

What is the difference between a template and a publication?

4.

What is the difference between opening a normal publication and a template?

5.

What are the different ways to move around a PageMaker document?

6.

Briefly explain the place command used to place text.

7.

Elaborate the process to change the view of a publication.

8.

Explain the concept of guides.

9.

What are rulers? Explain vertical and horizontal rulers.

10.

How do you place text in a column?

Answers: Self Assessment
1.

Show Tools

2.

Pasteboard

3.

Zoom In, Zoom Out, Actual Size, and Fit in Window

4.

Scroll Bars, Hand Tool, Master Pages and Page Numbers

5.

True

6.

False

7.

Layering Graphics

8.

Shift

9.

TIFF

10.

Pointer

11.

Oblique Line

12.

False

13.

True

14.

True
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15.

True

17.

True

16.

False

14.12 Further Readings

Books

PageMaker(r) 7: The Complete Reference by Carolyn Connally
Adobe PageMaker 7.0 Classroom in a Book [Paperback] by Adobe Creative Team
Adobe PageMaker 7.0 by Kevin G. Proot
PageMaker 6.5 Plus for Windows by Ted Alspach

Online links

http://www.print-templates.com/pagemaker6.5/basic4.php4#5
http://www.uncp.edu/doit/training/guides/pdf/pagemaker_6_5plus.pdf
http://www.brighthub.com/multimedia/publishing/articles/5615.aspx
http://www.leasttern.com/HighSchool/PagemakerTutorial.pdf
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